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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (http://
h20230.www2.hp.com/svi_partner_list.jsp), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide describes various solutions and integrations available for 
HP Business Availability Center.

How This Guide Is Organized

The guide contains the following parts:

 Part I HP Business Availability Center for SOA

Describes the tasks to perform in HP Business Availability Center to monitor 
your Service-Oriented Architecture (SOA) enterprise environment. 

 Part II HP Business Availability Center for SAP Applications

Describes how to install the SAP solution, the specific tasks involved in 
administering it, how the SAP discovery package discovers SAP-related CIs 
and general CIs (such as hosts) that are related to them, and provides 
information that can help troubleshooting the HP Business Availability 
Center SAP solution. 

This chapter describes: On page:

How This Guide Is Organized 11

Who Should Read This Guide 13

Getting More Information 13
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Welcome to This Guide
 Part III HP Business Availability Center for Siebel Applications

Describes how to administer Business Availability Center for Siebel 
Applications solution, the specific tasks involved in administering it, how 
the Siebel discovery package discovers Siebel-related CIs and general CIs that 
are related to them, and provide information that can help troubleshooting 
Business Availability Center for Siebel Applications solution. 

 Part IV Business Availability Center APIs

Describes how to use the HP Business Availability Center generic data 
engine API to extract data from HP Business Availability Center for use with 
third-party or custom tools, as well as how to use the CMDB API to 
read/write data from/to the CMDB and the Dashboard API to retrieve 
information about one or more views in an HP Business Availability Center 
system through a URL-based query to the database.

 Part V EMS Integrations

Describes how to build new integrations or customize out-of-the-box 
integrations for EMS (Enterprise Management Systems) applications, and 
how to integrate HP Business Process Insight (BPI) data into HP Business 
Availability Center.

 Part VI Diagnostics Integration

Describes how to configure the integration between HP Diagnostics and HP 
Business Availability Center.

 Part VII Application Performance Lifecycle

Describes how to use the Application Performance Lifecycle to integrate 
between HP Business Availability Center and HP Performance Center, 
enabling you to construct load tests based on real-user transaction data 
collected by the Real User Monitor, and how to use the Business Process 
Recognition tool to discover business processes that can help you monitor 
what really matters.
12
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Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the the HP Business Availability Center Deployment Guide PDF.
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HP Business Availability Center for SOA
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1
HP Business Availability Center for SOA

This chapter describes Business Availability Center for SOA.

This chapter describes: On page:

Concepts

Overview of the SOA Solution 18

HP Business Availability Center for SOA Architecture 19

SOA Discovery Modules 21

Integrating HP Diagnostics Data for SOA 24

Integrating with HP SOA Systinet 25

SiteScope Monitors for SOA 26

SOA Views and Reports 27

Tasks

Monitor SOA Environment in Dashboard 34

Upgrade HP Business Availability Center for SOA 38

Deploy SiteScope SOA Monitors 39

Run Business Process Monitor Transactions for SOA 41

Customization

Customize the Number of Web Services or Operations That Can Be 
Displayed in the SOA Reports

43
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Chapter 1 • HP Business Availability Center for SOA
Overview of the SOA Solution

HP Business Availability Center enables you to monitor your SOA 
environment, by monitoring the performance of SOA components within 
the environment. The data is collected by different HP Business Availability 
Center components:

➤ Discovery packages identify and map the SOA-based applications in your 
system from the UDDI registry, and from the Web services deployed onto 
IBM WebSphere, BEA WebLogic, and IIS containers. For more information, 
see “SOA Discovery Modules” on page 21.

➤ Dedicated SiteScope monitors collect Web service metrics and UDDI server 
health data. For more information, see “SiteScope Monitors for SOA” on 
page 26.

SiteScope data is displayed in the SOA reports and in the SOA views. 

➤ Business Process Monitors collect Web service performance data via Business 
Process Monitor transactions that run Web services scripts. For more 
information, see “Run Business Process Monitor Transactions for SOA” on 
page 41. 

Business Process Monitor data is not displayed in SOA reports; it is available 
only in the SOA views. 

➤ Diagnostics probes collect Web service performance and availability metrics 
directly on the Web server machines. For more information, see “Integrating 
HP Diagnostics Data for SOA” on page 24. 

Diagnostics data is displayed in the SOA reports and in the SOA views. 

Customize the Number of Elements That Can Be Displayed in the 
Top Metrics Reports

44

Troubleshooting and Limitations 44

This chapter describes: On page:
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Chapter 1 • HP Business Availability Center for SOA
Business Process Monitor and SiteScope are used for synthetic monitoring of 
Web services while Diagnostics is used for real monitoring of Web services 
calls. 

The collected data is used to build the SOA views and reports. For details, see 
“SOA Views and Reports” on page 27.

HP Business Availability Center for SOA Architecture

The following illustration shows the components of the HP Business 
Availability Center for SOA: 

Most of the SOA CIs and their relationships are created by automatic 
discovery. The configuration for those CIs is saved into the CMDB.
19



Chapter 1 • HP Business Availability Center for SOA
The architecture of the HP Business Availability Center for SOA solution 
includes the following components:

➤ The Discovery Probe communicates with HP Universal CMDB. In such a 
case, HP Universal CMDB and HP Business Availability Center use the same 
CMDB. HP Universal CMDB server collects information on changes made to 
CI’s properties (changes of the SOA infrastructure: hosts, application servers, 
and so on.) and functional changes of the web services (changes to WSDL; 
for example if a new parameter or a new operation were added or if an 
operation was removed). This information is stored in the History database, 
and is available in the SOA-related views in HP Business Availability Center. 
For details about the History database, see HP Universal CMDB 
documentation. For details about the change feature, see “View Changes 
Made to SOA CIs” on page 38.

The Discovery packages are used by the Discovery Probe to discover, 
identify, and map the SOA-based applications in your system, starting from 
the UDDI registry, and from Web services deployed onto IBM Websphere, 
BEA WebLogic, and IIS (Internet Information Services). This information is 
then used to create SOA-related CIs and other CIs in the CMDB. It also 
creates the hierarchy of CIs displayed in the SOA UDDI Registry, the SOA 
Web Services, the SOA Rogue Services, and other views. A rogue service is a 
service which is not registered in the UDDI registry.

➤ Business Process Monitor collects data on the performance and availability 
of the Web services by running transactions that run Web services scripts. 
The CIs and relationships for the incoming Business Process Monitor 
samples are created by the Business Process Monitoring source adapter 
(described in “Business Process Monitoring Source Adapter Details” in 
IT World Model Management). This information is not supported in SOA 
reports; it is available in the SOA views.

➤ The Diagnostics Monitor monitors real user traffic to the Web services and 
operations and sends it to the Diagnostics server, that processes and stores 
it. The CIs and relationships for the incoming Diagnostics samples are 
created by the Diagnostics source adapter (described in “Diagnostics Source 
Adapter Details” in IT World Model Management). Diagnostics data is 
available in the SOA reports when you select the Real Data parameter. For 
details, see each report description.
20



Chapter 1 • HP Business Availability Center for SOA
➤ SiteScope monitors the Web services and retrieves Web services metrics and 
UDDI server health data. The CIs and relationships for the incoming 
SiteScope samples are created by the SiteScope source adapter (described in 
“SiteScope Source Adapter Details” in IT World Model Management). 
SiteScope data is available in the SOA reports when you select the Synthetic 
parameter. For details, see each report description.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Introduction 
to Dashboard” in Using Dashboard .

SOA Discovery Modules

HP Business Availability Center includes discovery patterns for monitoring 
your SOA environment. 

The following discovery modules (containing discovery patterns) are 
involved in discovering the Web services and WSDL files that relate to your 
SOA infrastructure. When a module is run, it creates CIs for the discovered 
elements in the CMDB; the appropriate HP Business Availability Center 
views are automatically populated with the created CIs, according to the 
TQL for each view.

Note: HP Business Availability Center supports nested WSDL files (mapped 
to Configuration File CIs). A WSDL file contains several sections that can be 
mapped to different Configuration File CIs. For example the service 
operations can be mapped to one CI and the service binding information to 
a different CI. This practice enables sharing similar definitions across Web 
services. 
21



Chapter 1 • HP Business Availability Center for SOA
Application - Webservices Module
The Application - Webservices module contains the UDDI Registry pattern 
and is mainly responsible for mapping the service providers, Web services, 
and WSDL files that are discovered from the UDDI registry (for UDDI 
versions 2 and 3). This information is presented in the SOA UDDI view. 

For information on the Application - Webservices module, see “Universal 
Description Discovery and Integration (UDDI)” in Discovery.

For details about the SOA UDDI view, see “SOA Views and Reports” on 
page 27.

Note: WSDL files should be placed in the UDDI registry according to the 
following UDDI hierarchy (from the UDDI technical specification by 
OASIS): BusinessService > TemplateBinding > TModel > OverViewDoc. They 
cannot be found in any other location.

J2EE - WebLogic module
The J2EE - WebLogic module discovers Web services and their WSDL files, 
deployed onto BEA WebLogic servers. The resulting CIs for the Web services, 
Web service operations, and configuration files are presented in the 
WebLogic Topology view (along with other components discovered on the 
WebLogic servers) and added to the SOA Web Services view and SOA UDDI 
view, as relevant.

For information on the J2EE - WebLogic module, see “WebLogic” in 
Discovery.

For details about the SOA UDDI and SOA Web Services views, see “SOA 
Views in Dashboard” on page 28.
22



Chapter 1 • HP Business Availability Center for SOA
J2EE - WebSphere module 
The J2EE - WebSphere module discovers WSDL files deployed onto IBM 
WebSphere servers, and parses the WSDL to identify the Web service 
components. The resulting CIs for the Web services, Web service operations, 
and configuration files are presented in the WebSphere Topology view 
(along with other components discovered on the WebSphere servers) and 
added to the SOA Web Services view and SOA UDDI view, as relevant. 

For information on the J2EE - WebSphere module, see “WebSphere” in 
Discovery.

For details about the SOA UDDI and SOA Web Services views, see “SOA 
Views in Dashboard” on page 28.

Web Servers - IIS module
The Web Servers - IIS module discovers Web services and their WSDL files 
deployed onto Microsoft IIS servers. The discovery process creates CIs for the 
discovered Web services, Web service operations, and configuration (WSDL) 
files. These CIs are added to the SOA Web Services view and SOA UDDI view, 
as relevant, and the Web service CIs are presented in the IIS Topology view 
(along with other components discovered on the IIS servers). 

For information on the Web Servers - IIS module, see “Internet Information 
Services (IIS)” in Discovery.

For details about the SOA UDDI and SOA Web Services views, see “SOA 
Views in Dashboard” on page 28.
23



Chapter 1 • HP Business Availability Center for SOA
Integrating HP Diagnostics Data for SOA

HP Business Availability Center supports integration with HP Diagnostics, 
enabling you to view end-to-end performance information in HP Business 
Availability Center applications, for Web services that are monitored by 
HP Diagnostics. You can also directly access the HP Diagnostics application 
to view Web services reports. 

The Web service information is collected by HP Diagnostics probes installed 
on the Web Server machine. The probes detect Web service traffic on the 
machine and identify Web service operations for the Web services. The 
monitoring data, collected for each Web service operation, is sent by 
HP Diagnostics to HP Business Availability Center. 

The Diagnostics adapter imports the Web services discovered by Diagnostics 
and created the configuration that includes the Web service, its operations 
and also the monitors. The adapter does not contain the WSDLs files. The 
key attributes of the Web service and operations are the same regardless of 
the method used to create them (Diagnostics or other discovery patterns). 
The key attributes of a WS are its target name space and service name. (For 
information on the view, see “SOA Views in Dashboard” on page 28.) In 
addition, the HP Diagnostics sample data is used in the HP Business 
Availability Center for SOA application reports—for details, see “SOA Views 
and Reports” on page 27.

For information on deploying the HP Diagnostics probes, and accessing the 
HP Diagnostics application from HP Business Availability Center, see the 
HP Diagnostics User’s Guide (accessible from the HP Business Availability 
Center Help menu after registering the HP Diagnostics server).

Note: HP Diagnostics monitoring is supported for Web services based on 
SOAP over HTTP/S protocols.
24



Chapter 1 • HP Business Availability Center for SOA
Integrating with HP SOA Systinet

HP Business Availability Center supports integration with the HP SOA 
Systinet platform, enabling you to better manage and monitor your business 
services, and to understand the business impact of Web services. The 
integration also enables you to streamline the contracts information defined 
in HP SOA Systinet with your SLAs in HP Business Availability Center.

There are various dimensions to the integration with HP SOA Systinet:

➤ You can run the discovery UDDI registry pattern to discover the content of 
your HP SOA Systinet Registry, so that the HP SOA Systinet service model is 
available in HP Business Availability Center. For details, see “Universal 
Description Discovery and Integration (UDDI)” in Discovery.

➤ You can use the links available in Dashboard, Service Level Management, 
and HP Business Availability Center for SOA, to open HP SOA Systinet 
directly at the page for the selected Web service.

HP SOA Systinet provides information on the Web service such as the 
contracts on the service, policies and their compliancy, usage plans, and 
other general information. This can be useful for problem isolation and 
understanding the business impact. 

When defining an SLA in Service Level Management, you can use the link to 
HP SOA Systinet to view the contract information in HP SOA Systinet and 
then configure the SLA accordingly in HP Business Availability Center. 

➤ In HP SOA Systinet, you can view service performance status (availability, 
performance, and so on) derived from HP Business Availability Center. You 
can also link to the health report in HP Business Availability Center for the 
selected service. This information can help consumers understand and 
evaluate service status. 

For information on HP SOA Systinet, including service contracts and how to 
view service performance status derived from HP Business Availability 
Center, see the HP SOA Systinet documentation.
25



Chapter 1 • HP Business Availability Center for SOA
SiteScope Monitors for SOA

You deploy dedicated SiteScope monitors to collect Web service metrics and 
UDDI server health data. The collected data is used to calculate KPI values in 
the SOA views, and can be viewed in reports of the HP Business Availability 
Center for SOA application.

SiteScope monitors for SOA monitoring can be deployed from the Monitor 
Deployment Wizard, or from System Availability Management. 

The SiteScope monitors used to monitor your SOA environment are:

➤ UDDI Monitor. Used to perform a search in the UDDI Server. Each time that 
the monitor is run, SiteScope checks if the UDDI Server can find a business 
entity. For details, see “UDDI Monitor Overview” in Using System Availability 
Management.

➤ Web Service Monitor. Used to check the availability of a Web service 
accepting Simple Object Access Protocol (SOAP) requests. The Web Service 
Monitor checks that the service can send a response to the client in a certain 
amount of time and verifies that the SOAP response is correct based on 
match specifications. For details, see “Web Service Monitor Overview” in 
Using System Availability Management.

Important: It is recommended that you deploy the Web Service Monitor 
using the Monitor Deployment Wizard, so that the resulting CIs by default 
use the Availability and Performance KPIs (required for the Business 
Availability Center for SOA application); if you deploy the Web Service 
Monitor from System Availability Management, then the resulting CIs by 
default use the System KPI. 

➤ Technology Web Service Integration Monitor. Used to integrate Web service 
event data or metrics data from an existing EMS system to HP Business 
Availability Center. This monitor can only be deployed from System 
Availability Management, not from the Monitor Deployment Wizard. For 
details, see “About the Technology Web Service Integration Monitor” in 
Using System Availability Management.
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SOA Views and Reports

The SOA views present Web services performance, availability, and 
throughput (load on the Web service) information collected by SiteScope 
and Diagnostics monitors, about monitoring traffic to selected Web services, 
operations, or servers. The data enables you to analyze the detected 
performance issues, and helps you to identify the cause of delays. In 
addition, the views display information about the system status impacting 
the Web service and also changes indications.

If the Web service is discovered on an application server (WebLogic, 
WebSphere or IIS) the Web service has a relationship with its host (the host 
is a child of the Web service; if you monitor the host CPU for example, it has 
a System KPI that propagates to the Web service). This helps to triage Web 
service problems, when the Web service has a performance/availability 
problem due to a system issue. 

From the SOA views you can:

➤ Drill down to the HP Business Availability Center for SOA reports that 
present detailed metrics information about the performance, availability, 
and throughput over time, as well as the total number of calls, the number 
of calls that are slow or end with a SOAP fault, the least available Web 
services/operations, the slowest Web services/operations, consumer 
information, and server information, and so on. 

➤ Use the context menu to access additional information; for example to 
access the HP Diagnostics application. For details, see “Dashboard Menu 
Options” in Using Dashboard.

➤ Access User reports. User reports provide a list of all of the defined custom 
reports, trend reports, and custom links that have been defined in the 
system, that the current user has permissions to view. You can display the 
reports in Excel format, create custom reports, and trend reports, and so on. 
For details, see “About User Reports” in Custom Reporting and Alerting.

The SOA reports can be used for problem isolation or problem management, 
Web service trending and comparison, and for summary reports. For details, 
see Chapter 2, “Service-Oriented Architecture User Interface.”
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This section includes the following topics:

➤ “SOA Views in Dashboard” on page 28

➤ “HP Business Availability Center for SOA Reports” on page 32

SOA Views in Dashboard
HP Business Availability Center for SOA displays information about the 
performance, availability, and throughput of the UDDI registry, Web 
services, operations, SiteScope monitors, SiteScope Web services monitors, 
and nested WSDL in the following views:

➤ SOA Web Service View. Includes all of the web services that were discovered 
and stored in the CMDB. 

The TQL for the view is built as follows:
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➤ SOA Rogue Services View. Includes all of the web services that were discovered 
and stored in the CMDB and that are not registered in the UDDI registry. They also 
appear in the SOA Web Services View.

The TQL for the view is built as follows:
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➤ The SOA UDDI View. The SOA UDDI view represents information obtained 
by running the UDDI discovery. The SOA UDDI view includes the UDDI 
registries and all the Web services that were discovered from the UDDI 
registries. It also includes their operations and WSDL. The Web service 
providers (represented by the business unit) are also discovered and related 
to their respective Web services. The business unit level represents the 
service provider.

Note: Nested WSDL files are mapped to the Configuration File CIs. For 
details, see “View Configuration File CI Details” on page 37.
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The TQL for the view is built as follows:

CIs Discovered by the Discovery Process

The following CIs are discovered by the SOA discovery processes. For details, 
see “Universal Description Discovery and Integration (UDDI)”, “WebLogic”, 
or “WebSphere” in Discovery.

The default KPIs are described in “List of Dashboard KPIs and Their Details” 
in CI Attribute Customization. 

The CIs discovered by the discovery process are:

CI Name Icon Description

UDDI Registry The UDDI Registry CI represents all of the 
UDDI registries that were discovered in your 
network.

Business Unit The Business Unit CI represents the service 
providers discovered in your network.

Web Service 
Monitor

The Web Service Monitor CI represents the 
Web services monitors discovered in your 
network.
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HP Business Availability Center for SOA Reports
The HP Business Availability Center for SOA reports enable you to 
proactively monitor the availability, response time, throughput, number of 
calls, number of SOAP faults, and number of slow calls, to selected Web 
service(s) or operation(s), by selected consumer or server. 

You use the SOA reports to view and analyze the health of access to Web 
service(s) or operation(s).

For details on working with HP Business Availability Center reports, see 
“Reports User Interface” in Custom Reporting and Alerting.

This section includes the following topics:

➤ “Report Access and Permissions” on page 32

➤ “Business Availability Center for SOA Reports” on page 33

➤ “Data Aggregation” on page 34

Report Access and Permissions

The availability of report data for a specific user is dependent on the profile 
access permissions granted that user. Furthermore, access to specific data 
within a profile can also be limited by the administrator using report filters. 
For details on granting permissions, see “Permissions Management” in 
Platform Administration. 

For details on setting report filters, see “Configuring Report Filters Globally” 
in Platform Administration and “Active Filter Dialog Box” on page 46.

Web Services The Web Services CI represents the Web 
services discovered in your network.

Web Service 
Operation

The Web Service Operation CIs represent the 
operations discovered in your network.

Configuration 
File

The Configuration File CIs represent the URL of 
the WSDL page used by the Web service. 

CI Name Icon Description
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In addition, the SOA reports permissions is based on the views permissions. 
An SOA report (except for the Top Metrics Report) is dependent on the 
selected view. The user is able to display only views for which he has 
permissions. 

Only views that are assigned to SOA are available in the SOA reports. A view 
can be assigned to SOA in the view properties. For details, see “Create New 
View/View Properties Dialog Box” in IT World Model Management. By default, 
views created in the SOA folder are assigned to SOA. 

Business Availability Center for SOA Reports

The Business Availability Center for SOA tab includes the following reports:

➤ SOA reports:

➤ Health report. Displays health metrics for the selected Web service(s), 
operation(s), server, or consumer in a selected view. For details, see 
“Health Report” on page 52.

➤ Top Metrics report. Displays the top metrics information about the 
traffic to and from all of the monitored Web services or operations. For 
details, see “Top Metrics Report” on page 72.

➤ Metrics Over Time report. Displays the performance, over time, 
measuring access to selected Web services or operations, by a server, or a 
consumer. For details, see “Metrics Over Time Report” on page 63.

➤ Consumer Summary report. Displays specific metrics for all of the 
consumers accessing the selected Web services or operations in a selected 
view. For details, see “Consumer Summary Report” on page 48.

➤ Server Summary report. Displays a drillable summary of the metrics for 
all of the servers on which the selected Web services or operations of a 
selected view are running. For details, see “Server Summary Report” on 
page 68.

➤ User reports. User reports is common to some of the HP Business 
Availability Center applications. You configure and view user reports from 
the User Reports tab. For details, see “Introducing User Reports” in Custom 
Reporting and Alerting.

The data displayed in some of the reports is obtained from the Diagnostics, 
or SiteScope monitors.
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Data Aggregation

HP Business Availability Center uses data aggregation to make data handling 
and management more efficient and to improve the speed and performance 
of report generation. For more information on data aggregation in 
HP Business Availability Center, see “Data Aggregation” in Reference 
Information.

Monitor SOA Environment in Dashboard

This section describes the processes to monitor an SOA environment in 
Dashboard, and gives examples.

This task includes the following steps:

➤ “Valid License” on page 34

➤ “Perform Discovery” on page 35

➤ “Enable HP Diagnostics Integration and Deploy Diagnostics Probes” on 
page 35

➤ “Enable HP SOA Systinet Integration” on page 36

➤ “Deploy SiteScope Monitors” on page 36

➤ “Create Business Process Profiles” on page 36

➤ “View SOA Information in Dashboard” on page 36

➤ “View Configuration File CI Details” on page 37

➤ “View Changes Made to SOA CIs” on page 38

Valid License
In order to view the HP Business Availability Center for SOA application, 
you must have an HP Business Availability Center for SOA license. For 
details, see “License Management” in Platform Administration.
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Perform Discovery
You deploy the appropriate discovery patterns to discover the SOA 
architecture on your network. 

HP Business Availability Center includes discovery patterns for monitoring 
your SOA environment. The discovery patterns are deployed from Admin > 
Universal CMDB > Discovery > Job Configuration.

For information on deploying and running discovery, see “Package 
Administration Overview” in IT World Model Management and “Discovery 
Overview” in Discovery.

For information on the SOA discovery modules, see “SOA Discovery 
Modules” on page 21.

Enable HP Diagnostics Integration and Deploy Diagnostics 
Probes
To view metrics collected by HP Diagnostics probes installed on the Web 
server machines, register the Diagnostics server in HP Business Availability 
Center. For details, see “HP Diagnostics and HP Business Availability Center 
Integration” on page 427.

Note: HP Diagnostics monitoring is supported for Web services based on 
SOAP over HTTP/S protocols.
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Enable HP SOA Systinet Integration
If you are running HP SOA Systinet, you can integrate it with HP Business 
Availability Center to enable more unified management and monitoring of 
your business services, and to understand the business impact of Web 
services. The integration also enables you to streamline the contracts 
information defined in HP SOA Systinet with your SLAs in HP Business 
Availability Center.

To enable the HP SOA Systinet and HP Business Availability Center 
integration, you must register the HP SOA Systinet server in HP Business 
Availability Center. Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Foundations, select SOA Report Settings, 
and locate the Systinet server host and port entry in the Systinet Settings 
table. Define the host name and port, if required.

Deploy SiteScope Monitors
If you want dedicated SiteScope monitors to provide metrics on your SOA 
components, you must deploy the monitors. For details, see “Deploy 
SiteScope SOA Monitors” on page 39.

Create Business Process Profiles
If you want your SOA views to include performance metrics for running 
transactions on your Web servers, you must define the Business Process 
profiles and transactions. For details, see “Run Business Process Monitor 
Transactions for SOA” on page 41.

View SOA Information in Dashboard
Once your SOA monitoring environment is set up, you can view SOA 
monitoring data in Dashboard, Service Level Management, and the 
HP Business Availability Center for SOA application using views and reports. 
For details, see “SOA Views and Reports” on page 27.
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View Configuration File CI Details
Right-click a Configuration File CI in the SOA UDDI View, select Properties, 
and click Show document content to display the contents of the 
configuration file that displays the contents of the WSDL page 
corresponding to the URL. For details, see “Properties Tab” in IT World Model 
Management.

Note: Nested WSDL files are mapped to the Configuration File CIs. 

Example

Nested WSDL appear in View Explorer as a list of Configuration File CIs 
under the main Configuration File CI. For example:

http://<server_name>/uddi/doc/wsdl/account.wsdl
http://<server_name>/uddi/doc/wsdl/account_binding.wsdl
http://<server_name>/uddi/doc/wsdl/account_portType.wsdl
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View Changes Made to SOA CIs
Changes made to the properties of all types of CIs (changes of the SOA 
infrastructure: hosts, application servers, and so on) and functional changes 
of the web services (changes to WSDL; for example if a new parameter or a 
new operation were added or if an operation was removed) are discovered 
by different types of discoveries. Those changes are displayed in the Change 
report available as a context menu option for each one of the relevant CI 
types. 

For details about the Change report, see “Change Report Page” in IT World 
Model Management. 

For details about the UDDI Registry, WebSphere, WebLogic, and IIS 
discoveries, see “Discover Specific System Components” in Discovery.

Upgrade HP Business Availability Center for SOA 

For details about the upgrade procedure, see “Upgrading Components” in 
the HP Business Availability Center Deployment Guide PDF.

When you upgrade from HP Business Availability Center 6.x, all monitors 
and views for your SOA environment are automatically upgraded to the new 
version (the Web Services view is renamed to the SOA Web Services view). 
However, SiteScope Web Service monitors need to be redefined to work with 
the HP Business Availability Center for SOA reports. For details, see 
“Upgrading Web Service Monitors” on page 39.

To work with the HP Business Availability Center for SOA solution in 
HP Business Availability Center, you require a dedicated license. For 
information on updating your licensing information, see “License 
Management” in Platform Administration.
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Upgrading Web Service Monitors
If you deployed SiteScope Web Service Monitors in earlier HP Business 
Availability Center versions, these are not automatically upgraded in version 
6.5 to use the Availability and Performance KPIs. The Availability and 
Performance KPIs are required to view SiteScope Web service monitoring 
data in the HP Business Availability Center for SOA reports. 

After upgrading, you should delete the previous Web Service Monitors, and 
redeploy the monitors using the Monitor Deployment Wizard. For more 
information, see “Using the Monitor Deployment Wizard” on page 40.

Deploy SiteScope SOA Monitors

You deploy dedicated SiteScope monitors to collect Web service metrics and 
UDDI server health data. The collected data is used to calculate KPI values in 
the SOA views, and can be viewed in reports of the HP Business Availability 
Center for SOA application.

SiteScope monitors for SOA monitoring can be deployed from the Monitor 
Deployment Wizard, or from System Availability Management. 

This task includes the following steps:

➤ “Manually Attach SiteScope Monitors” on page 39

➤ “Using the Monitor Deployment Wizard” on page 40

Manually Attach SiteScope Monitors
If the monitors are deployed from System Availability Management, you 
must manually attach them to SOA discovery CIs. This is done in Admin > 
Universal CMDB > Modeling > IT Universe Manager. For details, see 
“Working with CIs” in IT World Model Management.

For details about the SiteScope monitors used to monitor your SOA 
environment, see “SiteScope Monitors for SOA” on page 26.
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Using the Monitor Deployment Wizard
You can create and map SiteScope monitors directly onto the SOA CIs 
created by the discovery process, using the Monitor Deployment Wizard. 
The SiteScope monitoring CIs generated by the SiteScope monitors are then 
deployed onto the UDDI Registry, Web Service, and Web Service Operation 
CIs, creating a Monitored By relationship between them. For details, see 
“Monitor Deployment Wizard” in Using System Availability Management.

Example

 1 Proceed as explained in “Monitor Deployment Wizard” in Using System 
Availability Management.

 2 In the left pane of the Select Configuration Items to Monitor page, select the 
relevant SOA view. Select the CIs you would like monitored and move them 
to the right pane.

Note: The Web Service Monitor monitors Web service operations so you can 
map Web service operations to Web Service Monitors monitors using the 
Monitor Deployment Wizard. The UDDI Registry Monitor monitors UDDI 
registries, so you can map UDDI Registry CIs to the UDDI Registry Monitors.

If the Web Service Operation CIs that you move to the right pane are already 
monitored, then they are displayed in italics with an Already monitored 
message.
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 3 Click Next. The Select Templates to Apply page opens. The left pane lists all 
the available templates in the wizard, including the Web Services Monitors 
and UDDI Monitors templates used for the SOA monitors, and the SiteScope 
templates for host if the hosts on which the Web services are deployed are 
also selected. Expand the template to see the monitors that are deployed by 
the template. The right pane lists the CI types (CITs) for the CIs selected in 
the previous page of the wizard.

If you added Web Service Operation CIs to the right pane at the previous 
stage of the wizard, then the wizard automatically matches them with the 
Web Services Monitors template, and displays the Web Service Operation 
CIT in the right pane with the template attached.

 4 Proceed with the wizard as indicated in “Monitor Deployment Wizard” in 
Using System Availability Management. 

To see the monitor CIs added in the views, synchronize the SiteScope source 
adapter in the Admin > Universal CMDB > Source Manager page. 
(Alternatively, wait for the automatic synchronization to take place).

The added Web Service Monitor CIs are given default names as follows: 
Synthetic Monitor On <name of relevant Web Service Operation CI>

Run Business Process Monitor Transactions for SOA

You can deploy Business Process profiles containing transaction monitors to 
actively monitor Web service performance. The transaction monitors run 
scripts that emulate Web service requests from end users, supplying 
end-to-end availability and response time metrics from varied and remote 
locations. The metrics are used for the BPM Transaction from Location CIs 
that are created in the CMDB.

You map the created business process monitoring CIs to the SOA CIs created 
by the discovery process, to produce an integrated SOA Web Services view.
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Note: Business process monitoring data is not available in the HP Business 
Availability Center for SOA application.

This task includes the following steps:

➤ “Create Scripts in HP Virtual User Generator” on page 42

➤ “Define Business Process Profiles” on page 42

➤ “View Business Process Monitoring CIs in the Views” on page 42

Create Scripts in HP Virtual User Generator
Create scripts in HP Virtual User Generator that emulate the Web service 
requests. For details, see Using HP Virtual User Generator.

Define Business Process Profiles
Define Business Process profiles in Admin > System Availability 
Management, using the Business Process Profile Wizard. Add transaction 
monitors to the profiles, to run the Vugen scripts for Web service requests, 
and assign the profiles to Business Process Monitor machines/instances at 
the required locations. For details, see “Creating Business Process Profiles” in 
Using End User Management.

View Business Process Monitoring CIs in the Views
To see the business process monitoring CIs immediately in the views, 
synchronize the Business Process Monitoring source adapter in the Admin > 
Universal CMDB > Source Manager page. (Alternatively, wait for the 
automatic synchronization to take place).
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Note: To include location information in the business process monitoring 
CI hierarchy, set the Business Process Monitoring source adapter to use the 
Transaction/Location hierarchy structure. For more information, see 
“Business Process Monitoring Source Adapter Details” in IT World Model 
Management.

Once Business Process Monitor has run the scripts, the resulting BPM 
Transaction from Location CIs are added to the CMDB and displayed in the 
monitors views and the End Users views. For information on the hierarchy 
of these views, see “Business Process Monitoring Source Adapter Details” in 
IT World Model Management.

To map the SOA CIs in the SOA Web Services view (discovered during the 
discovery process) to the relevant Business Process Step CIs and BPM 
Transaction from Location CIs, you must manually attach the business 
process monitoring CIs to the higher level CIs. This is done in Admin > 
Universal CMDB > Modeling > IT Universe Manager. For details, see 
“Attaching Existing CIs” in IT World Model Management.

Customize the Number of Web Services or Operations That 
Can Be Displayed in the SOA Reports

You can customize the number of Web services or operations that can be 
displayed in an SOA report. The default value is 20.

To customize the number of Web services or operations that can be 
displayed in an SOA report, access the Admin > Platform > Setup and 
Maintenance > Infrastructure Settings page, click Foundations, select SOA 
Report Settings, locate the SOA Reports Settings - General Settings table, 
and set the required value of the Max. number of selectable CIs in SOA 
reports parameter.
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Customize the Number of Elements That Can Be Displayed 
in the Top Metrics Reports

You can customize the number of elements that can be displayed in a Top 
Metrics report. The default value is 5. 

To customize the number of elements that can be displayed in a Top Metrics 
report, access the Admin > Platform > Setup and Maintenance > 
Infrastructure Settings page, click Foundations, select SOA Report Settings, 
locate the SOA Reports Settings - General Settings table, and set the 
required value of the Top Metrics Size parameter.

Troubleshooting and Limitations

The SOA reports reflect the relative view of the user. Therefore, if in a 
customized view, specific operations are attached to a Web service, the SOA 
reports based on the view display information related only to the Web 
service and the selected operations. Other operations connected to the Web 
service in the CMDB are not displayed.

If the monitors attached to the operations are not added to the customized 
view, the SOA reports display information that does not take into 
consideration the thresholds defined in the monitors.
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Service-Oriented Architecture User 
Interface

This chapter includes the pages and dialog boxes that are part of 
Service-Oriented Architecture (SOA) enterprise user interface.

This chapter describes: On page:

Active Filter Dialog Box 46

Consumer Summary Report 48

Health Report 52

Metrics Over Time Report 63

Server Summary Report 68

Top Metrics Report 72

User Reports 83
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Active Filter Dialog Box

Web Services/Operations Tab

The tab includes the following elements (listed alphabetically):

Description Enables you to filter SOA reports. The Active Filters 
have two tabs: Web Services/Operations and 
Servers/Consumers. You can filter by Web services, 
operations, server, or consumer. 

To Access: In the Health, Top Metrics, Metrics Over 
Time, Consumer Summary, or Server Summary reports, 
click Active Filters.

Important 
Information

You can also select items from both tabs to create more 
complex filters.

GUI Element Description

Search Click to search for a specific CI in the current view or 
in all views. For details, see “Search for Configuration 
Items” in Reference Information.

Selected CIs Select one of the following:

➤ Web Services. Displays a check box only for the Web 
services CIs appearing in the view. 

➤ Operations. Displays a check box only for the 
operation CIs appearing in the view. 

You can select up to 20 Web services or operations. This 
number can be modified in the Infrastructure Settings. 
For details, see “Customize the Number of Web Services 
or Operations That Can Be Displayed in the SOA 
Reports” on page 43.

View Select the appropriate view and select the relevant CIs 
in the view. Only views for which the user has 
permission and that have been assigned to SOA are 
displayed in the list. For additional information on the 
available views, see “SOA Views in Dashboard” on 
page 28. For additional information, see “Active Filter 
Dialog Box” on page 46.
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Server/Consumer Tab

The tab includes the following elements (listed alphabetically):

GUI Element Description

Filter Consumer By Select one of the following:

➤ In the Registered consumer IP box, enter the 
consumer IP number if you want to display 
information about the specific consumer. The 
consumer should be one of the consumers registered 
in HP Diagnostics. This is the default. For details, see 
HP Diagnostics Installation and Configuration Guide.

➤ Select Non-registered consumer IPs, to display 
information about the consumers that are not 
registered in HP Diagnostics. For details, see 
HP Diagnostics Installation and Configuration Guide.

Note: If you select the Registered consumer IP without 
entering an IP value in the box, then the filter includes 
all consumers. 

Server IP Enter the server IP number, if you want to display 
information about the Web services/operations 
working on the specific server.
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Consumer Summary Report

Report Settings

Description Displays specific metrics for all of the consumers 
accessing the selected Web services or operations 
in a selected view. 

To Access: Select Application > Business Availability 
Center for SOA, click the Business Availability Center 
for SOA tab, and select the Consumer Summary Report 
option in the Business Availability Center for SOA tab.

Important 
Information

When you select Real, the Consumer Summary Report 
displays information only for the consumers that were 
registered in the Diagnostics system. All other 
consumers are aggregated and presented as Others.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard” on page 34

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 46.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope 
monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 
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Consumer Summary Area

The area includes the following elements (listed alphabetically):

Description Displays the health metrics for all of the consumers 
accessing the selected Web services or operations. If, in 
the Active Filters, you also select specific consumer or 
server, the health metrics are further filtered by the 
selected consumer and server.

Important 
Information

The Consumer Summary area is the same in the View 
as Graph and View as Table tabs.

GUI Element Description

Click to drill down to the Health Report for the 
selected element. For details, see “Health Report” on 
page 52.

# of Calls The total number of calls to the selected Web services 
or operations accessed by the specific consumer.

# of Slow Calls The number of slow calls to the selected Web services 
or operations by the specific consumer. A slow call is a 
call with a response time longer than the predefined 
threshold.

# of SOAP Faults The number of faulty calls to the selected Web services 
or operations by the specific consumer. A faulty call is a 
call that ends in a SOAP fault.
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Availability The availability of the selected Web services or 
operations accessed by the specific consumer. The 
availability is calculated as the number of successful 
calls made by the specific consumer divided by the 
total number of calls made by the specific consumer, 
multiplied by 100.

The background is colored according to the threshold 
specified in the Availability KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

Consumer The IP number of the consumer.

Response Time (sec.) The average response time (in seconds) of the selected 
Web services or operations accessed by the specific 
consumer. 

The background is colored according to the threshold 
specified in the Response Time KPI definition. For 
details, see “How Dashboard KPIs Work” in Using 
Dashboard.

Throughput (calls 
per min.)

The number of calls, per minute, to the selected Web 
services or operations by the specific consumer. 

The background is colored according to the threshold 
specified in the Throughput KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

GUI Element Description
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Worst Consumer Area

\

The area includes the following elements (listed alphabetically):

Description Displays the successful and faulty calls of the worst five 
consumers accessing the selected Web services, 
operations, or servers.

Important 
Information

The Worst Consumer displays the same information in 
the View as Graph and View as Table tabs.

Each tab in the graph represents a different consumer 
and displays the number of successful calls (in green) 
and the number of faulty calls (in purple).

Move the mouse over a tab in the graph to display a 
tootlip. Hover above a tab to display a tooltip that 
indicates the number of faulty calls and the number of 
successful calls for the selected consumer.

 

GUI Element Description

Calls with errors 
(SOAP Faults)

The number of consumer calls that ended with a SOAP 
fault.

Successful calls The number of successful consumer calls.

Worst Consumer The IP number of the consumer.
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Health Report

Report Settings

Description Displays health metrics for the selected Web 
service(s), operation(s), server, or consumer in a 
selected view.

To Access: 

➤ Select Applications > Dashboard, select a view in 
View Explorer, right-click a specific Web Service or 
Operation CI in View Explorer, and select the Go to 
Report > Health Report option. In such a case, the 
Health Report is displayed filtered by the specific 
Web service or operation. For details, see 
“Dashboard Menu Options” in Using Dashboard

➤ Select Applications > Dashboard, select the Console, 
or Filters tab, select the appropriate view in View 
Explorer, right-click a specific Web Service or 
Operation CI in the right pane of Dashboard, and 
select Go to Report > Health Report. In such a case, 
the Health Report is displayed filtered by the specific 
Web service or operation. For details, see 
“Dashboard Menu Options” in Using Dashboard

➤ Select Applications > Business Availability Center for 
SOA, and select the Health Report option in the 
Business Availability Center for SOA tab.

Important 
Information

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard” on page 34

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.
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Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 46.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope 
monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

GUI Element Description
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Health Summary Area

Description The Health Report includes the Health Summary area. 
It can display:

➤ A list of same level items (Web services, operations, 
servers). In the following example, the Health report 
displays only the Health Summary. To display other 
metrics information, click the required item. See 
above for details.

➤ A tree (Web service/Operations, Operation/Servers). 
In the following example, the Health report also 
displays other metrics for the first item in the tree 
(for example, if the tree is a Web service/Operations 
tree, the other metrics are displayed for the Web 
service). See above for details.

Important 
Information

The Health Summary area is the same in the View as 
Graph and View as Table tabs.

Click the required element in the Health Summary 
report to access details about the health of the 
element’s components. For details about the elements’ 
components, see “Health Summary Area” on page 54.

Use the breadcrumbs to go back up the levels you 
drilled down.
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The area includes the following elements (listed alphabetically):

GUI Element Description

Click to access the Consumer Summary report for the 
selected element. For details, see “Consumer Summary 
Report” on page 48.

Click to access the Metrics Over Time report for the 
selected element. For details, see “Metrics Over Time 
Report” on page 63. 

Click to access Diagnostics reports for the selected 
element. For details, see HP Diagnostics User’s Guide.

Click to access the HP SOA Systinet application, 
focused on the relevant Web service. This option is 
relevant only when there is an integration between 
HP Business Availability Center and HP SOA Systinet. 
For details on the integration with HP SOA Systinet, see 
“Integrating with HP SOA Systinet” on page 25.

# of Calls The total of calls to the specific item. This is a metrics 
taken from the Diagnostics sample.

# of Slow Calls The number of calls to the specific item that were slow. 
This is a metrics taken from the Diagnostics sample. A 
slow call is a call with a response time that is longer 
than the predefined threshold.

# of SOAP Faults The number of calls to the specific item that ended in a 
SOAP fault. This is a metrics taken from the Diagnostics 
sample.

<any point in graph> You can also drill down from each point in the graphs 
to display more detailed information about the period 
of time represented by that point. You can drill down 
to the smallest unit of time (1 hour).

<breadcrumbs> Use the breadcrumbs to go back up the levels you 
drilled down.
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<item> The name of the item whose health metrics are 
provided in the Health Summary. It can be:

➤ Service

➤ Operation

➤ Service/Operations

➤ Operation/Servers

➤ Server

<Service, Operation, 
Service/Operations, 
Operation/Servers, 
Server in Health 
Summary report>

Click the required element in the Health Summary 
report to access details about the health of the 
element’s components. For details about the elements’ 
components, see “Health Summary Area” on page 54.

Availability The availability of the item. The background is colored 
according to the thresholds specified in the Availability 
KPI definition. The availability is calculated as the 
number of successful calls to the item, divided by the 
total number of calls to the item, and multiplied by 
100. For details, see “How Dashboard KPIs Work” in 
Using Dashboard.

Response Time (sec.) The response time (in seconds) of the item. The 
background is colored according to the thresholds 
specified in the Response Time KPI definition. For 
details, see “How Dashboard KPIs Work” in Using 
Dashboard

Throughput The number of calls to the item per minute. The 
background is colored according to the thresholds 
specified in the Throughput KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard

GUI Element Description
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Metrics Area

Description The Metrics area displays metrics information for the 
item listed in the first row of the Health Summary area. 
If multiple items were selected in the Active Filters, the 
SOAP Faults area displays average information for all of 
the selected items.

Important 
Information

You can also drill down from each point in the graphs 
to display more detailed information about the period 
of time represented by that point. You can drill down 
to the smallest unit of time (1 hour).
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The area includes the following elements in graph format:

GUI Element Description

Availability (%) The graph displays the availability of the item over the 
selected time frame of the report in graph format.

Response Time (sec) The graph displays the response time (in seconds) of 
the item over the selected time frame of the report in 
graph format.

The Response Time graph displays information about 
the Average Response Time (sec.) (olive line), the Max 
Response Time (sec.) (teal line), and the Min Response 
Time (sec.) (blue line).

Throughput The graph displays the number of calls to the item per 
minute, over the selected time frame of the report in 
graph format.

The title line of the Metrics area includes the name of 
the item whose metrics are displayed. If the Health 
Summary area displays a tree of Operation/Servers the 
title line of the Metrics area is Aggregated data for 
selected operations.
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SOAP Faults Area

GUI Element Description

# of Calls The total number of calls to the item, per time unit.

# of SOAP Faults The number of calls to the item that ended in a SOAP 
fault, per time unit.

Availability (%) The availability of the item, per time unit.

Max Response Time 
(sec.)

The highest response time (in seconds) of the item, per 
time unit.

Min Response Time 
(sec.)

The lowest response time (in seconds) of the item, per 
time unit.

Response Time (sec.) The response time (in seconds) of the item, per time 
unit.

Throughput The number of calls to the item per minute of the time 
unit.

Time The time units (hour) of the selected time period.

Description The SOAP Faults area displays information for the item 
listed in the first row of the Health Summary area. If 
multiple items were selected in the Active Filters, the 
SOAP Faults area displays average information for all of 
the selected items.

Important 
Information

➤ If you have selected to display synthetic data, the 
SOAP Faults area displays only the Worst Consumers 
graph.

➤ If you have selected to display real data, the SOAP 
Faults area displays all the graphs listed below.
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The area includes the following elements (listed alphabetically):

Graph Format

GUI Element Description

Pie chart Represents the faults distribution by type of SOAP fault 
that occurred when accessing the item during the 
specified time period. The types of error are: 
VersionMismatch, MustUnderstand, Sender, Receiver, 
and DataEncodingUnknown. The tooltip displays the 
number of faults of the type represented by the slice. 
The legend lists the SOAP Fault types.

SOAP Faults Shows the number of calls to the specific item that 
ended in a SOAP fault over the selected time period.

The title line of the SOAP Faults area or of the SOAP 
Faults table includes the name of the item whose 
metrics are displayed. If the Health Summary area 
displays a tree of Operation/Servers the title line of the 
SOAP Faults area is Aggregated data for selected 
operations.
60



Chapter 2 • Service-Oriented Architecture User Interface
Table Format

Worst Consumers Displays, for the five worst consumers (with the largest 
number of faulty calls), the number of successful calls 
(in green) and the number of faulty calls (in purple) to 
the item.

GUI Element Description

SOAP Faults 
Distribution

Shows the percentage of the occurrence of each type of 
SOAP fault compared to the total number of SOAP 
faults: VersionMismatch, MustUnderstand, Sender, 
Receiver, or DataEncodingUnknown.

GUI Element Description
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SOAP Faults 
Overtime

Displays the total number of calls to the selected item 
that ended in a SOAP fault over the selected time 
period, per unit of time.

Worst Consumers Displays the number of faulty calls to the selected item 
in the Calls with errors (SOAP Faults) column and the 
number of successful calls to the selected item in the 
Successful calls column, per consumer, for the five 
worst consumers (with the largest number of faulty 
calls).

GUI Element Description
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Metrics Over Time Report

Description Displays the performance, over time, measuring 
access to selected Web services or operations, by a 
server, or a consumer.

To Access: Select Applications > Business Availability 
Center for SOA, and select the Metrics Over Time 
Report option in the Business Availability Center for 
SOA tab.

Important 
Information

Move the mouse over a tab in the appropriate graphs to 
display the tooltip that includes the information listed 
in the table. 

➤ For a Web service:
 

➤ For an operation:
 

The tooltip displays the following information:

➤ Web Service/Operation. The name of the selected 
Web service/operation.

➤ <metric>. The value of the metric at this point.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard” on page 34
63



Chapter 2 • Service-Oriented Architecture User Interface
Report Settings

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 46.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope 
monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 
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Graph and Table Settings

The report includes the following elements (listed alphabetically):

GUI Element Description

<graph details> The View as Graph tab displays the selected metric 
performance of the selected Web services, operations, 
server, or consumer, during the selected time frame of 
the report.

The graph legend indicates the color used to display 
the metric information of the Web services if Web 
services were selected or operations if Operations were 
selected in the Active Filters.
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<right-click a point in 
the graph>

To display the Available Drilldowns menu, and select:

➤ Drill Down to Health Report. To display the Health 
report for the selected Web service or operation for 
the selected time period. For details, see “Health 
Report” on page 52

➤ Drill Down to Diagnostics Report. To open the 
Diagnostics application. For details, see 
HP Diagnostics User’s Guide.

➤ Time Range Drill Down. To display the metrics for 
the selected Web service or operation for the 
selected time period.

<table details> The View as Table tab displays the selected metric 
performance of the selected Web services, or 
operations, during the selected time frame of the 
report.

The table displays the Web service and/or operation, 
the namespace of the Web service and the value of the 
metric per time unit.

Generate Click to generate the report.

GUI Element Description
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Metrics Select the metric whose performance during the 
selected time period, you want to display. You can 
select: 

➤ Availability. The average availability (in percentage) 
of the selected Web services or operations, running 
on the selected servers, and accessed by the selected 
consumer during the selected time frame of the 
report.

➤ Throughput. The number of calls to the selected 
Web services or operations running on the selected 
server, by the selected consumer, per minute, during 
the selected time frame of the report.

➤ Avg. Response Time (sec.). The average response 
time (in seconds) of the selected Web services or 
operations, running on the selected server, by the 
selected consumer during the selected time frame of 
the report. 

➤ # of Calls. The total number of calls to the selected 
Web services or operations, running on the selected 
server, by the selected consumer, during the selected 
time frame of the report.

➤ # of SOAP Faults. The total number of faulty calls to 
the selected Web services or operations, running on 
the selected server, by the selected consumer, during 
the selected time frame of the report. A faulty call is 
a call that ends in a SOAP fault.

➤ # of Slow Calls. The total number of slow calls to the 
selected Web services or operations, running on the 
selected server, by the selected consumer, during the 
selected time frame of the report. A slow call is a call 
with a response time that is longer than the 
predefined threshold.

View as Graph tab Click to display the report in graph format.

View as Table tab Click to display the report in table format.

GUI Element Description
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Server Summary Report

Report Settings

Description Displays a drillable summary of the metrics for all of 
the servers on which the selected Web services or 
operations of a selected view are running. 

To Access: Select Application > Business Availability 
Center for SOA, click the Business Availability Center 
for SOA tab, and select the Server Summary Report 
option in the Business Availability Center for SOA tab.

Important 
Information

When you select Real, the Server Summary Report 
displays information only for the consumers that were 
registered in the Diagnostics system. All other 
consumers are aggregated and presented as Others. 

The report is available only if the Server IP field exists 
in the sample.

Move the mouse over a tab in a graph to display a 
tooltip that indicates the number of faulty calls and the 
number of successful calls to the selected server. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard” on page 34

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 46.
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Server Summary Area

The area includes the following elements (listed alphabetically):

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope 
monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

Description Displays the health metrics for all of the servers on 
which the selected Web services or operations are 
running. If, in the Active Filters, you also select specific 
consumer or server, the health metrics are further 
filtered by the selected consumer and server.

Important 
Information

The Server Summary area is the same in the View as 
Graph and View as Table tabs.

GUI Element Description

Click to drill down to the Health Report for the 
selected element. For details, see “Health Report” on 
page 52.

# of Calls The total number of calls to the server accessed by the 
Web services, operations, or consumer.

GUI Element Description
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# of Slow Calls The number of slow calls to the server accessed by the 
selected Web services, operations, or consumer. A slow 
call is a call whose response time is longer than the 
predefined threshold.

# of SOAP Faults The number of faulty calls to the server accessed by the 
selected Web services, operations, or consumer. A 
faulty call is call that ends in a SOAP fault.

Availability The availability of the server accessed by the selected 
Web services, operations, or consumer. The availability 
is calculated as the number of successful calls made to 
the server divided by the total number of calls made to 
the server, multiplied by 100.

The background is colored according to the threshold 
specified in the Availability KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

Response Time (sec.) The average response time (in seconds) of the server 
accessed by the selected Web services, operations, or 
consumer. 

The background is colored according to the threshold 
specified in the Response Time KPI definition. For 
details, see “How Dashboard KPIs Work” in Using 
Dashboard.

Server The IP number of the server.

Throughput (calls 
per min.)

The number of calls, per minute, to the server by the 
selected Web services, operations, or consumer.

The background is colored according to the threshold 
specified in the Throughput KPI definition. For details, 
see “How Dashboard KPIs Work” in Using Dashboard.

GUI Element Description
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Worst Server Area

The area includes the following elements (listed alphabetically):

Description Displays the successful and faulty calls of the worst five 
servers accessing by the selected Web services, 
operations, or consumer.

Important 
Information

The Worst Server displays the same information in the 
View as Graph and View as Table tabs.

Each tab in the graph represents one of the five worst 
servers and displays the number of successful calls (in 
green) and the number of faulty calls (in purple).

GUI Element Description

Calls with errors 
(SOAP Faults)

The number of calls to the server that ended with a 
SOAP fault.

Successful calls The number of calls to the server that was successful.

Worst Server The IP number of the server.
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Top Metrics Report

Report Settings

The area includes the following elements (listed alphabetically):

Description Displays the top metrics information about the traffic 
to and from all of the monitored Web services or 
operations. 

To Access: Select Applications > Business 
Availability Center for SOA, and select the Top 
Metrics option in the Business Availability Center for 
SOA tab.

Important 
Information

Move the mouse over a tab in the appropriate graphs to 
display the tooltip that includes the information listed 
in the table. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Monitor SOA Environment in Dashboard” on page 34

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.
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Top Area

The area includes the following elements (listed alphabetically):

Active Filter If relevant, click to select the appropriate conditions for 
the report. For details, see “Active Filter Dialog Box” on 
page 46.

Real/Synthetic Select one of the following:

➤ Real. To display data from the Diagnostics data 
collector.

➤ Synthetic. To display data from the SiteScope 
monitors.

Note: When you generate an SOA report, the Data 
Type selection is displayed in the top part of the report. 

GUI Element Description

From From the View as Table tab, click the Health 
report drill down button corresponding to:

➤ a specific Web service to open the Health Report of 
the Web service’s operation in table format. 

➤ a specific operation, to open the Health Report of 
the operation’s servers in table format. 

<bar in graph> From the View as Graph tab, click the bar that 
corresponds to:

➤ a specific Web service to open the Health Report of 
the Web service’s operations in graph format.

➤ a specific operation to open the Health Report of the 
operation’s servers in graph format.

Report Granularity Select:

➤ Web services to display the top metrics information 
for the selected Web services.

➤ Operations to display the top metrics information 
for the selected operations.

GUI Element Description
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Least Available Web Services Area

Description Displays the availability of the five Web services with 
the lowest availability, during the selected time frame 
of the report. The availability is calculated as the 
number of successful calls to the Web service, divided 
by the total number of calls to the Web service, and 
multiplied by 100.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.
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Slowest Web Services Area

Description Displays the five slowest Web services in the selected 
time frame of the report. A slow Web service is defined 
as having the longest response time (no matter the 
threshold value). Each tab represents the average of the 
response times for the Web service during the time 
frame of the report.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.
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Web Services with Most SOAP Faults Area

Web Services with Most Slow Calls Area

Description Displays the five Web services with the largest number 
of received SOAP faults, during the selected time frame 
of the report. Each tab represents the total number of 
SOAP faults received by the Web service.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.

Description Displays the five Web services with the highest number 
of slow calls, in the selected time frame of the report. A 
slow call is defined as a call that lasts longer than a 
predefined threshold. Each tab represents the total 
number of slow calls received by the Web service.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.
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Most Active Web Services Area

Least Active Web Services Area

Description Displays the five Web services with the highest number 
of calls, during the selected time frame of the report. 
Each tab represents the total number of calls to the 
Web service.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.

Description Displays the five Web services that received the lowest 
number of calls (that is, were least used), during the 
selected time frame of the report. Each tab represents 
the total number of calls to the Web service.

Important 
Information

This area is displayed if you have selected the Web 
Services report granularity.

For details about the table columns, see “Web Services-
Related Table” on page 78.
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Web Services-Related Table

The Least Active Web Services, Slowest Web Services, Web Services with 
Most SOAP Faults, Web Services with Most Slow Calls, Most Active Web 
Services, or Least Active Web Services table in the Top Metrics Report screen 
includes the following elements (listed alphabetically):

GUI Element Description

# of Calls The total number of calls to the specific Web service 
during the selected time frame of the report.

# of Slow Calls The number of slow calls to the specific Web service 
during the selected time frame of the report. A slow 
call is a call with a response time that is longer than 
a predefined threshold. 

# of SOAP Faults The number of calls to the specific Web service, 
during the selected time frame of the report, that 
ended in a SOAP fault.

Availability The average availability of the Web service during 
the selected time frame of the report. The 
availability is calculated as the number of successful 
calls to the Web service, divided by the total 
number of calls to the Web service, and multiplied 
by 100. 

Avg. Response Time (sec.) The average response time (in seconds) of the Web 
service during the selected time frame of the report.

Name The name of the selected Web service.

NameSpace The name space of the Web service.
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Least Available Operations Area

Description Displays the availability of the five operations with 
the lowest availability, during the selected time frame 
of the report. The availability is calculated as the 
number of successful calls to the operation, divided by 
the total number of calls to the operation, and 
multiplied by 100.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.
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Slowest Operations Area

Description The Slowest Operations graph displays the five slowest 
operations in the selected time frame of the report. A 
slow operation is defined as having the longest 
response time (no matter the threshold value). Each 
tab represents the average of the response times for the 
operation during the time frame of the report.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.
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Operations with Most SOAP Faults Area

Operations with Most Slow Calls Area

Description Displays the five operations with the largest number 
of received SOAP faults, during the selected time frame 
of the report. Each tab represents the total number of 
SOAP faults received by the operation.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.

Description Displays the five operations with the highest number 
of slow calls, in the selected time frame of the report. 
A slow call is defined as a call that lasts longer than a 
predefined threshold. Each tab represents the total 
number of slow calls received by the operation.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.
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Most Active Operations Area

Least Active Operations Area

Description Displays the five operations with the highest number 
of calls, during the selected time frame of the report. 
Each tab represents the total number of calls to the 
operation.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.

Description Displays the five operations that received the lowest 
number of calls (that is, were least used), during the 
selected time frame of the report. Each tab represents 
the total number of calls to the operation.

Important 
Information

This area is displayed if you have selected the 
Operations report granularity.

For details about the table columns, see “Operations-
Related Table” on page 83.
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Operations-Related Table

The Least Active Operations, Slowest Operations, Operations with Most 
SOAP Faults, Operations with Most Slow Calls, Most Active Operations, or 
Least Active Operations tables includes the following elements (listed 
alphabetically):

User Reports

For details about user reports, see “Introducing Business Process Monitor” in 
Custom Reporting and Alerting.

GUI Element Description

# of Calls The total number of calls to the specific operation 
during the selected time frame of the report.

# of Slow Calls The number of slow calls to the specific operation 
during the selected time frame of the report. A slow 
call is a call with a response time that is longer than 
a predefined threshold. 

# of SOAP Faults The number of calls to the specific operation, 
during the selected time frame of the report, that 
ended in a SOAP fault.

Availability The average availability of the operation during the 
selected time frame of the report. The availability is 
calculated as the number of successful calls to the 
operation, divided by the total number of calls to 
the operation, and multiplied by 100.

Avg. Response Time (sec.) The average response time (in seconds) of the 
operation during the selected time frame of the 
report. 

Name The name of the operation.

NameSpace The name space of the Web service that runs the 
operation.

Web Service The name of the Web service that runs the 
operation.
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HP Business Availability for SAP 
Applications 

This chapter includes information about deploying HP Business Availability 
for SAP Applications solution.

This chapter describes: On page:

Concepts

About Using the HP Business Availability for SAP Applications 88

HP Business Availability for SAP Applications License 89

HP Business Availability for SAP Applications Architecture 90

Business Process Monitor Measurements in SAP Systems View – 
Details

91

SiteScope Measurements in SAP View 98

SAP Systems View 100

SAP Service 102

Collecting SAP System Information 103

CCMS Counters 103

Tasks

Deploy HP Business Availability for SAP Applications 105

Use the SAP CCMS Monitor to Retrieve Measurements from the SAP 
System

110

Activate the SAP Service 115
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About Using the HP Business Availability for SAP 
Applications

The HP Business Availability for SAP Applications Application, integrating 
SiteScope, Business Process Monitor, and HP Universal CMDB enables you 
to gain visibility and control over your mission-critical SAP systems and 
applications.

The SAP solution provides:

➤ A single operation console consolidating all SAP monitoring information.

➤ Automatic discovery and modeling of SAP-related elements, as well as their 
relations to other systems in the organization’s IT.

➤ Change discovery and notification, for quicker problem resolution.

➤ Display of transport deployment impact, for move-to-production risk 
analysis.

➤ Proactive monitoring of end-user experience in SAP systems.

➤ A bridge between IT and line-of-business people using SAP Solution 
Manager business processes’ hierarchy monitoring.

Install HP Business Availability for SAP Applications – Details 117

Create Monitors – Details 122

Use a Business Process Monitor Profile to Simulate SAP Users – 
Details

123
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➤ The ability to distinguish between SAP-specific problems and general ones. 

➤ Examination, over time, of SAP CCMS monitoring data.

➤ Service Level Management of SAP systems’ service level commitments. 

Note: You must have a SAP license to view the SAP_Systems view in 
HP Business Availability Center.

HP Business Availability for SAP Applications License

The HP Business Availability for SAP Applications license unlocks the 
following functionality in HP Business Availability Center, helping to 
shorten time-to-value and minimize MTTR:

➤ The SAP Systems pattern view, displaying a hierarchical view of SAP 
applications and infrastructure.

➤ Automatic linkage of Business Process Monitor transactions to the SAP 
transactions they are monitoring.

➤ Automatic linkage of SiteScope measurements to their respective SAP 
infrastructure.

➤ SAP-specific KPIs that allow differentiation between SAP-related issues and 
non-SAP ones.

➤ Show Impact and Problem Isolation access from the Dashboard for quick 
visualization of change impact

➤ SAP-specific change reports, summarizing the impact transports have on 
transactions in the SAP system.
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HP Business Availability for SAP Applications Architecture

The architecture of HP Business Availability for SAP Applications application 
is illustrated in the following diagram:

Most of the SAP CIs are created by automatic discovery. The configuration 
for these CIs is saved into the CMDB. Some of the relationships to Business 
Process Monitor and SiteScope CIs are created by automatic mechanisms 
unique to HP Business Availability for SAP Applications.

The architecture of HP Business Availability for SAP Applications includes 
the following components:

➤ The Discovery Probe discovers SAP-related entities and the general entities 
(such as hosts) that are related to them using CCMS. The Discovery Probe 
communicates with the CMDB using a Remote Function Call (RFC) via a 
Java Connector (JCo).

➤ SiteScope SAP CCMS Solution Set communicates with the SAP system and 
retrieves CCMS monitoring data using a Remote Function Call (RFC) via a 
Java Connector (JCo).
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➤ Business Process Monitor collects data on the performance and availability 
of Business Process Monitor transactions carried out on the SAP system.

➤ HP Universal CMDB Server collects change information from the CMDB 
and stores it in the History database.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Introduction 
to Dashboard” in Using Dashboard.

Business Process Monitor Measurements in SAP Systems 
View – Details

You can view the Business Process Measurement in the SAP Systems view in 
different locations in the SAP hierarchy. 

This section includes the following topics:

➤ “Following the Naming Conventions for Business Process Steps and 
Transaction/Location Hierarchy Structure” on page 92

➤ “Not Following Naming Convention for Business Process Steps and 
Transaction/Location Hierarchy Structure” on page 94

➤ “Following Naming Conventions for Business Process Steps and Regular 
Hierarchy Structure” on page 96

➤ “Not Following the Naming Convention for Business Process Steps and 
Regular Hierarchy Structure” on page 97
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Following the Naming Conventions for Business Process 
Steps and Transaction/Location Hierarchy Structure
If you have used the naming convention for the Business Process Step, and 
you have set the Hierarchy structure of the Business Process Monitoring 
source adapter to Transaction/Location then the view displays the following 
structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed under a 
Business Process Step CI, under a SAP transaction CI, under several levels of 
SAP Application Component CIs, under a SAP System CI. For example:

➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Business Process Step CI under the Contained group CI (Business 
Processes). For example:
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➤ The BPM Monitor (BPM transaction from location CIT) is displayed under a 
Contained Location CI itself under a Contained group CI (Locations) under 
the SAP System CI. For example:

For details on the types of hierarchy, see “New/Edit Source Adapter Dialog 
Box” in IT World Model Management.
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Not Following Naming Convention for Business Process 
Steps and Transaction/Location Hierarchy Structure
If the Business Process Steps do not follow the naming conventions, and 
you have set the Hierarchy structure of the Business Process Monitoring 
source adapter to Transaction/Location, then the view displays the following 
structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed under a 
Business Process Step CI, under a SAP transaction CI, under several levels of 
SAP Application Component CIs, under a SAP System CI. For example:

➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Business Process Step CI under the Contained group CI (Business 
Processes). For example:
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➤ The BPM Monitor (BPM transaction from location CIT) is also displayed 
under a Contained Location CI, under a Contained group CI (Locations), 
under a SAP System CI. For example:

For details on the types of hierarchy, see “New/Edit Source Adapter Dialog 
Box” in IT World Model Management.
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Following Naming Conventions for Business Process Steps 
and Regular Hierarchy Structure
If the Business Process Steps follow the naming conventions and you have 
set the Hierarchy structure of the Business Process Monitoring source 
adapter to Regular, then the view displays the following structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed without 
the location information, under a Business Process Step CI, under a SAP 
transaction CI, under several levels of SAP Application Component CIs, 
under a SAP System CI. For example:

➤ The BPM Monitor (BPM transaction from location CIT) without location 
information, is also displayed under a Business Process Step CI under the 
Contained group CI (Business Processes). For example:
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Not Following the Naming Convention for Business 
Process Steps and Regular Hierarchy Structure
If a Business Process Step does not follow the naming conventions and you 
have set the Hierarchy structure of the Business Process Monitoring source 
adapter to Regular, then the view displays the following structure:

➤ The BPM Monitor (BPM transaction from location CIT) is displayed under a 
Business Process Step CI, under a SAP transaction CI, under several levels of 
SAP Application Component CIs, under a SAP System CI, without the 
location information. For example:

➤ The BPM Monitor (BPM transaction from location CIT) without location 
information, is also displayed under a Business Process Step CI under the 
Contained group CI (Business Processes). For example:

For details on the types of hierarchy, see “New/Edit Source Adapter Dialog 
Box” in IT World Model Management.
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SiteScope Measurements in SAP View

SiteScope monitors are displayed in the SAP view only if they are connected 
to hosts. To display them elsewhere in the hierarchy, advanced users must 
modify the TQL of the SAP System.

Note: If SiteScope measurements names are too long and are truncated in 
Dashboard, you can change the CIT default label to RegExp(data_name, 
(.*[/].*[/].*[/])(.*),2) instead of just data_name. Only the beginning of the 
path and the last part of the measurement's name are displayed instead of 
the entire measurement name (including the path). If you change the CIT 
default label, you must also change all references in the code and in the TQL 
layout from display_label to data_name. 

➤ The SiteScope Measurement is displayed under a SAP Work Process CI, under 
SAP R/3 Application Server CI, under an instance of a Contained Group CI, 
under a SAP System CI. For example: 
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➤ The SiteScope Measurement is displayed under a SAP R/3 Application Server 
CI, under an instance of a Contained Group CI, under a SAP System CI. For 
example:

➤ The SiteScope Measurement is displayed under a SAP System CI. For 
example:
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➤ The SiteScope Measurement is displayed under a Database CI, under an 
instance of a Contained Group CI, under a SAP System CI. For example:

SAP Systems View

You can view SAP information in the SAP Systems view in Dashboard. For 
details about how to work with the Console tab, see “Console Page” in Using 
Dashboard.

The SAP Systems view in View Explorer appears as follows:
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The following graph describes the various layers and drill-downs available in 
the topology of the SAP Systems view:
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SAP Service

The SAP service is assigned to the Modeling Data Processing Server. It is a 
configuration service that enables HP Business Availability Center to work 
with data that is in SAP format.

For details about how to view a service status via the JMX Web console, see 
“High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF.

The SAP Service provides the following advantages:

➤ Responsible for intelligent relation of monitoring information.

➤ Installation on the modeling processing server (5 server installation).

➤ Loading occurs after the CMDB and Viewing System services are loaded.

➤ Registration on 3 TQLs and notification on every change in each one of 
those TQLs.

➤ Check of the service activity in the JMX console. For details, see “Activate 
the SAP Service” on page 115.

➤ Responsible for automatic linkage of SiteScope measurements or BPM scripts 
with standardized names. For details, see “Follow the Naming Conventions 
for Naming Business Process Steps” on page 128.

➤ Creation of Business Process and Locations container and connection of the 
appropriate Business Process Steps to the containers. A Business Process Step 
connected manually to the SAP transaction would also be connected to 
these containers. For details, see “Attach Business Process Steps to a SAP 
Transaction without Following the Naming Conventions” on page 129.

➤ Works after BPM and SiteScope source adapters have been synchronized.
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Collecting SAP System Information

The Automatic Discovery component discovers the actual SAP IT entities 
and stores them as CIs in the CMDB.

All configuration actions of SAP CIs are performed inside the CMDB 
Administration application. All SAP CIs appear in the SAP Systems view 
under a root CI called SAP Systems. 

All SAP system metrics are monitored by SiteScope monitors.

SAP business processes/transactions are simulated using Business Process 
Monitor pre-recorded VUGen scripts. Each script includes one or more 
Business Process Steps and are executed from a specific location. All Business 
Process Monitor-related CIs are stored in the CMDB as non-SAP-related CIs 
with links to the appropriate SAP-related CIs.

Information about the SAP System is available in Dashboard in all of the 
relevant tabs like other information.

The SAP Systems views includes information from the SAP IT entities, SAP 
system metrics monitored by SiteScope monitors, and information about 
the SAP business processes/transactions simulated by Business Process 
Monitor scripts.

CCMS Counters

The CCMS Counters Dynamic Nodes collect the samples from SiteScope and 
display them as CIs under the elements they are monitoring. 

To view these CIs, select Applications > Dashboard, click Console, select SAP 
Systems in the View list, and click Background.
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The Console page displays the samples from SiteScope.

Move the mouse over the CI to display a tooltip that provides information 
about the CI, its status, the rule that calculates the status of the SAP KPI, the 
values returned by the monitor the last time it ran, the measurement names, 
and the monitor type. The tooltips includes the following information:

➤ CI Name. The name of the CI.

➤ Status. The status of the CI (calculated according to one of the status 
calculation methods). It may also display:

➤ Not up to date for decayed CIs, indicating that the CI has passed its 
timeout period. (For a SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped when a Business Process profile is stopped.

➤ Calculation Rule. The name of the rule that calculates the KPI status or 
value.

➤ Held Status Since. The date and time since which this CI has held its current 
operational status.
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➤ Message. The value(s) returned by the monitor the last time it ran, as 
displayed in SiteScope. This may simply be the retrieval time and file size or 
it may include specific parameters for a server component.

➤ Last Update. The date and time that the last update for the CI was received 
by Dashboard. This information is not always displayed.

➤ Measurement. The name of the measurement from SiteScope. This 
information is not always displayed.

➤ Monitor. The monitor type that the CI represents. This information is not 
always displayed.

Deploy HP Business Availability for SAP Applications 

This section describes the processes to follow to display SAP information in 
Dashboard, and gives examples.

This task includes the following steps:

➤ “Prerequisites” on page 105

➤ “Install HP Business Availability for SAP Applications” on page 106

➤ “Run SAP Discovery” on page 106

➤ “Create a Business Process Monitor Profile” on page 106

➤ “Create Monitors” on page 106

➤ “Display SAP Information in Dashboard” on page 106

Prerequisites
Ensure that the following software is installed before you install the SAP 
solution:

➤ Discovery Probe. Used to perform the discovery of Siebel topology in your 
organization. For details, see “Discovery”.

➤ SiteScope. Used to integrate the SiteScope data collector into the 
HP Business Availability for Siebel Applications solution. For details, see the 
HP SiteScope Deployment Guide PDF.
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➤ Business Process Monitor. Used to integrate the Business Process Monitor 
data collector into the HP Business Availability for Siebel Applications 
solution. For details, see “Introducing Business Process Monitor” in 
HP Business Process Monitor Administrator’s Guide.

Install HP Business Availability for SAP Applications
Install HP Business Availability for SAP Applications.

For details, see “Install HP Business Availability for SAP Applications – 
Details” on page 117.

Run SAP Discovery
You can run SAP discovery to discover SAP elements and SAP topology. For 
details, see “SAP” in Discovery.

Create a Business Process Monitor Profile

Business Process Monitor profiles are used to simulate SAP users to obtain 
performance and availability information on the SAP transactions.

For details, see “Use a Business Process Monitor Profile to Simulate SAP Users 
– Details” on page 123.

Create Monitors
You can create a SAP CCMS monitor and general SiteScope monitors to get 
the complete picture: Database Query Monitor, Ping Monitor, and so on. For 
details, see “Create Monitors – Details” on page 122.

Display SAP Information in Dashboard
You can display SAP information in Dashboard:

➤ View SAP data in Dashboard. For details, see “SAP Systems View” on 
page 100.

➤ View the CIs affected by a root cause CI. Select a CI, which is defined by a 
correlation rule as a root cause CI, and to display all of the CIs that are 
affected by it. For details, see “Show Impact Report” on page 142..
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➤ View the root cause CIs. Retrieve root cause information for CIs that are 
affected by a chain of correlation rules. For details, see “Problem Isolation 
Report” on page 143.

➤ View Changes Made to SAP System CIs. Changes made to the properties of 
all types of CIs are discovered by different types of discoveries. For details, 
see Performing a SAP Discovery in Application Administration. Those 
changes are displayed in the Change report available as a right-click menu 
option for each one of the relevant CI types. For details, see “Change Report 
Page” in IT World Model Management.

Some of the changes made to the SAP Transactions CIs are caused by the 
corresponding Transport CIs. Those specific changes are processed by 
correlation rules in discovery and are displayed in the SAP Transaction 
Changes report and the SAP Transport Changes report. See below.

➤ Display and track changes made to a SAP Transaction CI when a transport 
was discovered. For details, see “SAP Transaction Changes Report” on 
page 144.

➤ Display a SAP Transport Changes report. The report includes the transports 
discovered in the past week, the changes that are included in each transport, 
and under each change the SAP transaction that is impacted by this change. 
For details, see “SAP Transport Changes Report” on page 147.

➤ Display Configuration File, Software Component File, and Support Package 
File Information. You can display additional information for specific CIs:
107



Chapter 3 • HP Business Availability for SAP Applications
➤ Configuration File information. Right-click a Configuration File CI in the 
SAP Systems View, select Properties, and click Show document content 
to displays the contents of the configuration file. Details about the SAP 
configuration file are provided in the SAP product documentation.

➤ Software components file information. Right-click a Software 
Component CI in the SAP Systems View, select Properties, and click 
Show document content to display the contents of the software 
components file.
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The page includes the following elements (listed alphabetically):

➤ Support packages file information. Right-click a Support Package CI in 
the SAP Systems View, select Properties, and click Show document 
content to display the contents of the support packages file. 

.

The page includes the following elements (listed alphabetically):

You can also access this information by selecting Admin > Universal CMDB > 
Modeling > IT Universe Manager > Properties. For details, see “Properties Tab” in 
IT World Model Management.

GUI Element Description

Description A description of the package.

Name The name of the software component.

Package Level The level of the package.

Release The release number.

GUI Element Description

Description A description of the package.

Name The name of the support package.

Type The type of support package.
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Use the SAP CCMS Monitor to Retrieve Measurements from 
the SAP System

The SAP CCMS monitor retrieves and reports measurements from SAP's 
centralized monitoring system CCMS. CCMS is used to monitor all servers, 
components and resources in the SAP R/3® System from one single 
centralized server, facilitating problem discovery and problem diagnosis. For 
details, see “SAP CCMS Monitor Overview” in Using System Availability 
Management.

Note: The SAP CCMS Monitor is an optional SiteScope feature whose license 
is provided with the SAP solution.

This task includes the following steps:

➤ “Deploy a CCMS Monitor Using the SiteScope CCMS Solution Template” on 
page 111

➤ “Attach SiteScope to HP Business Availability Center” on page 111

➤ “Check that the Monitor Is Set to Report All Monitors and Measurements” 
on page 112

➤ “Synchronize the SiteScope Source Adapter” on page 112

➤ “Connect the SAP CCMS Measurements to the Appropriate Elements of the 
SAP Hierarchy” on page 112

➤ “Check/View the SiteScope Measurements in the SAP View” on page 115
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Deploy a CCMS Monitor Using the SiteScope CCMS 
Solution Template
The MonitorSetSSServer.mset solution template is the most effective way to 
deploy a CCMS monitor. 

To deploy a CCMS monitor using the SiteScope CCMS solution template:

 1 Access SiteScope via System Availability Management in HP Business 
Availability Center or directly using the URL: 
http://<SiteScope_server>:8080/topaz/.

 2 Select Admin > System Availability Center. 

 3 Right-click the appropriate SiteScope in the Enterprise tree, and select New 
Group.

 4 Enter the name of the group in the Group Name box in the Main Settings 
area.

 5 Click OK.

 6 Expand Solution Sets, right-click SAPR3Solution, and select Copy.

 7 Right-click the new group you have created, and select Paste.

 8 In the Main Settings area, enter the following information:

➤ The name of the SAP System in the TARGET_SERVER_NAME box.

➤ The user name in the USER_NAME box.

➤ The password in the Password box.

➤ The number of the SAP system in the SYSTEM_NUMBER box.

➤ The number of the client to which you connect SiteScope in the 
CLIENT_NUMBER box.

 9 Click OK.

Attach SiteScope to HP Business Availability Center
You must now attach SiteScope to HP Business Availability Center. For 
details, see “New SiteScope Page” in Using System Availability Management.
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Check that the Monitor Is Set to Report All Monitors and 
Measurements
To view SiteScope measurements, you must check that the monitor is set to 
report all monitors and measurements information.

To check that the monitor is set to Report All Monitors and Measurements:

 1 Select Admin > System Availability Center.

 2 Double-click the appropriate CCMS monitor under the appropriate group, 
select Properties, and expand the HP Business Availability Center Login 
area.

 3 Check that the value of the Logging to HP Business Availability Center is set 
to Report everything (all monitors and all measurements).

Synchronize the SiteScope Source Adapter
You can synchronize the SiteScope source adapter immediately or you can 
wait for the automatic synchronization to take place. For details, see “Source 
Manager Page” in IT World Model Management.

Connect the SAP CCMS Measurements to the Appropriate 
Elements of the SAP Hierarchy
The SAP CCMS measurements are connected to the appropriate elements of 
the SAP hierarchy as follows:

 1 A SAP CCMS measurement can reside only under a System, R/3 Application 
Server, Work Process, or Database CIT.

 2 The linkage is performed based on the CCMS measurement's name that 
includes the name of the appropriate CI. 
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A CCMS measurement name has the following syntax: 
<field1>/<field2>/<field3>. If the fields in the CCMS name include the 
name of an R/3 Application Server, System ID, Work Process name, or 
Database name, the CCMS measurement is attached to the appropriate CI as 
follows:

For more details about SAP hierarchy, see “Default CIs in the SAP Systems 
View” on page 132.

<field1> <field2> <field3> Attached to CI

R/3 Application 
Server name

System ID Work Process name Attached to the 
specified work 
process

R/3 Application 
Server name

System ID N/A Attached to the 
specified R/3 
application server

System ID N/A N/A Attached to the 
specified SAP 
system

System ID Database name N/A Attached to the 
specified database
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Example

If you have the following CCMS measurements, the first three CCMS 
measurements are attached to the Background CI (Work Process) under the 
R/3 Services CI (R/3 Application Server), under the Host CI, and the other 
group of measurements are attached to the Dialog Work Process under the 
R/3 Services (R/3 Application Server) under the Host calderone_MI6_00.
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Check/View the SiteScope Measurements in the SAP View
SiteScope monitors are displayed in the SAP view only if they are connected 
to hosts. To display them elsewhere in the hierarchy, advanced users must 
modify the TQL of the SAP System. For details, see “SiteScope Measurements 
in SAP View” on page 98.

Activate the SAP Service

Check that the SAP Service is activated (it is activated by default). If 
necessary, activate it manually. For details, see “High Availability for the 
Data Processing Server” in the HP Business Availability Center Deployment 
Guide PDF.

To manually activate the SAP Service:

 1 In the browser, enter http://<HP Business Availability Center server name>
:8080/jmx-console/

 2 Double-click service=Verticals External Enrichment Service listed under 
Topaz.
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 3 The JMX MBean View for Verticals External Enrichment Service opens:

 4 Specify:

➤ performLinkage. Gets customer ID and the relevant linkage to perform 
(CCMS/BPM AUTO/BPM manual.

➤ createTqlListeners. Mainly for debugging.
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➤ Start. Starts the service.

➤ Stop. Stops the service.

Install HP Business Availability for SAP Applications – 
Details

Note: An existing Business Process Monitor machine can be leveraged for 
running SAP scripts as well.

Deploying the SAP solution consists in setting the appropriate licences, 
connecting SAP Java Connector on the SiteScope machine, and setting the 
Discovery Probe.

This task includes the following steps:

➤ “Set the License for the SAP Solution” on page 118 

➤ “Install the SAP Java Connector on the SiteScope Machine” on page 119

➤ “Set the SiteScope License” on page 119

➤ “Perform the Discovery Probe Post-Installation Procedure” on page 120

➤ “Restart the Discovery Agent” on page 121
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Set the License for the SAP Solution
When setting the SAP solution license, verify that the license also contains 
the Auto Discovery license (customers with HP Business Availability Center 
for SAP license also receive the Auto Discovery license).

If the SAP solution license was set while installing HP Business Availability 
Center, then the SAP packages are automatically deployed and added to the 
CMDB.

If the SAP solution license was set after installing HP Business Availability 
Center, you must deploy the packages manually or restart HP Business 
Availability Center so the SAP packages are deployed automatically (this is 
the recommended procedure).

Note: The SAP-related packages: SAP.zip, SAP_discovery.zip, and 
SAP_monitoring.zip are at the following location on the machine where 
CMDB is installed:
<HP Business Availability Center root directory>\mam_lib\packages

To check that the packages are deployed, select Admin > Universal CMDB > 
Modeling > It Universe Manager and check that the SAP_Systems view is 
listed in the View list in View Explorer.

To set the license for the SAP solution, log in to HP Business Availability 
Center, select Admin > Platform > Setup and Maintenance > License 
Management. Click New License Key to open the New License Key page, 
and enter a valid license key in the License key box. The license key includes 
the SAP solution. Click OK to save the change. Verify that the value of 
Business Availability Center for SAP in the Applications area is Licensed. It is 
recommended to restart HP Business Availability Center at this point.
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Install the SAP Java Connector on the SiteScope Machine
Once SiteScope is installed, install SAP Java connector on the SiteScope 
machine, as follows:

 1 Download the SAP JCo package from the Tools & Services window of SAP 
JCo in SAP Service Marketplace:

https://websmp101.sap-ag.de/~form/
sapnet?_SHORTKEY=01100035870000463649

 2 Extract sapjco-ntintel-2.0.8.zip to a temporary directory (for example, 
C:\temp) on the SiteScope machine.

 3 Copy sapjco.jar from the temporary directory to the <SiteScope root 
directory>\SiteScope\WEB-INF\lib directory on the SiteScope machine.

 4 Copy sapjcorfc.dll from the temporary directory to the <SiteScope root 
directory>\SiteScope\bin directory on the SiteScope machine.

 5 Copy librfc32.dll from the temporary directory, in the SiteScope machine to:

➤ the %winnt%\system32 directory

➤ the <SiteScope root directory>\SiteScope\bin directory

If there is an old version of the librfc32.dll file already in the <SiteScope 
root directory>\bin or in the %winnt%\system32 directory, you should 
replace it. 

 6 Restart SiteScope as follows: on the SiteScope machine, go to Start > 
Programs > Administration Tools > Services, find SiteScope service and 
restart it.

Set the SiteScope License
To set the SiteScope license appropriate for your system:

 1 Launch SiteScope by entering the following URL in a browser:  
http://<SiS_machine_name>:8080

 2 Choose Preferences > General Preferences.

 3 Click Edit.

 4 Click Insert valid license keys.
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 5 In the License Number box, enter a valid SiteScope license key.

 6 In the Option Licenses box, enter the SiteScope license keys appropriate for 
the SAP solution.

Make sure to insert a license for: EMS monitors, SAP monitors, and the SAP 
R/3 solution template.

 7 Click OK to approve the changes.

Perform the Discovery Probe Post-Installation Procedure
After installing the Discovery Probe, perform the post-installation procedure 
(see below) and restart the Discovery Probe. If the Discovery Probe is already 
running before you perform the post-installation procedure, stop it and 
restart it afterwards.

To perform the Discovery Probe post-installation:

 1 Download the SAP JCo package from the Tools & Services window of SAP 
JCo in SAP Service Marketplace:

https://websmp101.sap-ag.de/~form/
sapnet?_SHORTKEY=01100035870000463649 

 2 Extract sapjco-ntintel-2.0.8.zip to a temporary directory (for example: 
C:\temp) on the HP Business Availability Center machine.

 3 Create a new sap directory (in lowercase) in the 
<HP Business Availability Center home directory>
\DiscoveryProbe\root\ext\ directory on the machine where the Discovery 
Probe is installed.

 4 Copy sapjco.jar from the temporary directory to the 
<HP Business Availability Center home directory>
\DiscoveryProbe\root\ext\sap\ directory on the machine where the 
Discovery Probe is installed.

 5 Copy sapjcorfc.dll from the temporary directory to the 
<HP Business Availability Center home directory>
\DiscoveryProbe\root\ext\sap\ directory on the machine where the 
Discovery Probe is installed.
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 6 Copy librfc32.dll from the temporary directory to the %winnt%\system32 
directory.

 7 Verify that the MSVCR71.dll and MSVCP71.dll files are located in the 
%winnt%\system32 directory. 

Restart the Discovery Agent

 1 On the Discovery Probe machine, access: Start > Programs > 
Business Availability Center > Administration > Discovery Agent

This starts the Discovery Probe and opens a CMD console.

 2 Wait until the console displays the following lines: Finished startup 
sequence
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Create Monitors – Details

You create a SAP CCMS monitor and general SiteScope monitors to get the 
complete picture.

This task includes the following steps:

➤ “Create a SAP CCMS Monitor” on page 122 

➤ “Create General Monitors” on page 122

Create a SAP CCMS Monitor
The SAP CCMS monitor retrieves and reports measurements using SAP 
centralized monitoring system CCMS. CCMS is used to monitor all servers, 
components, and resources in the SAP R/3® System from one single 
centralized server facilitating problem discovery and problem diagnosis.

For details on creating a SAP CCMS Monitor, see “SAP CCMS Monitor 
Overview” in Using System Availability Management.

SAP CCMS Monitor solution template is the most effective way to deploy a 
CCMS monitor. For details, see “Deploy a CCMS Monitor Using the 
SiteScope CCMS Solution Template” on page 111.

Create General Monitors
You create general SiteScope monitors to get the complete picture. For 
example, use:

➤ Database Query monitor. For details, see “Database Query Monitor 
Overview” in Using System Availability Management.

➤ Ping monitor, and so on. For details, see “Ping Monitor Overview” in Using 
System Availability Management.
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Use a Business Process Monitor Profile to Simulate SAP 
Users – Details

Use Business Process Monitor profiles to simulate SAP users and obtain 
performance and availability information on the SAP transactions.

You can view Business Process Steps under the SAP view to enable you to 
analyze what happens in the SAP system.

This task includes the following steps:

➤ “Create a Business Process Monitor Profile” on page 123

➤ “Select the Appropriate Protocol” on page 123

➤ “Select the Appropriate Run-Time Settings” on page 124

➤ “Edit the Script” on page 126

➤ “Synchronize the Business Process Monitoring Source Adapter” on page 127

➤ “Attach Business Process Monitor Transactions to SAP Application 
Components” on page 128

➤ “Check/View the Business Process Monitor Measurements in the SAP 
Systems View” on page 131

Create a Business Process Monitor Profile
You create a business process profile in End User Management. For details, 
see “About Creating Business Process Profiles and Monitors” in Using End 
User Management.

Select the Appropriate Protocol
In HP Virtual User Generator (VuGen), SAP scripts are recorded using the 
SAPGUI protocol. You must select the SAPGUI protocol when you create a 
new script. For details, see Using HP Virtual User Generator.
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Select the Appropriate Run-Time Settings
In VuGen, open the Run-Time settings window, and in the Performance 
area, select Show SAP client during replay to give more accurate user 
experience times. For details, see Using HP Virtual User Generator.

To select the appropriate run-time settings:

 1 After recording the script in VuGen, select Vuser > Run-Time Settings.
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 2 The Run-time Settings page opens. Select Show SAP client during replay, and 
clear Take ActiveScreen snapshots during replay.

 3 Click OK.
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Edit the Script
You can edit the script to make sure the password is recorded properly and 
to check and correct the script’s connection parameters.

To edit the script:

 1 Make sure the password is recorded correctly. Remove the stars and replace 
with the required password.

 2 Check the script’s connection parameters and if necessary, delete the string 
that appears after the system number in the first parameter.
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The result is as follows:

Synchronize the Business Process Monitoring Source 
Adapter
You can synchronize the Business Process Monitoring source adapter 
immediately or you can wait for the automatic synchronization to take 
place. For details, see “Source Manager Page” in IT World Model Management.
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Attach Business Process Monitor Transactions to SAP 
Application Components
To display Performance and Availability information, Business Process Steps 
must be attached to SAP transactions.

You can connect BMP transactions to a SAP transaction in two different 
ways:

➤ Follow the naming conventions for the BMP transaction names. For details, 
see “Follow the Naming Conventions for Naming Business Process Steps” on 
page 128.

➤ Do not follow the naming conventions for the BMP transaction names and 
manually link a Business Process Step to a SAP transaction. For details, see 
“Attach Business Process Steps to a SAP Transaction without Following the 
Naming Conventions” on page 129.

If you do not follow the naming conventions, be careful when deleting links 
between SAP transactions and Business Process Steps. For details, see “Delete 
Links Between SAP Transactions and Business Process Steps” on page 130.

Follow the Naming Conventions for Naming Business Process 
Steps

To logically connect Business Process Steps to a SAP transaction, the 
Business Process Step name should have the following format:
<tran_name>_ _<sys_name>_ _<BPM_tran_name>

➤ tran_name. The name of the SAP transaction to which you want to attach 
the Business Process Step.

➤ sys_name. The name of the SAP System on which the transaction is run (for 
example, MI7).

➤ BPM_tran_name. The unique name of the Business Process Step. Any set of 
alphanumeric and mixed case characters are supported (special characters 
are not allowed). It is good practice to name the transaction so that the 
name indicates what occurs in that set of dialog steps.
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Note: You assign the appropriate name to a Business Process Step when you 
record it. For details, see Using HP Virtual User Generator.

For example, the names of the Business Process Steps assigned to the SAP 
transaction VA01 in the MI7 SAP System should start with: va01_ _mi7_ 

In the SAP Systems View, a Business Process Steps node that is displayed 
under a specific SAP transaction is a container under which all relevant 
transactions are located.

It is important to split a SAP transaction into a few Business Process Monitor 
transactions so that you are able to pinpoint the problem. For example, if 
each step of the SAP transaction is a separate Business Process Monitor 
transaction, you can find the exact part of the SAP transaction where the 
problem occurs.

Attach Business Process Steps to a SAP Transaction without 
Following the Naming Conventions

If you do not want to follow the naming conventions for the Business 
Process Steps, go to System Availability Management and build a Business 
Process Monitor profile. 

You can then manually connect Business Process Steps with SAP 
transactions. Select Admin > Universal CMDB > Modeling > IT Universe 
Manager, and select SAP View in the View list. Right-click the SAP 
transaction that you want to monitor using the BPM profile and select 
Attach Related CI to open the Attach Related CIs wizard. Select one of the 
monitor views in the Views list. Expand and select the Business Process Step 
to which you want to connect the SAP transaction, and select the 
Monitored By for SAP relationship type, as well as the Allow CI Update 
option. 

For details, see “Attach Related CIs Wizard” in IT World Model Management.
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Delete Links Between SAP Transactions and Business Process 
Steps

SiteScope measurements and Business Process Monitor transactions are 
attached under the appropriate level of the SAP hierarchy. For details, see 
“Default CIs in the SAP Systems View” on page 132.

A TQL runs in the background and returns:

➤ CCMS measurements that are not linked to SAP entities. Most of the CCMS 
measurements’ names indicate to which SAP entities they should be 
attached in the hierarchy.

➤ Business Process Monitor transactions that are not attached to a SAP and 
follow the naming convention. The name of the Business Process Monitor 
transaction indicates to which SAP entity it should be attached. 

➤ Business Process steps that are manually attached to a SAP transaction. A 
Business Process Step is automatically attached to the Business Process 
container that was created by the Business Process Step, the Business Process 
Step is monitored by SAP. For details, see “Attach Business Process Steps to a 
SAP Transaction without Following the Naming Conventions” on page 129.

If the Business Process Monitor source adapter was assigned the 
Transaction/Location option, a copy of the location information is attached 
to the Locations container. For details on these types of hierarchy, see 
“New/Edit Source Adapter Dialog Box” in IT World Model Management.
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If you delete a link between a SAP transaction and its child Business Process 
Step transaction, then the following happens:

➤ If you followed the naming convention for the Business Process Step 
transaction, the link between the SAP transaction and its child Business 
Process Step is automatically recreated at the next synchronization.

➤ If you did not follow the naming convention and created a manual link 
between the SAP transaction and a Business Process Step transaction, then 
when you delete the link:

➤ If the Business Process Monitoring source adapter was assigned the 
Transactions/locations option, the Location container is not deleted. 

You can manually delete it. Delete the Location container only if the 
deleted Business Process Step transaction is the only CI attached to this 
location. If other Business Process Step transactions are attached to this 
location, delete only the links between the Business Process Monitor 
(BPM transaction from location) and the Location container.

➤ If the Business Process Monitoring source adapter was assigned the 
Regular option, the Business Process container is not deleted. You must 
manually delete the links between the Business Process container and the 
detached Business Process Step transaction.

For details about the Transactions/locations or Regular options, see 
“New/Edit Source Adapter Dialog Box” in IT World Model Management.

Check/View the Business Process Monitor Measurements 
in the SAP Systems View
You can view the Business Process Measurement in the SAP Systems view in 
different locations in the SAP hierarchy. For details, see “Business Process 
Monitor Measurements in SAP Systems View – Details” on page 91.
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Default CIs in the SAP Systems View

The CIs appear as follows (in alphabetical order):

GUI Element Description

Application Gateway An Internet Transaction Server (ITS) component. 
Establishes the connection to the R/3 System and 
performs the processing of tasks that are required to 
move data between R/3 applications and the Internet.

BPM Monitor Represents Business Process Monitor entities.

Business Process Step Business Process Steps (BPM transactions inside a 
script) are emulated SAP transactions executed on a 
Business Process Monitor machine. They are used to 
supply proactive monitoring of end user experience.

Business Processes A logical container that contains all of the Business 
Process steps attached to all of the SAP transactions.

CCMS Counters CCMS Counters (also called Measurements) are pieces 
of information elements, relevant to SAP, retrieved 
from SAP CCMS (Computer Center Management 
System).

Client An organizational and legal CI in the SAP system. The 
main objective of the client is to keep the data isolated: 
the data in a client can only be visible within that 
client; it cannot be displayed or changed from another 
client. Each client on a system can represent a unique 
working environment.

Configuration File Used to enter configuration parameters into the 
system/servers.

Contained Locations Created as part of the Business Process Monitor 
hierarchy when working with the 
Transactions/locations option.

Database A database management system holding the data tier, 
including all of the SAP elements: SAP transactions, 
programs, work processes, and so on. This is not a SAP-
specific CI.
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Hosts A logical unit, grouping together Host CIs.

A Host CI represents the physical machine on which a 
server is installed. This is not a SAP-specific element.

Locations A logical unit, grouping together Contained Locations 
CIs.

To separate the SAP Business Process steps locations 
status from the Location CI (from the Business Process 
Monitor), the Contained Locations CIs are created by 
the SAP solution and are connected to the SAP Business 
Process steps (identified by following the naming 
convention or by manually linking them).

The regular Location CI is connected to all Business 
Process steps both regular and SAP, but the Contained 
Location CI is connected only to the SAP Business 
Process steps.

The Locations information represents the locations 
specified in Admin > Universal CMDB, select the CI and 
click the Properties tab, locate the Location Name 
property.

Monitor SiteScope entities used to monitor the various CIs that 
exist in the CMDB. The monitors that are most likely 
to appear in the SAP view are host monitors: CPU, 
memory, disk space, and so on. These monitors appear 
in the SAP view only if they are manually attached to 
the Host CI.

R/3 Application 
Server

SAP R/3 Application Server is SAP’s integrated software 
solution for client/server and distributed open systems. 

R/3 Application servers and databases are displayed 
under Hosts. You can also have several levels of hosts 
under the Hosts CI, SiteScope Monitor CIs, and CCMS 
Monitor CIs.

SAP Application 
Component

May include other SAP Application Components and 
some SAP transactions with some common 
denominator.

GUI Element Description
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SAP Applications A logical unit, grouping together Application 
Components.

SAP System A logical unit, grouping together SAP-related CIs (and 
possibly other CIs as well) into one homogeneous SAP 
deployment. 

SAP Transaction Part of a business process defined in the SAP System. It 
is comprised of request-response couples called dialog 
steps. The end user uses SAP transactions to carry out 
actions on the SAP System.

Software Component Represents a software component installed on the SAP 
System, for example: SAP_ABA (cross-application 
component), SAP_HR (human resources), and so on.

Solution Manager 
Projects

Includes SAP Business Project CIs, SAP Scenario CIs, 
SAP Business Process CIs, and SAP Business Process Step 
CIs. Solution Manager Projects hierarchy is specified by 
the user in SAP Solution Manager.

Support Package Contains quality improvements for the SAP system, or 
adjustments due to legal changes.

Transports Represents packaged change requests that include the 
changes that are to be deployed onto the system. 

GUI Element Description
134



Chapter 3 • HP Business Availability for SAP Applications
Web Gateway An Internet Transaction Server (ITS) component. A web 
server extension that establishes the connection 
between ITS and the Web server and forwards user 
requests to the Application Gateway.

Work Processes A logical, single-instance representation of all of the 
work processes of the same type existing on the R/3 
server.

Several types of work processes are available:

➤ Dialog Work Process. Executes dialog programs 
(ABAP).

➤ Update Work Process. Responsible for asynchronous 
database changes (controlled by a COMMIT WORK 
statement in a dialog work process).

➤ Update2 Work Process. Used for statistical, non-
critical updates (for example, result calculations).

➤ Background Work Process. Executes time-dependent 
or event-controlled background jobs.

➤ Enqueue Work Process. Executes locking operations 
(if SAP transactions have to synchronize 
themselves).

➤ Spool Work Process. Performs print formatting (to 
printer, file, or database).

GUI Element Description
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SAP-Related KPIs

Different Key Performance Indicators (KPIs) are displayed depending on the 
selected CI. For details about the displayed KPIs, see “Default CIs in the SAP 
Systems View” on page 132.

The following table lists the SAP-related KPIs displayed in the Console tab:

The other KPIs displayed in the views are not SAP-related. For more details 
about those KPIs, see “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.

SAP-Related Menu Options

A list of all of the context menu options available in the SAP Systems view is 
available in “Dashboard Menu Options” in Using Dashboard.

Different menu options are available depending on the type of CIs:

GUI Element Description

SAP The SAP KPI indicates problems related to the SAP 
infrastructure that are reported by CCMS.

Transactions At the group level, displays the worst status of all of the 
child CIs. 

At the monitor level, displays the worst status of the 
Performance and Availability KPIs for the CI. 

Locations At the group level, displays the worst status of all of the 
child CIs.

At the monitor level, displays the worst status of the 
Performance and Availability KPIs for the CI. 

Context Menu Option Type of CI

Show Impact All SAP-specific CI types

Problem Isolation All SAP-specific CI types
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Troubleshooting and Limitations

This section provides information that can help troubleshoot some of the 
problems that can occur when working with HP Business Availability for 
SAP Applications.

This section includes the following topics:

➤ “The SAP KPI Remains Uninitialized” on page 137

➤ “CCMS Does Not Manage to Monitor a SAP System” on page 138

➤ “The Performance and Availability KPIs Remain Uninitialized” on page 138

➤ “SAP Business Process Monitor Scripts Do Not Execute” on page 139

➤ “Unable to Log Into HP Business Availability Center” on page 139

➤ “Limitations” on page 140

The SAP KPI Remains Uninitialized
If the SAP KPI remains uninitialized, check the following solutions in the 
order listed below:

 1 Make sure the SAP CCMS monitor is set to send samples to HP Business 
Availability Center in the monitor’s Logging to HP Business Availability 
Center property in System Availability Management.

 2 Check the following file to ensure that the samples arrive to the Business 
Logic Engine:
<HP Business Availability Center root 
directory>\log\EJBContainer\TrinitySamples.log

 3 Check that the samples arrive to the bus in the following file:
<HP Business Availability Center root directory>\log\core\
dispatcher_log.txt

SAP Transport Changes Report SAP System and SAP Transports CIs

SAP Transaction Changes Report SAP System and SAP Transaction CIs

Context Menu Option Type of CI
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 4 Check that the samples are sent in the following file:
<SiteScope root directory>\logs\topaz_all.log.1

 5 If you see values in the measurements' KPIs that are not colored, check the 
threshold definition in System Availability Management.

 6 Restart SiteScope, detach it, and reattach it.

 7 Check time synchronization between HP Business Availability Center and 
its management database.

CCMS Does Not Manage to Monitor a SAP System
If CCMS does not manage to monitor a SAP System, check the following 
solutions in the order listed below:

 1 If you are able to connect to the SAP System using SAP Logon, run the rz20 
transaction.

 2 Open SAP CCMS Monitor Templates > Entire System, and check if a tree is 
displayed.

➤ If there is no tree, there might be a problem with the job that is 
collecting CCMS information. Contact your SAP administrator.

➤ If there is a tree, check that the names of the application server and of 
the system match, in content and case, the ones used in SiteScope.

The Performance and Availability KPIs Remain 
Uninitialized
If the Performance and Availability KPIs remain uninitialized, check the 
following solutions in the order listed below:

 1 Check that the samples arrive, in the file:
<HP Business Availability Center root 
directory>\log\EJBContainer\TrinitySamples.log

 2 Try and run Business Process Monitor as a specific user.

 3 Check time synchronization between HP Business Availability Center and 
its Management database.

 4 Check the minute’s synchronization between Business Process Monitor and 
HP Business Availability Center.
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SAP Business Process Monitor Scripts Do Not Execute
If the SAP Business Process Monitor scripts do not execute, check the 
following solutions in the order listed below:

 1 Verify that SAP Logon is installed on the Business Process Monitor server.

 2 Check that the SAP Business Process Monitor scripts run in HP Virtual User 
Generator (VuGen) and check the script’s connection parameters. For 
details, see “Edit the Script” on page 126.

 3 Register DLLs under <Business_Process_Monitor_install_directory>\bin, as 
follows:

➤ regsvr32 SapGuiActiveScreen.dll

➤ regsvr32 SapGuiReplayEvents.dll

➤ regsvr32 ActiveScreen.dll

Unable to Log Into HP Business Availability Center
If you are unable to log into HP Business Availability Center, check the 
following solutions in the order listed below:

 1 Check that the last line in the following file:
<SiteScope root directory>\log\jboss_boot.log
displays the following information: JBoss .... started in ...

 2 If you are able to connect using port 8080 explicitly, give the Read and 
Execute permission to Everyone for the following DLLs in 
<Windows installation directory>\System32:

➤ msvcr71.dll

➤ msvcp71.dll

➤ mfc71.dll

➤ atl71.dll
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 3 If SiteScope is installed on the same machine as HP Business Availability 
Center, check that HP Business Availability Center is already running before 
you start SiteScope.

Note: It is not recommended to install HP Business Availability Center and 
SiteScope on the same machine.

Limitations

➤ An existing Business Process Monitor machine can be leveraged for running 
SAP scripts as well.

➤ The SAP CCMS Monitor is an optional SiteScope feature whose license is 
provided with the SAP solution.

➤ You must have a SAP license to view the SAP_Systems view in HP Business 
Availability Center.

➤ Transports that are older than a month are automatically deleted from the 
CMDB. The default is configurable.
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HP Business Availability for SAP 
Applications User Interface

This chapter includes the pages and dialog boxes that are part of the 
HP Business Availability for SAP Applications user interface.

This chapter describes: On page:

Show Impact Report 142

Problem Isolation Report 143

SAP Transaction Changes Report 144

SAP Transport Changes Report 147
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Show Impact Report

Description Enables you to display all of the CIs that are affected by 
the selected CI, which is defined as a root cause by a 
correlation rule). The report also displays the CI’s 
statuses. 

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
Show Impact. 

Important 
Information

For details about correlation rules, see “Correlation 
Manager” in IT World Model Management.

Included in Tasks “Display SAP Information in Dashboard” on page 106

GUI Element Description

Indicates the root cause CI.

Indicates a CI that is part of the correlation rule, but is 
neither the root cause CI nor an affected CI. 

Indicates an affected CI.
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Problem Isolation Report

Description Enables you to retrieve root cause information for CIs 
that are affected by a chain of correlation rules. The 
report displays a logical map that describes a chain of 
trigger/affected CITs that affect the CI.

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
Problem Isolation. For details, see “Dashboard Menu 
Options” in Using Dashboard.

Included in Tasks “Display SAP Information in Dashboard” on page 106

Important 
Information

For details about correlation rules, see “Correlation 
Manager” in IT World Model Management.

GUI Element Description

<Relationship> The relationships represent the Correlation rule you 
defined in Correlation Manager. For details, see 
“Correlation Definition Dialog Box” in IT World Model 
Management.

<The statuses and 
the colors that 
represent each one>

The statuses that appear and the colors that represent 
each status are the ones that were defined in the 
severity list for that state in System Type Manager. For 
details, see “Create/Update List/Enumeration 
Definition Dialog Box” in CI Attribute Customization.
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SAP Transaction Changes Report
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SAP System Level Area

The area includes the following elements (listed alphabetically):

SAP Transaction Level Area

The area includes the following elements (listed alphabetically):

Description Enables you to display and track changes made to a 
SAP Transaction CI when a transport was discovered. 
The SAP Transaction Change report displays 
information about the SAP systems with changed 
transactions, and under each transaction the SAP 
transports that have changed during the past week 
(you can modify the default).

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
SAP Transaction Changes report. 

For details, see “Dashboard Menu Options” in Using 
Dashboard.

Included in Tasks “Display SAP Information in Dashboard” on page 106

GUI Element Description

Name The name of the SAP system with a new transaction.

GUI Element Description

Devclass The development class that includes the transaction.

Name The name of the SAP transaction that has changed.

Program The name of the program that runs the transaction.

Program Version The version of the program that runs the transaction.

Screen The first screen that opens when you load the 
transaction.
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SAP Transport Level Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Creation Date The date when the transport was created.

Description A description of the transport.

Name The name of the transport that has changed.

Target System The target system for non-local transport.

User The name of the user who created the transport.
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SAP Transport Changes Report
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Description The table displays information about the SAP systems 
with the transports discovered during the past week 
(this default is configurable), under each transport the 
changes that are included in the transport, and under 
each change, the SAP transaction that is impacted by 
this change.

To Access: In Dashboard, access the SAP Systems view, 
and in View Explorer, click the gray arrow  to the 
right of the element, or right-click a SAP System CI or a 
SAP Transaction CI and select Application Mapping > 
SAP Transaction Changes report. 

For details, see “Dashboard Menu Options” in Using 
Dashboard.

Important 
Information

Customization: Transports that are older than a month 
are automatically deleted from the CMDB. This is 
configurable. You can configure the time period after 
which the old transports are deleted from the CMDB. 
Select Admin > Universal CMDB > Modeling > 
Enrichment Manager, expand SAP, select TQL, right-
click SAP_Old_Transports in the map, and select Node 
conditions. Access the Attribute condition dialog box, 
assign the required condition for the Actual Delete 
Time - (date) attribute. For details, see “Attribute 
Condition Dialog Box” in IT World Model Management.

Customization: You can configure the time period 
during which the transport discovery takes place. 
Select Admin > Universal CMDB > Modeling > Report 
Manager, expand SAP, right-click SAP_Transports in 
the map, and select Node conditions. Access the 
Attribute condition dialog box, assign the required 
condition for the Last Access Time - (date) attribute. 
For details, see “Attribute Condition Dialog Box” in 
IT World Model Management.

Included in Tasks “Display SAP Information in Dashboard” on page 106
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SAP System Level Area

The area includes the following elements (listed alphabetically):

SAP Transport Level Area

The area includes the following elements (listed alphabetically):

SAP Transport Change Level Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Name The name of the SAP system.

GUI Element Description

Creation Date The date when the transport was created.

Description A description of the transport.

Name The name of the transport that has changed.

Target System The target system for non-local transport.

User The name of the user who created the transport.

GUI Element Description

Devclass The development class that includes the transaction.

Name The real name of the transaction.

Object Name The change that was made.

Object Type The object that changed.

Program The name of the program that runs the transaction.

Program Version The version of the program that runs the transaction.
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Screen The first screen that opens when you load the 
transaction.

Title The name of the transaction followed by (SAP 
Transaction).

GUI Element Description
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HP Business Availability Center for Siebel 
Applications 

This chapter describes the HP Business Availability Center for Siebel 
Applications solution.

This chapter describes: On page:

Concepts

About Using HP Business Availability Center for Siebel Applications 154

Diagnostics Tools 156

License 160

Architecture 161

Working with Firewalls 162

Siebel Monitors 163

The Siebel Service 164

Siebel View 165

Tasks

Deploy HP Business Availability Center for Siebel 
Applications–Workflow

167

Deploy HP Business Availability Center for Siebel 
Applications–Detailed Steps

171

Upgrade from HP Business Availability Center for Siebel 5.1 SP1 201

General Reference

Requirements 202
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About Using HP Business Availability Center for Siebel 
Applications

HP Business Availability Center for Siebel Applications, integrating 
SiteScope, Business Process Monitor, and HP Universal CMDB, enables you 
to gain visibility and control over your mission-critical Siebel applications.

HP Business Availability Center for Siebel Applications, integrating 
SiteScope, Business Process Monitor, and HP Universal CMDB, enables you 
to gain visibility and control over your mission-critical Siebel applications.

The Siebel solution provides:

➤ A single operation console consolidating all Siebel monitoring information. 

➤ Automatic discovery and modeling of Siebel-related elements, as well as 
their relationships to other systems in the organization’s Information 
Technology (IT) department.

➤ Change discovery and notification for quicker problem resolution. 

Support Matrix 203

Context Menu Options 204

Default CITs in the Siebel View 205

Customization

Save the Generated XML Files After Generating the SARM Report 209

Specify the Default SiteScope Monitors 209

Specify the SiteScope Monitor Used to Execute Siebel Diagnostics 
Tools

210

Change the Default Timeout for the Execution of a SiteScope 
Monitor

210

Increase the Default Timeout for Either a SARM Task or a SARM 
Analyzer Execution

211

Troubleshooting and Limitations 211

This chapter describes: On page:
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➤ Proactive monitoring of end-user experience in Siebel enterprises. 

➤ The ability to distinguish between Siebel-specific problems and general 
ones.

➤ Management of Siebel-related service level commitments. 

Note: You must have an HP Business Availability Center for Siebel 
Applications license to view the Siebel Enterprises view in HP Business 
Availability Center.

HP Business Availability Center for Siebel Applications consolidates Siebel 
components and business processes in the Siebel Enterprises view to gain 
real-time visibility over the entire Siebel infrastructure from a business 
perspective.

HP Business Availability Center for Siebel Applications also monitors, 
reports, and issues alerts on the performance and functionality of the Siebel 
eBusiness applications and servers that comprise your Siebel Enterprise 
business process infrastructure. 

Using HP Business Availability Center for Siebel Applications, your IT 
operation can analyze how each link in the Siebel Enterprise chain is 
affecting the user experience of customers, partners, suppliers, and 
employees. This enables your IT team to more accurately assess the resulting 
impact on business performance. It also enables the IT team, Siebel 
application support team, and Siebel Expert Services to take any steps that 
might be necessary to maximize availability, performance, and service levels 
to provide quality of service for all Siebel applications and end users.

The Siebel Enterprises view is available in the Dashboard. For details, see 
“View Configuration File CI–Details” on page 199.

Right-click the CIs in the Siebel Enterprises view to access additional 
information and diagnostics tools. For details on the context menu, see 
“Context Menu Options” on page 204. For details on the diagnostics tools, 
see below.
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Diagnostics Tools

You access the HP Business Availability Center for Siebel Applications 
information from the Applications menu. The following diagnostics tools 
are available:

SARM - User Trace Breakdown
The Siebel SARM - User Trace Breakdown tool enables you to view Siebel real 
user monitoring information. The diagnostic tool processes the data in the 
User Session Trace output files produced by Siebel Application Response 
Measurement (SARM) process. 

This data can be retrieved for a specific user in a specific time frame. It can 
also be retrieved for a specific transaction of a prerecorded script. For details, 
see “SARM - User Trace Breakdown (Run the Diagnostics Tool) Page” on 
page 239 and “SARM - User Trace Breakdown Dialog Box” on page 242 or 
“SARM - User Trace Breakdown - Analysis Report” on page 244.

The tool records logs for each Siebel transaction activity in the Web server or 
in the application server. It also records data about how long each 
transaction remains in each tier of the Siebel enterprise: Network, Web 
Server, Application Server, and Database. Siebel SARM tool logs Siebel real 
user monitoring data into binary SARM files (with .sarm extension). The 
transaction activity itself is written into the .sarm files.

HP Business Availability Center interacts with SARM Analyzer (a Siebel tool) 
using remote API calls to SiteScope. These calls activate a batch file, which 
copies files from Siebel, and then uses the SARM Analyzer to generate user-
readable files from the Siebel files. The user-readable files are then copied 
using SiteScope remote API to HP Business Availability Center.
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The SARM - User Trace Breakdown diagnostic tool is built over the Siebel's 
SARM tool. It produces required CSV and XML files as part of the analysis 
process, in which the Siebel SARM Analyzer package is utilized. The tool also 
analyzes and displays a graphical view of the results. It retrieves the SARM 
data for a specific user, in a specific time frame. It enables retrieving the 
SARM data for a specific Business Process Monitor transaction that belongs 
to a prerecorded script with Siebel breakdown enabled.

In the SARM - User Trace Breakdown tab, you can compare this breakdown 
per user sessions, user transactions, or application servers to enable you to 
identify the prime suspect for performance problems. You can also drill 
down within these logs to determine which layer is responsible for the slow 
response.

The SARM - User Trace Breakdown diagnostic tool is activated on demand. 

Note: The Virtual User Generator script must be recorded using the Siebel 
Web protocol. Select the Enable Siebel Breakdown checkbox while 
configuring the Business Process Monitor in System Availability 
Management. For details, see “Editing Business Process Transaction 
Monitors” in Using End User Management.

Details about how to use the SARM - User Trace Breakdown diagnostics tool 
are provided in the “SARM - User Trace Breakdown (Run the Diagnostics 
Tool) Page” on page 239.

Database Breakdown Diagnostic
The Siebel Database Breakdown diagnostics tool enables you to determine 
the cause of slow database response time by analyzing the database activity 
carried out as a result of running a Business Process Step and to extract 
comprehensive information regarding database time spent by various SQLs. 
The database activity is logged into database logs created on the Siebel 
application server. 
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You analyze Siebel database SQL activity by examining information in the 
Siebel application server logs. These logs contain a record of SQLs carried 
out as a result of Siebel components activity.

Logs are constantly created and updated on the Application Server. 
However, most of the time they are only logging errors, and do not include 
the extensive information that Database Breakdown can display. To log the 
extensive database time distribution information, the log level needs to be 
brought up.

When the user runs Database Breakdown, after defining the analysis' scope 
(Siebel Enterprise, Application, Business Process Step, and so on, Business 
Availability Center for Siebel Applications automatically increases (via 
SiteScope) the database log level for the selected component (if a specific 
component was selected). 

Then, Business Availability Center for Siebel Applications instructs the 
Business Process Monitor to run the transaction you selected. During the 
transaction run, as a result of the higher log level, database-related 
information is written into the application server log. 

When the transaction has finished running, the database log level for the 
selected component is returned to normal by HP Business Availability 
Center for Siebel. 

For details, see “Siebel Database Breakdown Configuration Report” on 
page 257 and “Siebel Database Breakdown Analysis Report” on page 259.

Tasks Diagnostic Tool
The Siebel tasks diagnostic tool enables you to view details of the Siebel 
Application Server tasks, for each monitored Siebel Enterprise. For details, 
see “Siebel View” on page 165.
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Using the Siebel Tasks Diagnostics tool, you can:

➤ Retrieve details of the Siebel Application Server tasks that are running, or 
were run, on each Siebel Enterprise

➤ Choose to view details of all tasks, regardless of status, or details of only 
these tasks with a specific status

➤ Choose to view task details for all components in all component groups on 
all Siebel Application Servers, or for specific components in specific 
component groups on specific Siebel Application Servers

For details, see “Tasks Diagnostics Tool Report” on page 262 and “Tasks 
Diagnostics Tool - Advanced Filter Dialog Box” on page 264.

Siebel Processes Tool 
The Siebel process diagnostic tool enables you to view details of the 
operating system processes running on the various Siebel Application 
Servers, for each monitored Siebel Enterprise. For details, see “Siebel View” 
on page 165.

To ensure that Diagnostics tools work properly, check the Diagnostics-
related settings. For details, see “Verify Diagnostics-Related Settings–Details” 
on page 174.

Using SiteScope, you can retrieve details of the Siebel Application Server 
processes that are running, or were run, on each Siebel Enterprise. You can 
view the details of all processes, regardless of status, or you can view only 
the processes with a specific status. Similarly, you can choose to view process 
details for all components in all component groups on all Siebel Application 
Servers, or for specific components in specific component groups on specific 
Siebel Application Servers.

When an application has performance/availability issues, you may use the 
Siebel Processes tool to verify that all Siebel processes are up and running 
and that none of the processes is using 100% CPU.

For details, see “Processes Report” on page 236 and “Processes Tool - 
Advanced Filter Dialog Box” on page 238.
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License

The HP Business Availability Center for Siebel Applications license unlocks 
the following functionality in HP Business Availability Center, helping to 
shorten time-to-value and MTTR:

➤ The Siebel Enterprises pattern view, displaying a hierarchical view of Siebel 
applications and infrastructure.

➤ Automatic linkage of Business Process Monitor transactions to the Siebel 
transactions they are monitoring.

➤ Automatic linkage of SiteScope measurements to their respective Siebel 
infrastructure.

➤ Siebel-specific KPIs that allow differentiation between Siebel-related issues 
and non-Siebel ones.

➤ Siebel diagnostics – SARM, Database Breakdown, Tasks, Processes – for in-
depth, in-context data on the Siebel environment.
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Architecture

The architecture of HP Business Availability Center for Siebel Applications is 
illustrated in the following diagram: 

Most of the Siebel CIs are created by automatic discovery. The configuration 
for these CIs is saved into the CMDB. Some of the relationships to Business 
Process Monitor and SiteScope CIs are created by automatic mechanisms 
specific to the HP Business Availability Center for Siebel Applications.

The architecture of the Business Availability Center for Siebel Applications 
solution includes the following components:

➤ The Discovery Probe discovers Siebel-related CIs and other CIs (such as 
hosts) that are related to them. 

➤ The Real User Monitor Probe monitors real user traffic and sends it to the 
Real User Monitor engine, that processes and stores it.
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➤ SiteScope communicates with the Siebel Enterprise system and retrieves 
system monitoring information using the srvrmgr CLI tool. It is also used as 
a middleware for all of the Siebel diagnostics tools.  

➤ Business Process Monitor collects data on the performance and availability 
of the Siebel Enterprise by running transactions that correspond to Business 
Process Steps. It is also used for Database Breakdown, and can be leveraged 
in SARM; for example, user sessions can be correlated to the corresponding 
Business Process Monitor transactions.

➤ Dashboard tabs and reports are used as the central console for viewing all of 
the data and performing analysis of the data. For details, see “Using 
Dashboard” in Using Dashboard.

Working with Firewalls

If you want to work with firewalls, you must install a firewall with a Virtual 
Private Network (VPN) between:

➤ HP Business Availability Center and the Business Process Monitor, to view 
Siebel Application Response Measurement (SARM) - user trace breakdown 
and/or database breakdown information

➤ HP Business Availability Center and SiteScope, to view all diagnostics 
information
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The following diagram illustrates a possible deployment involving firewalls:

Siebel Monitors

The SiteScope monitors used to monitor Siebel are:

➤ Siebel Application Server. Uses Siebel Server Manager client to monitor all 
aspects of Siebel application servers. For details about the monitor, see 
“Siebel Application Server Monitor Overview” in Using System Availability 
Management.

➤ Siebel Web Server. Watches Siebel server login session statistics and gauges 
the performance of Siebel Server Object Managers and database. For details 
about the monitor, see “Siebel Web Server Monitor Overview” in Using 
System Availability Management.
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➤ Siebel Log Monitor. Monitors the Siebel log files by looking for entries 
containing a specific event type or subtype. For details about the monitor, 
see “Siebel Log File Monitor Overview” in Using System Availability 
Management.

These monitors must be deployed. For details, see “Deploy the SiteScope 
Siebel Monitors–Details” on page 187.

The Siebel Service

The Siebel Service is a configuration service that provides the following 
advantages:

➤ Automatic linkage of SiteScope measurements to the relevant CIs based on 
measurement name.

➤ Automatic linkage of Business Process Steps with standardized names to the 
application they are monitoring. For details, see “Automatically Attach 
Business Process Steps to a Siebel Application CI by Following the Naming 
Convention” on page 185.

➤ Creation of a Business Process and Locations container and connection of 
the Business Process Steps monitoring Siebel, and their respective locations, 
to the containers. For details, see “Attach Business Process Monitor 
Transactions to Siebel Application Components” on page 184.

The Siebel Service starts working after BPM and SiteScope source adapters 
have been synchronized.

For details about how to view a service status via the JMX Web console, see 
“High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF.

The Siebel Service must be activated. For details, see “Check If the Siebel 
Service Is Activated–Details” on page 190.
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Siebel View

The Siebel Enterprises view is enabled by default; the other Siebel views 
must be enabled before they are displayed.

In Dashboard, access the Siebel Enterprises view to view information about 
the Siebel IT entities, the Siebel enterprise metrics monitored by SiteScope 
monitors, and information about the Siebel business processes/transactions 
simulated by Business Process Monitor scripts.

The Siebel Enterprises appears as follows:
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The following graph describes the various layers and drill-downs available in 
the topology of the Siebel Enterprises view. 

Note: The CIs, their hierarchy, and their KPIs are detailed in “Default CITs in 
the Siebel View” on page 205.

To enable the other Siebel views, select Dashboard & Service Level 
Management in the View Properties dialog box. For details, see “Create New 
View/View Properties Dialog Box” in IT World Model Management.
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The Siebel Topology and Siebel Web Topology views are created when you 
run the discovery package. They display the results of the Siebel discovery 
and are intermediate views whose information is included in the Siebel 
Enterprises view.

The Siebel Service uses the Siebel BPM Locations Linkage, Siebel BPM 
Locations Linkage Automatic, Siebel BPM Locations Linkage Manual, Siebel 
Host Monitor Linkage, and Siebel SiteScope Measurement Linkage views to 
automatically link measurements and monitors to CIs. These views are used 
for debugging purposes.

Deploy HP Business Availability Center for Siebel 
Applications–Workflow

This section describes the processes to follow to view Siebel data in 
Dashboard, and gives examples.

Check the Prerequisites

Ensure that the following software is installed before you install the 
HP Business Availability Center for Siebel Applications:

➤ Requirements. For details, see “Requirements” on page 202.

➤ Support Matrix. For details, see “Support Matrix” on page 203.

➤ Discovery Probe. Used to perform the discovery of Siebel topology in your 
organization. For details, see Discovery.

➤ SiteScope. Used to integrate the SiteScope data collector into the 
HP Business Availability Center for Siebel Applications. For details, see the 
HP SiteScope Deployment Guide PDF. 

➤ Business Process Monitor. Used to integrate the Business Process Monitor 
data collector into the HP Business Availability Center for Siebel 
Applications. For details, see HP Business Process Monitor Administrator’s 
Guide.

➤ Siebel. Install the applications you want to integrate into HP Business 
Availability Center. For details, see the Siebel documentation.
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➤ Optional - Real User Monitor. Required if you want to integrate the Real 
User Monitor Probe to monitor real user traffic and sends it to the RUM 
engine, that processes and stores it. For details, see “Real User Monitor 
Administration” in Using End User Management.

Check the Siebel Licence in HP Business Availability Center

Check that the appropriate Siebel licenses are set in HP Business Availability 
Center:

 1 In HP Business Availability Center, the license for running the HP Business 
Availability Center for Siebel Applications.

 2 In HP Business Availability Center, the license to enable the necessary 
amount of Business Process transactions to run. 

To check that the licenses are set properly or to update the licenses, select 
Admin > Platform > Setup and Maintenance > License Management. 

For details, see “License Management” in Platform Administration.

Check the Siebel Licence in SiteScope

Check that the license that enables the definition of SiteScope Siebel 
monitors and deployment of Siebel solution templates is set properly in 
SiteScope. For details, see “Siebel Solution Templates” in Using System 
Availability Management.

Deploy the Siebel Monitoring Package

Deploy the Siebel Monitoring package. For details, see “Package Manager” in 
IT World Model Management.
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Copy the srvrmgr Tool to the Discovery Probe Server

The srvrmgr tool is used to extract data about the enterprise's structure from 
Siebel. To copy the srvrmgr tool to the Discovery Probe server, copy the 
srvrmgr Command Line Interface (CLI) tool from the Siebel server to any 
folder on the Discovery Probe server. It is recommended to run the Siebel 
connection test to validate the srvrmgr installation. For details, see“Copy 
the srvrmgr Tool to the Discovery Probe Server–Details” on page 177.

Copy SARM Analyzer and srvrmgr Tool to the SiteScope Server

On SiteScope, the srvrmgr tool is launched by the Siebel Application Server 
monitor and is used to get the metrics. 

SARM Analyzer is used for analyzing SARM data, so that it can be displayed 
in Business Availability Center for Siebel Applications's SARM - User Trace 
Breakdown tab.

For details, see “Copy the srvrmgr Tool and the SARM Analyzer Tool to the 
SiteScope Server–Details” on page 178.

Perform Discovery

You run Siebel discovery to discover Siebel elements and Siebel topology. For 
details, see “Siebel” in Discovery.

Configure Specific Siebel CIs Manually

When you run the Siebel discovery, the process creates CIs for the 
discovered components in the CMDB. In addition to the CI’s properties that 
are automatically defined by the discovery process, you must manually 
define some properties so the Monitor Deployment Wizard and the Siebel 
diagnostics tools can run correctly. For details, see “Configure Specific Siebel 
CIs Manually–Details” on page 172.

Change the Business Process Monitor Hierarchy Structure to 
Transactions/Locations

Click Admin > Universal CMDB > Source Manager, click the Edit button  for 
the Business Process source adapter, and change the hierarchy structure to 
Transaction/Locations in the Hierarchy Structure parameter. 
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Use a Business Process Monitor Profile to Simulate Siebel Users

You can use Siebel transactions to simulate Siebel users and obtain 
performance and availability information on the Siebel application. You can 
use Business Process profiles to group several transactions.

For details, see “Use a Business Process Profile to Simulate Siebel 
Users–Details” on page 181.

Deploy the SiteScope Siebel Monitors

For details, see “Matching Connection Parameters to SiteScope” on 
page 223.

Synchronize the Source Adapters to Enter SiteScope CIs in the CMDB

To view data in the Siebel Enterprises view in Dashboard, you must 
synchronize the SiteScope source adapter. You can synchronize the 
SiteScope source adapter immediately or you can wait for the automatic 
synchronization to take place. For details, see the buttons in “Source 
Manager Page” in IT World Model Management.

Activate The Siebel Service

The Siebel Service starts working after Business Process Monitor and 
SiteScope source adapters have been synchronized. The siebel service is 
automatically activated when you have entered the appropriate license for 
HP Business Availability Center for Siebel solution. For additional 
information about the Siebel Service, see “The Siebel Service” on page 164.

For details about how to view a service status via the JMX Web console, see 
“High Availability for the Data Processing Server” in the HP Business 
Availability Center Deployment Guide PDF. Check that the Siebel Service is 
activated (it is activated only if you have a license). If necessary activate it 
manually. For details, see “Check If the Siebel Service Is Activated–Details” 
on page 190.

Configure HP Business Availability Center for Siebel Applications

To monitor your Siebel eBusiness applications and servers using HP Business 
Availability Center for Siebel Applications, you must first set up the Siebel 
monitoring environment. For details, see “Configure HP Business 
Availability Center for Siebel Applications–Details” on page 172.
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Display Siebel Information in Dashboard

HP Business Availability Center for Siebel Applications is ready. After all 
these steps are completed, you can view Siebel data in the Dashboard, use 
diagnostic tools, and so on. For details, see “Display Siebel Information in 
Dashboard” on page 197.

Deploy HP Business Availability Center for Siebel 
Applications–Detailed Steps

This section provides details about the steps described in “Deploy 
HP Business Availability Center for Siebel Applications–Workflow” on 
page 167.

This section includes the following topics:

➤ “Configure HP Business Availability Center for Siebel Applications–Details” 
on page 172

➤ “Configure Specific Siebel CIs Manually–Details” on page 172

➤ “Verify Diagnostics-Related Settings–Details” on page 174

➤ “Copy the srvrmgr Tool to the Discovery Probe Server–Details” on page 177

➤ “Copy the srvrmgr Tool and the SARM Analyzer Tool to the SiteScope 
Server–Details” on page 178

➤ “Use a Business Process Profile to Simulate Siebel Users–Details” on page 181

➤ “Deploy the SiteScope Siebel Monitors–Details” on page 187

➤ “Check If the Siebel Service Is Activated–Details” on page 190

➤ “Run the Siebel Database Breakdown Diagnostic Tool–Details” on page 192

➤ “Run the SARM - User Trace Breakdown Diagnostics Tool–Details” on 
page 193

➤ “Display Siebel Information in Dashboard” on page 197

➤ “View Configuration File CI–Details” on page 199
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Configure HP Business Availability Center for Siebel 
Applications–Details
This section describes the detailed steps used to configure the Siebel 
monitoring environment.

Create Business Process Profiles That Emulate Siebel Application 
Users

You can use Siebel transactions to simulate Siebel users and obtain 
performance and availability information on the Siebel application. You use 
Business Process profiles to group several transactions.

For information on creating Business Profiles, see “Use a Business Process 
Profile to Simulate Siebel Users–Details” on page 181.

Deploy SiteScope Monitors for the Siebel Templates Using the 
Monitor Deployment Wizard

You can use SiteScope monitors to monitor Siebel. For more information 
about the monitors, see “Siebel Monitors” on page 163.

For details about deploying the SiteScope Siebel monitors, see “Deploy the 
SiteScope Siebel Monitors–Details” on page 187.

Go Through the Diagnostics Checklist

Check that the Diagnostics-related settings correctly set up to ensure that 
Diagnostics work properly.

For details, see “Verify Diagnostics-Related Settings–Details” on page 174.

Configure Specific Siebel CIs Manually–Details
When you run the Siebel discovery, the process creates CIs for the 
discovered components in the CMDB. In addition to the CI’s properties that 
are automatically defined by the discovery process, you must manually 
define some properties so the Monitor Deployment Wizard and the Siebel 
diagnostics tools can run correctly. 

You manually define properties in IT Universe Manager. For details on 
defining properties for a CI, see “CIT-Specific Properties” in IT Universe 
Manager Administration.
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The following properties remain empty and must be entered manually.

CI Type Properties Description

Siebel 
Enterprise

Admin user name The name of the user used to login to 
Server Manager.

Admin password The password of the user used to login to 
Server Manager.

SARM Script Path The path to the location of the Siebel 
Application Response Measurement 
(SARM) Analyzer package on the SiteScope 
server. The path is relative to the SiteScope 
server. 

Server Manager 
Script Path

The path to the location of Server 
Manager package on the SiteScope server. 
The path is relative to the SiteScope server. 
For details, see “Copy the srvrmgr Tool 
and the SARM Analyzer Tool to the 
SiteScope Server–Details” on page 178.

Siebel 
Application

Emulated 
Transaction User 
Name

The name of the user used in the script 
that analyzes the application. It is the 
default user name that appears when 
configuring the Database Breakdown tool.

Siebel Web 
Server 
Extension

SARM Log Folder The log folder to which SARM log files are 
written on the Web Server Extension's 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_web_server_extension_name>\
<log_directory>
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Note: In addition, you must check that the connection parameters used to 
connect to SiteScope monitors are the ones that exist in the various relevant 
CIs (Enterprise, Application Server, and so forth). For details, see “Matching 
Connection Parameters to SiteScope” on page 223.

Verify Diagnostics-Related Settings–Details
This section provides details about the Diagnostics-related settings that 
ensure that Diagnostics work properly.

Diagnostics-Related Settings for Siebel

Check that:

➤ The SiteScope user has at least read-only access to the log directories of all 
Web and Application Servers.

➤ The SiteScope user has administrative privileges on all Siebel servers or, if 
this is not possible, give the permissions specified at the Microsoft Help and 
Support site (http://support.microsoft.com/default.aspx?scid=kb;en-
us;Q300702).

Siebel 
Application 
Server

SARM Log Folder The log folder to which SARM files are 
written on the Application Server 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_app_server_name>\<log_direct
ory>

Log Folder The log folder to which Siebel general log 
files are written on the Application Server 
machine. The path is relative to the 
SiteScope server. The folder should be 
shared. The format should be: 
\\<siebel_app_server_name>\<log_direct
ory>

CI Type Properties Description
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➤ You have defined a special Siebel user to be used by Business Process 
Monitor profiles. Note that this user should be used only for that purpose.

➤ Siebel Breakdown is enabled for the script that monitors the Siebel 
application. For details, see “Managing Business Process Profiles” in Using 
End User Management.

➤ Siebel Server Manager and SARM Analyzer. Check that:

➤ The srvrmgr package and SARM Analyzer package are installed on a 
SiteScope machine (they are needed for running the Diagnostics tools). 
You copy Siebel Server Manager and the SARM Analyzer to a SiteScope 
machine (preferably) or, if this is not possible, to another machine where 
it can be executed by a SiteScope user. For details, see “Copy the srvrmgr 
Tool and the SARM Analyzer Tool to the SiteScope Server–Details” on 
page 178.

➤ The SiteScope user on Siebel Server Manager has execution permissions 
when both SiteScope and Siebel are running on UNIX.

Diagnostics-Related Settings for SiteScope

Check that:

➤ SiteScope service is running under a domain account (not a local system). 
This domain account (SiteScope user) must have the permissions specified 
in “Diagnostics-Related Settings for Siebel” on page 174.

➤ Each Siebel Web and Application Server is defined as Remote NT or Remote 
UNIX appropriately. Remote UNIX machines must be defined using the 
Telnet protocol. Additionally, in the initialize shell environment field, enter 
stty cols 1024; stty tabs; $SHELL.

➤ SiteScope has access permissions to the Siebel machines. Check that the 
account SiteScope Service is running in Services (in Windows NT) or in the 
process (on UNIX).

➤ The log and SARM log folders on Siebel Web Server and Application Server 
are accessible from the SiteScope machine.
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➤ SiteScope is attached to the Gateway Server.

➤ SiteScope has an additional license for Siebel Monitors.

Diagnostics-Related Settings for HP Business Availability Center

Check that:

➤ All the HP Business Availability Center for Siebel Applications configuration 
parameters of the Enterprise, and Siebel Servers are spelled correctly, the 
appropriate case is used, and there are no blank spaces at the end of the 
parameter string. 

➤ There is no inconsistency in the treatment of the SiteScope host name 
between the SiteScope profile and System Availability Management (either 
defined with domain or as an IP address). Also, check that SiteScope can 
communicate with the Siebel server.

Diagnostics cannot access a SiteScope located in an outer LAN. The solution 
is to define SiteScope in System Availability Management using the host 
name provided by the SiteScope server. If the SiteScope server cannot be 
accessed using such a host name from the Gateway Server the host name 
must be defined in the hosts file in the operating system of all the Gateway 
Servers (for NT, the location is: C:\WINNT\system32\drivers\etc\hosts; for 
some UNIX environments, the location is: /etc/hosts; in other UNIX 
environments it is in the .rhosts file). 

➤ The SiteScope you are using for diagnostics is attached (click 
Admin > System Availability Management in HP Business Availability 
Center).

➤ You are using a dedicated SiteScope for diagnostics purposes, when working 
with medium to large Siebel deployments.

➤ The time zone and time definitions of the SiteScope server used for 
diagnostic purposes (on which SARM Analyzer and srvrmgr are installed) are 
synchronized with the Siebel server time zone and time definition.

➤ You have network access (without firewalls or via VPN) to the Business 
Process Monitor servers (port 2696) you are going to use for diagnostics 
purposes. 

➤ For each Business Process Monitor server used for Diagnostics, you can open 
the http://<BPM_server>:2696/ page from the Gateway Server.
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➤ All paths you set in HP Business Availability Center for Siebel Applications 
configuration are relative to SiteScope; for example: if they are local on 
SiteScope (Server Manager, SARM analyzer) use the local path, otherwise use 
the complete network path.

➤ You have a license for Siebel on the Gateway Server (select Admin > Platform 
> Setup and Maintenance > License Management to verify this).

➤ SiteScope data arrives to HP Business Availability Center. 

Consult the dispatcher.txt log file with the appropriate log level to check 
that information. You can update the log level of the dispatcher log in the 
first line of the 
<HP Business Availability Center home directory>
\conf\core\DataService\DataService_logs.ini\dispatcher_log.cfg file on 
the Gateway Server. Change the value of LogLevel to debug5. This causes 
the samples from SiteScope to appear in the dispatcher.txt file.

Note: It is recommended to increase the log level only for a short period, so 
HP Business Availability Center performance is not affected.

➤ The user of your Siebel Application in HP Business Availability Center for 
Siebel Applications Configuration has appropriate permissions in the Siebel 
Site and the password is correct.

Copy the srvrmgr Tool to the Discovery Probe 
Server–Details
The srvrmgr tool is used to extract data about the enterprise's structure from 
Siebel.

Note: If you are working with different versions of Siebel in your 
organization, make sure you use a srvrmgr with a version that is appropriate 
for the Siebel server.
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To copy the srvrmgr tool to the Discovery Probe server, copy the srvrmgr 
Command Line Interface (CLI) tool from the Siebel server to any folder on 
the Discovery Probe server. It is recommended to run the Siebel connection 
test to validate the srvrmgr installation. 

To run the connection test, open the command line on the Discovery Probe 
server and change directory to the location of the srvrmgr.exe file. Run from 
the command line:
>srvrmgr /e [site_name] /g [gateway_host] /u [username] /p [password] 

If the connection is established successfully, you must see the srvrmgr 
prompt and the status message about the number of connected servers, as 
follows:

Copy the srvrmgr Tool and the SARM Analyzer Tool to the 
SiteScope Server–Details

Note: If you are working with different versions of Siebel in your 
organization, make sure you use a srvrmgr and a SARM Analyzer with a 
version that is appropriate for the SiteScope server. For details, see 
“Requirements” on page 202.
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This section provides details about the processes used to copy the srvrmgr 
tool and the SARM Analyzer tool to the SiteScope server.

Copy the srvrmgr Tool to the SiteScope Server

To copy the srvrmgr tool to the SiteScope server use the following steps:

 1 Copy the srvrmgr Command Line Interface (CLI) tool from the Siebel server 
to any folder on the SiteScope server.

Note: It is recommended to run the Siebel connection test to validate the 
srvrmgr installation.

 2 To run a connection test, open the command line on the SiteScope server 
and change directory to the location of the srvrmgr.exe file.

 3 Run from the command line:
>srvrmgr /e [site_name] /g [gateway_host] /u [username] /p [password]

Note: For the connection to work properly you must check that the user and 
password you are using have the correct permission for a remote 
connection. For details, see “Perform the Remote Connection from 
SiteScope to Siebel” on page 180.
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If the connection is established successfully, you should see the srvrmgr 
prompt and the status message about the number of connected servers, as 
follows:

Copy the SARM Analyzer Tool to the SiteScope Server

To copy the SARM Analyzer tool to the SiteScope server, copy the SARM 
Analyzer tool from the Siebel server to a folder on the SiteScope server.

Note: If your site includes a large number of Web servers, it is better to use 
multiple SiteScopes to distribute the work done by the SARM Analyzer tool 
between these SiteScopes. In such a case, copy SARM Analyzer to each 
SiteScope.

Perform the Remote Connection from SiteScope to Siebel

All Siebel servers (Windows and UNIX) must be defined as remote servers on 
the SiteScope server. For details, see the SiteScope documentation.
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Run the SiteScope Service with a Domain User

SiteScope should run under a domain user who has permissions to run 
server manager and SARMAnalyzer and also has read access to the log 
folders on the Siebel servers (Web servers and application servers).

Use a Business Process Profile to Simulate Siebel 
Users–Details
This section provides details about how to use Siebel transactions to 
simulate Siebel users and obtain performance and availability information 
on the Siebel application. 

You can use Business Process profiles to group several transactions.

Tips for Recording Business Process Monitor Transactions for Siebel

In the HP Virtual User Generator (VuGen), check that:

➤ When recording scripts on VuGen for Siebel, you only use the Siebel-Web 
protocol. For details see Using HP Virtual User Generator.

➤ You record scripts with a special user created for monitoring/diagnostics 
purposes on Siebel.

➤ You set a think time separator of 10 seconds for the script transactions used 
for Siebel diagnostics. The VuGen script includes discrete transactions 
(transactions that do not include lr_think_time() within them) and that it 
uses the lr_think_time(…) functions to separate between the VuGen 
transactions. 

➤ The script must not be too long (recommended no more than five 
transactions per script) since the Diagnostics tools need to run the whole 
script every time you want to analyze a specific transaction. For example, if 
a problematic transaction is located close to the end of the script, you would 
have to run all the previous transactions to reach the problematic one. If 
you need to record more transactions, record an additional script.

➤ You must select the Siebel-Web protocol when you create a new script, 
because, in HP Virtual User Generator (VuGen), Siebel scripts are recorded 
using the Siebel-Web protocol. For details, see Using HP Virtual User 
Generator.
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➤ Sometimes, the Run-Time Settings should be configured for setting 
appropriate values: Think-Time-Replay policy, Timeout values, logging 
options, Proxy, Browser Emulation, and so on.

You can only use Vugen scripts with Siebel applications.

In HP Business Availability Center, you can attach Business Process Monitor 
transactions to Siebel application components automatically or manually. 
For details, see “Attach Business Process Monitor Transactions to Siebel 
Application Components” on page 184.

To select the appropriate protocol:

 1 In VuGen, select New to open the New Virtual User page.

 2 Select New Single Protocol Script.

 3 Select the Siebel-Web protocol.

Create a Business Process Profile

You can create business process profiles in End User Management. For 
details, see “Managing Business Process Profiles” in Using End User 
Management.

View SARM Data in Business Process Steps

To view Siebel Application Response Measurement (SARM) data in Business 
Process Steps in the HP Business Availability Center for Siebel Applications 
SARM - User Trace Breakdown diagnostics tool, you must select the Enable 
Siebel Breakdown property for each Siebel transaction monitor in the 
Business Process profile. When you do not select the property, the 
Transactions tab is empty.
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To see SARM data under Business Process Steps, select Admin > End User 
Management, right-click the relevant transaction monitor and select Edit, 
and in the Transaction Breakdown Settings area, select the Enable Siebel 
Breakdown parameter.

Synchronize the Business Process Monitoring Source Adapter to Enter 
Business Process Monitor CIs in the CMDB

To view data in the Siebel Enterprises view in Dashboard, the Business 
Process Monitor source adapter must be synchronized. 

You can synchronize the Business Process Monitoring source adapter 
immediately or you can wait for the automatic synchronization to take 
place.

For details, see the action buttons in “Source Manager Page” in IT World 
Model Management.
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Specify a Transaction/Location or Regular Hierarchy in the Business 
Process Monitor Source Adapter

To display location information in the Siebel view(s), select the 
Transaction/Location type of hierarchy to the Business Process Monitor 
source adapter. To hide location information, select the Regular type of 
hierarchy. For details about the option, see “Business Process Monitoring 
Source Adapter Details” in IT World Model Management.

Attach Business Process Monitor Transactions to Siebel Application 
Components

To display Performance and Availability information on Siebel applications, 
you must attach Business Process Step CIs to Siebel Application CIs. 

If the Business Process Monitor source adapter was assigned the 
Transaction/Location option a copy of the location information is attached 
to the Locations container. For details about the option, see “Business 
Process Monitoring Source Adapter Details” in IT World Model Management.

You can connect Business Process Steps to a Siebel application in two ways:

➤ Follow the naming conventions for Siebel Business Process Steps names. For 
details, see “Automatically Attach Business Process Steps to a Siebel 
Application CI by Following the Naming Convention” on page 185.

➤ Do not follow the naming conventions for the Business Process Steps 
names. In this case, you must manually link a Business Process Step to a 
Siebel application. For details, see “Attach Business Process Steps to a Siebel 
Application CI without Following the Naming Convention” on page 185.

If you do not follow the naming conventions, be careful when deleting links 
between Siebel applications and Business Process Steps. For details, see 
“Delete Links Between Siebel Applications and Business Process Steps” on 
page 186.
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Automatically Attach Business Process Steps to a Siebel 
Application CI by Following the Naming Convention

To automatically connect Business Process Steps to a Siebel application, the 
Business Process Step name should have the following format:
<app_name>_ _<ent_name>_ _<BPM_tran_name>

➤ app_name. The name of the Siebel application to which you want to attach 
the Business Process Step.

➤ ent_name. The name of the Siebel Enterprise on which the Siebel 
application is run.

➤ BPM_tran_name. The unique name of the Business Process Step. Any set of 
alphanumeric and mixed case characters are supported (special characters 
are not allowed). It is good practice to name the transaction so that the 
name indicates what occurs in it.

Make sure the double underscore do not have spaces between them.

Note: You assign the appropriate name to a Business Process Step when you 
record it. For details, see Using HP Virtual User Generator.

Attach Business Process Steps to a Siebel Application CI 
without Following the Naming Convention

After you have built a Business Process profile, you must manually connect 
Business Process Steps with Siebel Application CIs. To attach Business 
Process Steps to a Siebel Application CI without following the naming 
convention:

 1 Select Admin > Universal CMDB > Modeling > IT Universe Manager.

 2 Select Siebel Enterprises in the View list.

 3 Right-click the Siebel Application CI that you want to monitor using the 
BPM profile and select Attach Monitoring CI to open the Attach Related CIs 
wizard. For details, see “Attach Related CIs Wizard” in IT World Model 
Management.

 4 Select End User Monitors View in the Views list.
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 5 Expand and select the Business Process Step to which you want to connect 
the Siebel Application CI. You can select more than one.

 6 Click the right arrow to move the CI to the right-hand box. 

 7 Click Next. 

 8 In the Relationship Type list, select Monitoring By Siebel.

 9 Select Allow CI Update. 

 10 Click Finish.

Delete Links Between Siebel Applications and Business Process 
Steps

If you delete a link between a Siebel Application CI and its child Business 
Process Step transaction, then the following happens:

➤ If you follow the naming convention for the Business Process Step 
transaction, the link between the Siebel transaction and its child Business 
Process Step is automatically recreated at the next synchronization.

➤ If you do not follow the naming convention and created a manual link 
between the Siebel transaction and a Business Process Step transaction, then 
when you delete the link:

➤ If the Business Process Monitoring source adapter was assigned the 
Transactions/locations option, the Contained Location CI is not deleted. 

Delete the Contained Location CI only if the deleted Business Process 
Step transaction is the only CI attached to this location. If other Business 
Process Step transactions are attached to this location, delete only the 
links between the Business Process Monitor (BPM transaction from 
location) and the Location container.

➤ If the Business Process Monitoring source adapter was assigned the 
Regular option, the link between the BP Step and the BP Steps container 
is not automatically deleted, and you should delete it.

For details about the Transactions/locations or Regular options, see 
“Business Process Monitoring Source Adapter Details” in IT World Model 
Management.
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Deploy the SiteScope Siebel Monitors–Details
This section provides the detailed steps to use to deploy SiteScope Siebel 
monitors.

You can deploy the Siebel monitors using one of the following techniques:

➤ The Monitor Deployment Wizard.

➤ The Siebel solution template(s).

Both techniques leverage the concept of solution sets. Solution sets 
automate the creation of the monitors that should be used, and include 
built-in threshold information. Essentially, they encompass monitoring best 
practices.

Use the Monitor Deployment Wizard

Use the Monitor Deployment Wizard to deploy Siebel monitors. For details, 
see “Monitor Deployment Wizard” in Using System Availability Management.

In the Monitor Deployment wizard, in the left pane of the Select 
Configuration Items to Monitor page, select the Siebel Enterprises view. 
Select the CIs you would like monitored and move them to the right pane. 
In the Select Templates to Apply page, the left pane lists all the available 
templates in the wizard. The names of the Siebel-specific templates start 
with Siebel. The child objects are the monitors that are deployed by the 
template. The right pane lists the CI Types of all the CIs selected in the 
previous page.
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If the wizard is able to match templates to the selected CI Types, the CI Type 
is listed with the applicable template as a child object:

Note: When deploying monitors on Siebel objects, the CI Types appearing 
in the right pane may be Siebel CI Types.
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Using the Siebel Solution Templates

To create a SiteScope monitor that can monitor a Siebel Enterprise, you can 
run dedicated solution templates. Two kinds of solution templates are 
available for each solution (one for UNIX and one for Windows):

➤ Siebel Appl Server For UNIX and Siebel Appl Server For Windows solution 
templates. Deploy a set of monitors that test both Siebel-specific and 
general statistics on the Siebel Application servers.

➤ Siebel Gateway Server For UNIX and Siebel Gateway Server For Windows 
solution templates. Deploy a set of monitors that test machine and OS-
oriented statistics of Siebel Gateway servers.

➤ Siebel Web Server For UNIX and Siebel Web Server For Windows solution 
templates. Deploy a set of monitors that test both Siebel-specific and 
general statistics on Siebel Web servers installed. 

For details about running the solution template, see “Siebel Solution 
Templates” in Using System Availability Management.

Synchronize the SiteScope Source Adapter to Enter SiteScope CIs in 
the CMDB

To view data in the Siebel Enterprises view in Dashboard, the SiteScope 
source adapter must be synchronized. 

You can synchronize the SiteScope source adapter immediately or you can 
wait for the automatic synchronization to take place.

For details, see the action buttons in “Source Manager Page” in IT World 
Model Management.
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Check If the Siebel Service Is Activated–Details
This section provides details about checking if the Siebel Service is activated.

The Siebel Service is a configuration service for automatic linkage. For 
details, see “The Siebel Service” on page 164.

The Siebel Service starts working after BPM and SiteScope source adapters 
have been synchronized.

The siebel service is automatically activated when you have entered the 
appropriate license for HP Business Availability Center for Siebel 
Applications. 

Check that the Siebel Service is activated (it is activated only if you have a 
license). If necessary activate it manually. For details about how to view a 
service status via the JMX Web console, see “High Availability for the Data 
Processing Server” in the HP Business Availability Center Deployment Guide 
PDF.

Note: If you enter a new license in an old HP Business Availability Center 
installation, you may need to restart the Modeling server to activate the 
service. 

To view if the Siebel Service is activated:

 1 In the browser, enter http://<HP Business Availability Center server name>
:8080/jmx-console/

 2 Double-click service=hac-manager listed under Topaz.
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 3 The JMX MBean View for hac-manager opens. 

 4 Click the Invoke button corresponding to the listAllAssignments parameter. 
The result is as follows:
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Run the Siebel Database Breakdown Diagnostic 
Tool–Details
This section provides details about running the Siebel Database Breakdown 
diagnostics tool.

When the user runs Database Breakdown, after defining the analysis' scope 
(Siebel Enterprise, Application, Business Process Step, and so on, 
HP Business Availability Center for Siebel Applications automatically 
increases (via SiteScope) the database log level for the selected component 
(if a specific component was selected). 

Then, HP Business Availability Center for Siebel Applications instructs the 
Business Process Monitor to run the transaction you selected. During the 
transaction run, as a result of the higher log level, database-related 
information is written into the application server log. 

When the transaction has finished running, the database log level for the 
selected component is returned to normal by HP Business Availability 
Center for Siebel Applications.

To run the Database Breakdown tool, click Applications > Business 
Availability Center for Siebel > Database Breakdown to open the Siebel 
Database Breakdown Configuration page. For details, see “Siebel Database 
Breakdown Configuration Report” on page 257.

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Siebel Database Breakdown option. For details, 
see “Dashboard Menu Options” in Using Dashboard.
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Run the SARM - User Trace Breakdown Diagnostics 
Tool–Details
This section provides details about running the SARM - User Trace 
Breakdown diagnostics tool.

There are two stages to run the SARM - User Trace Breakdown diagnostics 
tool:

 1 Provide details on the data you want to process. For details, see “Configure 
the SARM - User Trace Breakdown Diagnostic Tool” on page 193.

 2 Run the SARM - User Trace Breakdown diagnostics tool. For details, see “Use 
the SARM Logs for a Specific Web and Application Server” on page 196.

The data is then displayed and you can generate different views and pie 
charts to display the data in a user-friendly manner in the SARM - User Trace 
Breakdown page. For details, see “Siebel View” on page 165.

Configure the SARM - User Trace Breakdown Diagnostic Tool

You can view data about the activity taking place in the Web server(s) and 
application server(s) at a specific Siebel Enterprise and for a specific user, in a 
specified period of time. HP Business Availability Center searches all of the 
SARM files at the Siebel Enterprise, looks for the sessions of the specified 
user, fetches the appropriate files, runs the SARM analyzer, and lists all of 
the sessions used by the user.

You can configure the SARM - SARM - User Trace Breakdown diagnostic tool.
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To configure the SARM - User Trace Breakdown diagnostics tool, access the 
SARM - User Trace Breakdown page. For details, see “SARM - User Trace 
Breakdown (Run the Diagnostics Tool) Page” on page 239.

Select the Siebel Enterprise for which you want to view SARM User Trace 
Breakdown data, enter the name of the user whose activity you want to trace 
in the User box, and click the linked date in From or To to open a calendar 
and select a new date and time if you want to change the default date and 
time.

After you configure the SARM, you can:

➤ Invoke a specific Business Process Monitor script. You can view data 
about a Business Process Monitor transaction of a specific script running 
in the Web server(s) and application server(s) at a specific Siebel 
Enterprise, and in a specified period of time. HP Business Availability 
Center invokes the Business Process Monitor transaction, and then 
analyzes the relevant session. For details, see “Invoke Business Process 
Monitor Script” on page 241.
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➤ Specify where the files can be found:

➤ Automatically collected Web and application server logs. You can run 
the SARM - User Trace Breakdown diagnostic tool on automatically 
collected Web and application server logs. 

➤ The SARM logs of a specific application server and Web server. You 
can run the SARM - User Trace Breakdown diagnostic tool on the 
SARM logs of a specific application server and Web server. 

➤ An already generated user session trace XML file for a Siebel 
Enterprise, a user, and a specific time frame. You can run the SARM - 
User Trace Breakdown diagnostic tool on an already generated user 
session trace XML file for a site, a user, and a specific time frame. 
HP Business Availability Center searches all of the SARM files at the 
Siebel Enterprise, looks for the sessions of the specified user, fetches 
the appropriate files, runs the SARM analyzer, and lists all of the 
sessions used by the user that were active within the time frame. 

For details, see “Advanced Options Area” on page 241.

You can then run the diagnostic tool. 
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Use the SARM Logs for a Specific Web and Application Server

When you run the SARM - User Trace Breakdown diagnostic tool, the SARM 
- User Trace Breakdown page indicates the status of each step in the 
procedure.

➤ Check SiteScopes connectivity. When the status indicator shows running 
stripes, the SiteScopes connectivity is being checked. When the status 
indicator is complete, the operation has completed.

➤ Load Web Servers’ session data. When the status indicator shows running 
stripes, the Web server session data is being loaded. When the status 
indicator is complete, the loading has completed.

➤ Extract Application Servers’ session data. When the status indicator shows 
running stripes, the application server session data is being extracted. When 
the status indicator is complete, the extraction has completed.

➤ Analyze Results and Prepare Charts. When the status indicator shows 
running stripes, the final results are being analyzed and charts are prepared. 
When the status indicator is complete, the loading has completed.

➤ Processing. The progress in the current step.
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➤ Total Progress. Indicates the total progress of the SARM - User Trace 
Breakdown diagnostic tool.

After the process is complete, the page closes and the diagnostic results are 
displayed on the SARM - User Trace Breakdown - Analysis page. For details, 
see “SARM - User Trace Breakdown - Analysis Report” on page 244. 

Display Siebel Information in Dashboard
HP Business Availability Center for Siebel Applications is ready. After all 
these steps are completed, you can view Siebel data in the Dashboard, use 
diagnostic tools, and so on. You can display Siebel information in 
Dashboard as follows:

➤ View Siebel information in the Siebel views. For details about the views, see 
“Siebel View” on page 165.

➤ View the SARM - User Trace Breakdown Diagnostic report. HP Business 
Availability Center for Siebel Applications SARM Diagnostics is a user trace 
breakdown diagnostic tool that processes the data in the User Session Trace 
output files produced by Siebel’s SARM process. This data can be retrieved 
for a specific user in a specific time frame. It can also be retrieved for a 
specific transaction of a prerecorded script. 

Run the tool. For details, see “Run the SARM - User Trace Breakdown 
Diagnostics Tool–Details” on page 193.

Display the information. For details, see “SARM - User Trace Breakdown - 
Analysis Report” on page 244.

➤ View the Siebel Database Breakdown Diagnostic report. The Siebel 
Database Breakdown diagnostic tool enables you to analyze database logs 
created on the Siebel application server, and extract comprehensive 
information regarding database time spent by various SQLs. 

Run the tool. For details, see “Run the Siebel Database Breakdown 
Diagnostic Tool–Details” on page 192.

Display the information. For details, see “Siebel Database Breakdown 
Analysis Report” on page 259.
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➤ View the Tasks Diagnostics Tool report. The Siebel tasks diagnostic tool 
enables you to view details of the Siebel Application Server tasks, for each 
monitored Siebel Enterprise. For details, see “Tasks Diagnostics Tool Report” 
on page 262.

➤ View the Processes Tool report. The Siebel Processes tool enables you to 
view details of the Siebel Application Server processes, for each monitored 
Siebel Enterprise. For details, see “Processes Report” on page 236.

➤ View Changes Made to Siebel Enterprise CIs. You can assign CIs to keep 
change information. For details on assigning CIs to keep change 
information, see the HP Universal CMDB documentation. 

When the discovery process discovers changes made to the properties of 
these CIs, the changes are displayed in the Change report available as a 
context menu option for each one of the relevant CI types. For details about 
the Change report, see “Change Report Page” in IT World Model 
Management.

➤ View Configuration File CI Details. For details, see “View Configuration File 
CI–Details” on page 199.
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View Configuration File CI–Details
You can view configuration file details:

➤ siebel.cfg file. Right-click the relevant Siebel Application Server CI in the 
Siebel Enterprises view, select Properties, and click Show document content 
to display tdetails of the siebel.cfg file. The siebel.cfg configuration file 
displays information taken from the application server installation. 
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➤ parameters.cfg file. Right-click the relevant Configuration File CI in the 
Siebel Enterprises view, select Properties, and click Show document content 
to display details of the parameters.cfg file. The parameters.cfg. file 
includes the output of the list parameters for component command using 
srvrmgr. 

You can also access this information by selecting Admin > Universal CMDB > 
Modeling > IT Universe Manager > Properties. For details, see “Properties Tab” in 
IT World Model Management.
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Upgrade from HP Business Availability Center for Siebel 5.1 
SP1

This section describes the procedure to follow when upgrading from 
HP Business Availability Center for Siebel Applications version 5.1 SP1 to the 
current HP Business Availability Center version. The upgrade is performed 
manually. Some configuration may be lost during the upgrade. (For details 
about the general upgrade procedure for HP Business Availability Center, see 
“Upgrading Components” in the HP Business Availability Center Deployment 
Guide PDF.)

To perform the manual upgrade, proceed as follows. (These instructions 
assume that HP Business Availability Center is already upgraded to the 
current version):

 1 Run the Siebel automatic discovery patterns. For details, see Discovery.

 2 Optionally, run other discovery patterns, or add CIs manually, and link 
them to the discovered Siebel CIs.

 3 For each Siebel Application CI, use the Attach Monitoring CI option in the 
IT Universe to relate the application to the Business Process Steps 
monitoring it. For details, see “Attach Business Process Monitor Transactions 
to Siebel Application Components” on page 184.

 4 Follow the manual configuration steps as defined in “Deploy the SiteScope 
Siebel Monitors–Details” on page 187.

 5 For each Siebel Component and Siebel Application Server monitored by 
SiteScope, add the Number of sessions counter to the existing monitor, in 
SiteScope. For details, see SiteScope documentation. 
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Note: 

➤ Predefined Siebel reports, custom-made Siebel Dashboard views, and 
thresholds defined on a view's element (and not through System 
Availability Management) are lost.

➤ The Sites View is replaced by the standard Siebel Enterprises view.

➤ A dimension/Key Performance Indicator that appears for a Siebel 
element/configuration item (CI), appears also as a measurement for the 
Siebel KPI.

➤ The Component Group, Component, and Siebel Web Application CIs 
exist now in the CMDB. They are not monitoring information linked to 
the Siebel Application Server CI as in version 5.1.

➤ A user sees the Siebel Enterprises view in Dashboard or is able to 
configure the Siebel Enterprises view, only after a user with the 
appropriate administration privileges has granted that user the 
appropriate permissions.

Requirements

➤ Siebel 7.5.3, 7.7, or 7.8

➤ SiteScope 8.5

➤ Business Process Monitor 4.5.2 or later

➤ Discovery Probe 6.5

➤ The version of the Siebel Application Response Measurement Analyzer 
(SARM) package that is appropriate for the Siebel version you have installed. 
If you are working with SARM in Siebel version 7.8, use SARM Analyzer for 
Siebel version 7.7.

➤ The Siebel Server Manager version that is appropriate for the Siebel version 
you have installed. 
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Support Matrix

The support matrix for HP Business Availability Center for Siebel 
Applications is as follows:

Note: 

➤ SiteScope monitors are not tested for SiteScope UNIX installation.

➤ If the SiteScope machine is located outside the HP Business Availability 
Center LAN, you must configure the Virtual Private Network (VPN) to 
enable SiteScope to communicate with the HP Business Availability 
Center Gateway Server. 

Siebel Version 
Solaris Operating System Version (on 
the Siebel Servers) 

Windows Operating 
System Version (on 
the Siebel Servers) 

Siebel 7.5.3 ➤ Solaris 5.9 - Supported not tested 

➤ SARM on mixed environment - 
Not supported 

Windows 2000 

Siebel 7.7 Solaris 9 Windows 2000 

Siebel 7.8 

(to work with 
SARM you 
must use 
SARMAnalyzer 
version 7.7)

Solaris 9 - Supported not tested Windows 2000 
203



Chapter 5 • HP Business Availability Center for Siebel Applications
Context Menu Options

In the Siebel-related views, right click CIs to display a list of the context 
menu options available in the Siebel Enterprises view. For details, see 
“Dashboard Menu Options” in Using Dashboard.

The context menu options available from the Siebel-specific CITs are listed 
in “Go to Siebel Diagnostics” in Using Dashboard. An additional context 
menu option is Cross-Performance Report accessed by using the Siebel Cross-
Performance option. For details, see “Go to Report” in Using Dashboard.

Different context menu options are available depending on the type of 
Siebel-specific CIs you right-click:

Type of CIT Context Menu Option

Siebel Site Siebel Database Breakdown 

Siebel SARM 

Siebel Application Siebel Database Breakdown 

Siebel Application Server Cross-Performance Report

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Component Group Cross-Performance Report 

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Component Cross-Performance Report 

Show Tasks in Error

Show Running Tasks

Show Processes

Siebel Web Server 
Extension

Cross-Performance Report

Siebel Web Application Cross-Performance Report
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Default CITs in the Siebel View

In Dashboard, access the Siebel Enterprises view to view information about 
the Siebel IT entities, the Siebel enterprise metrics monitored by SiteScope 
monitors, and information about the Siebel business processes/transactions 
simulated by Business Process Monitor scripts.

The Siebel Enterprises appears as follows:

The CITs are as follows:

CIT Icon Description

Siebel Enterprise The Siebel Enterprise CI represents the 
logical grouping of Siebel Application Servers 
that support the same group of users 
accessing a common database server.

Contained Group The Group CI is a logical container. This is 
not a Siebel-specific CI. The Siebel 
Enterprises view includes the following 
groups: Applications, Business Processes, 
Hosts, and Locations.

Siebel Application The Siebel Application CI represents the 
Siebel complete solution for an 
organization’s needs in a certain area. For 
example: marketing, call center, and so 
forth.
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Business Process Step The Business Process Steps (BPM transactions 
inside a script) CIs are emulated Siebel 
transactions executed on a Business Process 
Monitor machine. They are used to supply 
proactive monitoring of end user experience.

Contained Location The Contained Location CIs are created as 
part of the Business Process Monitor 
hierarchy when working with the 
Transactions/locations option. They 
represent the locations from which the BP 
Steps monitoring Siebel are run.

BPM 
Transaction/Location

The BPM Transaction/Location CIs  
represent a BP Step/Location intersection (a 
specific transaction running at a specific 
location).

Host A Host CI  represents the physical machine 
on which a server is installed. This is not a 
Siebel-specific element.

Web Server The Web Server CI represents the Web server 
that forwards requests to the Siebel 
enterprise. 

Siebel We Server 
Extension

The Siebel Web Server Extension CI 
represents the Siebel Web Server Extension 
installed on the Web server.

Siebel Web 
Application

The Siebel Web Application CI  represents 
the application URL as it exists on the Siebel 
Web Server Extension.

Siebel Gateway The Siebel Gateway server is a coordinating 
server that routes requests to the correct 
component and provides enhanced 
scalability, load balancing, and high 
availability across the Siebel Enterprise.

CIT Icon Description
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Siebel Application 
Server

The Siebel Application Server CI represents a 
server running the business logic tier that 
supports both back-end and interactive 
processes for every Siebel client. 

Siebel Component 
Group

The Component Group CI represents an 
administrative grouping of components 
comprising an application running on the 
Siebel Application Server. 

Siebel Component The Component CI represents a process 
running on the Siebel Application Server, 
which encapsulates some Siebel application 
functionality. 

Database The Database CI  represents the database 
that is holding the data tier. This is not a 
Siebel-specific CI. 

CIT Icon Description
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SiteScope 
Measurement

The SiteScope Measurement CI is not a 
Siebel-specific CI. However, in the Siebel 
Enterprises view, it usually represents a 
metric of a Siebel monitor; for example, the 
Siebel Application Server monitor.

Note: If SiteScope measurements names are 
too long and are truncated in Dashboard, 
you can change the CIT default label to be 
RegExp(data_name, (.*[/].*[/].*[/])(.*),2) 
instead of just data_name. In such a case, 
only the beginning of the path and the last 
part of the measurement's name are 
displayed instead of the entire measurement 
name (including the path). If you change the 
CIT default label, you must also change all 
references in the code and in the TQL layout 
from display_label to data_name. 

Configuration File The Configuration File CIs represent the 
siebel.cfg configuration file that includes 
information from the application server 
installation or the parameters.cfg that 
includes the output of the list parameters for 
component command using srvrmgr.

CIT Icon Description
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Save the Generated XML Files After Generating the SARM 
Report

After the generation of the SARM report, the generated XML files are 
automatically deleted from the SiteScope and HP Business Availability 
Center.

To prevent the deletion and save the generated XML files after generating 
the SARM report, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Siebel, and locate the 
Siebel - Siebel SARM Breakdown area. Modify the following parameters:

➤ Remove SARM results temporary directory from BAC. If you give this 
parameter the value false, then the XML files are saved in the 
<HP Business Availability Center center server>\AppServer\webapps
\site.war\Imgs\chartTemp\offline directory.

➤ Remove SARM results temporary directory from SiteScope. If you give this 
parameter the value false, then the XML files are saved in the <SiteScope 
installation directory>\cache\tempbyage\
<TimeStamp>_SIEBEL_SARM\<web_server>_<App_server> directory.

Specify the Default SiteScope Monitors

Specify the default SiteScope monitors you want to work with.

To specify the default SiteScope monitors, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Siebel, and locate the Default SiteScopes for SARM diagnostics entry in the 
Siebel - Siebel SARM Breakdown table. Modify the value by entering one of 
the following:

➤ The SiteScope monitor names separated by semicolons (for example: 
rca3;rca4)

➤ ALL if you want to use all attached SiteScope monitors
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Specify the SiteScope Monitor Used to Execute Siebel 
Diagnostics Tools

Specify the default SiteScope agent/profile used to execute Siebel diagnostics 
tools when using the context menus options listed in the Go to Siebel 
Diagnostics context menu. For details, see “Go to Siebel Diagnostics” in 
Using Dashboard.

To specify the default SiteScope monitors, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Siebel, and locate the Default SiteScope for Diagnostic drilldown from the 
Dashboard entry in the Siebel - General Settings table. Enter the name of the 
default SiteScope that is being used from Dashboard to execute diagnostic 
tools.

Change the Default Timeout for the Execution of a 
SiteScope Monitor

If the Siebel.ejb.log, located on the Center server, indicates that an 
execution of a SiteScope monitor timed-out, change the default timeout for 
the execution of this monitor.

To change the default timeout for the execution of a SiteScope Monitor, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Verticals, and locate the SiteScope monitor 
timeout in seconds entry in the Vertical - SiteScope Remote Control Settings 
table. Modify the parameters’s value. The parameter indicates the default 
timeout for the execution of a SiteScope monitor. 
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Increase the Default Timeout for Either a SARM Task or a 
SARM Analyzer Execution

If the <SiteScope home directory>\tools\sarmDiagnostics\logSiteScope
\sarmanalyzer.log indicates that a SARM task or SARMAnalyzer execution 
has been timed-out, increase the default timeout for either a SARM task or a 
SARM analyzer execution.

To increase the default timeout for either a SARM task or a SARM analyzer 
execution, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Siebel, and locate the 
Siebel - Siebel SARM Breakdown table. Modify the following parameters:

➤ SARM task timeout in seconds. Indicates the default timeout for the 
execution of a SARM task (analyzing Web Server file, analyzing Application 
Server files, and so on).

➤ SarmAnalyzer command timeout in seconds. Indicates the default timeout 
for the execution of sarmanalyzer.exe (used to generate CSV or XML files).

Troubleshooting and Limitations

This section includes troubleshooting for the HP Business Availability 
Center for Siebel Applications.

This section includes the following topics:

➤ “Siebel Enterprises View Is Not Found” on page 212

➤ “SARM-Related Issues in Siebel” on page 212

➤ “Troubleshooting Errors in Logs” on page 221

➤ “Troubleshooting Siebel Enterprises View” on page 223

➤ “Troubleshooting Diagnostics Tools” on page 223

➤ “Troubleshooting SARM-Related Issues” on page 224

➤ “Troubleshooting Database Breakdown” on page 230

➤ “Troubleshooting Processes” on page 233

➤ “Troubleshooting Tasks” on page 233
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Siebel Enterprises View Is Not Found
If the “Siebel Enterprises” view is not found, the procedure of deploying the 
Siebel Monitoring package should be manually executed:

 1 In the browser on the Data Processing server, enter 
http://<HP Business Availability Center Data Processing 
server name>:8080/jmx-console/

Note: If HP Business Availability Center has a split installation, use the Data 
Processing Modeling server name instead of the Data Processing server 
name.

 2 Click service=Package manager listed under MAM.

 3 The JMX MBean View for Package manager opens. In the deployPackages 
area, specify:

➤ customerId. Enter the HP Business Availability Center customer ID 
(usually 1).

➤ packagesNames. Enter: Siebel_monitoring.zip.

 4 Click Invoke.

 5 To check that the package has been deployed, go to <HP Business 
Availability Center Data Processing server directory>\log\packaging.log, 
check that you have the following entry at the end of the log:
Finished installing package for <customer_ID>. 

SARM-Related Issues in Siebel
This section includes the following topics:

➤ “Large Log Files” on page 213

➤ “Siebel Application Response Monitoring (SARM)” on page 213
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Large Log Files

The Siebel logging mechanism for an application is sometimes configured in 
such way that all log data is written to a few large log files instead of creating 
a separate log file per task. Large log files are a problem because parsing takes 
a long time.

To solve the problem, two solutions are available:

➤ The Siebel administrator should configure the relevant parameters so that 
each task writes to a separate log data file. 

➤ The Siebel administrator should provide:

➤ A script to be used before running the diagnostic tools. That script should 
set the logging mechanism to log each task into a separate file. This is 
required when you want to use the Database Breakdown reports and may 
also be relevant when the Siebel Log Monitor is configured. Consult 
Siebel documentation for more detailed instructions.

➤ A script to be used after running the diagnostics tool. That script should 
switch the log level back to its initial state.

Siebel Application Response Monitoring (SARM)

This section describes how to improve Siebel configuration so SARM works 
properly and how to solve SARM-related issues in Siebel.

This section includes the following topics:

➤ “Enabling SARM for Siebel” on page 214

➤ “Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 218

➤ “Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 218

➤ “Tips” on page 219

➤ “SARM on the NT Platform” on page 219

➤ “SARM on the UNIX Platform” on page 219
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Enabling SARM for Siebel

You can control Siebel Application Response Monitoring (SARM) using 
Siebel server parameters and environment variables. To enable SARM, you 
must enable specific SARM parameters for the Web server using 
environment variables and for the Siebel Server using Server Manager or the 
Siebel Server Manager Graphical User Interface. When a component starts 
up in the Siebel Enterprise, it checks the status of the following SARM 
parameters:

➤ For Siebel 7.5.3:

Name of SARM 
Parameter in the Web 
Server

Name of SARM 
Parameter for 
Application Server

Description

SIEBEL_SarmEnabled SARMEnabled Indicates whether SARM is enabled or disabled 
for a Siebel Server Component. The default 
value is false. This parameter can be set at the 
Siebel Enterprise level, Siebel Application 
Server level, or Siebel Component level.

SIEBEL_SarmMaxMemory SARMMaxMemory The maximum size of the SARM memory. This 
parameter can be set at the Siebel Server or 
Siebel Server Component level. 

SIEBEL_SarmMaxFileSize SARMMaxFileSize The maximum size of a SARM file. SARM 
continues to append file segments to the 
current file until the maximum size is reached. 
When the limit is reached, SARM starts a new 
file. The default value is 20,000,000 (~20 MB) 
and is specified in bytes.
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➤ For Siebel 7.7 or 7.8:

You can enable SARM for the Web server only at the Web server level, and 
for the application server either at the Application Server level, or at the 
component level (see the procedures below for more details).

To enable SARM for Siebel at the Web server level:

 1 Update the values of the appropriate environment variables parameters 
listed in the table above.

 2 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 218 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 218.

 3 Restart the Siebel server for the new values to take effect.

Name of SARM 
Parameter in the Web 
Server

Name of SARM 
Parameter for 
Application 
Server

Description

SIEBEL_SARMBufferSize SARMBufferSize The size of the SARM buffer. The default value is 
5,000,000 bytes (~5MB). 

SIEBEL_SARMLevel SARMLevel The SARM granularity level. The default value is 0. 
This parameter can be set at the Siebel Server or 
Siebel Server Component level.

SIEBEL_SARMFileSize SARMFileSize The maximum size of a SARM data file. The default 
value is 15,000,000 bytes (~15MB).

SIEBEL_SARMMaxFiles SARMMaxFiles The maximum number of SARM files determines 
how many SARM files should be saved for a session. 
The recommended value is 5.

SIEBEL_SarmPeriod SARMPeriod The SARM period is the time when SARM outputs 
the stored data to the SARM log file regardless of the 
Buffer size. The default value is 3.
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Note: SARM is disabled by default. 

To enable SARM for Siebel at the Application level from the environment 
variables:

 1 Update the values of the appropriate environment variables parameters 
listed in the table above.

 2 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 218 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 218.

 3 Restart the Siebel server for the new values to take effect.

Note: 

➤ The Application Server Parameters can be updated from either the 
environment variables or from the Siebel Server user interface (follow the 
procedure below). If the parameters are defined both in the user interface 
and the environment variables, the environment variables override the 
user interface definitions. 

➤ SARM is disabled by default. 

To enable SARM for Siebel at the Application Server level from the Siebel 
Server user interface:

 1 In Siebel Server Manager Graphical User Interface, select Site Map > Server 
Administration > Servers > Server Parameters.

 2 In the Server Parameters List Applet, query for SARM.

 3 Update the values of the appropriate parameters listed in the table above.
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 4 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 218 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 218.

Note: 

➤ The Application Server Parameters can be updated from either the 
environment variables (follow the procedure above) or from the Siebel 
Server user interface (follow the procedure below). If the parameters are 
defined both in the user interface and the environment variables, the 
environment variables override the user interface definitions. 

➤ SARM is disabled by default. 

To enable SARM for Siebel at the component level:

 1 In Siebel Server Manager Graphical User Interface, select Site Map > Server 
Administration > Servers > Component Parameters.

 2 In the Component Parameters List Applet, query for SARM.

 3 Update the values of the appropriate parameters listed in the table above.

Note: SARM is disabled by default. 

 4 Check whether the settings for the SarmMaxMemory and SarmMaxFileSize 
parameters are appropriate since these parameters determine how soon 
SARM flushes its data to a disk, and how large the SARM files can be. For 
details on the recommendations for these parameters settings, see 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3” on page 218 or 
“Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8” on 
page 218.
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Calculating the SarmMaxFileSize Parameter for Siebel 7.5.3

This section describes the SarmMaxFileSize parameter settings 
recommended for working with SARM in Siebel 7.5.3.

The amount of data that is written per second can be calculated in the 
following way:
37kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/
<nbr_of_server_components_instances>

For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component of the application, the file size should be:
37*20*60/3 = 14,800 Kb. Therefore the SARM Data File Size Limit should be 
set to 15,000,000. The buffer size should be set to 4,000,000. The growth 
rates of the Web server data is 1/5 the growth of the Application Server data.

Calculating the SarmMaxFileSize Parameter for Siebel 7.7 or 7.8

This section describes the SarmMaxFileSize parameter settings 
recommended for working with SARM in Siebel 7.7 or 7.8.

The amount of data that is written per second in Siebel 7.7 or 7.8 depends 
on the granularity level and can be calculated in the following way:

➤ Level 1 (SIEBEL_SarmLevel=1). The calculation is as follows:
10kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/
<nbr_of_server_components_instances>

For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component, the file size should be: 10*20*60/3 = 
4,000 Kb. Therefore, the SARM Data File Size Limit should be set to: 
4,000,000.

➤ Level 2 (SIEBEL_SarmLevel=2). To store more data. The calculation is as 
follows:
60kb/min*<nbr_of_concurrent_users>*<required_time_frame_saved>/ 
<nbr_of_server_components_instances>
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For example, if your Siebel Enterprise has 20 concurrent users, you want to 
save the data of the last hour for all users, and you have three instances of 
the Object Manager component, the file size should be: 60*20*60/3 = 24,000 
Kb. Therefore, the SARM Data File Size Limit should be set to: 24,000,000.

Tips

 1 To save disk space, it is recommended to enable SARM only for Object 
Manager components since Siebel is only measuring the Object Managers 
time for the User Session trace.

 2 If you restart the Siebel Application Server or the Web server regularly it is 
recommended to search, in the log folder, for old SARM files that can be 
deleted. Every time you restart the server a new log file, which includes the 
Process ID, is created. Only five log files with the same Process ID are kept at 
a time (the older ones are overwritten). Files with other Process IDs must be 
deleted manually. This procedure saves disk space and also improves the 
efficiency of the User Session Breakdown. 

It is best if the number of SARM files saved in the SARM folders is minimal. 
Save only the files you want to retrieve data from. Other files can be moved 
to another folder (not to a sub-directory of the SARM folder) and can be 
used later. Too many SARM files in the SARM directories cause the SARM 
tool to work more slowly.

SARM on the NT Platform

When working with the SARM tool in Siebel 7.8, use SARM Analyzer for 
Siebel version 7.7.

SARM on the UNIX Platform

When working with the SARM tool on a UNIX platform, check that the 
following requirements are met:

➤ For Siebel 7.7 and 7.8

➤ When working with the SARM tool in Siebel 7.8, use SARM Analyzer for 
Siebel version 7.7.

➤ The SARM feature is supported only if SiteScope is installed on an NT 
platform.
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➤ A mount point must exist between SiteScope and the Siebel machine. 
The SiteScope user must have permission to read from the relevant 
directories (it means that the user has to be declared as a mounting point 
machine user and as a UNIX user).

➤ For Siebel 7.5.3

Note: The SARM user trace breakdown diagnostic tool is not recommended 
for use on Siebel 7.5.3 running on UNIX. It only works for full UNIX 
environments (in Siebel 7.7 you can work with mixed environments). This 
is a limitation from Siebel. For example, in Siebel 7.5.3, the SARMAnalyzer 
tool cannot work on files from different environments; therefore, if you use 
SARMAnalyzer for the Windows NT platform you must work only with the 
Windows NT environment.

➤ The SiteScope user has execution permissions for the server manager and 
the SARM Analyzer.

➤ A mount point must exist between the SiteScope machine and the Siebel 
machine.

➤ The SiteScope user must have permissions to read from the relevant 
directories on the Siebel machine.

➤ Make the following changes to the start-monitor and start-service scripts 
located in the <SiteScope>/classes directory: insert all the variables that 
are related to LD_LIBRARY_PATH from the siebenv.sh file (generally 
located in the siebsrvr directory), and set them to be accurate (insert all 
the definitions from the siebenv.sh file). This definition is needed to run 
srvrmgr and SARMAnalyzer on the SiteScope machine with mount. It is 
recommended to copy the srvrmgr and SARMAnalyzer directories to 
SiteScope for better performance.
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Troubleshooting Errors in Logs
Logs are available to help you debug problems with Siebel views and 
problems that occur when using the Siebel diagnostics tools. 

This section includes the following topics:

➤ “Errors that Occur when Building the Siebel Enterprises View” on page 221

➤ “Errors that Occur when Running One of the Diagnostics Tools” on 
page 222

Errors that Occur when Building the Siebel Enterprises View

The Siebel.ejb.log file (on the Modeling server) includes information about 
all the automatic links between the Business Process Monitor or SiteScope 
and the Siebel CIs whether these links worked correctly or not.

For details about the automatic links, see “Use a Business Process Profile to 
Simulate Siebel Users–Details” on page 181.

To debug the log:

 1 Open the
<HP Business Availability Center home 
directory>\conf\core\Tools\log4j\EJB\topaz.properties file

 2 In the line that follows, change ${loglevel} to debug. The lines should be as 
follows: 
log4j.category.com.mercury.topaz.vertical=debug, vertical.appender
log4j.category.com.mercury.am.bac.vertical.rules=debug, vertical.appender

 3 Open the error log, located on the Modeling server at the following 
location:
<HP Business Availability Center root directory>\log
\EJBContainer\Siebel.ejb.log

 4 Locate the #define appender for vertical module line.

 5 You can now analyze the log information.
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 6 After you complete the debugging tasks, make sure to change debug back to 
${loglevel} in the lines that follows #define appender for vertical module. 
The lines should be as follows:
log4j.category.com.mercury.topaz.vertical=${loglevel}, vertical.appender
log4j.category.com.mercury.am.bac.vertical.rules=${loglevel}, 
vertical.appender

Errors that Occur when Running One of the Diagnostics Tools

The Siebel.ejb.log file (on the Center server) includes detailed information 
about the operations that take place in the Siebel Diagnostics tools.

For details about the Siebel Diagnostics tools, see “HP Business Availability 
Center for Siebel Applications” on page 151.To debug the log:

 1 Open the <HP Business Availability Center home 
directory>\conf\core\Tools\log4j\EJB\topaz.properties file

 2 In the line that follows, change ${loglevel} to debug. The line should be as 
follows:
log4j.category.com.mercury.topaz.siebel=debug, siebel.appender

 3 Open the error log, located on the Center server at the following location:
<HP Business Availability Center root directory>\log
\EJBContainer\Siebel.ejb.log

 4 Locate the #define appender for siebel line.

 5 You can now analyze the log information.

 6 After you have completed the debugging tasks, make sure to change debug 
back to ${loglevel} in the line that follows #define appender for siebel. The 
line should be as follows:
log4j.category.com.mercury.topaz.siebel=${loglevel}, siebel.appender
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Troubleshooting Siebel Enterprises View
This section describes issues related to the Siebel Enterprises View and how 
to solve these problems.

This section includes the following topics:

➤ “Session Data Is Not Available” on page 223

➤ “Task Data Is Not Available” on page 223

Session Data Is Not Available

If, in the view, the Sessions KPI is empty, it might be because the No. of 
Running Sessions measurement is not monitored for an application 
server/component in the relevant Siebel Application Server monitor. 

Task Data Is Not Available

If, in the view, the Tasks in Error KPI is empty, it might be because the No. of 
Tasks in Error measurement is not monitored for an application 
server/component in the relevant Siebel Application Server monitor.

Troubleshooting Diagnostics Tools
This section describes issues related to the Diagnostics tools and how to 
solve these problems.

Matching Connection Parameters to SiteScope

When one of the diagnostics tools is activated, a temporary SiteScope 
monitor is created, run, and then erased. The connection parameters used 
are the ones that exist in the various relevant CIs (Enterprise, Application 
Server, and so on).

You must check that the connection parameters (user name, password, 
enterprise name, and gateway name) used in the CIs must conform to the 
parameters used in the permanent SiteScope monitors monitoring the Siebel 
Enterprise. (If the connection parameters do not match, then most 
diagnostics features do not work.) For example, the same user name and 
password needs to be utilized in the Siebel Enterprise configuration and in 
the permanent monitors defined in SiteScope.
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If a problem occurs, check the SiteScope error log (in SiteScope under the 
logs directory) and the Siebel log and check the list of parameters used to 
access SiteScope and Siebel. For details about the Siebel log, see “Errors that 
Occur when Running One of the Diagnostics Tools” on page 222. 

Troubleshooting SARM-Related Issues
This section describes issues related to Siebel Application Response 
Measurement (SARM) and how to solve these problems.

This section includes the following topics:

➤ “SARM Does Not Work” on page 224

➤ “SARM Data Does Not Generate Properly” on page 225

➤ “SARM Analyzer Crashes” on page 226

➤ “SARM Analyzer Fails to Run” on page 227

➤ “SARM Configuration Issues” on page 228

➤ “Sitescope Server Failed to Access a Siebel SARM Folder or File” on page 228

➤ “Operation Completed with Several Errors” on page 228

➤ “Timed-out Execution of a SARM Task or SARMAnalyzer Execution” on 
page 229

➤ “No Working Sitescope Server Could Be Found” on page 229

SARM Does Not Work

Ensure that all steps of the following checklist are followed.

 1 Check that the SARM Analyzer path that you defined for the Siebel 
Enterprise is accessible via SiteScope.

 2 Check that at least one Web Server, one Application Server, and one 
Gateway Server have been discovered during the discovery process.

 3 Check that the SARM log folder defined for the Web Server is accessible via 
SiteScope.

 4 Check that the SARM log folder defined for the Application Server is 
accessible via SiteScope.
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 5 Check that SiteScope is running with a user on the SiteScope machine:

➤ In the SiteScope machine, open Services.

➤ Right-click the SiteScope service to open its properties.

➤ Click the Log On tab.

➤ Check that This Account is checked.

➤ Check that the user name and password are correct.

 6 To run the SARM Analyzer tool, check that the directory 
<SiteScope_home_directory>\tools\sarmdiagnostics exists on the SiteScope 
server.

 7 Check that Siebel Server Manager properties are defined properly for the 
Siebel Enterprise, in IT universe (select Admin > Universal CMDB > Modeling 
> IT Universe Manager) in HP Business Availability Center (for more 
information, see “Matching Connection Parameters to SiteScope” on 
page 223).

 8 Check that SiteScope is attached.

 9 If you checked the entire list and SARM still does not work, check the 
following options:

➤ “SARM Data Does Not Generate Properly” on page 225

➤ “SARM Analyzer Crashes” on page 226

SARM Data Does Not Generate Properly

If the No Relevant Sessions error message is issued when you know that you 
should have data, SARM might not generate properly.

To identify the problem: 

 1 Open one the XML files located in the relevant SiteScope in the following 
directory: <SiteScope installation directory>\cache\tempbyage
\<TimeStamp>_SIEBEL_SARM\ <web_server>_<App_server>

Note: If there are no XML files in that directory follow the next procedure.
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 2 Select any of the last requests in the XML file:

➤ If the request does not include a <SiebsrvrDetails> section with a 
<Group> node under it, then Siebel is not generating the SARM data 
properly.

➤ If the request does include a <SiebsrvrDetails> section with a <Group> 
node under it, then follow the procedures below. For details, see below or 
“SARM Analyzer Fails to Run” on page 227.

To solve the problem:

 1 The generated XML files are being deleted from the SiteScope and 
HP Business Availability Center after the generation of the SARM report. To 
see them you should first select the appropriate settings to save these files 
and not delete them. For details, see “Save the Generated XML Files After 
Generating the SARM Report” on page 209.

 2 Delete all the SARM files from the Application Server and from the Web 
server. 

 3 If this does not help, restart the Siebel machine.

SARM Analyzer Crashes

If the No Relevant Sessions error message is issued when you know that you 
should have data, SARM Analyzer might have crashed because the requests 
counter was reset to 0 in the middle of the session without any logical 
reason. Another indication is that it takes at least five minutes for this error 
to appear, because the execution of the batch files in SiteScope times out.

To identify the problem: 

SARM Analyzer has crashed if any one of the following situations occurs:

➤ A message (No relevant sessions were found) is issued, indicating that there 
are no sessions when you know there should be sessions.

➤ This indication almost always occurs. The timestamp of the crash<nnn> file 
in the SARM Analyzer folder corresponds to the time when you ran the User 
Session Trace.

➤ This indication is rare. An error message is issued in the SiteScope machine.
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To solve the problem:

Connect to the Siebel Web server, and delete (locally) the last SARM binary 
file from the Web server log folder. 

If this does not help and the problem occurs again, restart the Siebel 
machine. 

SARM Analyzer Fails to Run

When you run the SARM Analyzer from a remote machine (not locally on 
the SiteScope machine), the SARM Analyzer fails to run.

To identify the problem: 

SARM Analyzer failed to run if any one of the following situations occurs:

➤ A message (No relevant sessions were found) is issued, indicating that there 
are no sessions when you know there should be sessions.

➤ One of the following errors was added to the SiteScope sarmAnalyzer.log log 
in <SiteScope installation directory> 
\Tools\sarmDiagnostics\log\sarmAnalyzer.log during the execution of the 
SARM diagnostics:

➤ Failed to analyze app server SARM files

➤ SarmAnalyzer failed

➤ Error running command: <command_name>

Note: The problem occurs because of a different domain or because of 
permissions issues.

To solve the problem: 

Check that SiteScope can communicate with the Siebel server.
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SARM Configuration Issues

SARM configuration is not correct, if SARM is configured to store data for 
long time period (several days) or processing takes too long.

To solve the problem: 

Configure SARM correctly.

Sitescope Server Failed to Access a Siebel SARM Folder or File

After running SARM Diagnostics, the error message A Sitescope server failed 
to access a Siebel SARM folder or file. Make sure all SiteScope servers have 
the proper permissions. is displayed.

This usually happens because the user name used to log to the SiteScope 
Service does not have the appropriate permissions to access the SARM folder 
on the Web or application server.

To solve the problem:

 1 Go through steps 3 to 8 of the SARM Does Not Work procedure above. For 
details, see “SARM Does Not Work” on page 224.

 2 Log in to one of the SiteScope machines with the SiteScope username and 
password, and try to access the SARM folders defined in HP Business 
Availability Center. 

Operation Completed with Several Errors

After running SARM Diagnostics, the error message The operation 
completed with several errors. Please check the logs for more information. 
is displayed.

This error can be caused by a number of reasons, including unexpected 
SARMAnalyzer output, network issues, or Server manager errors. 
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To check the errors that occurred, go through the following log files and 
search for error messages logged around the time you invoked User Session 
Breakdown:

➤ On the HP Business Availability Center Gateway server: 
<HP Business Availability Center home directory>
/log/EJBContainer/siebel.ejb.log

➤ On the SiteScope machine: 
<SiteScope home directory>/tools/sarmDiagnostics/log/sarmAnalyzer.log

Timed-out Execution of a SARM Task or SARMAnalyzer 
Execution

If the sarmAnalyzer.log (SiteScope) indicates that a SARM task or 
SARMAnalyzer execution has been timed-out, increase the default timeout 
for either a SARM task or a SARM analyzer execution. For details, see 
“Increase the Default Timeout for Either a SARM Task or a SARM Analyzer 
Execution” on page 211.

If the Siebel.ejb.log (on the Gateway Server) indicates that an execution of a 
SiteScope monitor got timed-out, change the default timeout for the 
execution of this monitor. For details, see “Increase the Default Timeout for 
Either a SARM Task or a SARM Analyzer Execution” on page 211.

No Working Sitescope Server Could Be Found

If the message No working SiteScope server could be found to process 
SARM data. is issued when running SARM Diagnostics, proceed as explained 
in this section.

To solve the problem:

 1 Open the Advanced Options section of the User Trace Breakdown page in 
HP Business Availability Center. For details, see “SARM - User Trace 
Breakdown - Analysis Report” on page 244.

 2 Verify that the SiteScope servers that are selected in Using SiteScope: list are 
the servers you want to use for SARM diagnostics.

 3 Go through steps 5- 8 (of the SARM Does Not Work section) for these 
servers. For details, see “SARM Does Not Work” on page 224.

 4 If this does not help, restart the SiteScope servers.
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Troubleshooting Database Breakdown
This section describes how to solve Database Breakdown-related issues.

This section includes the following topics:

➤ “Problem When Looking for a Task Using the Siebel Database Breakdown 
Tool” on page 230

➤ “Only the Total Database Time Chart and Not the 15 SQLs Chart Is 
Displayed” on page 231

➤ “Error: Cannot Raise Log Level” on page 231

➤ “Error: Could Not Retrieve Log File” on page 231

➤ “Error: Could Not Run BPM Transaction” on page 232

➤ “Limitation: The Siebel Log Monitor Does not Work on a UNIX Platform” 
on page 232

➤ “Error: Database Breakdown Analysis Data for the Transaction Cannot Be 
Displayed” on page 232

Problem When Looking for a Task Using the Siebel Database 
Breakdown Tool

If the Siebel Enterprise uses a gateway with an additional SSL that supplies 
dynamic IDs for every user session, searching for the proper tasks using the 
Siebel Database Breakdown tool may be problematic. 

To solve the problem:

A possible solution is to find the correlation in the VuGen script and to 
update the Siebel Application’s user in the Siebel Application Configuration. 

To do so, select Admin > Universal CMDB, select the Siebel Enterprises view, 
select the appropriate Siebel Application CI in View Explorer, and select the 
Properties tab. In the Other Properties area, enter the appropriate user name 
in the Emulated Transaction User Name box, and click OK. 
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Note: It is recommended to use a script with no more than five transactions 
when using the Database Breakdown diagnostics. 

Only the Total Database Time Chart and Not the 15 SQLs Chart 
Is Displayed

When the Siebel Database SQL Breakdown pie chart displays only the total 
database time chart and not the 15 SQLs chart, then there were no 
significant SQL queries to display. The chart displays only the 15 SQL 
queries that were the most time consuming. If all SQLs were under 1% of the 
total execution time of the transaction, then this information is not 
displayed. For details, see “Siebel Database Breakdown Analysis Report” on 
page 259.

Error: Cannot Raise Log Level

The error message: Cannot raise log level is issued in one of the following 
situations:

➤ A server manager has not been copied to the SiteScope server. For details, see 
“Copy the srvrmgr Tool and the SARM Analyzer Tool to the SiteScope 
Server–Details” on page 178.

➤ You did not configure the correct parameters for the Siebel Enterprise CI. For 
details, see “Matching Connection Parameters to SiteScope” on page 223.

➤ There is no license for Siebel in the SiteScope. For details, see “Check the 
Siebel Licence in SiteScope” on page 168. 

Error: Could Not Retrieve Log File

When the error message: Could not retrieve log file is issued, check that the 
log folder of the server where the Siebel application is located, is shared and 
that there is access to it from SiteScope, so the user can open the shared 
folder from the SiteScope and copy files from it. Check also that all the 
relevant Siebel servers have a remote definition on the SiteScope. For details, 
see “Windows Remote Preferences Overview” in Using System Availability 
Management.
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Error: Could Not Run BPM Transaction

The error message: Could not run BPM transaction occurs in one of the 
following situations:

➤ The Business Process Monitor server is down

➤ The connection from HP Business Availability Center to the Business Process 
Monitor is problematic

➤ There is a problem with the Business Process Monitor script

Access the Business Process Monitor and run the transaction manually to 
check if there is a problem with the Business Process Monitor.

Limitation: The Siebel Log Monitor Does not Work on a UNIX 
Platform

The SiteScope Siebel Log monitor does not work when logs are located on a 
UNIX platform.

Error: Database Breakdown Analysis Data for the Transaction 
Cannot Be Displayed

The error message: Database breakdown analysis data for the transaction 
cannot be displayed. This might be because the analysis filters currently set 
for the transaction exclude the existing data. is displayed when the time 
zone and time definitions of the SiteScope server or Business Process 
Monitor server used for the Database Breakdown tool are not synchronized 
with the Siebel server time zone and time definition.

A workaround is to synchronize the time zone and time definition of the 
servers and if they are synchronized, to rerun the Database Breakdown tool.
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Troubleshooting Processes
This section describes how to solve processes-related issues.

Processes Tool Does Not Function Or Files Do Not Get Through 
SiteScope

➤ Check that the SiteScope user has permission to log to the Siebel machines. 

➤ If another user is currently running SiteScope or ran SiteScope when the 
SiteScope server had not been booted, restart the SiteScope machine and the 
SiteScope service.

➤ Check that all Siebel servers are defined as remote servers on the SiteScope 
server.

Troubleshooting Tasks
This section describes how to solve task-related issues.

No. of tasks in error Counter

The No. of tasks in error counter reports all the tasks that have exited with 
error in the last hour.

In the advanced options of the SiteScope monitor, if you configure the 
Siebel Tasks Time Window parameter to 0, the No. of tasks in error counter 
displays all the tasks regardless of their start time.
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6
HP Business Availability for Siebel 
Applications User Interface

This chapter describes the pages and dialog boxes that are part of the 
HP Business Availability for Siebel Applications user interface, listed 
alphabetically.

This chapter describes: On page:

Processes Report 236

Processes Tool - Advanced Filter Dialog Box 238

SARM - User Trace Breakdown (Run the Diagnostics Tool) Page 239

SARM - User Trace Breakdown Dialog Box 242

SARM - User Trace Breakdown - Analysis Report 244

Siebel Database Breakdown Configuration Report 257

Siebel Database Breakdown Analysis Report 259

Tasks Diagnostics Tool Report 262

Tasks Diagnostics Tool - Advanced Filter Dialog Box 264
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Processes Report

Description Enables you to view details of the Siebel Application 
Server processes, for each monitored Siebel Enterprise. 

To Access: Applications > Business Availability Center 
for Siebel > Processes 

You can also access this page filtered for a selected CI, 
when you right-click the CI in Dashboard and select 
the Show Processes option. For details, see “Go to 
Siebel Diagnostics” in Using Dashboard.

Important 
Information

➤ To sort the processes by a specific column, click the 
column heading.

➤ To move between pages, use the First, Previous, 
Next, and Last arrows  above the 
table.

Included in Tasks “View Configuration File CI–Details” on page 199
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The report includes the following elements (listed alphabetically):

GUI Element Description

Advanced Options If necessary, click to open the Process Diagnostics Tool 
- Advanced Filter page. For details, see “Processes Tool - 
Advanced Filter Dialog Box” on page 238.

Apply Click to display the process diagnostic information. 
The process information you requested is retrieved 
from the Siebel Application Servers and displayed on 
the Tasks Diagnostic Tool page.

Component The name of the component. If the process does not 
have a task attached, then the Component column is 
empty.

Component Group Select the name of the component groups. Select All 
component groups if you want to display the process 
diagnostics for all of the component groups.

Component Group The name of the component group. If the process does 
not have a task attached, then the Component Group 
column is empty.

CPU (%) The percentage of the host machine CPU that the 
relevant process instance is currently using.

Enterprises Select the name of the Siebel Enterprise.

Memory (KB) The amount of memory (in KB) that the relevant 
process instance is currently using.

Process ID The process identifier.

Process Type The name of the operating system process that deals 
with the Siebel process.

Server Select the name of the application server. Select All 
servers if you want to display the process diagnostics 
for all of the application servers.

Server The name of the server on which the process runs.
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Processes Tool - Advanced Filter Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Use the advanced filter to filter the list of processes you 
want to display.

To Access: In the Process Diagnostics Tool page, click 
the Advanced Filter link to open the Process 
Diagnostics Tool - Advanced Filter page. 

GUI Element Description

Process Id Enter the process ID.

Process Type Select the type of process. Select All process types if you 
want to display the process diagnostics for all of the 
process types.

Siebel Components Select the Siebel component. Select All components if 
you want to display the process diagnostics for all of 
the Siebel components.

Using SiteScope Select the SiteScope machine you want to use to 
retrieve process information.
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SARM - User Trace Breakdown (Run the Diagnostics Tool) 
Page

Description HP Business Availability for Siebel Applications 
SARM Diagnostics is a user trace breakdown diagnostic 
tool that processes the data in the User Session Trace 
output files produced by Siebel’s SARM process. This 
data can be retrieved for a specific user in a specific 
time frame. It can also be retrieved for a specific 
transaction of a prerecorded script. 

You can then:

➤ Invoke a specific Business Process Monitor script. 
For details, see “Invoke Business Process Monitor 
Script” on page 241.

➤ Specify where the files can be found:

➤ Automatically collected Web and application 
server logs. 

➤ The SARM logs of a specific application server and 
Web server. 

➤ An already generated user session trace XML file 
for a Siebel Enterprise, a user, and a specific time 
frame. 

To Access: Select Applications > Business Availability 
Center for Siebel > SARM - User Trace Breakdown to 
open the SARM - User Trace Breakdown Diagnostic 
Tool page. 

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Siebel SARM 
option. For details, see “Dashboard Menu Options” in 
Using Dashboard.

Important 
Information

HP Business Availability Center does not support 
SiteScope 8.7 and earlier. 

Included in Tasks “View Configuration File CI–Details”
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The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Advanced Options You can run the SARM - User Trace Breakdown 
diagnostic tool on:

➤ automatically collected Web and application server 
logs.

➤ the SARM logs of a specific application server and 
Web server. 

➤ an already generated user session trace XML file for a 
site, a user, and a specific time frame. HP Business 
Availability Center searches all of the SARM files at 
the Siebel Enterprise, looks for the sessions of the 
specified user, fetches the appropriate files, runs the 
SARM analyzer, and lists all of the sessions used by 
the user that were active within the time frame. 

Enterprises Select the Siebel Enterprise for which you want to view 
SARM User Trace Breakdown data.

From ... To Click the linked date in From or To to open a calendar 
and select a new date and time if you want to change 
the default date and time.

Invoke Business 
Process Monitor 
Script area

You can view data about a Business Process Monitor 
transaction of a specific script running in the Web 
server(s) and application server(s) at a specific Siebel 
Enterprise, and in a specified period of time. 
HP Business Availability Center invokes the Business 
Process Monitor transaction, and then analyzes the 
relevant session. See below for details.

User Enter the name of the user whose activity you want to 
trace.
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Invoke Business Process Monitor Script

The area includes the following elements (listed alphabetically):

Advanced Options Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Application Select the application.

Host Select the location of the Business Process Monitor 
running the script.

Invoke Script Click to invoke the script transaction.

Script Select the script.

GUI Element Description

Automatically collect 
files

Select to run SARM - User Trace Breakdown diagnostics 
on all Web and application servers at the Siebel 
Enterprise. Then select the SiteScope(s) used to collect 
the data in the Using SiteScope list. This is the default.

Run Click to run the diagnostics tool. The resulting 
information is displayed in the SARM - User Trace 
Breakdown - Analysis screen. For details, see “SARM - 
User Trace Breakdown - Analysis Report” on page 244

Specify a User 
Session Trace File

Select Specify a User Session Trace File to work on an 
already generated user session trace XML file. 

In the User Session Trace File box, enter the path to the 
trace file. The path is relative to the SiteScope machine.

Then select the SiteScope(s) used to collect the data in 
the Using SiteScope list.
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SARM - User Trace Breakdown Dialog Box

Specify the SARM 
logs folders 

Select Specify the SARM logs folders to run SARM - 
User Trace Breakdown diagnostics only on the specified 
Web and application servers for the Siebel Enterprise:

➤ In the Application Servers box, enter the path to the 
SARM logs of the application server(s).

➤ In the Web Servers box, enter the path to the SARM 
logs of the Web server(s).

The paths are relative to the SiteScope machine.

Then select the SiteScope(s) used to collect the data in 
the Using SiteScope list. This is the default.

Using SiteScope Enter the SiteScope(s) used to collect the data.

Description When you run the SARM - User Trace Breakdown 
diagnostic tool, the SARM - User Trace Breakdown page 
indicates the status of each step in the procedure.

Important 
Information

After the process is complete, the page closes and the 
diagnostic results are displayed on the SARM - User 
Trace Breakdown - Analysis page. For details, see 
“SARM - User Trace Breakdown - Analysis Report” on 
page 244.

GUI Element Description
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The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Analyze Results and 
Prepare Charts

When the status indicator shows running stripes, the 
final results are being analyzed and charts are prepared. 
When the status indicator is complete, the loading has 
completed.

Check SiteScopes 
connectivity

When the status indicator shows running stripes, the 
SiteScopes connectivity is being checked. When the 
status indicator is complete, the operation has 
completed.

Extract Application 
Servers’ session data

When the status indicator shows running stripes, the 
application server session data is being extracted. 
When the status indicator is complete, the extraction 
has completed.

Load Web Servers’ 
session data

When the status indicator shows running stripes, the 
Web server session data is being loaded. When the 
status indicator is complete, the loading has 
completed.

Processing The progress in the current step.

Total Progress Indicates the total progress of the SARM - User Trace 
Breakdown diagnostic tool.
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SARM - User Trace Breakdown - Analysis Report
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Summary Tab

Description Enables you to view:

➤ Summary tab. A chart that displays the 
segmentation between the average Application 
Server time, Web Server time, Network time, and 
Database time for all of the relevant requests that 
were found in the files. For details, see “Summary 
Tab” on page 245.

➤ Sessions tab. The time distribution of the various 
sessions. For details, see “Sessions Tab” on page 247.

➤ Transaction tab. For each Business Process Monitor 
transaction, the timestamp of the session it belongs 
to, the session id, the application server name, the 
average total time of all requests that belong to that 
transaction, the number of request and the maximal 
request time. For details, see “Transactions Tab” on 
page 248.

➤ Application Server tab. A comparison between 
application servers in terms of times' distribution. 
For details, see “Application Servers” on page 250.

➤ Requests tab. For each request, the request detailed 
information. For details, see “Requests Tab” on 
page 251.

To Access: Running the user trace breakdown 
diagnostic tool. For details, see “SARM - User Trace 
Breakdown (Run the Diagnostics Tool) Page” on 
page 239.

Included in Tasks “View Configuration File CI–Details”

Description Enables you to view a chart that displays the 
segmentation between the average Application Server 
time, Web Server time, Network time, and Database 
time for all of the relevant requests that were found in 
the files.  
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The tab includes the following elements (listed alphabetically):

GUI Element Description

<drill down> Drilling down one of the segments in the chart 
provides a pie chart that displays the segmentation 
between the sub areas of that segment. If there is 
another level of specification (available in Siebel 7.7), 
you can then drill down to the sub area level.

You can then click segments of the Area Breakdown 
chart to open the corresponding Sub Area Breakdown 
chart (if it exists). For details, see below.

<pie chart> The chart displays the segmentation between the 
average Application Server time, Web Server time, 
Network time, and Database time for all of the relevant 
requests that were found in the files.
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The breakdown is as follows:

Sessions Tab

The tab includes the following elements (listed alphabetically):

Layer Breakdown Area Breakdown Sub Area Breakdown

Web Server N/A N/A

Application Server Application Manager Request Receipt (sessID SeqID)

Object Manager Session Re-Login

Communications Server 
Services

Communications Client 
Invoke Method 

Communications Server 
Invoke Method

Build Web Page Build View Layout

Show Applet, Build View Data

Build Applet

Get View Layout

Database Database Connector N/A

Network N/A N/A

Description Enables you to view the time distribution of the 
various sessions. 

GUI Element Description

Application Server The name of the application server on which the 
session is running.

Avg. Request Time 
(sec)

The average time the request spent in the session.

Date The timestamp of the session.
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Transactions Tab

Layer Breakdown The breakdown of the layer into its areas relative to the 
time spent by the session in each area: Web Server, 
Application Server, Database, and Network. Tooltips 
display the average time the session spent in each area.

Max Request Time 
(sec)

The maximum time spent by a request in the session. 
Scroll to the right to see the rest of the information.

No. of Requests The number of requests that ran in the session.

Session Id The ID of the session. You can drill the session ID to 
display information about the session requests. For 
details, see “Requests Tab” on page 251.

Summary You can select one or more sessions and click Summary 
to display a summary chart for the sessions you 
selected. For details, see “Summary Tab” on page 245.

Task ID The ID of the task the request belongs to.

Web Server The name of the Web server on which the session is 
running.

Description Enables you to view, for each Business Process Monitor 
transaction, the timestamp of the session it belongs to, 
the session id, the application server name, the average 
total time of all requests that belong to that 
transaction, the number of request and the maximal 
request time. 

GUI Element Description
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The tab includes the following elements (listed alphabetically):

GUI Element Description

<drill down a 
transaction>

Displays all of the requests that belong to that 
transaction. For details, see “Requests Tab” on 
page 251.

<tooltip> Click any part of the chart to get the tooltip that 
indicates the time the transaction spent in the layer, 
area, or sub area.

Application Server The name of the application server on which the 
transaction ran.

BPM Time This column displays the time the invoked transaction 
ran in Business Process Monitor (only when the 
transaction is invoked using Invoke Business Process 
Monitor Script). This value is larger than the value in 
the Total Time column as it includes client time, 
network time, and so on.

Note: The BPM Time is displayed only when the SARM 
User Session Trace breakdown diagnostics has been run 
after invoking a BPM script monitoring the Siebel 
Application. Some additional tuning of Siebel 
Application\Web Server environment variables is 
required. This is due to the fact that the flush ratio of 
SARM files is approximately five times slower in the 
Web Server than in the Application Server, and 
therefore running SARM with the default value of 
SARM_MaxFileSize variable might not be enough for 
the SARM User Trace Breakdown diagnostic tool to 
return data. For details, see “SARM-Related Issues in 
Siebel” on page 212.

Date The date when the transaction ran.

Layer Breakdown The breakdown of the layer into its areas relative to the 
time spend by the transaction in each area: Web Server, 
Application Server, Database, and Network. Tooltips 
display the average time the transaction spent in each 
area.
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Application Servers

The tab includes the following elements (listed alphabetically):

Max. Request Time The maximum time spent by any of the requests in the 
transaction.

No. of Requests The number of transaction requests that ran in this 
application server.

Session ID The ID of the session.

Task ID The ID of the task the transaction belongs to.

Total Time The total time the transaction ran in Siebel.

Transaction Name The name of the transaction.

Web Server The name of the Web server on which the transaction 
ran.

Description Enables you to view a comparison between application 
servers in terms of times' distribution. 

GUI Element Description

<drill down an 
application server>

Displays all of the requests that were executed on that 
application server. For details, see “Requests Tab” on 
page 251.

Application Server. The name of the application server. You can drill the 
session ID to display information about the application 
server. For details, see “Requests Tab” on page 251.

Avg. Request Time The average time spent by a request executing in this 
application server.

Layer Breakdown The time consumption breakdown by layers into its 
areas relative to the time spent by the request in each 
area: Web Server, Application Server, Database, and 
Network. Tooltips display the average time the request 
spent in each area.

GUI Element Description
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Requests Tab

Max. Request Time The maximum time a request spent in this application 
server.

No. of Requests The number of requests that ran in this application 
server.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 245.

Description Enables you to view, for each request, the request 
detailed information.

GUI Element Description
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The tab includes the following elements (listed alphabetically):

GUI Element Description

Application Server The name of the application server on which the task 
ran.

BPM Time Displays the time the invoked request ran in Business 
Process Monitor (only when the request is invoked 
using Invoke Business Process Monitor Script). This 
value is larger than the value in the Total Time column 
as it includes client time, network time, and so on. 

Note: The BPM Time is displayed only when the SARM 
User Session Trace breakdown diagnostics has been run 
after invoking a BPM script monitoring the Siebel 
Application. Some additional tuning of Siebel 
Application\Web Server environment variables is 
required. This is due to the fact that the flush ratio of 
SARM files is approximately five times slower in the 
Web Server than in the Application Server, and 
therefore running SARM with the default value of 
SARM_MaxFileSize variable might not be enough for 
the SARM User Trace Breakdown diagnostic tool to 
return data. For details, see “SARM-Related Issues 
in Siebel” on page 212.

Date The date when the request ran.

Layer Breakdown The time consumption breakdown by layers into its 
areas relative to the time the request spent in each area: 
Web Server, Application Server, Database, and Network. 
Tooltips display the average time the request spent in 
each area.

Request ID The ID of the request. 

You can drill the request ID to display information 
about the area where the request ran. For details, see 
“Area Details Area” on page 253.

Session ID The ID of the session on which the request ran. Scroll 
to the right to see the rest of the information.
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Area Details Area

The area includes the following elements (listed alphabetically):

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 245.

Task ID The ID of the task the request belongs to.

Total Time  The total time spent to execute a request.

Transaction Name  The name of the transaction the request belongs to.

Web Server The name of the Web server on which the task ran.

GUI Element Description

Area Name The name of the area where the request ran. You can 
drill the area name to display information about its sub 
areas. For details, see “Sub Area Details Area” on 
page 254.

Avg. Execution Time The average time spent by the request executing in the 
area.

Exclusive Memory 
Max Allocated Sub 
Area

The amount of memory used by requests that entered 
only this area.

Max Execution Time The maximum time spent by the request executing in 
the area.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

No. of Sub Areas The number of sub areas in the area.

GUI Element Description
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Sub Area Details Area

The area includes the following elements (listed alphabetically):

Non-Recursive 
Invocations

The number of times requests were invoked (non-
recursive invocation) in the area.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the area.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 245.

Total Execution Time The total time spent by the request executing in the 
area.

GUI Element Description

Area Name The name of the area where the sub area is located.

Avg. Execution Time The average time spent by the request executing in the 
sub area.

Exclusive Memory 
Max Allocated 
Instance

The amount of memory used by requests that entered 
only this sub area.

Max Execution Time The maximum time spent by the request executing in 
the sub area.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

No. of Instances The number of instances of the request.

GUI Element Description
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Instance Details Area

The area includes the following elements (listed alphabetically):

Non-Recursive 
Invocations

The number of times requests were invoked (non-
recursive invocation) in the sub area. Scroll to the right 
to see the rest of the information.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the sub area.

Sub Area Name The name of the sub area where the request ran. You 
can drill the sub area name to display information 
about the session requests. For details, see “Instance 
Details Area” on page 255.

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 245.

Total Execution Time The total time spent by the request executing in the 
sub area.

GUI Element Description

Area Name The name of the area where the request ran. 

Avg. Execution Time The average time spent by the request executing in the 
instance.

Instance Name The name of the instance where the request ran.

Max Execution Time The maximum time spent by the request executing in 
the instance.

Max Response Time 
SARM node App 
String 1

The name of the method invoked or workflow process 
involved.

Max Response Time 
SARM node App 
String 2

The name of the method invoked or workflow process 
involved.

GUI Element Description
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Non-Recursive 
Invocations

The number of times requests were invoked (non-
recursive invocation) in the instance.=Scroll to the 
right to see the rest of the information.

Recursive Invocations The number of times requests were invoked by other 
requests (recursive invocation) in the instance.

Sub Area Name The name of the sub area where the request ran. 

Summary Select one or more application servers and click 
Summary to display a summary chart for the 
application servers you selected. For more details on 
the summary chart, see “Summary Tab” on page 245.

Total Execution Time The total time spent by the request executing in the 
instance.

GUI Element Description
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Siebel Database Breakdown Configuration Report

Selection Area

The area includes the following elements (listed alphabetically):

Description Enables you to run the Database Breakdown tool.

To Access: Select Applications > Business Availability 
Center for Siebel > Database Breakdown to open the 
Siebel Database Breakdown Configuration page.

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Siebel 
Database Breakdown option. For details, see 
“Dashboard Menu Options” in Using Dashboard.

Included in Tasks “View Configuration File CI–Details” on page 199

GUI Element Description

Select an application In the list, select the Siebel application for which you 
want to analyze data.
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Available Transactions Area

The area includes the following elements (listed alphabetically):

Advanced Options Area

The area includes the following elements (listed alphabetically):

Select an enterprise In the list, select the Siebel Enterprise.

User Name The value in the User Name box appears automatically 
when you select the application. The appropriate user 
name has been entered manually by your 
administrator after discovery has taken place and the 
monitoring script was recorded, but you can override 
it. For details, see “Deploy the SiteScope Siebel 
Monitors–Details” on page 187.

Description Lists the transactions when you select a Siebel 
Enterprise and an application in the top part of the 
page. Click the Business Process Monitor transaction 
whose activity you want to analyze. (Note that the list 
of transactions includes only those for which you have 
permissions.)

Important 
Information

For diagnostic purposes it is recommended to use a 
script running a dedicated user. This enables you to 
make sure diagnosis results refer to the Business Process 
Monitor transaction intended to be analyzed.

GUI Element Description

Analyze Click to display the Siebel Tier Breakdown and Siebel 
Database SQL Breakdown pie charts. For details, see 
“Siebel Database Breakdown Analysis Report” on 
page 259.

Select a server Select a Siebel Application Server in the list. You can 
also leave All servers selected.

GUI Element Description
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Siebel Database Breakdown Analysis Report

An example of the report:

Select a Siebel 
component

Select a Siebel component in the list. Only the log level 
for that component is brought up. 

Using SiteScope Select the SiteScope machine you want to use to 
monitor the Siebel component in the list.

GUI Element Description
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An example of the detail of one segment of the pie chart:

Description Analyze the Siebel database logs that you have created 
to determine which of the component SQL operations, 
or parts of operations, were responsible for slow 
database response time.

To Access: Click Analyze on the Siebel Database 
Breakdown: Configuration (Advanced Option) 
page.

Included in Tasks “View Configuration File CI–Details” on page 199
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The page includes the following elements (listed alphabetically):

GUI Element Description

Siebel Database SQL 
Breakdown Pie Chart

Displays a breakdown of up to 15 of the most time-
consuming SQLs.

Siebel Tier 
Breakdown Pie Chart

Shows the transaction’s database time relative to its 
application time.

Specific SQL 
Breakdown Pie Chart

Click, in the Siebel Database SQL Breakdown pie chart, 
a section representing the required SQL, to view the 
database-specific time distribution of that specific SQL. 
For each SQL operation, you can view the various 
database times: preparation time, execution time, 
initial fetch time, total time, and write time (time 
stamp). This enables you to isolate the exact segment 
responsible for the delay in the database response time. 
Underneath the Specific SQL Breakdown pie chart, you 
can view the corresponding SQL statement.
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Tasks Diagnostics Tool Report

Description Enables you to view details of Siebel Application Server 
tasks.

To Access: Select Applications > Business Availability 
Center for Siebel > Tasks to open the Task Diagnostics 
Tool page.

You can also access this page filtered for the selected CI, 
when you right-click the CI and select the Show Tasks 
in Error or Show Running Tasks option. For details, see 
“Dashboard Menu Options” in Using Dashboard.

Important 
Information

➤ To sort the tasks by a specific column, click the 
column heading.

➤ To move between pages, use the arrows 
 above the table.

Included in Tasks “View Configuration File CI–Details” on page 199
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The report includes the following elements (listed alphabetically):

GUI Element Description

Advanced Filter If necessary, click the link to filter the list of tasks. For 
details, see “View Configuration File CI–Details” on 
page 199.

Apply When you click the button, the task information you 
requested is retrieved from the Siebel Application 
Server(s) and displayed on the Tasks Diagnostic Tool 
page.

CC_ALIAS The name of the component the task belongs to.

CC_INCARN_NO The number of times the task was restarted.

CC_RUNMODE The mode used to execute the task: Interactive or 
Batch.

CG_ALIAS The name of the component group the task belongs to.

Enterprise Select the Siebel site/enterprise for which you want to 
view task data.

Status Select the specific status—Running, Paused, Stopping, 
Completed, Exited with Error, or Killed. Alternatively, 
you can select to view tasks of all statuses.

SV_NAME The name of the server on which the task is running.

TK_DISP_RUNSTATE The state of the task: Running, Paused, Stopping, 
Completed, Exited with Error, or Killed. 

TK_END_TIME The time when the task stopped executing.

TK_IDLE For future use.

TK_LABEL The name of the user who is running the tasks. Note 
that some tasks (such as the ones belonging to the 
system component group) do not have a user.

TK_PARENT_T The task that caused this task to execute.
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Tasks Diagnostics Tool - Advanced Filter Dialog Box

The dialog box includes the following elements (listed alphabetically):

TK_PID The operating system process ID that deals with the 
task. One process can deal with more than one task. 
This column displays data only for tasks whose 
TK_DISP_RUNSTATE is running.

TK_PING_TIM For future use.

TK_START_TIME The time when the task started to execute.

TK_STATUS A description of the task—added by the task. If 
TK_DISP_RUNSTATE is Exited with Error, TK_STATUS 
displays the error message.

TK_TASKID The ID of the task.

TK_TASKTYPE The urgency of the task.

User If you want to focus on the tasks of a specific user, fill 
in the user name in the User box.

Description Use the advanced filter to filter the list of tasks you 
want to display.

To Access: In the Task Diagnostics Tool page, click the 
Advanced Filter link to open the Tasks Diagnostics Tool 
Advanced Filter page.

GUI Element Description

Component Select the specific component for which you want to 
view task data.

Component group Select the specific component group for which you 
want to view task data.

GUI Element Description
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Server Select the specific server whose task data you want to 
view.

Using SiteScope Select the SiteScope machine you want to use to 
retrieve task data from the Siebel Application Server, if 
you do not want HP Business Availability for Siebel 
Applications to use the default SiteScope machine.

GUI Element Description
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7
HP Business Availability Center APIs

The following APIs are included with HP Business Availability Center:

➤ Generic Reporting Engine API. Enables extraction of data from the Business 
Availability Center database for use with third-party or custom tools. For 
details, see “Working with the Generic Reporting Engine API” on page 271.

➤ CMDB API. Enables writing configuration item definitions and topological 
relations to the CMDB (Configuration Management Database), and 
querying the information with TQL and ad hoc queries. For details, see 
“Working with the HP Universal CMDB API” on page 295.

➤ Dashboard API. Enables retrieving information about one or more views in a 
HP Business Availability Center system through a URL-based query to the 
database. For details, see “Working with the Dashboard API” on page 361.
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Working with the Generic Reporting 
Engine API 

Note to HP Managed Software Solution customers: For details on how to 
use the Generic Reporting Engine API in a HP Managed Software Solution 
environment, contact HP Managed Software Solution Support.

This chapter explains how to manually work with the Generic Reporting 
Engine API to extract data from HP Business Availability Center for use with 
third-party or custom tools.

This chapter describes: On page:

Introducing the Generic Reporting Engine API 272

Data Returned 273

Querying with a Browser 274

Using the Web Service 275

Supported SQL Syntax 275

Query Limitations 276

Date-Time Values 277

byTime Function 278

Query Examples 279

Legacy Queries 280
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Introducing the Generic Reporting Engine API

The recommended method for creating API-level queries to the profile 
database is building queries using the Custom Query Builder. The Custom 
Query Builder enables the building of queries using a graphical user 
interface, and facilitates the generation of reports, extraction of data in 
different formats, and generation of query URLs that can be used with third-
party or custom tools. For details, see “Custom Query Builder” in Custom 
Reporting and Alerting.

The Generic Reporting Engine API also enables manual creation of queries 
using the following methods:

➤ Web browser. The request is sent as an HTML query and the data is returned 
as HTML or as a CSV (Comma Separated Values) file that can be opened with 
Microsoft Excel or processed with a custom tool.

➤ Web Service. The return object contains the data in CSV format.

The remainder of this chapter describes how to create queries manually.

Prerequisite Knowledge
Users of the API should be familiar with SQL syntax and HP Business 
Availability Center administration and applications. Users of the API via 
Web Service should also be familiar with the SOAP specification and an 
object-oriented programming language such as C++ or Java.

Permissions
For a query to access the data using the API query syntax described below, 
the user and password parameters passed in the query must be those of a 
user with either System Viewer or Superuser permissions. (For details on 
setting permissions in the Permissions Manager, see “Permissions 
Management” in Platform Administration.)

Configuration
You can configure the API options at Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Foundations > Generic Data Engine 
Open API. You can set the maximum number of data rows returned, as well 
as disable use of the Generic Reporting Engine API.
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Getting Metadata on the Samples
When building queries, you must know the data representation of the 
sample. For information on commonly queried samples and descriptions of 
their fields, see “Data Samples” in Reference Information.

Advanced Sample Retrieval
Users with special reporting needs can retrieve a list of all samples and their 
fields using the MBean Inspector. Access the MBean Inspector page by 
entering the following URL in your browser:

http://<server>[:port]/jmx-
console/HtmlAdaptor?action=inspectMBean&name=Topaz%3Aservice%3DMet
a-Data+Manager

The default port number is 8080. If this port is incorrect, consult your 
system administrator for the correct port number.

On the MBean Inspector page, click the Invoke button next to the operation 
showMetaDataDBMapping. The bean returns a list of fields in each sample.

Data Returned 

The same data is returned whether the request is made from a browser or 
with the Web Service. With a browser, the data resides in the response body, 
and for the Web Service, the data resides in the return object.

Web Browser Response Body
When the query is submitted from a browser, the response CSV or HTML 
contains the data, or error code and message. If the number of rows to be 
returned exceeds the maximum, the last row of the data is Returned X of Y 
rows, where X is the number of rows returned and Y is the actual number of 
rows that fulfil the conditions of the query. If there is an error at the engine 
level, the HTTP success code is returned, but the body of the response is 
<error code>, <error message>.
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Web Service Return Object
The Web Service return object contains the following:

➤ retval. The data or an error message.

➤ errorCode. The error code (type int). Possible error codes are:

➤ 0 - Success

➤ 100 - Authorization error

➤ 101 - Processing error

➤ 102 - Open API has been disabled

➤ origRowCount. The actual number of rows the query should have returned 
(type int). If the number of rows to be returned exceeds the maximum, the 
origRowCount field is set to the actual number of rows that the query would 
have returned had the maximum not been exceeded.

Querying with a Browser

When querying with a browser, the getData service is called with the URL:

http://<server>[:port]/topaz/gdeopenapi/GdeOpenApi?method=getData&user=<
username>&password=<password>&query=<query>

or with the optional result type parameter:

http://<server>[:port]/topaz/gdeopenapi/GdeOpenApi?method=getData&user=<
username>&password=<password>&query=<query>&resultType=csv

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

The default return type is HTML. If resultType=csv is specified, a comma 
separated values file is returned.
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Using the Web Service

The API Web Service enables submitting a query consisting of a username, 
password, and an SQL-like select statement. The engine returns an error 
description if it cannot parse the statement or if there is a problem running 
the query. If there is no error, the results of the query are returned.

SOAP programmers can access the WSDL at:

http://<server>[:port]/topaz/gdeopenapi/services/GdeWsOpenAPI?wsdl

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

Supported SQL Syntax

The language supported is a subset of SQL and supports these keywords, 
modifiers, and operators:

➤ SELECT

➤ WHERE

➤ FROM

➤ TOP 

➤ HAVING 

➤ Aliasing with the AS keyword

➤ Logical operators OR , AND , NOT

➤ DISTINCT modifier 

➤ IN operator. Inner selects can be used to return the values for the IN 
operator.

➤ BETWEEN operator 

➤ IS NULL (IS NOT NULL is not supported) 

➤ LIKE. Note that the wildcard character is the asterisk (*). Do not use the 
percent sign (%). The asterisk can not be used by itself (LIKE *). It must be 
used with other characters.
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➤ Comparators: =, IS, !=, <>, >, >=, <, <=

➤ Functions: MAX, MIN, SUM, COUNT, AVG, STDDEV, SUMOFSQR, LOG, 
CEIL, FLOOR, MOD, SQRT, REPLACENULL, IF, and the “byTime Function” 
described on page 278.

➤ ORDER BY and the ASC and DESC modifiers 

Query Limitations

The following limitations apply to queries submitted to the service: 

➤ Composite expressions in the SELECT clause using parenthesis are not 
supported. For example, you cannot select (a+b)/c. Use of parentheses for 
function arguments is supported, for example, max(a+b).

➤ Only one monitor type can be selected in a single query.

➤ The asterisk (*) is not supported as a wildcard character except in 
combination with the LIKE operator. It is supported as the multiplication 
operator.

➤ Inner selects and joins are not supported, with one exception: an inner 
select can be used to return the values for an IN clause.

➤ The ORDER BY clause requires a column number, for example ORDER BY 1. 
ORDER BY column name is not supported.

➤ The engine requires that queries contain a time limitation in the WHERE 
clause.

➤ The GROUP BY clause is not supported. It is unnecessary because the engine 
treats all fields that do not have an aggregate function as GROUP BY fields.

➤ When manually defining a filter that consists of strings containing white 
space or special characters (for example, where bb_guid IN (a b, c)), you must 
enclose the white space or special character string with quotes (for example, 
where bb_guid IN (‘a b’, c)). When you create filters on the Filter Builder page, 
HP Business Availability Center automatically adds the quotes. Special 
characters are defined as any characters other than digits, letters, and the 
following characters: "_", "$", "#".
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➤ When defining a filter that consists of strings containing one or more single 
quote characters, you must add a second single quote character beside each 
instance. For example, change szTransactionName = ('Login_to_O'brien') to 
szTransactionName = ('Login_to_O''brien').

➤ The columns in the returned data are labeled Column 0, Column 1, and so on. 
To return meaningful column labels, use the SQL AS operator. For example, 
Select time_stamp as TimeStamp. With this use of the AS operator, the 
column label is TimeStamp.

Date-Time Values

Time in queries and return data is specified in seconds since January 1, 1970. 
You can use Microsoft Excel to understand the time values. 

Time is most commonly used for time stamp fields.

To get a GMT time for use in a query, enter the date and time in a Date-
formatted cell and in another cell, formatted as General, enter the formula:

=(<date cell> - 25569 ) * 86400

To correct for a local time zone, add the time zone offset times 3600 seconds 
to the result. For example, for Central Europe (GMT + 2):

=(<date cell> - 25569 ) * 86400 + ( 2 * 3600 )
To view a time value from a query as a GMT date in Excel, use a Date format 
for the cell and enter the formula:

=<time stamp> / 86400 + 25569

To correct for a local time zone, subtract the time zone offset times 3600 
seconds from the time stamp. For example, for the Eastern United States, 
standard time (GMT - 3):

=(<time stamp> - ( -3 * 3600 ) )/ 86400 + 25569
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byTime Function

The Generic Reporting Engine SQL supports the function byTime, which 
returns data grouped by time periods. For example, if you build a query that 
returns the average response time of a transaction for the past day, without 
the byTime function one value would be returned; using the byTime 
function, you could request to view the average response time of the 
transaction for each hour of the past day, in which case a value would be 
returned for each hour of the past 24 hours.

The function syntax is:

byTime(<timefield >, <step value>, <number of step>, <offset>)

For example, to return one value for each 3 days, corrected to two hours East 
of GMT:

byTime(time_stamp, 40, 3, 2) 

Argument Description

timefield Usually a timestamp field

step value One of:

-1 - Time not set
10 - Second
20 - Minute
30 - Hour
40 - Day
50 - Week 
60 - Month
70 - Quarter
80 - Year

number of step The number of the units specified in step value to 
group.

offset Time zone offset from GMT in hours. Positive 
numbers indicate time zones East of GMT. Negative 
numbers indicate time zones West of GMT.
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Query Examples

Below are several examples of query URLs that retrieve different types of 
data from the database.

Example of ss_t Sample
This example illustrates retrieving the average value for SiteScope samples 
on a given measurement and monitor.

http://myServer/topaz/gdeopenapi/GdeOpenApi?method=getData&user=admin
&password=admin&query=select szMeasurementName, szMonitorName, 
avg(dValue) from ss_t where u_iStatus=1 and time_stamp > 123456 and 
szMeasurementName = ‘myMeasurmentName’ and szMonitorName = 
‘myMonitorName’

Example of trans_t Sample
This example illustrates retrieving the average response time, grouped by 
minutes and offset to GMT + 3 for Springfield_infra_ems_login transactions in 
the Springfield_Location profile on for a given period from BPM data.

http://myServer/topaz/gdeopenapi/GdeOpenApi?method=getData&user=admin
&password=admin&query=select byTime(time_stamp, 20, 1, 3.0), profile_name  
as ProfileName, szTransactionName as TransactionName, 
AVG(dResponseTime) from trans_t where time_stamp>=1126594800.64 and 
time_stamp<1126596000.64 and profile_name='Springfield_Location' and 
szTransactionName='Springfield_infra_ems_login' 
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Example of rum_server_t Sample
This example illustrates retrieving a list of all rum_server_t samples in a 
given day that failed on a specified server:

http://myServer/topaz/gdeopenapi/GdeOpenApi?method=getData&user=admin
&password=admin&query=select time_stamp, engine_name, server_name from 
rum_server_t where availability=0 and total_hits > 0 and time_stamp > 
1041379200 and time_stamp < 1136197020 and server_name = 
‘myServerName’

Example of rum_page_t Sample
This example illustrates retrieving the total server time for each URL as 
measured by RUM.

http://myServer/topaz/gdeopenapi/GdeOpenApi?method=getData&user=admin
&password=admin&query=select page_url, sum(tot_server_time) from 
rum_page_t where time_stamp > 1041379200 and time_stamp < 1136197020 
&resultType=csv

Legacy Queries

From HP Business Availability Center version 6.0, it is possible to write SQL 
queries directly on samples, as described in the previous sections. Customers 
who used the previous version of the data engine API can use the 
information in this section to maintain older reports.

Structure of the Query
The query begins with the URL of the OpenAPI.jsp: 
http://<server_name>/topaz/openapi/OpenAPI.jsp

Following this is a series of query parameter=value pairs. The pairs are 
separated with an ampersand (&). You build the query using required and 
optional parameters. 

You can also add filter parameters. For details, see “Filter Parameters” on 
page 291.
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➤ Required Parameters. The following parameters are required:

username The name of the HP Business Availability Center user 
running the query.

password The password of the HP Business Availability Center user 
running the query

function The type of the data to receive. One of:

transactions – Business Process Monitor response time data

transactions_breakdown – Business Process Monitor 
transaction breakdown data

sitescope – SiteScope measurement data

routings – WebTrace routing data

hops – WebTrace hop data

transactions_error – Business Process Monitor transaction 
error data

alerts – Business Process Monitor alert data

components_breakdown – Business Process Monitor 
component breakdown data

rowDataType The type of aggregation to use. One of:

row – raw data

hour – hourly aggregated data

day – daily aggregated data

The type of aggregation cannot be a larger unit than the one 
specified with the optional parameter, stepValueType.
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profileIds The IDs of the profiles for which to get data. Separate 
multiple IDs with a comma (,). 
For example: profileIds=2,7,9

To extract a profile’s ID from the database:

1  Open the page http://<servername>:8080/jmx-
console/index.jsp in a Web browser, where <servername> 
represents the name of the HP Business Availability 
Center server.

2  In the Topaz list, click the link service=OAPI Services.

3  Invoke com.mercury.infra.db.tools.oapiservices.
ProfileMapping getProfiles() to retrieve the profile ID 
information.

Time range

either
from and to
or
lastPeriod

Either use from and to to specify the start and end of the 
period, or use lastPeriod to specify the period or periods 
ending at the time the query is called.

The time format for from and to is:
dd/MM/yyyy HH:mm:ss

lastPeriod

is one of:

hour

day

week

month

quarter

year

To specify more that one unit of lastPeriod, use the parameter 
numStepUnit together with lastPeriod.
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➤ Optional Parameters. The following parameters are optional:

numStepUnit Used with <italic>lastPeriod to indicate the number of 
periods included in the data. For example, get data for the 
last two days with:

lastPeriod=day&numStepUnit=2

resultType The output file format. One of:

html

xml

csv

The default is html.

stepValueType The unit of time by which the data is grouped. One of:

minute

hour

day

week

month

Use stepValueType in conjunction with stepValue to see a 
larger grouping than that specified with rowDataType.

stepValue The number of the time units specified by stepValueType by 
which to group. For example

stepValueType=hour&stepValue=8

groups the data by 8-hour periods.

The default is 1.

dateFormat The format for date value output (that is, the way the date 
and time are displayed in the report). For example,

MM/dd/yyyy%20HH:mm:ss

The “%20” indicates a space. (A space is ASCII character 
number 32, written 20 in hexadecimal.)

timeZone A time zone specification in the form:
&timezone=<time zone value from below time zone list> 
For example: 
&timezone=Europe/London
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Time Zone List

ACT Antarctica/McMurdo Etc/GMT0

AET Antarctica/Palmer Etc/Greenwich

AGT Antarctica/Rothera Etc/UCT

ART Antarctica/South_Pole Etc/UTC

AST Antarctica/Syowa Etc/Universal

Africa/Abidjan Antarctica/Vostok Etc/Zulu

Africa/Accra Arctic/Longyearbyen Europe/Amsterdam

Africa/Addis_Ababa Asia/Aden Europe/Andorra

Africa/Algiers Asia/Almaty Europe/Athens

Africa/Asmera Asia/Amman Europe/Belfast

Africa/Bamako Asia/Anadyr Europe/Belgrade

Africa/Bangui Asia/Aqtau Europe/Berlin

Africa/Banjul Asia/Aqtobe Europe/Bratislava

Africa/Bissau Asia/Ashgabat Europe/Brussels

Africa/Blantyre Asia/Ashkhabad Europe/Bucharest

Africa/Brazzaville Asia/Baghdad Europe/Budapest

Africa/Bujumbura Asia/Bahrain Europe/Chisinau

Africa/Cairo Asia/Baku Europe/Copenhagen

Africa/Casablanca Asia/Bangkok Europe/Dublin

Africa/Ceuta Asia/Beirut Europe/Gibraltar

Africa/Conakry Asia/Bishkek Europe/Helsinki

Africa/Dakar Asia/Brunei Europe/Istanbul

Africa/Dar_es_Salaam Asia/Calcutta Europe/Kaliningrad

Africa/Djibouti Asia/Choibalsan Europe/Kiev

Africa/Douala Asia/Chongqing Europe/Lisbon
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Africa/El_Aaiun Asia/Chungking Europe/Ljubljana

Africa/Freetown Asia/Colombo Europe/London

Africa/Gaborone Asia/Dacca Europe/Luxembourg

Africa/Harare Asia/Damascus Europe/Madrid

Africa/Johannesburg Asia/Dhaka Europe/Malta

Africa/Kampala Asia/Dili Europe/Minsk

Africa/Khartoum Asia/Dubai Europe/Monaco

Africa/Kigali Asia/Dushanbe Europe/Moscow

Africa/Kinshasa Asia/Gaza Europe/Nicosia

Africa/Lagos Asia/Harbin Europe/Oslo

Africa/Libreville Asia/Hong_Kong Europe/Paris

Africa/Lome Asia/Hovd Europe/Prague

Africa/Luanda Asia/Irkutsk Europe/Riga

Africa/Lubumbashi Asia/Istanbul Europe/Rome

Africa/Lusaka Asia/Jakarta Europe/Samara

Africa/Malabo Asia/Jayapura Europe/San_Marino

Africa/Maputo Asia/Jerusalem Europe/Sarajevo

Africa/Maseru Asia/Kabul Europe/Simferopol

Africa/Mbabane Asia/Kamchatka Europe/Skopje

Africa/Mogadishu Asia/Karachi Europe/Sofia

Africa/Monrovia Asia/Kashgar Europe/Stockholm

Africa/Nairobi Asia/Katmandu Europe/Tallinn

Africa/Ndjamena Asia/Krasnoyarsk Europe/Tirane

Africa/Niamey Asia/Kuala_Lumpur Europe/Tiraspol

Africa/Nouakchott Asia/Kuching Europe/Uzhgorod

Africa/Ouagadougou Asia/Kuwait Europe/Vaduz
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Africa/Porto-Novo Asia/Macao Europe/Vatican

Africa/Sao_Tome Asia/Macau Europe/Vienna

Africa/Timbuktu Asia/Magadan Europe/Vilnius

Africa/Tripoli Asia/Makassar Europe/Warsaw

Africa/Tunis Asia/Manila Europe/Zagreb

Africa/Windhoek Asia/Muscat Europe/Zaporozhye

America/Adak Asia/Nicosia Europe/Zurich

America/Anchorage Asia/Novosibirsk GB

America/Anguilla Asia/Omsk GB-Eire

America/Antigua Asia/Oral GMT

America/Araguaina Asia/Phnom_Penh GMT0

America/Aruba Asia/Pontianak Greenwich

America/Asuncion Asia/Pyongyang HST

America/Atka Asia/Qatar Hongkong

America/Barbados Asia/Qyzylorda IET

America/Belem Asia/Rangoon IST

America/Belize Asia/Riyadh Iceland

America/Boa_Vista Asia/Riyadh87 Indian/Antananarivo

America/Bogota Asia/Riyadh88 Indian/Chagos

America/Boise Asia/Riyadh89 Indian/Christmas

America/Buenos_Aires Asia/Saigon Indian/Cocos

America/Cambridge_Bay Asia/Sakhalin Indian/Comoro

America/Cancun Asia/Samarkand Indian/Kerguelen

America/Caracas Asia/Seoul Indian/Mahe

America/Catamarca Asia/Shanghai Indian/Maldives

America/Cayenne Asia/Singapore Indian/Mauritius
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America/Cayman Asia/Taipei Indian/Mayotte

America/Chicago Asia/Tashkent Indian/Reunion

America/Chihuahua Asia/Tbilisi Iran

America/Cordoba Asia/Tehran Israel

America/Costa_Rica Asia/Tel_Aviv JST

America/Cuiaba Asia/Thimbu Jamaica

America/Curacao Asia/Thimphu Japan

America/Danmarkshavn Asia/Tokyo Kwajalein

America/Dawson Asia/Ujung_Pandang Libya

America/Dawson_Creek Asia/Ulaanbaatar MET

America/Denver Asia/Ulan_Bator MIT

America/Detroit Asia/Urumqi MST

America/Dominica Asia/Vientiane MST7MDT

America/Edmonton Asia/Vladivostok Mexico/BajaNorte

America/Eirunepe Asia/Yakutsk Mexico/BajaSur

America/El_Salvador Asia/Yekaterinburg Mexico/General

America/Ensenada Asia/Yerevan Mideast/Riyadh87

America/Fort_Wayne Atlantic/Azores Mideast/Riyadh88

America/Fortaleza Atlantic/Bermuda Mideast/Riyadh89

America/Glace_Bay Atlantic/Canary NET

America/Godthab Atlantic/Cape_Verde NST

America/Goose_Bay Atlantic/Faeroe NZ

America/Grand_Turk Atlantic/Jan_Mayen NZ-CHAT

America/Grenada Atlantic/Madeira Navajo

America/Guadeloupe Atlantic/Reykjavik PLT

America/Guatemala Atlantic/South_Georgia PNT
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America/Guayaquil Atlantic/St_Helena PRC

America/Guyana Atlantic/Stanley PRT

America/Halifax Australia/ACT PST

America/Havana Australia/Adelaide PST8PDT

America/Hermosillo Australia/Brisbane Pacific/Apia

America/Indiana/Indiana
polis

Australia/Broken_Hill Pacific/Auckland

America/Indiana/Knox Australia/Canberra Pacific/Chatham

America/Indiana/Mareng
o

Australia/Darwin Pacific/Easter

America/Indiana/Vevay Australia/Hobart Pacific/Efate

America/Indianapolis Australia/LHI Pacific/Enderbury

America/Inuvik Australia/Lindeman Pacific/Fakaofo

America/Iqaluit Australia/Lord_Howe Pacific/Fiji

America/Jamaica Australia/Melbourne Pacific/Funafuti

America/Jujuy Australia/NSW Pacific/Galapagos

America/Juneau Australia/North Pacific/Gambier

America/Kentucky/Louis
ville

Australia/Perth Pacific/Guadalcanal

America/Kentucky/Mont
icello

Australia/Queensland Pacific/Guam

America/Knox_IN Australia/South Pacific/Honolulu

America/La_Paz Australia/Sydney Pacific/Johnston

America/Lima Australia/Tasmania Pacific/Kiritimati

America/Los_Angeles Australia/Victoria Pacific/Kosrae

America/Louisville Australia/West Pacific/Kwajalein

America/Maceio Australia/Yancowinna Pacific/Majuro

America/Managua BET Pacific/Marquesas
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America/Manaus BST Pacific/Midway

America/Martinique Brazil/Acre Pacific/Nauru

America/Mazatlan Brazil/DeNoronha Pacific/Niue

America/Mendoza Brazil/East Pacific/Norfolk

America/Menominee Brazil/West Pacific/Noumea

America/Merida CAT Pacific/Pago_Pago

America/Mexico_City CET Pacific/Palau

America/Miquelon CNT Pacific/Pitcairn

America/Monterrey CST Pacific/Ponape

America/Montevideo CST6CDT Pacific/Port_Moresby

America/Montreal CTT Pacific/Rarotonga

America/Montserrat Canada/Atlantic Pacific/Saipan

America/Nassau Canada/Central Pacific/Samoa

America/New_York Canada/East-
Saskatchewan

Pacific/Tahiti

America/Nipigon Canada/Eastern Pacific/Tarawa

America/Nome Canada/Mountain Pacific/Tongatapu

America/Noronha Canada/Newfoundland Pacific/Truk

America/North_Dakota/
Center

Canada/Pacific Pacific/Wake

America/Panama Canada/Saskatchewan Pacific/Wallis

America/Pangnirtung Canada/Yukon Pacific/Yap

America/Paramaribo Chile/Continental Poland

America/Phoenix Chile/EasterIsland Portugal

America/Port-au-Prince Cuba ROK

America/Port_of_Spain EAT SST

America/Porto_Acre ECT Singapore
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America/Porto_Velho EET SystemV/AST4

America/Puerto_Rico EST SystemV/AST4ADT

America/Rainy_River EST5EDT SystemV/CST6

America/Rankin_Inlet Egypt SystemV/CST6CDT

America/Recife Eire SystemV/EST5

America/Regina Etc/GMT SystemV/EST5EDT

America/Rio_Branco Etc/GMT+0 SystemV/HST10

America/Rosario Etc/GMT+1 SystemV/MST7

America/Santiago Etc/GMT+10 SystemV/MST7MDT

America/Santo_DomingoEtc/GMT+11 SystemV/PST8

America/Sao_Paulo Etc/GMT+12 SystemV/PST8PDT

America/Scoresbysund Etc/GMT+2 SystemV/YST9

America/Shiprock Etc/GMT+3 SystemV/YST9YDT

America/St_Johns Etc/GMT+4 Turkey

America/St_Kitts Etc/GMT+5 UCT

America/St_Lucia Etc/GMT+6 US/Alaska

America/St_Thomas Etc/GMT+7 US/Aleutian

America/St_Vincent Etc/GMT+8 US/Arizona

America/Swift_Current Etc/GMT+9 US/Central

America/Tegucigalpa Etc/GMT-0 US/East-Indiana

America/Thule Etc/GMT-1 US/Eastern

America/Thunder_Bay Etc/GMT-10 US/Hawaii

America/Tijuana Etc/GMT-11 US/Indiana-Starke

America/Tortola Etc/GMT-12 US/Michigan

America/Vancouver Etc/GMT-13 US/Mountain

America/Virgin Etc/GMT-14 US/Pacific
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Filter Parameters
There can be one filters clause in the query. It is not required. If there is 
more than one filter in the clause, the filters are separated by a semicolon (;). 

A filter consists of a report column name, a filter type, the number of 
patterns in the list, and a list of patterns. Each element in a filter is separated 
by a semicolon (;).

For example:

filters=MonitorTitle;in;2;9,12;Measurement;in;1;18

means:

select where (MonitorTitle equals 9 or 12) and (Measurement equals 18)

America/Whitehorse Etc/GMT-2 US/Pacific-New

America/Winnipeg Etc/GMT-3 US/Samoa

America/Yakutat Etc/GMT-4 UTC

America/Yellowknife Etc/GMT-5 Universal

Antarctica/Casey Etc/GMT-6 VST

Antarctica/Davis Etc/GMT-7 W-SU

Antarctica/DumontDUrv
ille

Etc/GMT-8 WET

Antarctica/Mawson Etc/GMT-9 Zulu 
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The following filter parameters are available:

Query Examples
Example 1:

http://<server_name>/topaz/openapi/OpenAPI.jsp?
username=fitzwilliam&password=darcy&function=transactions&profileIds=33&
lastPeriod=hour&rowDataType=raw&dateFormat=MM/dd/yyyy HH:mm:ss

Example 2:

http://<server_name>/topaz/openapi/OpenAPI.jsp?
username=fitzwilliam&password=darcy&function=transactions&profileIds=33&
from=10/12/2002 14:00:00&to=10/12/2002 15:00:00& rowDataType=raw&
dateFormat=MM/dd/yyyy%20HH:mm:ss

General Filter Types These types can be used with numerical or text columns.

in – Data is included in the report if it equals one of the 
items in the list of patterns.

not_in – Data is included in the report if it does not equal 
any item in the list of patterns.

Text Filter Types This type can be used with text columns.

like – Data is included in the report if it matches the pattern.

When like is used, the number of patterns in the list must be 
one (1).

The wildcard, asterisk (*), can be used with like.

For example:

filters=Host Name;like;1;ServerNum*

Numeric Filter Types These types can be used with numerical columns.

bigger

smaller

equals
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Example 3:

http://<server_name>/topaz/openapi/OpenAPI.jsp?username=fitzwilliam&passw
ord=darcy&function=sitescope&profileIds=35&lastPeriod=day&numStepUnit=2&
&rowDataType=hour&dateFormat=MM/dd/yyyy%20HH:mm:ss&filters=MonitorTi
tle;in;1;9;Measurement;in;1;18&stepValueType=hour&stepValue=6
293



Chapter 8 • Working with the Generic Reporting Engine API
294



9
Working with the HP Universal CMDB API

Note to HP Managed Software Solutions customers: For details on how to 
use the UCMDB API in a HP Managed Software Solutions environment, 
contact HP Managed Software Solutions Support. 

This chapter explains how third-party or custom tools can use the 
HP Universal CMDB API to extract data and calculations and to write data to 
the UCMDB (Universal Configuration Management Database).

Use this chapter in conjunction with the UCMDB schema documentation, 
available in the on-line documentation library.

This chapter describes: On page:

Using the HP Universal CMDB API 296

Calling the Web Service 298

UCMDB General Parameters 299

UCMDB Output Parameters 302

Creating Queries to Return Unambiguous TopologyMap Elements 304

Querying the HP UCMDB Module 308

Updating the HP UCMDB Module 323

Querying the HP UCMDB Module Class Model 327

Querying for Impact Analysis 329
295



Chapter 9 • Working with the HP Universal CMDB API
This chapter uses the following conventions:

➤ This style, Element, indicates that an item is an entity in the database or an 
element defined in the schema, including structures passed to or returned 
by methods. Plain text indicates that the item is being discussed in a general 
context. For example:

A third-party application collects information about CIs and relations in its 
domain, and uses the appropriate API to pass the information to the 
UCMDB. Using this information, the UCMDB creates CIs and Relations and 
creates a map of the client IDs and the UCMDB IDs.

In the first sentence, CI and relation are in plain text because they are not 
UCMDB elements. In the second sentence, the UCMDB has created entities 
according to the structure specified by the schema. Therefore, they are now 
CI and Relation.

➤ UCMDB elements and method arguments are spelled in the case in which 
they are specified in the schema. This usually means that a class name or 
generic reference to an instance of the class is capitalized. An element or 
argument to a method is not capitalized. For example:

A relation is an element of type Relation passed to a method.

Using the HP Universal CMDB API

The HP Universal CMDB API is a Web Service API used to integrate 
applications with the Universal CMDB (UCMDB). The API provides methods 
to:

➤ add, remove, and update configuration items and relations in the CMDB

➤ retrieve information about the class model

➤ retrieve impact analyses

➤ retrieve information about configuration items and relationships

Use Cases 332

Examples 333

This chapter describes: On page:
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Methods for retrieving information about configuration items and 
relationships generally use the Topology Query Language (TQL). For details, 
see “Topology Query Language” in IT World Model Management.

Users of the HP Universal CMDB API should be familiar with:

➤ The SOAP specification 

➤ An object-oriented programming language such as C++, C# or Java 

➤ HP Universal CMDB 

This section includes the following topics:

➤ “Uses of the API” on page 297

➤ “Permissions” on page 298

Uses of the API
The API is used to fulfill a number of business requirements. For example:

➤ A third-party system can query the Class Model for information about the 
available configuration item (CI) classes. These classes are called 
Configuration Item Types (CITs).

➤ A third-party asset management tool can update the UCMDB with 
information available only to that tool, thereby unifying its data with data 
collected by HP applications.

➤ A number of third-party systems can populate the UCMDB to create a 
central UCMDB that can track changes and perform impact analysis.

➤ A third-party system can create entities and relations according to its 
business logic, and then write the data to the UCMDB to take advantage of 
the UCMDB query capabilities.

➤ Other systems, such as the Change Control Management (CCM) system, can 
use the Impact Analysis methods for change analysis.
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Permissions
The administrator provides user names and passwords for connecting with 
the API. Whether the password comes from the UCMDB or from Business 
Availability Center depends on the deployment of UCMDB. There are 
several deployment options:

➤ HP Universal CMDB standalone. Use an HP Universal CMDB user name and 
password.

➤ HP Universal CMDB standalone accessed through Business Availability 
Center. Use an HP Universal CMDB user name and password.

➤ HP Universal CMDB embedded in Business Availability Center. In this case, 
use a Business Availability Center user name and password.

Calling the Web Service

The HP Universal CMDB Web Service enables calling server-side methods 
using standard SOAP programming techniques. If the statement cannot be 
parsed or if there is a problem invoking the method, the API methods throw 
a SoapFault exception. When a SoapFault exception is thrown, the UCMDB 
populates one or more of the error message, error code, and exception 
message fields. If there is no error, the results of the invocation are returned.

SOAP programmers can access the WSDL at:

http://<server>[:port]/ axis2/services/UcmdbService?wsdl 

The port specification is only necessary for non-standard installations. 
Consult your system administrator for the correct port number.

The URL for calling the service is:

http://<server>[:port]/ axis2/services/UcmdbService

For examples of connecting to the UCMDB, see “Use Cases” on page 332.
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UCMDB General Parameters 

This section describes the most common parameters of the service’s 
methods. For details, refer to the schema documentation.

This section includes the following topics:

➤ “CmdbContext” on page 299

➤ “ID” on page 299

➤ “Key Attributes” on page 299

➤ “ID Types” on page 300

➤ “CIProperties” on page 300

➤ “Type Name” on page 301

➤ “Configuration Item (CI)” on page 301

➤ “Relation” on page 301

CmdbContext
All UCMDB API service invocations require a CmdbContext argument. 
CmdbContext is a callerApplication string that identifies the application that 
invokes the service. CmdbContext is used for logging and troubleshooting.

ID
Every CI and Relation has an ID field. It consists of a case-sensitive ID string 
and an optional temp flag, indicating whether the ID is temporary.

Key Attributes
For identifying a CI or Relation in some contexts, key attributes can be used 
in place of a UCMDB ID. Key attributes are those attributes with the 
ID_ATTRIBUTE set in the class definition. 

In the user interface, the key attributes have a key icon next to them in the 
list of Configuration Item Type attributes in the user interface. For details, 
see “Attributes Page” in IT World Model Management. For information about 
identifying the key attributes from within the API client application, see 
“getCmdbClassDefinition” on page 328.
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ID Types
An ID element can contain a real ID, a temporary ID, or can be empty. 

A real ID is a string assigned by the UCMDB that identifies an entity in the 
database. A temporary ID can be any string that is unique in the current 
request. An empty ID means no value is assigned.

A temporary ID can be assigned by the client and often represents the ID of 
the CI as stored by the client. It does not necessarily represent an entity 
already created in the UCMDB. When a temporary ID is passed by the client, 
if the UCMDB can identify an existing data configuration item using the CI 
key properties, that CI is used as appropriate for the context as though it 
had been identified with a real ID. 

The real ID of a CI is calculated by the UCMDB based on a combination of 
the CI’s type and key properties. The real ID of a Relation is based on the 
relations’s type, the IDs of the two CIs that are part of the relationship, and 
the relation’s key properties. Therefore, key attribute values must be set 
during CI or Relation creation. If the key properties values are not specified 
when creating a CI, there are two possibilities. If the CIT has the 
RANDOM_GENERATED_ID qualifier, the server generates a unique ID. If 
not, an exception is thrown.

For details, see CI Attribute Customization.

CIProperties
A CIProperties element is composed of collections, each containing a 
sequence of name-value elements that specify properties of the type 
indicated by the collection name. None of the collections are required, so 
the CIProperties element can contain any combination of collections. 

CIProperties are used by CI and Relation elements. For details, see 
“Configuration Item (CI)” on page 301 and “Relation” on page 301. 

The properties collections are:

➤ dateProps - collection of DateProp elements

➤ doubleProps - collection of DoubleProp elements

➤ floatProps - collection of FloatProp elements
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➤ intListProps - collection of DateProp elements

➤ intProps - collection of IntProp elements

➤ strProps - collection of StrProp elements

➤ strListProps - collection of StrListProp elements

➤ longProps - collection of LongProp elements

➤ bytesProps - collection of BytesProp elements

➤ xmlProps - collection of XmlProp elements

Type Name
The type name is the class name of a configuration item type or relation 
type. The type name is used in code to refer to the class. It should not be 
confused with the display name, which is seen on the user interface where 
the class is mentioned, but which is meaningless in code.

Configuration Item (CI)
A CI element is composed of an ID, a type, and a props collection. 

When using HP UCMDB Module Update Methods to update a CI, the ID 
element can contain a real UCMDB ID or a client-assigned temporary ID. If a 
temporary ID is used, set the temp flag to true. When deleting an item, the 
ID can be empty. HP UCMDB Module Query Methods take real IDs as input 
parameters and return real IDs in the query results.

The type can be any type name defined in the CI Type Manager. For details, 
see “CI Type Manager User Interface” in IT World Model Management.

The props element is a CIProperties collection. For details, see “CIProperties” 
on page 300.

Relation
A Relation is an entity that links two configuration items. A Relation element 
is composed of an ID, a type, the identifiers of the two items being linked 
(end1ID and end2ID), and a props collection.
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When using HP UCMDB Module Update Methods to update a Relation, the 
value of the Relation’s ID can be a real UCMBD ID or a temporary ID. When 
deleting an item, the ID can be empty. HP UCMDB Module Query Methods 
take real IDs as input parameters and return real IDs in the query results. 

The relation type is the Type Name of the HP UCMDB class from which the 
relation is instantiated. The type can be any of the relation types defined in 
the UCMDB. For further information on classes or types, see “Querying the 
HP UCMDB Module Class Model” on page 327.

For details, see “CI Type Manager User Interface” in IT World Model 
Management.

The two relation end IDs must not be empty IDs because they are used to 
create the ID of the current relation. However, they both can have 
temporary IDs assigned to them by the client. 

The props element is a CIProperties collection. For details, see “CIProperties” 
on page 300.

UCMDB Output Parameters 

This section describes the most common output parameters of the service 
methods. For details, refer to the schema documentation.

This section includes the following topics:

➤ “CIs” on page 303

➤ “ShallowRelation” on page 303

➤ “Topology” on page 303

➤ “CINode” on page 303

➤ “RelationNode” on page 303

➤ “TopologyMap” on page 303

➤ “ChunkInfo” on page 304
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CIs
CIs is a collection of CI elements.

ShallowRelation
A ShallowRelation is an entity that links two configuration items, composed 
of an ID, a type, and the identifiers of the two items being linked (end1ID 
and end2ID). The relation type is the Type Name of the UCMDB class from 
which the relation is instantiated. The type can be any of the relation types 
defined in the UCMDB. 

Topology
Topology is a graph of CI elements and relations. A Topology consists of a CIs 
collection and a Relations collection containing one or more Relation 
elements.

CINode
CINode is composed of a CIs collection with a label. The label in the CINode 
is the label defined in the node of the TQL used in the query.

RelationNode
RelationNode is a set of Relations collections with a label. The label in the 
RelationNode is the label defined in the node of the TQL used in the query.

TopologyMap
TopologyMap is the output of a query calculation that matches a TQL query. 
The labels in the TopologyMap are the node labels defined in the TQL used in 
the query.

The data of TopologyMap is returned in the following form:

➤ CINodes. This is one or more CINode (see “CINode” on page 303).

➤ relationNodes. This is one or more RelationNode (see “RelationNode” on 
page 303).

The labels in these two structures order the lists of configuration items and 
relations.
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ChunkInfo
When a query returns a large amount of data, the server stores the data, 
divided into segments called chunks. The information the client uses to 
retrieve the chunked data is in the ChunkInfo structure returned by the 
query. ChunkInfo is composed of the numberOfChunks that must be retrieved 
and the chunksKey. The chunksKey is a unique identifier of the data on the 
server for this specific query invocation.

For more information, see “Processing Large Responses” on page 309.

Creating Queries to Return Unambiguous TopologyMap 
Elements

Query methods that return the data in topology or topologyMap elements 
search the system for a match of a TQL query. The following diagrams 
illustrate how the resulting topology and topologyMap structures are affected 
by the use of unique labels in the query. 

Labels are user-specified names in the query for relations and configuration 
items in specific configurations. The labels specified in the query are used as 
the node labels in the returned map. If no labels are specified, the CI or 
Relation Type Name is used as the label in the resulting map. The following 
example illustrates of specifying labels IISHost and DBHost in place of the 
default Host label, and labels ContainerIIS and ContainsDB in place of the 
default Contained label.
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Example
This is a representation of a small IT universe model. There are three hosts: 
H1, H2, H3, which host web servers (WS) and database managers (DB). WS1 
resides on H1. DB1 and WS2 both reside on H2. DB2 resides on H3.

This query is defined using the default labels:

The result of running this TQL query on the IT universe can be a Topology or 
TopologyMap.

Topology Response

CIs: H1,H2,H3,WS1,WS2,DB1,DB2
relations: H1-WS1, H1-H2, H2-H3, WS2-H2,DB1-H2, DB2-H3
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TopologyMap Response

In the above TopologyMap response, the first two CINodes contain identical 
Host labels, corresponding to the two Host configuration items in the query. 
Both of these CINodes contain host H2, with no indication of why H2 is 
duplicated. 

The last two relationNodes contain identical Contained labels, corresponding 
to the two Container link relations in the query. 

The duplications occur because no unique labels are specified in the query, 
resulting in the use of default labels, the type names Host and Container, in 
the map. To extract a more usable map, define queries with unique labels for 
each configuration to be matched, as shown in the following query.

CINode:
label: Host
CIs: H1,H2

CINode:
label: Host
CIs: H2,H3

CINode:
label: DB
CIs: DB1,DB2

CINode:
label: Webserver

CIs: IIS

relationNode:
label: talk
relations: H1-H2, H2-H3

relationNode:
label: Contained
relations: WS1-H1, WS2-H2

relationNode:
label: Contained
relations: DB2-H3, DB1-H2
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This query is defined with unique labels:

The topology result is identical to that of the TQL without unique labels. The 
topologyMap result, however, is different: Each label is now unique. 

In this map, it is clear why H2 is returned twice. The unique labels indicate 
that it is returned once as a Web server host and once as a database host.

Tip: Wherever possible in the UCMDB, apply unique, user-defined labels to 
specific configurations.

CINode:
label: IISHOST
CIs: H1, H2

CINode:
label: DBHOST
CIs: H2, H3

...

relationNode:
label: ContainerIIS
relations: WS1-H1, WS2-H2

relationNode:
label: ContainerDB
relations: DB2-H3, DB1-H2
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Querying the HP UCMDB Module

The HP UCMDB is queried using the APIs described in “HP UCMDB Module 
Query Methods” on page 312.

The queries and the returned UCMDB elements always contain real 
UCMDB IDs. 

Some general information on queries is presented below. 

For examples of the use of the query methods, see “Query Example” on 
page 336.

This section includes the following topics:

➤ “Just In Time Response Calculation” on page 308

➤ “Processing Large Responses” on page 309

➤ “Specifying Properties to Return” on page 309

➤ “HP UCMDB Module Query Methods” on page 312

Just In Time Response Calculation
For all query methods, the UCMDB server calculates the values requested by 
the query method when the request is received, and returns results based on 
the latest data. The result is always calculated at the time the request is 
received, even if the TQL query is active and there exists a previously 
calculated result. Therefore, the results of running a query returned to the 
client application may be different than the results of the same query 
displayed on the user interface.

Tip: If your application uses the results of a given query more than once and 
the data is not expected to change significantly between uses of the result 
data, you can improve performance by having the client application store 
the data rather than repeatedly running the query.
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Processing Large Responses
The response to a query always includes the structures for the data requested 
by the query method, even if no actual data is being transmitted. For many 
methods where the data is a collection or map, the response also includes 
the ChunkInfo structure, comprised of chunksKey and numberOfChunks. The 
numberOfChunks field indicates the number of chunks containing data that 
must be retrieved.

The maximum transmission size of data is set by the system administrator. If 
the data returned from the query is larger than the maximum size, the data 
structures in the first response contain no meaningful information, and the 
value of the numberOfChunks field is 2 or greater. If the data is not larger 
than the maximum, the numberOfChunks field is 0 (zero), and the data is 
transmitted in the first response. Therefore, in processing a response, check 
the numberOfChunks value first. If it is greater than 1, discard the data in the 
transmission and request the chunks of data. Otherwise, use the data in the 
response.

For information on handling chunked data, see “pullTopologyMapChunks” 
on page 321 and “releaseChunks” on page 322.

Specifying Properties to Return
Configuration Items and Relations generally have many properties. Some 
methods that return collections or graphs of these items accept input 
parameters that specify which property values to return with each item that 
matches the query. The UCMDB does not return empty properties. 
Therefore, the response to a query may have fewer properties than requested 
in the query.

This section describes the types of sets used to specify the properties to 
return.Properties can be referenced in two ways. First, properties can be 
referenced by their names. Second, they can be referenced by using names 
of predefined properties rules. Predefined properties rules are used by the 
UCMDB to create a list of real property names.

When an application references properties by name, it passes a 
PropertiesList.
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Tip: Whenever possible, use a PropertiesList to specify the names of the 
properties in which you are interested, rather than a rule-based set. Using 
the predefined properties rules nearly always results in returning more 
properties than you need, and has a performance price.

There are two types of predefined properties: qualifier properties and simple 
properties.

To use qualifier properties, the client application passes a QualifierProperties 
element. QualifierProperties is a list of qualifies that can be applied to 
properties. The UCMDB converts the list of qualifies passed by the client 
application to the list of the properties to which at least one of the qualifiers 
apply. The values of those properties are returned with the CI elements or 
Relation elements.

To use simple rule-based properties, the client application passes a 
SimplePredefinedProperty or SimpleTypedPredefinedProperty element. These 
elements contain the name of the rule by which the UCMDB generates the 
list of properties to return. The rules that can be specified in a 
SimplePredefinedProperty or SimpleTypedPredefinedProperty element are 
CONCRETE, DERIVED, and NAMING. 

Concrete Properties

Concrete properties are the set of properties defined for the specified class 
type. The properties added by derived classes are not returned for instances 
of those derived classes.

A collection of instances returned by a method may consist of instances of a 
class specified in the method invocation and instances of classes that inherit 
from that class. The derived classes inherit the properties of the specified 
class. In addition, the derived classes extend the parent class by adding 
properties.

Concrete properties are the properties defined in the specified class. 
Properties added by classes derived from the specified class are not included.
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For example: 

Class T1 has properties P1 and P2. Class T11 inherits from T1 and extends 
T1 with properties P21 and P22.

The collection of CIs of type T1 includes the instances of T1 and T11. The 
concrete properties of all instances in this collection are P1 and P2.

Derived Properties

Derived properties are the set of properties defined for the specified class 
type and, for each derived class, the properties added by the derived class.

The derived properties of a class are all the properties inherited from the 
parent class and all the properties added by the derived class.

Continuing the example from concrete properties, the derived properties of 
instances of T1 are P1 and P2. The derived properties of instances of T11 are 
P1, P2, P21, and P22.

Naming Properties

The naming properties are display_label and data_name.

Other Property Specification Elements

➤ PredefinedProperties 

PredefinedProperties can contain a QualifierProperties element and a 
SimplePredefinedProperty element for each of the other possible rules. A 
PredefinedProperties set does not necessarily contain all types of lists.

➤ PredefinedTypedProperties 

PredefinedTypedProperties is used to apply a different set of properties to 
each CI type. PredefinedTypedProperties can contain a QualifierProperties 
element and a SimpleTypedPredefinedProperty element for each of the other 
applicable rules. Because PredefinedTypedProperties is applied to each type 
individually, Derived properties are not relevant. A PredefinedProperties set 
does not necessarily contain all applicable types of lists.
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➤ CustomProperties 

CustomProperties can contain any combination of the basic PropertiesList 
and the rule-based property lists. The properties filter is the union of all the 
properties returned by all the lists.

➤ CustomTypedProperties

CustomTypedProperties can contain any combination of the basic 
PropertiesList and the applicable the rule-based property lists. The properties 
filter is the union of all the properties returned by all the lists.

➤ TypedProperties 

TypedProperties is used to pass a different set of properties for each CI type. 
TypedProperties is a collection of pairs composed of type names and 
properties sets of all types. Each properties set is applied only to the 
corresponding type.

HP UCMDB Module Query Methods

getCIsByID

getCIsByID retrieves configuration items by their UCMDB IDs.

Input:
 

Output: 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

CIsTypedProperties A typed properties collection. For details, see 
“TypedProperties” on page 312. 

IDs Only real UCMDB IDs are valid in this collection.

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 304 and 
“Processing Large Responses” on page 309.  
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getCIsByType

getCIsByType retrieves configuration items according to the type specified.

getCIsByType returns the collection of configuration items of the specified 
type and of all types that inherit from the specified type.

Input: 

Output: 

getFilteredCIsByType 

getFilteredCIsByType retrieves the configuration items of the specified type 
that meet the conditions.

getFilteredCIsByType uses conditions. A condition is comprised of a name 
field containing the name of a property, an operator field containing a 
comparison operator, and an optional value field, containing a value or list 
of values. Together, they form a boolean expression: <item>.property.value 
[operator] <condition>.value. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

type The class name. For details, see “Type Name” on 
page 301.

properties The data to be returned on each configuration item. 

For details, see “CustomProperties” on page 312. 

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 304 and 
“Processing Large Responses” on page 309. 
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For example, if the condition name is root_actualdeletionperiod, the condition 
value is 40 and the operator is Equal, the boolean statement is: 
<item>.root_actualdeletionperiod.value = = 40. The query returns all items 
whose root_actualdeletionperiod is 40, assuming there are no other 
conditions.

If the conditionsLogicalOperator argument is AND, the query returns the 
items that meet all conditions in the conditions collection. If 
conditionsLogicalOperator is OR, the query returns the items that meet at 
least one of the conditions in the conditions collection.

The following table lists the comparison operators: 

Operator Type of condition/comments

ChangedDuring Date 

This is a range check. The condition value is 
specified in hours. If the value of the date property 
is in the range of the time the method is invoked 
plus or minus the condition value, then the 
condition is true.

For example, if the condition value is 24, the 
condition is true if the value of the date property is 
between yesterday at this time and tomorrow at this 
time.

Note: The name ChangedDuring is kept to preserve 
backward compatibility. In previous versions, the 
operator was used only with create and modify time 
properties.

Equal String and numerical 

EqualIgnoreCase String

Greater Numerical

GreaterEqual Numerical

In String, numerical, and list 

The condition’s value is a list. The condition is true 
if the value of the property is one of the values in 
the list.
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InList List

The condition’s value and the property’s value are 
lists. 

The condition is true if all the values in the 
condition's list are also in the item's property list. 
There may be more property values than specified 
in the condition without effecting the truth of the 
condition.

IsNull String, numerical and list

The item's property has no value. When operator 
IsNull is used, the value of the condition is ignored, 
and in some cases can be nil.

Less Numerical

LessEqual Numerical

Like String 

The condition’s value is a substring of the value of 
the property’s value. The condition’s value must be 
bracketed with percent signs (%). For example, 
%Bi% matches ‘Bismark’ and ‘Bay of Biscay’, but 
not ‘biscuit’.

LikeIgnoreCase String

Use the LikeIgnoreCase operator as you use the Like 
operator. The match, however is not case-sensitive. 
Therefore, %Bi% matches ‘biscuit’.

Operator Type of condition/comments
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Example of setting up a condition:

Input: 

NotEqual String and numerical

UnchangedDuring Date 

This is a range check. The condition value is 
specified in hours. If the value of the date property 
is in the range of the time the method is invoked 
plus or minus the condition value, then the 
condition is false. If it is outside that range, the 
condition is true

For example, if the condition value is 24, the 
condition is true if the value of the date property is 
before yesterday at this time or after tomorrow at 
this time.

Note: The name UnchangedDuring is kept to 
preserve backward compatibility. In previous 
versions, the operator was used only with create and 
modify time properties.

FloatCondition fc = new FloatCondition();
FloatProp fp = new FloatProp();
fp.setName("attr_name");
fp.setValue(11);
fc.setCondition(fp);
fc.setFloatOperator(FloatCondition.floatOperatorEnum.Equal);

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

type The class name, see “Type Name” on page 301. 
The type can be any of the types defined using the 
CI Type Manager in the UCMDB user interface 

Operator Type of condition/comments
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Output:

getQueryNameOfView

getQueryNameOfView retrieves the name of the query (TQL) on which the 
specified view is based.

Input: 

 

Output:

 

properties The data to be returned on each configuration item. 
(Called the Query Layout in the user interface)

For details, see “CustomProperties” on page 312. 

conditions A collection of name-value pairs and the operators 
that relate one to the other. For example, 
host_hostname like QA. 

conditionsLogicalOperator If AND, all of the conditions must be met. If OR, at 
least one of the conditions must be met.

Parameter Comment

CIs Collection of CI elements. 

chunkInfo For details, see “ChunkInfo” on page 304 and 
“Processing Large Responses” on page 309. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

viewName The name of a view, that is, a sub-set of the IT 
universe in the UCMDB.

Parameter Comment

queryName The name of the TQL in the UCMDB on which the 
view is based.

Parameter Comment
317



Chapter 9 • Working with the HP Universal CMDB API
executeTopologyQueryByName

executeTopologyQueryByName retrieves the topology map that matches the 
specified query. 

Tip: The map contains more information and is easier to understand if the 
label for each CINode and each relationNode in the TQL is unique. For 
details, see “Creating Queries to Return Unambiguous TopologyMap 
Elements” on page 304.

Input: 

 

Output: 

 

executeTopologyQueryByNameWithParameters

executeTopologyQueryByNameWithParameters retrieves a topologyMap that 
matches the specified parameterized query. 

The values for the query parameters are passed in the parameterizedNodes 
argument. The specified TQL must have unique labels defined for each 
CINode and each relationNode or the method invocation fails.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

queryName The name of the TQL in the UCMDB for which to 
get the map.

Parameter Comment

topologyMap For details, see “TopologyMap” on page 303. 
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Input: 

 

Output: 

 

executeTopologyQueryWithParameters 

executeTopologyQueryWithParameters retrieves a topologyMap that matches 
the parameterized query. 

The query is passed in the queryXML argument. The values for the query 
parameters are passed in the parameterizedNodes argument. The TQL must 
have unique labels defined for each CINode and each relationNode.

executeTopologyQueryWithParameters is used to pass ad-hoc queries, rather 
than accessing a query defined in the UCMDB. You can use this method 
when you do not have access to the UCMDB user interface to define a query, 
or when you do not want to save the query to the database.

Input: 

 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

queryName The name of the parameterized TQL in the UCMDB 
for which to get the map.

parameterizedNodes The conditions each node must meet to be included 
in the query results.  

Parameter Comment

topologyMap For details, see “TopologyMap” on page 303. 

chunkInfo For details, see “ChunkInfo” on page 304 and 
“Processing Large Responses” on page 309. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.
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Output:

 

getCINeighbours

getCINeighbours returns the immediate neighbors of the specified CI. 

For example, if the query is on the neighbors of CI A, and CI A contains CI B 
which users CI C, CI B is returned, but CI C is not.

Only neighbors of the specified type are returned.

Input: 

 

queryXML An XML representation of a TQL. 

parameterizedNodes The conditions each node must meet to be included 
in the query results.  

Parameter Comment

topologyMap For details, see “TopologyMap” on page 303. 

chunkInfo For details, see “ChunkInfo” on page 304 and 
“Processing Large Responses” on page 309. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

ID The ID of the configuration item for which to 
retrieve the neighbors. This must be a real UCMDB 
ID.

neighbourType The Configuration Item Type Name of the 
neighbors to retrieve. Neighbors of the specified 
type and of types derived from that type are 
returned.

For details, see “Type Name” on page 301.

Parameter Comment
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Output:

 

pullTopologyMapChunks

pullTopologyMapChunks retrieves one of the chunks that contain the 
response to a method. 

Each chunk contains a topologyMap that is part of the response. The first 
chunk is numbered 1, so the retrieval loop counter iterates from 1 to 
<response object>.getChunkInfo().getNumberOfChunks().

For details, see “ChunkInfo” on page 304 and “Querying the HP UCMDB 
Module” on page 308.

The client application must handle the partial maps. See the example of 
handling a CIs collection below and the example of merging chunks to a 
map, mergeMaps, in the “Query Example” on page 336.

Input: 

CIProperties The data to be returned on each configuration item, 
called the Query Layout in the user interface.

For details, see “TypedProperties” on page 312. 

relationProperties The data to be returned on each relation (called the 
Query Layout in the user interface). For details, see 
“TypedProperties” on page 312

Parameter Comment

topology For details, see “Topology” on page 303. 

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

ChunkRequest The number of the chunk to retrieve and the 
ChunkInfo that was returned by the query method.  

Parameter Comment
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Output:

 

This is an example of handling chunks:

releaseChunks

releaseChunks frees the memory of the chunks that contain the data from 
the query. 

Parameter Comment

topologyMap For details, see “TopologyMap” on page 303. 

comments Disregard this value. It is for internal use by HP.

GetCIsByType request = 
new GetCIsByType(cmdbContext, typeName, customProperties);

GetCIsByTypeResponse response = 
ucmdbService.getCIsByType(request);

ChunkRequest chunkRequest = new ChunkRequest();
chunkRequest.setChunkInfo(response.getChunkInfo());
for(int j=1 ; j < response.getChunkInfo().getNumberOfChunks() ; j++) {
chunkRequest.setChunkNumber(j);
PullTopologyMapChunks req = new PullTopologyMapChunks(cmdbContext, 

chunkRequest);
PullTopologyMapChunksResponse res = 

ucmdbService.pullTopologyMapChunks(req);
for(int m=0 ; 

m < res.getTopologyMap().getCINodes().sizeCINodeList() ;
m++) { 
CIs cis = 

res.getTopologyMap().getCINodes().getCINode(m).getCIs();
for(int i=0 ; i < cis.sizeCIList() ; i++) {

// your code to process the CIs 
}

}

}
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Tip: The server discards the data after ten minutes. Calling this method to 
discard the data as soon as it has been read conserves server resources.

Input: 

Updating the HP UCMDB Module

Update the UCMD with the update APIs. For details of the API methods, see 
“HP UCMDB Module Update Methods” on page 325 in this topic.

This section includes the following topics:

➤ “HP UCMDB Update Parameters” on page 323

➤ “Use of ID Types with Update Methods” on page 324

➤ “HP UCMDB Module Update Methods” on page 325

For examples of the use of the update methods, see “Update Example” on 
page 350.

HP UCMDB Update Parameters 
This topic describes the parameters used only by the service’s update 
methods. For details, refer to the schema documentation.

CIsAndRelationsUpdates

The CIsAndRelationsUpdates type consists of CIsForUpdate, 
relationsForUpdate, and referencedCIs. A CIsAndRelationsUpdates instance 
does not necessarily have all three elements.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

chunksKey The identifier of the data on the server that was 
chunked. The key is an element of ChunkInfo.  
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CIsForUpdate is a CIs collection. relationsForUpdate is a Relations collection. 
The CI and relation elements in the collections have a props element. When 
creating a CI or relation, properties that have either the required attribute or 
the key attribute in the CI Type definition must be populated with values. 
The items in these collections are updated or created by the method. 

referencedCIs is a CIs collection of configuration items that are already 
defined in the UCMDB. The CI elements in the collection are identified with 
a temporary ID in conjunction with all the key properties. Configuration 
items in this collection are never created or updated by the method. 

Each of the CI and relation elements in these collections has a properties 
collection. New items are created with the property values in these 
collections. 

Use of ID Types with Update Methods
The following describes all the possibilities with regard to ID types and 
configuration items and relations. When the ID is not a real CMDB ID, the 
type and key attributes are required.

Deleting or Updating Configuration Items

A temporary or empty ID may be used by the client when calling a method 
to delete or update an item. In this case, the CI type and the key attributes 
that identify the CI must be set. 

Deleting or Updating Relations

When deleting or updating relations, the relation ID may be empty, 
temporary, or real. 

If a CI’s ID is temporary, then the CI must be passed in the referencedCIs 
collection and its key attributes must be specified. See referencedCIs in the 
CIsAndRelationsUpdates topic in this section.

Inserting New Configuration Items into the UCMDB

It is possible to use either an empty ID or a temporary ID to insert a new CI. 
However, if the ID is empty, the server cannot return the real UCMDB ID in 
the structure createIDsMap because there is no clientID. For details, see 
“addCIsAndRelations” on page 325.
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Inserting New Relations into the UCMDB

The relation ID can be either temporary or empty. However, if the relation is 
new but the configuration items on either end of the relation are already 
defined in the UCMDB, then those Configuration Items that already exist 
must be identified by a real UCMDB ID or be specified in a referencedCIs 
collection.

HP UCMDB Module Update Methods

addCIsAndRelations

addCIsAndRelations adds or updates Configuration Items and relations. 

If the Configuration Items or relations do not exist in UCMDB, they are 
added and their properties are set according to the contents of the 
CIsAndRelationsUpdates argument. If they already exist, they are updated with 
the new data if updateExisting is true. If updateExisting is false, 
CIsAndRelationsUpdates cannot reference existing configuration items or 
relations. Attempting to reference existing items when updateExisting is false 
results in an exception.

createIDsMap is a map or dictionary of type ClientIDToCmdbID that 
connects the client’s temporary IDs with the corresponding real UCMDB 
IDs. 

Input:

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

updateExisting Set to true to update items that already exist in the 
UCMDB. Set to false to throw an exception if any 
item already exists. 

CIsAndRelationsUpdates The items to update or create. For details, see 
“CIsAndRelationsUpdates” on page 323.
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Output: 

 

deleteCIsAndRelations

deleteCIsAndRelations removes the specified configuration items and 
relations from the UCMDB.

When a CI is deleted and the CI is one end of one or more Relation items, 
those Relation items are also deleted.

Input: 

updateCIsAndRelations

updateCIsAndRelations updates the specified Configuration Items and 
Relations. 

The update uses the property values from the CIsAndRelationsUpdates 
argument. If any of the configuration items or relations do not exist in the 
UCMDB, an exception is thrown.

Input: 

Parameter Comment

createIDsMap The map of client IDs to UCMDB IDs. For details, 
see “addCIsAndRelations” on page 325.

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

CIsAndRelationsUpdates The items to delete. For details, see 
“CIsAndRelationsUpdates” on page 323

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

CIsAndRelationsUpdates The items to delete. For details, see 
“CIsAndRelationsUpdates” on page 323
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Querying the HP UCMDB Module Class Model 

The class model methods return information about CI and Relation types. 
The class model is configured using the CI Type Manager in the UCMDB 
user interface. 

For examples of the use of the class model methods, see “Class Model 
Example” on page 354.

This section includes the following topics:

➤ “HP UCMDB Module Class Model (CIT) Methods” on page 327

HP UCMDB Module Class Model (CIT) Methods
The following methods return information about CI and Relation types. 

getClassAncestors

getClassAncestors retrieves the path between the given CI Type and its root, 
including the root. 

Input: 

Output: 

 

getAllClassesHierarchy

getAllClassesHierarchy retrieves the entire class model tree.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

className The type name. For details, see “Type Name” on 
page 301.

Parameter Comment

classHierarchy A collection of pairs of class names and parent class 
name. 

comments Disregard this value. It is for internal use by HP.
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Input: 

 

Output:

 

getCmdbClassDefinition

getCmdbClassDefinition retrieves information about the specified class.

If you use getCmdbClassDefinition to retrieve the key attributes, you must 
also query the parent classes up to the base class. getCmdbClassDefinition 
identifies as key attributes only those attributes with the ID_ATTRIBUTE set 
in the class definition specified by className. Inherited key attributes are 
not recognized as key attributes of the specified class. Therefore, the 
complete list of key attributes for the specified class is the union of all the 
keys of the class and of all its parents, up to the root.

Input: 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

Parameter Comment

classesHierarchy A collection of pairs of class name and parent class 
name. 

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

className The type name. For details, see “Type Name” on 
page 301.
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Output: 

 

Querying for Impact Analysis

The Identifier in the impact analysis methods points to the service’s response 
data. It is unique for the current response and is discarded from the server’s 
memory cache after 10 minutes of non-use.

For examples of the use of the impact analysis methods, see “Impact 
Analysis Example” on page 356.

HP UCMDB Module Impact Analysis Methods

calculateImpact

calculateImpact calculates what other configuration items are affected by 
the given CI according to the rules defined in the UCMDB. 

This shows the effect of an event triggering of the rule. The identifier output 
of calculateImpact is used as input for getImpactPath.

Input: 

Parameter Comment

cmdbClass The class definition, consisting of name, classType, 
displayLabel, description, parentName, qualifiers, and 
attributes.  

comments Disregard this value. It is for internal use by HP.

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

impactCategory The type of event that would trigger the rule being 
simulated.

IDs A collection of ID elements.  
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Output: 

 

getImpactPath

getImpactPath retrieves the topology graph of the path between the affected 
CI and the CI that affects it. 

The identifier output of calculateImpact is the used as the identifier input 
argument of getImpactPath.

Input: 

Output: 

 

impactRulesNames A collection of ImpactRuleName elements.

severity The severity of the triggering event.

Parameter Comment

impactTopology For details, see “Topology” on page 303. 

identifier The key to the server response. 

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

identifier The key to the server response that was returned by 
calculateImpact.

relation A Relation based on one of the ShallowRelations 
returned by calculateImpact in the impactTopology 
element. 

Parameter Comment

impactPathTopology A CIs collection and an ImpactRelations collection.  

comments Disregard this value. It is for internal use by HP.

Parameter Comment
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An ImpactRelations element consists of an ID, type, end1ID, end2ID, a rule, and 
an action.

getImpactRulesByNamePrefix

getImpactRulesByNamePrefix retrieves rules using a prefix filter.

This method applies to impact rules that are named with a prefix that 
indicates the context to which they apply, for example, SAP_myrule, 
ORA_myrule, and so on. This method filters all impact rule name for those 
beginning with the prefix specified by the ruleNamePrefixFilter argument.

Input: 

Output:

Parameter Comment

cmdbContext For details, see “CmdbContext” on page 299.

ruleNamePrefixFilter A string containing the first letters of the rule names 
to match. 

Parameter Comment

impactRules impactRules is composed of zero or more 
impactRule. An impactRule, which specifies the 
effect of a change, is composed of ruleName, 
description, queryName, and isActive.
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Use Cases

The following use cases assume two systems:

➤ HP Universal CMDB server

➤ A third-party system that contains a repository of configuration items

This section includes the following topics:

➤ “Populating the UCMDB” on page 332

➤ “Querying the HP UCMDB” on page 332

➤ “Querying the Class Model” on page 333

➤ “Analyzing Change Impact” on page 333

Populating the UCMDB
Use cases:

➤ A third-party asset management updates the UCMDB with information 
available only in asset management 

➤ A number of third-party systems populate the UCMDB to create a central 
CMDB that can track changes and perform impact analysis

➤ A third-party system creates Configuration Items and Relations according to 
third-party business logic to leverage the CMDB query capabilities 

Querying the HP UCMDB 
Use cases:

➤ A third-party system gets the Configuration Items and Relations that 
represent the SAP system by getting the results of the SAP TQL

➤ A third-party system gets the list of Oracle servers that have been added or 
changed in the last five hours

➤ A third-party system gets the list of servers whose host name contains the 
substring lab

➤ A third-party system finds the elements related to a given CI by getting its 
neighbors
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Querying the Class Model
Use cases:

➤ A third-party system enables users to specify the set of data to be retrieved 
from the UCMDB. A user interface can be built over the class model to show 
users the possible properties and prompt them for required data. The user 
can then choose the information to be retrieved.

➤ A third-party system explores the class model when the user cannot access 
the UCMDB user interface.

Analyzing Change Impact 
Use case:

A third-party system outputs a list of the business services that could be 
impacted by a change on a specified host.

Examples

This section includes the following topics:

➤ “The Example Base Class” on page 333

➤ “Query Example” on page 336

➤ “Update Example” on page 351

➤ “Class Model Example” on page 354

➤ “Impact Analysis Example” on page 357

The Example Base Class
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.services.UcmdbService;
import com.hp.ucmdb.generated.services.UcmdbServiceStub;
import com.hp.ucmdb.generated.types.CmdbContext;
import org.apache.axis2.AxisFault;
import org.apache.axis2.transport.http.HTTPConstants;
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import org.apache.axis2.transport.http.HttpTransportProperties;

import java.net.MalformedURLException;
import java.net.URL;

/**
* User: hbarkai
* Date: Jul 12, 2007
*/
abstract class Demo {

UcmdbService stub;
CmdbContext context;

public void initDemo() {
try {

setStub(createUcmdbService("admin", "admin"));
setContext();

} catch (Exception e) {
//handle exception

}
}

public UcmdbService getStub() {
return stub;

}

public void setStub(UcmdbService stub) {
this.stub = stub;

}

public CmdbContext getContext() {
return context;

}

public void setContext() {
CmdbContext context = new CmdbContext();
context.setCallerApplication("demo");
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this.context = context;
}

//connection to service  - for axis2/jibx client

private static final String PROTOCOL = "http";
private static final String HOST_NAME = "host_name";
private static final int PORT = 8080;
private static final String FILE = "/axis2/services/UcmdbService";

protected UcmdbService createUcmdbService
(String username, String password) throws Exception{

URL url;
UcmdbServiceStub serviceStub;
try {

 url = new URL
(Demo.PROTOCOL, Demo.HOST_NAME, 
Demo.PORT, Demo.FILE);

 serviceStub = new UcmdbServiceStub(url.toString());
 HttpTransportProperties.Authenticator auth =

new HttpTransportProperties.Authenticator();
 auth.setUsername(username);
 auth.setPassword(password);

serviceStub._getServiceClient().getOptions().setProperty
(HTTPConstants.AUTHENTICATE,auth);

} catch (AxisFault axisFault) {
throw new Exception
("Failed to create SOAP adapter for "

+ Demo.HOST_NAME , axisFault);
} catch (MalformedURLException e) {

throw new Exception
("Failed to create SOAP adapter for "

+ Demo.HOST_NAME, e);
}
return serviceStub;

 }
}
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Query Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.query.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import com.hp.ucmdb.generated.services.UcmdbService;
import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.props.*;

import java.rmi.RemoteException;

public class QueryDemo extends Demo{

UcmdbService stub;
CmdbContext context;

public void getCIsByTypeDemo() {
GetCIsByType request = new GetCIsByType();
//set cmdbcontext
CmdbContext cmdbContext = getContext();
request.setCmdbContext(cmdbContext);
//set CIs type
request.setType("anyType");
//set CIs propeties to be retrieved
CustomProperties customProperties = new CustomProperties();
PredefinedProperties predefinedProperties = 

new PredefinedProperties();
SimplePredefinedProperty simplePredefinedProperty = 

new SimplePredefinedProperty();
simplePredefinedProperty.setName

(SimplePredefinedProperty.nameEnum.DERIVED);
SimplePredefinedPropertyCollection 

simplePredefinedPropertyCollection = 
new SimplePredefinedPropertyCollection();

simplePredefinedPropertyCollection.addSimplePredefinedProperty
(simplePredefinedProperty);
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predefinedProperties.setSimplePredefinedProperties
(simplePredefinedPropertyCollection);

customProperties.setPredefinedProperties(predefinedProperties);
request.setProperties(customProperties);
try {

GetCIsByTypeResponse response =
getStub().getCIsByType(request);

TopologyMap map =
getTopologyMapResultFromCIs

(response.getCIs(), response.getChunkInfo());
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getCIsByIdDemo() {
GetCIsById request = new GetCIsById();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set ids
ID id1 = new ID();
id1.setBase("cmdbobjectidCIT1");
ID id2 = new ID();
id2.setBase("cmdbobjectidCIT2");
IDs ids = new IDs();
ids.addID(id1);
ids.addID(id2);
request.setIDs(ids);
//set CIs properties to be retrieved
TypedPropertiesCollection properties = 

new TypedPropertiesCollection();

TypedProperties typedProperties1 =
new TypedProperties();

typedProperties1.setType("CIT1");
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CustomTypedProperties customProperties1 =
new CustomTypedProperties();

PredefinedTypedProperties predefinedProperties1 = 
new PredefinedTypedProperties();

SimpleTypedPredefinedProperty simplePredefinedProperty1 = 
new SimpleTypedPredefinedProperty();

simplePredefinedProperty1.setName
(SimpleTypedPredefinedProperty.nameEnum.CONCRETE);

SimpleTypedPredefinedPropertyCollection
simplePredefinedPropertyCollection1 = 

new SimpleTypedPredefinedPropertyCollection();
simplePredefinedPropertyCollection1

.addSimpleTypedPredefinedProperty
(simplePredefinedProperty1);

predefinedProperties1.
setSimpleTypedPredefinedProperties

(simplePredefinedPropertyCollection1);
customProperties1.

setPredefinedTypedProperties
(predefinedProperties1);

typedProperties1.setProperties(customProperties1);
properties.addTypedProperties(typedProperties1);

TypedProperties typedProperties2 = 
new TypedProperties();

typedProperties2.setType("CIT2");
CustomTypedProperties customProperties2 = 

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties2 = 

new PredefinedTypedProperties();
SimpleTypedPredefinedProperty simplePredefinedProperty2 = 

new SimpleTypedPredefinedProperty();
simplePredefinedProperty2.setName

(SimpleTypedPredefinedProperty.nameEnum.NAMING);
SimpleTypedPredefinedPropertyCollection

simplePredefinedPropertyCollection2 = 
new SimpleTypedPredefinedPropertyCollection();

simplePredefinedPropertyCollection2.
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addSimpleTypedPredefinedProperty
(simplePredefinedProperty2);

predefinedProperties2.setSimpleTypedPredefinedProperties
(simplePredefinedPropertyCollection2);

customProperties2.setPredefinedTypedProperties
(predefinedProperties2);

typedProperties2.setProperties(customProperties2);
properties.addTypedProperties(typedProperties2);

request.setCIsTypedProperties(properties);
try {

GetCIsByIdResponse response = 
getStub().getCIsById(request);

CIs cis = response.getCIs();
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getFilteredCIsByTypeDemo() {
GetFilteredCIsByType request = new GetFilteredCIsByType();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set CIs type
request.setType("anyType");
//sets Filter conditions
Conditions conditions = new Conditions();
IntConditions intConditions = new IntConditions();
IntCondition intCondition = new IntCondition();
IntProp intProp = new IntProp();
intProp.setName("int_attr1");
intProp.setValue(100);
intCondition.setCondition(intProp);
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intCondition.setIntOperator
(IntCondition.intOperatorEnum.Greater);

intConditions.addIntCondition(intCondition);
conditions.setIntConditions(intConditions);
request.setConditions(conditions);
//set logical operator for conditions
request.setConditionsLogicalOperator

(GetFilteredCIsByType.conditionsLogicalOperatorEnum.AND);
//set CIs properties to be retrieved
CustomProperties customProperties =

new CustomProperties();
PredefinedProperties predefinedProperties = 

new PredefinedProperties();
SimplePredefinedProperty simplePredefinedProperty = 

new SimplePredefinedProperty();
simplePredefinedProperty.setName

(SimplePredefinedProperty.nameEnum.NAMING);
SimplePredefinedPropertyCollection 

simplePredefinedPropertyCollection =
new SimplePredefinedPropertyCollection();

simplePredefinedPropertyCollection.
addSimplePredefinedProperty

(simplePredefinedProperty);
predefinedProperties.setSimplePredefinedProperties

(simplePredefinedPropertyCollection);
customProperties.setPredefinedProperties

(predefinedProperties);

request.setProperties(customProperties);
try {

GetFilteredCIsByTypeResponse response =
getStub().getFilteredCIsByType(request);

TopologyMap map =
getTopologyMapResultFromCIs

(response.getCIs(), response.getChunkInfo());
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
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}

}

public void executeTopologyQueryByNameDemo() {
ExecuteTopologyQueryByName request = new 

ExecuteTopologyQueryByName();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query name
request.setQueryName("queryName");

try {
ExecuteTopologyQueryByNameResponse response =

getStub().executeTopologyQueryByName(request);
TopologyMap map =

getTopologyMapResult
(response.getTopologyMap(), response.getChunkInfo());

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

// assume the follow query was defined at UCMDB
// Query Name: exampleQuery
// Query sketch:
//    Host
//    /  \
//  ip Disk
// Query Parameters:
//   Host-
//   host_os (like)
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//   Disk-
//   disk_failures (equal)

public void executeTopologyQueryByNameWithParametersDemo() {
ExecuteTopologyQueryByNameWithParameters request =

new ExecuteTopologyQueryByNameWithParameters();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query name
request.setQueryName("queryName");
//set parameters
ParameterizedNode hostParametrizedNode = 

new ParameterizedNode();
hostParametrizedNode.setNodeLabel("Host");
CIProperties parameters = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp = new StrProp();
strProp.setName("host_os");
strProp.setValue("%2000%");
strProps.addStrProp(strProp);
parameters.setStrProps(strProps);
hostParametrizedNode.setParameters(parameters);
request.addParameterizedNodes(hostParametrizedNode);
ParameterizedNode diskParametrizedNode = 

new ParameterizedNode();
diskParametrizedNode.setNodeLabel("Disk");
CIProperties parameters1 = new CIProperties();
IntProps intProps = new IntProps();
IntProp intProp = new IntProp();
intProp.setName("disk_failures");
intProp.setValue(30);
intProps.addIntProp(intProp);
parameters1.setIntProps(intProps);
diskParametrizedNode.setParameters(parameters1);
request.addParameterizedNodes(diskParametrizedNode);
try {

ExecuteTopologyQueryByNameWithParametersResponse 
response =
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getStub().executeTopologyQueryByNameWithParameters
(request);

TopologyMap map =
getTopologyMapResult

(response.getTopologyMap(), response.getChunkInfo());
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

/ // assume the follow query was defined at UCMDB
// Query Name: exampleQuery
// Query sketch:
//    Host
//    /  \
//  ip Disk
// Query Parameters:
//   Host-
//   host_os (like)
//   Disk-
//   disk_failures (equal)

public void executeTopologyQueryWithParametersDemo() {
ExecuteTopologyQueryWithParameters request = 

new ExecuteTopologyQueryWithParameters();
CmdbContext cmdbContext = getContext();
//set cmdbcontext
request.setCmdbContext(cmdbContext);
//set query definition
String queryXml = "<xml that represents the query above>";
request.setQueryXml(queryXml);
//set parameters
ParameterizedNode hostParametrizedNode = 

new ParameterizedNode();
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hostParametrizedNode.setNodeLabel("Host");
CIProperties parameters = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp = new StrProp();
strProp.setName("host_os");
strProp.setValue("%2000%");
strProps.addStrProp(strProp);
parameters.setStrProps(strProps);
hostParametrizedNode.setParameters(parameters);
request.addParameterizedNodes(hostParametrizedNode);
ParameterizedNode diskParametrizedNode = 

new ParameterizedNode();
diskParametrizedNode.setNodeLabel("Disk");
CIProperties parameters1 = new CIProperties();
IntProps intProps = new IntProps();
IntProp intProp = new IntProp();
intProp.setName("disk_failures");
intProp.setValue(30);
intProps.addIntProp(intProp);
parameters1.setIntProps(intProps);
diskParametrizedNode.setParameters(parameters1);
request.addParameterizedNodes(diskParametrizedNode);
try {

ExecuteTopologyQueryWithParametersResponse 
response = getStub().executeTopologyQueryWithParameters

(request);
TopologyMap map =

getTopologyMapResult
(response.getTopologyMap(), response.getChunkInfo());

 } catch (RemoteException e) {
 //handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}
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public void getCINeighboursDemo() {
GetCINeighbours request = new GetCINeighbours();
//set cmdbcontext
CmdbContext cmdbContext = getContext();
request.setCmdbContext(cmdbContext);
// set CI id
ID id = new ID();
id.setBase("cmdbobjectidCIT1");
request.setID(id);
//set neighbour type
request.setNeighbourType("neighbourType");
//set Neighbours CIs propeties to be retrieved
TypedPropertiesCollection properties = 

new TypedPropertiesCollection();
TypedProperties typedProperties1 = new TypedProperties();
typedProperties1.setType("neighbourType");
CustomTypedProperties customProperties1 = 

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties1 =

new PredefinedTypedProperties();
QualifierProperties qualifierProperties =

new QualifierProperties();
qualifierProperties.addQualifierName("ID_ATTRIBUTE");
predefinedProperties1.setQualifierProperties(qualifierProperties);
customProperties1.setPredefinedTypedProperties

(predefinedProperties1);
typedProperties1.setProperties(customProperties1);
properties.addTypedProperties(typedProperties1);
request.setCIProperties(properties);

TypedPropertiesCollection relationsProperties =
new TypedPropertiesCollection();

TypedProperties typedProperties2 = new TypedProperties();
typedProperties2.setType("relationType");
CustomTypedProperties customProperties2 = 

new CustomTypedProperties();
PredefinedTypedProperties predefinedProperties2 = 

new PredefinedTypedProperties();
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SimpleTypedPredefinedProperty simplePredefinedProperty2 =
new SimpleTypedPredefinedProperty();

simplePredefinedProperty2.setName
(SimpleTypedPredefinedProperty.nameEnum.CONCRETE);

SimpleTypedPredefinedPropertyCollection
simplePredefinedPropertyCollection2 = 

new SimpleTypedPredefinedPropertyCollection();
simplePredefinedPropertyCollection2.

addSimpleTypedPredefinedProperty
(simplePredefinedProperty2);

predefinedProperties2.
setSimpleTypedPredefinedProperties

(simplePredefinedPropertyCollection2);
customProperties2.setPredefinedTypedProperties

(predefinedProperties2);
typedProperties2.setProperties(customProperties2);
relationsProperties.addTypedProperties(typedProperties2);
request.setRelationProperties(relationsProperties);

try {
GetCINeighboursResponse response =

getStub().getCINeighbours(request);
Topology topology = response.getTopology();

   } catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
 //handle exception

}

}

//get Topology Map for chunked/non-chunked result

private TopologyMap getTopologyMapResult(TopologyMap topologyMap, 
ChunkInfo chunkInfo) {
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if(chunkInfo.getNumberOfChunks() == 0) {
return topologyMap;

} else {
topologyMap = new TopologyMap();
for(int i=1 ; i <= chunkInfo.getNumberOfChunks() ; i++) {

ChunkRequest chunkRequest = new ChunkRequest();
chunkRequest.setChunkInfo(chunkInfo);
chunkRequest.setChunkNumber(i);
PullTopologyMapChunks req = 

new PullTopologyMapChunks();
req.setChunkRequest(chunkRequest);
req.setCmdbContext(getContext());
PullTopologyMapChunksResponse res = null;
try  {

res = getStub().pullTopologyMapChunks(req);
TopologyMap map = res.getTopologyMap();
topologyMap = mergeMaps(topologyMap, map);

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}
}

}
return topologyMap;

}

private TopologyMap getTopologyMapResultFromCIs(CIs cis, ChunkInfo 
chunkInfo) {

TopologyMap topologyMap = new TopologyMap();
if(chunkInfo.getNumberOfChunks() == 0) {

CINode ciNode = new CINode();
ciNode.setLabel("");
ciNode.setCIs(cis);
CINodes ciNodes = new CINodes();
ciNodes.addCINode(ciNode);
topologyMap.setCINodes(ciNodes);
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} else {
for(int i=1 ; i <= chunkInfo.getNumberOfChunks() ; i++) {

ChunkRequest chunkRequest =
new ChunkRequest();

chunkRequest.setChunkInfo(chunkInfo);
chunkRequest.setChunkNumber(i);
PullTopologyMapChunks req = 

new PullTopologyMapChunks();
req.setChunkRequest(chunkRequest);
req.setCmdbContext(getContext());
PullTopologyMapChunksResponse res = null;
try  {

res = getStub().pullTopologyMapChunks(req);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}
TopologyMap map = res.getTopologyMap();
topologyMap = mergeMaps(topologyMap, map);

}
//release chunks
ReleaseChunks req = new ReleaseChunks();
req.setChunksKey(chunkInfo.getChunksKey());
req.setCmdbContext(getContext());
try {

getStub().releaseChunks(req);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}
return topologyMap;

}

//===================================================
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/*  WARNING merge will be correct only if a each node is given
a unique name. This applies to both CI and Relation nodes .*/

//===================================================
private TopologyMap mergeMaps(TopologyMap topologyMap, TopologyMap 

newMap) {
for(int i=0 ; i < newMap.getCINodes().sizeCINodeList() ; i++ ) {

CINode ciNode = newMap.getCINodes().getCINode(i);
boolean alreadyExist = false;
if(topologyMap.getCINodes() == null) {

topologyMap.setCINodes(new CINodes());
}
for(int j=0 ; j < topologyMap.getCINodes().sizeCINodeList() ; j++) {

CINode ciNode2 = topologyMap.getCINodes().getCINode(j);
if(ciNode2.getLabel().equals(ciNode.getLabel())){

CIs cisTOAdd = ciNode.getCIs();
CIs cis =

mergeCIsGroups
(topologyMap.getCINodes().getCINode(j).getCIs(),

cisTOAdd);
topologyMap.getCINodes().getCINode(j).setCIs(cis);
alreadyExist = true;

}
}
if(!alreadyExist) {

topologyMap.getCINodes().addCINode(ciNode);
}

}

for(int i=0 ; i < newMap.getRelationNodes().sizeRelationNodeList() ; i++ ) {
RelationNode relationNode =

newMap.getRelationNodes().getRelationNode(i);
boolean alreadyExist = false;
if(topologyMap.getRelationNodes() == null) {

topologyMap.setRelationNodes(new RelationNodes());
}
for(int j=0 ; 

j < topologyMap.getRelationNodes().sizeRelationNodeList() ;
j++) {
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RelationNode relationNode2 =
topologyMap.getRelationNodes().getRelationNode(j);

if(relationNode2.getLabel().equals(relationNode.getLabel())){
Relations relationsTOAdd = relationNode.getRelations();
Relations relations =

mergeRelationsGroups
(topologyMap.getRelationNodes().

getRelationNode(j).getRelations(),
relationsTOAdd);

topologyMap.getRelationNodes().
getRelationNode(j).setRelations(relations);

alreadyExist = true;
}

}
if(!alreadyExist) {

topologyMap.getRelationNodes().addRelationNode(relationNode);
}

}

return topologyMap;

}

private Relations mergeRelationsGroups(Relations relations1, Relations 
relations2) {

for(int i=0 ; i < relations2.sizeRelationList() ; i++) {
relations1.addRelation(relations2.getRelation(i));

}
return relations2;

}

private CIs mergeCIsGroups(CIs cis1, CIs cis2) {
for(int i=0 ; i < cis2.sizeCIList() ; i++) {

cis1.addCI(cis2.getCI(i));
}
return cis1;
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}

}

Update Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.update.AddCIsAndRelations;
import 
com.hp.ucmdb.generated.params.update.AddCIsAndRelationsResponse;
import com.hp.ucmdb.generated.params.update.UpdateCIsAndRelations;
import com.hp.ucmdb.generated.params.update.DeleteCIsAndRelations;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.update.CIsAndRelationsUpdates;
import com.hp.ucmdb.generated.types.update.ClientIDToCmdbID;

import java.rmi.RemoteException;

public class UpdateDemo extends Demo{

public void getAddCIsAndRelationsDemo() {
AddCIsAndRelations request = new AddCIsAndRelations();
request.setCmdbContext(getContext());
request.setUpdateExisting(true);
CIsAndRelationsUpdates updates = new CIsAndRelationsUpdates();
CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("temp1");
id.setTemp(true);
ci.setID(id);
ci.setType("host");
CIProperties props = new CIProperties();
StrProps strProps = new StrProps();
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StrProp strProp = new StrProp();
strProp.setName("host_key");
String value = "blabla";
strProp.setValue(value);
strProps.addStrProp(strProp);
props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

AddCIsAndRelationsResponse response  =
getStub().addCIsAndRelations(request);

for(int i = 0  ;  i < response.sizeCreatedIDsMapList() ; i++) {
ClientIDToCmdbID idsMap = response.getCreatedIDsMap(i);
//do something

}
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getUpdateCIsAndRelationsDemo() {
UpdateCIsAndRelations request = new UpdateCIsAndRelations();
request.setCmdbContext(getContext());

CIsAndRelationsUpdates updates =
new CIsAndRelationsUpdates();

CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("temp1");
id.setTemp(true);
ci.setID(id);
ci.setType("host");
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CIProperties props = new CIProperties();
StrProps strProps = new StrProps();

StrProp hostKeyProp = new StrProp();
hostKeyProp.setName("host_key");
String hostKeyValue = "blabla";
hostKeyProp.setValue(hostKeyValue);
strProps.addStrProp(hostKeyProp);

StrProp hostOSProp = new StrProp();
hostOSProp.setName("host_os");
String hostOSValue = "winXP";
hostOSProp.setValue(hostOSValue);
strProps.addStrProp(hostOSProp);

StrProp hostDNSProp = new StrProp();
hostDNSProp.setName("host_dnsname");
String hostDNSValue = "dnsname";
hostDNSProp.setValue(hostDNSValue);
strProps.addStrProp(hostDNSProp);

props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

getStub().updateCIsAndRelations(request);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getDeleteCIsAndRelationsDemo() {
DeleteCIsAndRelations request = 
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new DeleteCIsAndRelations();
request.setCmdbContext(getContext());
CIsAndRelationsUpdates updates = 

new CIsAndRelationsUpdates();
CIs cis = new CIs();
CI ci = new CI();
ID id = new ID();
id.setBase("stam");
id.setTemp(true);
ci.setID(id);
ci.setType("host");
CIProperties props = new CIProperties();
StrProps strProps = new StrProps();
StrProp strProp1 = new StrProp();
strProp1.setName("host_key");
String value1 = "for_delete";
strProp1.setValue(value1);
strProps.addStrProp(strProp1);
props.setStrProps(strProps);
ci.setProps(props);
cis.addCI(ci);
updates.setCIsForUpdate(cis);
request.setCIsAndRelationsUpdates(updates);
try {

getStub().deleteCIsAndRelations(request);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

}

Class Model Example
package com.hp.ucmdb.demo;
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import com.hp.ucmdb.generated.params.classmodel.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import 
com.hp.ucmdb.generated.types.classmodel.UcmdbClassModelHierarchy;
import com.hp.ucmdb.generated.types.classmodel.UcmdbClass;

import java.rmi.RemoteException;

public class ClassmodelDemo extends Demo{

public void getClassAncestorsDemo() {
GetClassAncestors request = 

new GetClassAncestors();
request.setCmdbContext(getContext());
request.setClassName("className");
try {

GetClassAncestorsResponse response  =
getStub().getClassAncestors(request);

UcmdbClassModelHierarchy hierarchy =
response.getClassHierarchy();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

public void getAllClassesHierarchyDemo() {
GetAllClassesHierarchy request = 

new GetAllClassesHierarchy();
request.setCmdbContext(getContext());
try {

GetAllClassesHierarchyResponse response  =
getStub().getAllClassesHierarchy(request);

UcmdbClassModelHierarchy hierarchy =
response.getClassesHierarchy();
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} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

public void getCmdbClassDefinitionDemo() {
GetCmdbClassDefinition request = 

new GetCmdbClassDefinition();
request.setCmdbContext(getContext());
request.setClassName("className");
try {

GetCmdbClassDefinitionResponse response  =
getStub().getCmdbClassDefinition(request);
UcmdbClass ucmdbClass = response.getUcmdbClass();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}

}

}
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Impact Analysis Example
package com.hp.ucmdb.demo;

import com.hp.ucmdb.generated.params.impact.*;
import com.hp.ucmdb.generated.services.UcmdbFaultException;
import com.hp.ucmdb.generated.types.*;
import com.hp.ucmdb.generated.types.impact.*;

import java.rmi.RemoteException;

/**
 * User: hbarkai
 * Date: Jul 17, 2007
 */
public class ImpactDemo extends Demo{

//Impact Rule Name : impactExample
//Impact Query:
//  Network
//  |
// Host
//  |
//  IP
//Impact Action: network affect on ip ;severity 100% ; category: change
//
public void calculateImpactAndGetImpactPathDemo() {

CalculateImpact request = new CalculateImpact();
request.setCmdbContext(getContext());
//set root cause ids
IDs ids = new IDs();
ID id = new ID();
id.setBase("rootCauseCmdbID");
ids.addID(id);
request.setIDs(ids);
//set impact category
request.setImpactCategory("change");
//set rule Names
ImpactRuleNames impactRuleNames = new ImpactRuleNames();
ImpactRuleName impactRuleName = new ImpactRuleName();
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impactRuleName.setBase("impactExample");
impactRuleNames.addImpactRuleName(impactRuleName);
request.setImpactRuleNames(impactRuleNames);
//set severity
request.setSeverity(100);
CalculateImpactResponse response =

new CalculateImpactResponse();
try {

response  = getStub().calculateImpact(request);
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}
Identifier identifier= response.getIdentifier();
Topology topology = response.getImpactTopology();
Relation relation = topology.getRelations().getRelation(0);
GetImpactPath request2 = new GetImpactPath();
//set cmdb context
request2.setCmdbContext(getContext());
//set impact identifier
request2.setIdentifier(identifier);
//set shallowRelation
ShallowRelation shallowRelation = new ShallowRelation();
shallowRelation.setID(relation.getID());
shallowRelation.setEnd1ID(relation.getEnd1ID());
shallowRelation.setEnd2ID(relation.getEnd2ID());
shallowRelation.setType(relation.getType());
request2.setRelation(shallowRelation);

try {
GetImpactPathResponse response2 =

getStub().getImpactPath(request2);
ImpactTopology impactTopology =

response2.getImpactPathTopology();
} catch (RemoteException e) {

//To change body of catch statement
// use File | Settings | File Templates.
e.printStackTrace();
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} catch (UcmdbFaultException e) {
//To change body of catch statement
// use File | Settings | File Templates.
e.printStackTrace();

}

}

public void getImpactRulesByGroupName() {
GetImpactRulesByGroupName request =

new GetImpactRulesByGroupName();
//set cmdb context
request.setCmdbContext(getContext());
//set group names list
request.addRuleGroupNameFilter("groupName1");
request.addRuleGroupNameFilter("groupName2");
try {

GetImpactRulesByGroupNameResponse response  =
getStub().getImpactRulesByGroupName(request);

ImpactRules impactRules = response.getImpactRules();
} catch (RemoteException e) {

//handle exception
} catch (UcmdbFaultException e) {

//handle exception
}

}

public void getImpactRulesByNamePrefix() {
GetImpactRulesByNamePrefix request =

new GetImpactRulesByNamePrefix();
//set cmdb context
request.setCmdbContext(getContext());
//set prefixes list
request.addRuleNamePrefixFilter("prefix1");
try {

GetImpactRulesByNamePrefixResponse response  =
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getStub().getImpactRulesByNamePrefix(request);
ImpactRules impactRules = response.getImpactRules();

} catch (RemoteException e) {
//handle exception

} catch (UcmdbFaultException e) {
//handle exception

}
}

}
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Working with the Dashboard API

This chapter describes how to retrieve a list of all available views in an 
HP Business Availability Center system through a URL-based query to the 
database.

Building Queries

You use the Dashboard API to query the database and return a list of views 
in XML format.

Tip: You can use XSLT to convert the XML output into any other format 
(commonly text or HTML). For example, using basic XSLT transformations, 
you can produce HTML reports that are formatted to fit on mobile devices. 
These reports can be served via a mobile portal to display critical Business 
Availability Center views on users’ mobile phones.

This chapter describes: On page:

Building Queries 361

Query Examples 364
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Query Syntax
The basic syntax of the query is as follows:

http://<Gateway 
Server>/topaz/bam/BAMOpenApi?customerId=<customer 
ID>&userName=<user 
name>&password=<password>&command=<command parameter>

Depending on the command parameter defined, additional parameters may 
also be included.

Main Parameters Used in the Query
The table below lists the parameters that must be defined in the query.

Parameter Description

customerID HP Business Availability Center customers should 
specify 1. HP Managed Software Solutions 
customers should specify their unique customer ID.

userName Specify a user name defined in HP Business 
Availability Center. Note that the query does not 
encrypt the login credentials.

password Specify the password for the user name provided. 
Note that the query does not encrypt the login 
credentials.

command Specify one of the following values:

getViews – Specify to retrieve all views from the 
CMDB. No other parameters are required.

getNodes – Specify to retrieve all child nodes of a 
specified view (you must also specify the view for 
which to retrieve child nodes in the viewName 
parameter); if using this command parameter you 
can also set the following parameters: showTooltip, 
depth, layout
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viewName If the getNodes command parameter is defined, 
include this parameter in the query and specify the 
view to retrieve. You can set the value to 
ticker_all_views to retrieve all views and their 
nodes.

showTooltip If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify whether to display Dashboard’s KPI tooltip 
data, either true to display data or false to not. The 
default value is false.

depth If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the number of levels in the view to display. 
The default value is 1.

layout If the getNodes command parameter is defined, 
you can include this parameter in the query to 
specify the layout for the query results, either 
hierarchical or flat. In flat mode all nodes are 
retrieved in a flat list, and in hierarchical mode 
nodes are retrieved in the same hierarchy as in the 
view. The default value is flat.

Parameter Description
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Query Examples

Below are examples of queries and the data they return.

➤ The query below returns a flat list of all views in the CMDB.

http://myserver/topaz/bam/BAMOpenApi?customerId=1&userName=admi
n&password=admin&command=getViews

➤ The query below returns a hierarchical tree showing KPI status and tooltip 
information for the Service Measurements view, to a depth of three child 
nodes.

http://myserver/topaz/bam/BAMOpenApi?customerId=1&userName=admi
n&password=admin&command=getNodes&viewName=Service%20Measur
ements&showTooltip=true&depth=3&layout=hierarchical
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Enterprise Management Systems 
Integration

This chapter describes the Enterprise Management Systems integration.

This chapter describes: On page:

Concepts

About Enterprise Management Systems 368

About the EMS Integration Application 368

Assignment Rules Mechanism and KPI Propagation 369

Understanding the HP OVO Integration 370

Understanding the HP Service Center Integration 373

Understanding the Application<-->Host or Host Integration Adapters 375

Reconciliation of Hosts 377

Tasks

Integrate Data from Third-Party Sources (EMS Data) into HP Business 
Availability Center

380

Define the KPI Assignment Rule 388

Use the EMS Integration Tool for HP ServiceCenter Data 390

Use the EMS Integration Tool for HP OVO Server Data 395
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About Enterprise Management Systems

HP Business Availability Center has the ability to integrate with existing 
EMS (Enterprise Management Systems) software and provides the capability 
to build new integrations or to customize out-of-the-box integrations (for 
example: HP OVO).

SiteScope Integration Monitors integrate measurements, open incidents, 
alerts, and events generated by Enterprise Management Systems software 
into HP Business Availability Center reports. Enterprise Management 
Systems integrations can integrate alerts generated by HP Business 
Availability Center, Dashboard, and Service Level Management into your 
Enterprise Management Systems program.

About the EMS Integration Application

The EMS Integrations application helps you customize the Integration 
Monitor configuration files to correctly map the data Integration Monitors 
collect to a format recognizable by HP Business Availability Center, provides 
out-of-the-box integrations, and enriches your business views. 

The EMS Integrations application enables you to sketch a CIT relationship 
map of the integration you are creating to help you formulate the KPI 
assignment rules that are described below.

You can directly access the System Availability Management Administration 
via a window in the EMS Integration application, where you can access a 
SiteScope and deploy integration monitors to collect performance and 
availability data from your EMS. That information, which can represent 
CPU, disk space, or other information, provides the global status of the EMS 
Monitor CI. 

You can create or customize a KPI assignment rule for each integration CI 
type in the CIT relationship map you sketched previously. An assignment 
rule consists of a condition and a task. The condition describes specific 
characteristics of a CI. The task describes the context menus, KPIs, rules, rule 
parameters, and selectors that are to be assigned automatically to the CI 
when the condition occurs, if the assignment is running. For details, see 
“Assignment Rules Mechanism and KPI Propagation” on page 369.
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You can then display the view that is created by the integration.

An EMS integration is used to display, in Dashboard, an overview of data 
from other applications. It is not a run-time solution where you can see 
events and errors as they occur.

Assignment Rules Mechanism and KPI Propagation

The Dashboard and Service Level Management KPIs assignment rules 
mechanism receives notification from the CMDB about the creation of 
monitor CIs. When a specific monitor CI attribute is updated and the 
assignment rule conditions for that CI are based on the updated attribute, 
the assignment rules mechanism is performed. The assignment rules 
mechanism:

➤ creates the KPI attached to the monitor CI

➤ assigns the business rule to the KPI with parameters that may be based on 
attributes of the monitor CI

➤ assigns objectives that can be based on attributes of the monitor CI

➤ assigns selectors that can be based on attributes of the monitor CI

➤ adds the context menus

The assignment rules mechanism is an HP Business Availability Center 
service and can be managed by Service Manager. For details, see “Service 
Manager Dialog Box” in Platform Administration.

After the service is stopped, it completes the missed assignments as soon as 
it is restarted.

The assignment rules mechanism is deployed on the Data Processing server.

Note: It is recommended to create assignment rules only for monitor CIs.

In EMS integration, the topology is added either when performing discovery 
or by the EMS Integration monitors.
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The regular propagation mechanism propagates the assignment rule KPIs to 
higher levels in the model. For details, see “How Dashboard KPIs Work” in 
Using Dashboard.

For details about creating assignments, see “Define Assignment 
Configuration Dialog Box” on page 418.

Understanding the HP OVO Integration

This section describes the main concepts of the HP OVO integration adapter. 
For details on creating an HP OVO integration, see “Use the EMS Integration 
Tool for HP OVO Server Data” on page 395.

This section includes the following topics:

➤ “OVO Hierarchies” on page 371

➤ “CIs and KPIs for HP OVO” on page 371

➤ “OVO Rules” on page 372

➤ “OVO Context Menus, Context Menu Items, and Tooltip in Dashboard” on 
page 373
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OVO Hierarchies
When you select this integration adapter and enable the KPI enrichment, 
the relevant CIs, hierarchy, and pattern view are created in the CMDB. You 
can then view the hierarchy in the OVO Hosts and Applications view in the 
View Manager tab in UCMDB Administration.

CIs and KPIs for HP OVO
The OVO Source Adapter creates EMS Monitor CIs for the monitored OVO 
system, based on the samples sent by the SiteScope HP OVO Event monitor. 
Status for these CIs can be viewed in Dashboard in the OVO Hosts and 
Applications view, and the CIs are available to add to SLAs in Service Level 
Management.

The following KPIs are preconfigured to work with OVO EMS Monitor CIs in 
Dashboard and in Service Level Management: Application, Network, 
Security, and System. For details, see “Use the EMS Integration Tool for HP 
OVO Server Data” on page 395.
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Note: When multiple KPIs are assigned to an EMS Monitor CI, the status of a 
KPI that did not correspond to a sample is Not up to date. The date 
displayed in the Held status since field displays the date and time 
corresponding to the first time the rule was activated by a sample. The Not 
up to date status persists until the rule is activated by a sample that 
corresponds to the KPI.

OVO Rules

➤ Dashboard rule for OVO: In Dashboard, each OVO KPI (attached to an EMS 
Monitor CI) uses the SiteScope EMS Multiple Events monitor rule. The rule 
handles the samples sent to HP Business Availability Center by the EMS 
system. It aggregates all the samples received from a specified CI. The rule 
saves up to 10 events. If there are more than 10 events, the rule discards 
samples with the lowest severity (critical is highest) and then the oldest 
samples.

For details, see “List of Dashboard Business Rules” in CI Attribute 
Customization.

➤ Service Level Management rules for OVO: In Service Level Management, 
each OVO KPI (attached to an EMS Monitor CI) uses its own monitor rule. 
For details, see “List of Service Level Management Business Rules” in 
CI Attribute Customization.
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OVO Context Menus, Context Menu Items, and Tooltip in 
Dashboard
The EMS Clear Event context menu, Clear Event context menu item, and 
SiteScope EMS Rule tooltip are preconfigured to work with OVO EMS 
Monitor CIs in Dashboard. 

For details about the context menu, see “EMS Clear Events” in CI Attribute 
Customization.

For details about the context menu item, see “Clear Events” in CI Attribute 
Customization.

For details about the tooltip, see “SiteScope EMS Rule” in CI Attribute 
Customization.

The OVO Drill Down event enables you to access the HP OVO application. 
For details about the context menu, see “OVO Drill Down Event” in 
CI Attribute Customization.

Understanding the HP Service Center Integration

This section describes the main concepts of the HP Service Center 
integration adapter.

This section includes the following topics:

➤ “CIs and KPIs for HP Service Center” on page 374

➤ “HP Service Center Rules” on page 374

➤ “HP Service Center Context Menus, Context Menu Items, and Tooltip” on 
page 375
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CIs and KPIs for HP Service Center
The HP Service Center integration creates EMS Monitor CIs for the 
monitored HP Service Center system, based on the samples sent by the 
SiteScope HP Service Center Monitor. Status for these CIs can be viewed in 
Dashboard in the Business Services and the Service Measurements views, 
and the CIs are available to add to SLAs in Service Level Management.

The KPIs that are preconfigured to work with HP Service Center Monitor CIs 
are Number of Open Incidents in Dashboard and MTTR (Mean Time to 
Repair), MTBF (Mean Time Between Failures), and MTBSI (Mean Time 
Between System Incidents) in Service Level Management. Each KPI uses 
different business rules and logic in each application. 

HP Service Center Rules

➤ Dashboard rule for HP Service Center: In Dashboard, each HP Service 
Center KPI (attached to an EMS Monitor CI) uses the Number of Open 
Incidents monitor rule. The rule handles the samples sent to HP Business 
Availability Center by the EMS system. 

For details about the rule, see “Number of Open Incidents” in CI Attribute 
Customization.

➤ Service Level Management rules for HP Service Center: In Service Level 
Management, each HP Service Center KPI (attached to an EMS Monitor CI) 
uses its own monitor rule. For details, see “List of Service Level Management 
Business Rules” in CI Attribute Customization.
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HP Service Center Context Menus, Context Menu Items, 
and Tooltip
The HP SC Menu context menu, HP Service Center context menu item, and 
SiteScope EMS Rule tooltip are preconfigured to work with OVO EMS 
Monitor CIs in Dashboard. 

For details about the context menu, see “HP SC Menu” in CI Attribute 
Customization.

For details about the context menu item, see “HP Service Center” in 
CI Attribute Customization.

For details about the tooltip, see “Number of Open Incidents Sentence” in 
CI Attribute Customization.

Understanding the Application<-->Host or Host Integration 
Adapters

This section describes the main concepts of the Application <--> Host or 
Host integration adapter. 

The out-of-the-box Application <--> Host and Host integration adapters use 
out-of-the-box Jython scripts to create the appropriate topology. 

This section includes the following topics:

➤ “Application <--> Host Integration Adapter” on page 376

➤ “Host Integration Adapter” on page 376

➤ “Host Integration Adapter” on page 376
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Application <--> Host Integration Adapter
The integration adapter adds the EMS Monitor CI to the Application CI, 
assigns the Application KPI to the Application CI, adds the Host CI to the 
topology, assigns the System KPI to the Host CI. It also adds the Clear Events 
context menu item that enables you to clear an event. All the host 
information: CPU, disk space, and so on available from the sample provides 
status information to the EMS Monitor CI. 

Note: The integration adapter automatically run on all existing CIs and 
applies to those CIs the topology changes described above.

The status of the Host CI in that topology is grey. To display the status of the 
Host CI, set the flag to Host in Jython. By default the flag is set to 
Application. For details, see “Topology Settings” in Using System Availability 
Management.

For details about the System KPI, see “System” in CI Attribute Customization.

For details about the Clear Events context menu item, see “Clear Events” in 
CI Attribute Customization.

Host Integration Adapter
The Host integration adapter adds the EMS Monitor CI to the Host CI in the 
topology, and adds the System KPI to the Host CI. It also adds the Clear 
Events context menu item that enables you to clear an event. All the host 
information: CPU, disk space, and so on available from the sample provides 
status information to the Host CI via the EMS Monitor CI. The status of the 
Host CI represents the global status of the host.

For details about the System KPI, see “System” in CI Attribute Customization.

For details about the Clear Events context menu item, see “Clear Events” in 
CI Attribute Customization.
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EMS Monitor CI
When running the EMS integration generally only one EMS Monitor CI is 
created per host CI. In the process of the integration, if there is a problem 
with identifying the DNS name of the host while creating the monitor, more 
than one EMS Monitor CI may be created for the host. (For example, one 
monitor CI has the IP address and the other monitor CI has the DNS name.)

When reporting status to the host CI, only one monitor CI receives the data 
and passes status onto the host CI. The other CIs remain empty and will 
eventually disappear due to the Aging Mechanism. For details, see 
“Removing Out of Date CIs Using the Aging Mechanism” in IT World Model 
Management.

Note: The integration adapter automatically run on all existing CIs and 
applies to those CIs the topology changes described above.

Reconciliation of Hosts

The HP Business Availability Center reconciliation service is used to 
reconcile incomplete hosts with complete hosts. Incomplete hosts are 
created in the CMDB after they are discovered by the Discovery process 
(from Discovery Manager) or by SiteScope (as the Enable host topology 
reporting option is set by default). Complete hosts are created in the CMDB 
after they are discovered by the Discovery process. 

A complete host is a host with the complete flag set. It is identified by its 
MAC address.
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The reconciliation service:

 1 Disables Discovery double host enrichment. Double host enrichment works 
as follows: for every instance in the CMDB in which an IP CI is connected to 
two identical Host CIs, but one host is identified by its IP address and the 
other is identified by its lowest MAC address, the host that is identified by 
its IP address is deleted from the CMDB. For more information, see “Sample 
Enrichment Rule” in IT World Model Management.

 2 Creates its own TQL Listener and searches for incomplete Host CIs and 
complete Host CIs linked to the same IP. Note that more than one 
incomplete Host CI can be linked to the same IP.

 3 Copies each Depends on, System monitor, or Monitored by link that links 
to an incomplete Host CI to the corresponding complete Host CI (linked to 
the same IP), in the CMDB. The default KPIs attached to the incomplete 
Host CIs are also copied to the complete Host CI. If an incomplete Host CI is 
part of an SLA, the SLA is copied to the corresponding complete Host CI.

 4 Erases the incomplete Host CI from the CMDB.

The CMDB_ID_MAPPING table in the Management database lists the pairs 
of the CMDB IDs of incomplete hosts to the CMDB IDs of the complete 
hosts that were processed by the service.

If an error occurs during the reconciliation, to rerun the reconciliation 
process, access the HP Business Availability Center JMX, go to the HAC-
MANAGER, stop the EMS HOST reconciliation service (select Change 
assignment and set the value to 0) and restart it (select Change assignment 
and set the value to 1). 

Limitations
The limitations of the reconciliation of hosts are:

 1 Custom KPIs are not copied from the incomplete Host CI to the complete 
Host CI.

 2 Alerts assigned to an incomplete Host CI are not copied to the 
corresponding complete Host CI.
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 3 All the autogenerated CIs linked to the incomplete host CI are 
autogenerated and linked to the complete host CIs (for example: KPIs and 
discovery CIs).

 4 After the reconciliation of hosts takes place, the historical reports of 
reconciled Host CIs display data at the level of the complete Host CI, only 
from the date and time when the reconciliation took place. Host CIs, which 
did not need reconciliation, continue to display data. 

To restore data at the level of the Host CI, you can run an SLA recalculation 
taking into account the recalculation limitations. For details, see 
“Recalculation for Agreements” in Using Service Level Management.

 5 Manually modified properties of incomplete Host CIs are not copied to the 
complete Host CI.
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Integrate Data from Third-Party Sources (EMS Data) into 
HP Business Availability Center

This section describes the processes for integrating data from third-party 
sources (EMS data) into HP Business Availability Center, and gives examples.

The flowchart below describes the process required to integrate data from 
third-party enterprise management systems (EMS data) into HP Business 
Availability Center using SiteScope Integration Monitors. 
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This task includes the following steps:

➤ “Plan EMS Strategy” on page 381

➤ “Configure the Integration” on page 381

➤ “Display Data in the Event Log” on page 387

➤ “Configure Measurement Filters” on page 388

➤ “Assign Group Permissions” on page 388
x

Plan EMS Strategy
Review the Integration Monitor types. Consider the type of information you 
want to see in HP Business Availability Center from your EMS system. 
Determine whether one of the specific Integration Monitors meets your 
organization’s needs or whether a generic Integration Monitor (Technology 
Log File, Database, SNMP Trap, Web Service) is required.

Review the Event and Metrics samples and fields to understand how the 
incoming EMS metadata maps to HP Business Availability Center metadata. 

For more information, see “Working with SiteScope Integration Monitors” 
in Using System Availability Management.

Configure the Integration
Access the EMS Integrations application where you customize the 
Integration Monitor configuration files to correctly map the data 
Integration Monitors collect to a format recognizable by HP Business 
Availability Center:

➤ Sketch a CIT relationship map of the integration you are creating to help 
you formulate the KPI assignment rules that are described below and to 
understand which topology to create.

➤ Open the System Availability Management Administration window where 
you can access a SiteScope and deploy integration monitors to collect 
performance and availability data from your EMS. For details, “Working 
with SiteScope Integration Monitors” in Using System Availability 
Management.
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➤ Create or customize a KPI assignment rule for each integration CI type in 
the CIT relationship map you sketched previously. An assignment rule 
consists of a condition and a task. The condition describes specific 
characteristics of a CI. The task describes the KPIs, rules, and context menus 
that are to be assigned automatically to the CI when the condition occurs, if 
the assignment is running. For details, see “Define the KPI Assignment Rule” 
on page 388.

You can then display the view that is created by the integration.

The view displays:

➤ EMS Monitor CIs that were created by the EMS integration

➤ CIs that were created by the EMS integration and that have a relationship to 
the above EMS Monitor CIs. 

➤ All hosts with a relationship to either of the CIs mentioned above.

Note: Do not edit or change the view–parts of the view are hidden in 
Dashboard. If you want to view the integration topology in a different way, 
create another view.

The HP OVO and HP Service Center integrations are out-of-the-box 
integrations that enable the user to view HP OVO and HP Service Center 
data in HP Business Availability Center.
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Example–Create an Application <--> Host Integration

 1 Perform the integration between HP Business Availability Center and the 
appropriate SiteScope. To do that, select Admin > System Availability 
Management. Right-click Summary and select New SiteScope. In Main 
Settings, enter the name of the host in the Display Name and Host Name 
boxes.

 2 Select Admin > EMS Integrations, and click to open the Add Integration 
dialog box. Enter emsTest in the Data Source box, select Application <--> Host 
in the Type list, and enter a description in the Description box.

 3 In the Integrations Implementation Test area, click 1. Define the CIT 
relationships map to display the sketch of relationships for a typical 
Application <--> Host integration.
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 4 In the Integrations Implementation Test area, click 2.  Retrieve data from 
EMS system using BAC's System Availability Management Administration 
(SAM Admin) to open the Summary page of System Availability 
Management. In that page:

 a Right-click the SiteScope monitor you set in step 1 on page 378, create a 
new group EMS, and under new monitor select the Integration Monitor 
and then select Log File Integration, enter content match and the log file 
path name. Click Load File and click Test Script.

 b In the Topology Settings, select Host-Application, Load, Test Script, and 
click OK.

For details, see “Technology Log File Integration Monitor Settings” in 
System Availability Management.

 5 In the Integrations Implementation Test area, under 3. Define the data 
assignments rules, select the Host Monitor CIs assignment rule and click the 
Start button to run the assignment rule. Do the same for the Application 
Monitor CIs assignment rule.

 6 In the Integrations Implementation Test area, click 4. View the integration 
results, to display the topology of the default view named after the name 
you gave in the Data Source box in step 2 on page 378.

 7 Select Applications > Dashboard, select the Console tab, and select the 
emsExample view. The topology of the new view is displayed with data.

The integration is complete.
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Example–Create a Technology Log File Integration Monitor

To create the Technology Log File Integration monitor, access SiteScope and 
create a new monitor. Select the Integration Monitor category, and click 
Technology Log File Integration to open the New Technology Log File 
Integration monitor page. Enter the following values:

➤ In Content Match, use the following example:

➤ In Sample type, use the following example:

➤ In Fields mapping, enter the following example:

/(.*),(.*),(.*),(.*),(.*),(.*)/

8,event8,1,espresso,emsLog,app
8,event8,1,espresso,emsLog,app

#####################################################################
#   EMS Integration event config file           #
# Use this file to send events to Business Availability Center      #
#             #
# Refer to "Integration Monitor Configuration Files" in SiteScope   #
#  documentation for more information.          #  
#####################################################################

[$DEFAULT_PARAMETERS$]
################################################
# NOTE: the following parameters are mandatory #
################################################
# Time stamp in seconds since Jan 1st 1970 format. 
# Use time() to get the sitescope host time or str_to_seconds() to read a value from the 
input event
time_stamp:DOUBLE=time()
# Severity of event. Possible values are: 
# SEVERITY_UNKNOWN , SEVERITY_INFORMATIONAL , SEVERITY_WARNING , 
SEVERITY_MINOR , SEVERITY_MAJOR, SEVERITY_CRITICAL 
severity:INT=$group2
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# The name of the host / device that caused this event. If the name cannot be 
determined an IP address can be used instead
target_name=$group3
# Event status or type (e.g "OPEN", "ASSIGNED", "CLOSED")
status="OPEN"

# Subject of event (e.g. CPU , SAP application, Hard Disk ). Middle / High level of 
hierarchy describing the event source
# The hierarchy describing an event is in the following format:
# monitor_group (optional) --> object (optional) --> subject --> instance
# More levels can be added above monitor_group by using logical_group, and attr1 - 5
subject=$group4

# Instance of subject that generated the event (e.g "D:\\" ). The lowest level of hierarchy 
describing the event source.
# See Subject explanation above.
instance=$group4

# Event description. Up to 2000 characters.
description=$group1

# Application / Software from which this event was collected
data_source=$group4
###################################################
# NOTE: The following parameters are optional.   #
# Remove comments from entries you wish to use  #
###################################################
# IP of the host \ device that caused this event
#target_ip=
# Object of this event (e.g. OS, Network, etc). optional level in the hierarchy describing 
the event source

# See Subject explanation above.
#object=
# A unique identifier for this event
event_id=$group0
# For logical grouping
# See Subject explanation above.
#logical_group=
# Monitor group that reported this event. optional level in the hierarchy describing the 
event source
# See Subject explanation above.
#monitor_group=
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➤ In Topology Settings, select the Host--Applications topology.

Test the script by clicking Test Script to view the expected results of the 
monitor.

For details, see “Technology Log File Integration Monitor Settings” in Using 
System Availability Management.

Display Data in the Event Log
After monitors are defined in System Availability Management 
Administration, data can be seen in the Event Log and in Dashboard.

Depending on whether you configure Integration Monitors that use the 
metrics data template or Integration Monitors that use the event data 
template, you proceed differently to enable the data to be viewed in 
HP Business Availability Center.

# Severity name in integrated system terminology
#orig_severity_name=
# Operator who acknowledged this event
#acknowledged_by=
# Operator who owns this event
#owner=
# Use with any numeric values you wish to send to Business Availability Center
#value:DOUBLE=

# Additional attributes 1..5
attr1=$group5
#attr2=
#attr3=
#attr4=
# For long string values up to 2000 use attr5
#attr5=
[allRecords]
$MATCH=true
$ACTION=TOPAZ_BUS_POST(event)
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Configure Measurement Filters
If you configured a generic integration monitor with an Events sample 
script, configure measurement filters to enable viewing Integration Monitor 
event data in trend reports. In addition, each measurement filter created 
gets added to the UDX Measurement Filters view as a CI. These CIs can be 
added to Dashboard views and SLAs. For more information, see “Working 
with Measurement Filters” in Platform Administration.

Assign Group Permissions
If you configured a generic integration monitor with an Measurements 
sample script, for each defined user, assign permissions to view SiteScope 
groups and their subgroups in System Availability Management reports and 
custom reports. For more information, see “Set Group Permissions for 
Reports” in Using System Availability Management.

x

Define the KPI Assignment Rule

An assignment definition includes a condition and a task. When the 
assignment’s condition occurs, the assignment’s task is performed 
automatically if the assignment is running. For details, see “Assignment 
Rules Mechanism and KPI Propagation” on page 369.

Note: Only users with administrator privileges can create assignments.

You must define an assignment rule for each element in the map you have 
created. For details, see “Define Assignment Configuration Dialog Box” on 
page 418.

This task includes the following steps:

➤ “Define the Condition” on page 389

➤ “Define the Task” on page 389
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Define the Condition
The condition specifies the criteria that is used to trigger the assignment 
performed by the task. 

Example

If you want the assignment to be triggered when the value of the data-name 
attribute of the host cmdb-class that appears in the sample equals test, the 
condition that corresponds to this request is:

Example

If you want the assignment to be triggered when the cmdb-class is 
logical_application, the condition that corresponds to this request is:

Define the Task
The task specifies the KPIs, rules, context menus, context menu items, and 
tooltips to assign to the relevant CI. 

Example

The groupMenu and itCIs context menus, the Availability KPI, the WS 
Operation Availability Rule are assigned to the CI, the default value of the 
No data timeout parameter of the rule is changed to 1200 (the type of the 
value is Long), and the rule calculates the KPI status when the value of the 
sampleType sample field is ws_perf_aggr_t and the value of the dc_source 
sample field is RefProp:data_name:

<condition cmdb-class="host">
 <property-condition name="data_name" operator="EQ" value="test"/>

</condition>

<condition cmdb-class="logical_application"/>
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Use the EMS Integration Tool for HP ServiceCenter Data

You can collect performance and availability data from an existing 
HP ServiceCenter Server and view the data in HP Business Availability 
Center applications.

To integrate data from an existing HP ServiceCenter, use the following steps:

Note: Complete each step before starting on the next step.

This task includes the following steps:

➤ “Configure the HP ServiceCenter Monitor” on page 391

➤ “Specify the HP ServiceCenter Host and Port” on page 391

➤ “Specify the State and Severity of Open Incidents to Be Displayed” on 
page 392

➤ “Customize the Integration Adapter” on page 392

<task-config>
<contextmenu id="groupMenu, itCIs" /> 
<kpis-config>

<kpi-config type="7">
<rule>1300</rule> 

<rule-parameter key=”No data timeout” value=”1200” type=”Long”/>
<rule/>
<trinity-selector>

<CompositeSelector logicalOp="AND">
<Selector key="sampleType" op="EQ" type="String" value="ws_perf_aggr_t" /> 
<Selector key="dc_source" op="EQ" type="String" value="RefProp:data_name" /> 

</CompositeSelector>
</trinity-selector>

</kpi-config>
</kpis-config>

</task-config>
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➤ “Include Service Center CIs in Service Level Management Agreements” on 
page 394

➤ “View Service Center Data in Dashboard and Service Level Management” on 
page 394

Configure the HP ServiceCenter Monitor
In SiteScope, you must provide external access to the clocks and 
probe_summary_tables, edit the topology script, create the peregrine.jar file, 
edit the attributes mapping files and the ticket.config file, and more. For 
details, see “HP ServiceCenter Integration Workflow” in Using System 
Availability Management.

Specify the HP ServiceCenter Host and Port
To specify the HP ServiceCenter host and port information, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and, in the Dashboard 
Application - Ticketing Integration table, locate:

➤ the Host of the Web Tier entry and enter the name of the HP ServiceCenter 
host.

➤ the Port of the Web Tier entry and enter the port number of the 
HP ServiceCenter server.
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Specify the State and Severity of Open Incidents to Be 
Displayed
To specify the state and severity of the open incidents that are to be 
displayed, you can edit the parameters of the Number of incidents rule 
parameters:

➤ For the Number of Open Incidents KPIs attached to a specific EMS Monitor 
CI. For details, see “New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for 
Child Transaction Dialog Box” in Using Dashboard. 

➤ Globally, for all KPIs defined with the Number of Open Incidents rule. For 
details, see “Number of Open Incidents” in CI Attribute Customization

Note: The values available for the Initial State, Final State, and Severity 
parameters reflect the values defined in HP ServiceCenter.

Customize the Integration Adapter
Use the EMS Integrations application to customize an HP ServiceCenter 
integration adapter. The integration adapter forwards the retrieved data 
captured from the HP ServiceCenter system by the SiteScope HP Service 
Center monitor to HP Business Availability Center, and creates the 
appropriate topology that is used to display the data in Dashboard. The 
topology is: Business Service - EMS Monitor, or Business Service - Business 
Service - EMS monitor, according to what is received in the sample. 

The HP ServiceCenter integration adapter is predefined. Access the EMS 
Integration Administration and select HP ServiceCenter to access the HP 
Service Center Integration adapter definition. 
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In the Add Integration dialog box, you can:

➤ view/edit the CIT relationship map

➤ configure the HP ServiceCenter Monitor. The monitor is used to retrieve 
data from EMS system using System Availability Management 
Administration. You add the HP ServiceCenter Monitor to a SiteScope 
monitor group created for this monitor and other Integration Monitor 
types. It is recommended that you configure Integrations Monitors only 
after a connection between the SiteScope and HP Business Availability 
Center is established. 

➤ activate the data assignment rules. Select the assignment rule and click the 
Activate button.

When the EMS monitor sample includes open incidents in its data source, 
the Number Of Open Incidents KPI (2600), the Number Of open Incidents 
rule (2600), the HP SC Menu context menu (hpsc), the HP Service Center 
context menu item, and the HP Open Incidents tooltip (2600) are assigned 
to the EMS Monitor CI. 

➤ display the Business Services and the Service Measurements views.

Note: SiteScope cannot be deployed behind a firewall. The SiteScope and the 
monitored system must be on the same LAN or special firewall 
configuration may be required.

For details, see “Add Integration Dialog Box” on page 411.
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Include Service Center CIs in Service Level Management 
Agreements
You can include Service Center EMS Monitor CIs in your agreements in 
Service Level Management. Service Level Management contains KPIs and 
rules specifically configured for Service Center EMS Monitor CIs. The MTTR, 
MTBF, and MTBSI KPIs and the MTTR, MTBF, and MTBSI rules are dedicated 
for this integration. 

You must also configure the incident initial and final state in those rules. For 
details, see “Incident State and Severity Values” on page 112.

For details, see “Agreement Wizard” in Using Service Level Management.

View Service Center Data in Dashboard and Service Level 
Management
SiteScope automatically creates the appropriate topology when 
HP ServiceCenter data is integrated into HP Business Availability Center. 
HP Business Availability Center adds the data to the Business Services and 
Service Measurement views, and you can display these views in Dashboard 
and Service Level Management.

In Dashboard, the context menu for the HP ServiceCenter CIs includes an 
HP Service Center option, which directly accesses the relevant incident in 
the HP ServiceCenter application.

You must disable query security to the HP Service Center application to 
enable accessing it from Dashboard. You still have the necessary capabilities 
to properly secure your system without the query hash. 
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To enable accessing HP Service Center from within Dashboard:

 1 Edit the web.xml file located in the following folder:

 2 In the file, locate the <!-- Specify the ServiceCenter server host and port 
location --> section.

 3 Add the following strings into the section:

<context-param>
<param-name>sc.querysecurity</param-name>
<param-value>false</param-value>

</context-param>

Use the EMS Integration Tool for HP OVO Server Data

You can collect performance and availability data from an existing HP OVO 
Server and view the data in HP Business Availability Center applications.

To integrate data from an existing HP OVO Server, use the following steps:

Note: Complete each step before starting on the next step.

This task includes the following steps:

➤ “Install HP OVO Integration Add-on” on page 396

➤ “Customize the Integration” on page 396

➤ “Activate OVO Hosts and Applications View” on page 397

➤ “Optional - Customize Automated Mapping Between OVO Event Fields and 
KPIs” on page 398

➤ “Assign the OVO EMS Monitor CI to SLAs and Add Optional KPIs” on 
page 398

➤ “View OVO Data in Dashboard and Service Level Management Views” on 
page 398
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Install HP OVO Integration Add-on
The HP OVO Integration Add-on enables connecting to the HP OVO 
message infrastructure, receiving events from the HP OVO server, and 
forwarding these events to the SiteScope machine. For details, see “HP OVO 
Event Monitor” in Using System Availability Management.

Customize the Integration
Use the EMS Integrations application to customize an HP OVO integration. 
The integration forwards the retrieved data captured from the OVO system 
by the SiteScope HP OVO Event monitor to HP Business Availability Center, 
and creates the appropriate topology (host and application CIs). 

The HP OVO integration is predefined. Access the EMS Integration 
Administration and select HP OVO to access the HP OVO Integration 
adapter definition. 

In the Add Integration dialog box, you can:

➤ specify the host, user name, and password. This information is used to 
access the HP OVO application user interface from the OVO Drill Down 
context menu option in Dashboard from the HP OVO view.

➤ view/edit the CIT relationship map. If you want to understand the topology 
that is going to be created. For details, see “OVO Hierarchies” on page 371.

➤ configure the HP OVO Event Monitor. The monitor is used to retrieve data 
from the HP OVO server using System Availability Management 
Administration. You add the HP OVO Event Monitor to a SiteScope monitor 
group created for this monitor and other Integration Monitor types. It is 
recommended that you configure Integrations Monitors only after a 
connection between the SiteScope and HP Business Availability Center is 
established. For details, see “HP OVO Event Monitor” in System Availability 
Management.

➤ activate the data assignment rules. Select the assignment rule and click the 
Activate button.

➤ display the HP OVO view. This view is similar to the OVO Hosts and 
Applications view. It is automatically activated. The topology of the HP 
OVO integration is displayed in this view and in the OVO Hosts and 
Applications View. 
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For details, see “Add Integration Dialog Box” on page 411.

Note: SiteScope cannot be deployed behind a firewall. The SiteScope and the 
monitored system must be on the same LAN or special firewall 
configuration may be required.

Activate OVO Hosts and Applications View
This view is mainly used for backward compatibility. If you want to see the 
topology in this view, you must activate the view and assign the view to the 
required Business Availability Center applications. For details, see 
Activate/Deactivate View in “View Manager Window” in IT World Model 
Management.
397



Chapter 11 • Enterprise Management Systems Integration
Optional - Customize Automated Mapping Between OVO 
Event Fields and KPIs
The HP OVO integration is configured to automatically map the events 
retrieved from the HP OVO system to the appropriate KPIs for the 
corresponding EMS Monitor CIs. The appropriate KPIs, rule, context menu 
items, and tooltips are used to display the retrieved data. 

Use the Clear Event context menu item to clear events in Dashboard only. 

Use the OVO Drill Down context menu items to open the HP OVO 
application. For details, see “Understanding the HP OVO Integration” on 
page 370.

Once you have began working with the data, you can optionally customize 
these mappings. For details, see “HP OVO Event Monitor” in System 
Availability Management.

Assign the OVO EMS Monitor CI to SLAs and Add Optional 
KPIs
You can include OVO EMS Monitor CIs in your SLAs in Service Level 
Management. Service Level Management contains KPIs and rules specifically 
configured for OVO EMS Monitor CIs, including optional KPIs for network 
and security. For details, see “Integration with HP OVO” in Using Service 
Level Management.

View OVO Data in Dashboard and Service Level 
Management Views
SiteScope automatically creates the appropriate topology when a HP OVO 
data is integrated into HP Business Availability Center. HP Business 
Availability Center adds the data to the view in Dashboard and Service Level 
Management. The OVO Drill Down context menu option is added to the 
appropriate CIs. Use that option to access the HP OVO application. 

In both Dashboard and Service Level Management, the Application, System, 
Network, and Security KPIs are defined as default KPIs for the OVO EMS 
Monitor CIs. 
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For details about the Dashboard KPIs, see “List of Dashboard KPIs and Their 
Details” in CI Attribute Customization. 

For details about the Service Level Management KPIs, see “List of Service 
Level Management KPIs and Details” in CI Attribute Customization.
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12
Integrate HP Business Process Insight 
Data Into HP Business Availability Center

This chapter describes how to integrate HP Business Process Insight (BPI) 
data into HP Business Availability Center.

HP Business Process Insight Overview

HP Business Process Insight provides:

➤ Simple definition of health and performance metrics along with associated 
thresholds, allowing you to automatically track and escalate against 
business process level objectives

➤ Simplified graphical modeling of only the key milestones in a business 
process, therefore reducing implementation time and complexity

This chapter describes: On page:

Concepts

HP Business Process Insight Overview 401

Tasks

View HP Business Process Insight Data in HP Business Availability 
Center

402

Access the HP Business Process Insight Application from HP Business 
Availability Center

410

View Business Process Insight Portlets in My BAC 410
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➤ Automatic representation of business process health and performance 
information in a graphical web-based console for use by IT or business users, 
delivering complete visibility into what is going on in your processes

➤ Powerful business impact information to indicate when and to what extent, 
a problem with the computing infrastructure or applications has affected 
the health of a business process

➤ Ability to interoperate with OpenView Internet Services, HP Operations 
Manager, Service Navigator component, HP Operations Manager for 
Windows, HP Service Desk, or any third party source to obtain information 
about infrastructure or application problems.

View HP Business Process Insight Data in HP Business 
Availability Center

HP Business Process Insight data can be displayed in HP Business 
Availability Center. The hierarchy of the Business Process flow and its steps 
is imported into HP Business Availability Center using an XML File source 
adapter. Real-time data (samples) is sent to HP Business Availability Center 
using the WDE (Web Data Entry) mechanism which receives data from 
HP Business Process Insight for processing before it enters the data loader. 
Data about each BPI Monitor CI and its KPIs is sent to HP Business 
Availability Center every two minutes (this period can be altered in 
HP Business Process Insight).

This task includes the following steps:

➤ “Pre-requisite Steps” on page 403

➤ “Modify the Infrastructure Settings to Provide Connection Information to 
the Business Process Insight Machine” on page 403

➤ “Set Up the BPI_entities.xml Source Adapter” on page 403

➤ “Create a New XML File Source Adapter” on page 404

➤ “View HP Business Process Insight Data in the Business Process View and 
Enrich the View” on page 408
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Pre-requisite Steps
Consult HP Business Process Insight documentation for the steps to be 
performed on the HP Business Process Insight server before the integration 
with HP Business Availability Center can take place.

Modify the Infrastructure Settings to Provide Connection 
Information to the Business Process Insight Machine
To provide connection information to the Business Process Insight machine, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and in the Dashboard 
Application - Business Process Insight Integration table, locate the following 
settings:

➤ Business Process Insight Host. Enter the HP Business Process Insight host 
name or IP address.

➤ Business Process Insight Port. Enter the HP Business Process Insight HTTP 
port number (named Servlet Engine HTTP as a parameter within 
HP Business Process Insight).

Set Up the BPI_entities.xml Source Adapter
The steps to follow to work with the BPI_entities.xml source adapter are:

➤ In the HP Business Process Insight application, export the XML entities file 
to HP Business Availability Center, and save it as BPI_entities.xml in the 
following location:
<HP Business Availability Center processing server root directory>\BPI\

Note: This is the path you enter in the Path box in the adapter definition. 
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The XML entities file contains all the HP Business Process Insight entities 
needed for the integration. The following XML entities files are available: 

➤ An XML entities file that includes all flows/business processes. This file 
enables you to represent the complete set of HP Business Process Insight 
flows/business processes in HP Business Availability Center.

➤ An XML entities file that includes a single flow/business process. The 
single flow/business process XML file enables you to represent a sub-set 
of HP Business Process Insight flows/business-processes in HP Business 
Availability Center. 

If you want to import two flows, then you can either create two XML 
entities files (one per each flow) or you can import and edit the XML 
entities file that includes all flows (recommended).

For details about the XML entities file, see HP Business Process Insight 
documentation.

➤ Create a new XML File source adapter called BPI adapter. For details, see 
“Create a New XML File Source Adapter” on page 404.

The XML File source adapter template file is also generated by HP Business 
Process Insight at the same time as the XML entities files.

Create a New XML File Source Adapter
To create a new XML File source adapter called BPI adapter, select Admin > 
Universal CMDB > Source Manager, and click the New Source button to 
open the New Source dialog box. In the Type list, select XML File. In the 
Name box, enter BPI Source Adapter. In the Path box enter the path to the 
BPI_entities.xml file as described in “Set Up the BPI_entities.xml Source 
Adapter” on page 403. Click Edit Template. The dialog box expands to 
display the adapter template in the Template box.

Note: In the Template box, use the dialog box scrollbar and the Template 
box scrollbar to display the areas of the template you want to modify. You 
can also highlight the text, copy it to a text editor, make the appropriate 
changes and copy the text back into the Template box.
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Replace the text in the Template box with the template provided below.

<?xml version="1.0" encoding="UTF-8"?>
<autoMappingEntities bac-version="BAC 7.0">

<entity id="business_process">
<basicEntity>Mercury:bpi_business_process</basicEntity>
<contextmenu>BPIMenu</contextmenu>
<dimensions>

<dimension>
<id>400</id>
<logics>

<logic>
<id>1</id>

</logic>
</logics>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
<dimension>

<id>600</id>
<logics>

<logic>
<id>1</id>

</logic>
</logics>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
<dimension>

<id>601</id>
<logics>

<logic>
<id>1</id>

</logic>
</logics>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
<dimension>

<id>602</id>
<logics>

<logic>
<id>1</id>

</logic>
</logics>
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<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
</dimensions>

</entity>
<entity id="bpi_monitor">

<basicEntity>Mercury:bpi_monitor</basicEntity>
<contextmenu>BPIMenu</contextmenu>
<dimensions>

<dimension>
<id>400</id>
<logics>

<logic>
<id>600</id>

</logic>
</logics>
<selectors type="AND">
<selector dataType="String" key="sampleType" operator="EQ" readOnly="true" reference="false"

referencedProperty="sampleType" value="bpi_t"/>
<selector dataType="String" key="metric_id" operator="EQ" readOnly="false" reference="true"

referencedProperty="metric_id"/>
<selector dataType="Integer" key="bac_kpi_type" operator="EQ" readOnly="false" 

reference="false" referencedProperty="bac_kpi_type" value="400"/>
</selectors>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
<dimension>

<id>600</id>
<logics>

<logic>
<id>600</id>

</logic>
</logics>
<selectors type="AND">
<selector dataType="String" key="sampleType" operator="EQ" readOnly="true" reference="false"

referencedProperty="sampleType" value="bpi_t"/>
<selector dataType="String" key="metric_id" operator="EQ" readOnly="false" reference="true"

referencedProperty="metric_id"/>
<selector dataType="Integer" key="bac_kpi_type" operator="EQ" readOnly="false"

reference="false" referencedProperty="bac_kpi_type" value="600"/>
</selectors>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
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<dimension>
<id>601</id>
<logics>

<logic>
<id>601</id>

</logic>
</logics>
<selectors type="AND">
<selector dataType="String" key="sampleType" operator="EQ" readOnly="true" reference="false"

referencedProperty="sampleType" value="bpi_t"/>
<selector dataType="String" key="metric_id" operator="EQ" readOnly="false" reference="true"

referencedProperty="metric_id"/>
<selector dataType="Integer" key="bac_kpi_type" operator="EQ" readOnly="false"

reference="false" referencedProperty="bac_kpi_type" value="601"/>
</selectors>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
<dimension>

<id>602</id>
<logics>

<logic>
<id>602</id>

</logic>
</logics>
<selectors type="AND">
<selector dataType="String" key="sampleType" operator="EQ" readOnly="true" reference="false"

referencedProperty="sampleType" value="bpi_t"/>
<selector dataType="String" key="metric_id" operator="EQ" readOnly="false" reference="true"

referencedProperty="metric_id"/>
<selector dataType="Integer" key="bac_kpi_type" operator="EQ" readOnly="false" 

reference="false" referencedProperty="bac_kpi_type" value="602"/>
</selectors>
<removeDimensionIfObsolete>true</removeDimensionIfObsolete>
<dnodeAwareDimension>false</dnodeAwareDimension>

</dimension>
</dimensions>

</entity>

<entity id="bpi_step">
<basicEntity>Mercury:bpi_step</basicEntity>
<contextmenu>BPIMenu</contextmenu>
<dimensions/>

</entity>
</autoMappingEntities>
<autoMappingLinks bac-version="BAC 7.0">

<link dest_obj_type="bpi_monitor" src_obj_type="bpi_business_process" type="Mercury:monitored_by"
weight="1"/>

<link dest_obj_type="bpi_step" src_obj_type="bpi_business_process" type="Mercury:depends_on" weight="1"/>
</autoMappingLinks>
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View HP Business Process Insight Data in the Business 
Process View and Enrich the View
An HP Business Process Insight business process flow includes only the 
nodes that you need to monitor to obtain meaningful impact data about the 
health of your business. Nodes (square boxes) may represent one or more 
business activities and arcs (arrows) display the direction of the business 
process flow. For example, a business flow can have the following structure:
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In HP Business Availability Center, the Business Process view has the 
following structure:

The BPI Business Process CI, in Dashboard, corresponds to the Business 
Process flow in HP Business Process Insight.

The BPI Step CI, in Dashboard, corresponds to an activity in the Business 
Process flow in HP Business Process Insight.

The BPI Monitor CIs are children of the BPI Business Process CIs. All the 
sample information sent by HP Business Process Insight is displayed by the 
Backlog, Throughput, Health, and Duration KPIs attached to the BPI 
Monitor CI and propagated to the BPI Business Process CI. The following 
rules: BPI Duration Metric Status Rule, BPI Monitor Health Rule and BPI 
Metric Status Rule calculate the statuses of those KPIs based on data from 
HP Business Process Insight.

The IT Universe CI represents the HP Business Availability Center CI the BPI 
Step CI depends on, such as: database, host, CPU, and other information 
provided by SiteScope, Business Process Monitor, Real User Monitor, or 
Diagnostics monitors. 

To enrich the view, you attach IT Universe CIs to the appropriate BPI Step 
CI. For example, if the BPI Step CI depends on a specific host, then you 
attach a Host CI to the BPI Step CI. The KPIs of the IT Universe CI are then 
propagated to the BPI Step CI and displayed by the KPIs you assigned to the 
IT Universe CIs. 
409



Chapter 12 • Integrate HP Business Process Insight Data Into HP Business Availability Center
For details about attaching KPIs to a CI, see “Attach KPIs to CIs” on 
page 220.

For details about the SiteScope, Business Process Monitor, Real User 
Monitor, or Diagnostics monitors, see “Source Adapters” in IT World Model 
Management .

For details about the KPIs, see “KPI Repository Reference” in CI Attribute 
Customization.

For details about the rules, see “Rules Repository Reference” in CI Attribute 
Customization.

Access the HP Business Process Insight Application from 
HP Business Availability Center

From the Business Process view, you can connect to the Business Process 
Insight application using the Go to BPI context menu option from the 
Business Process, BPI Monitor, and BPI Step CIs in the Business Process view. 
For details, see “Dashboard Menu Options” in Using Dashboard.

View Business Process Insight Portlets in My BAC

You can add the Business Process Insight portlets to My BAC to display the 
Business Process Insight data. For details on how to add BPI portlets to a 
My BAC page, see “Business Process Insight Portlet” in Using My BAC.
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EMS User Interface

This chapter includes the pages and dialog boxes that are part of the EMS 
user interface, listed alphabetically.

Add Integration Dialog Box

This chapter describes: On page:

Add Integration Dialog Box 411

CIT Relationships Map Dialog Box 418

Define Assignment Configuration Dialog Box 418

EMS Integrations Admin Page 424

Description Enables you to create a new integration or to edit an 
existing integration.

To access: Click  in the EMS Integrations page or 
select an integration and click . An extended Add 
Integration page opens.

Important 
Information

Complete each step of the procedure before starting on 
the next one.

Do not remove the data source when editing an 
integration.

It is recommended to work as much as possible with 
the out-of-the-box solutions: HP Sercice Center, HP 
OVO, Host, or Application<-->Host.
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The initial dialog box includes the following elements (listed 
alphabetically):

Included in Tasks ➤ “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 380

➤ “Use the EMS Integration Tool for HP ServiceCenter 
Data” on page 390

➤ “Use the EMS Integration Tool for HP OVO Server 
Data” on page 395

Useful Links “About Enterprise Management Systems” on page 368

GUI Element Description

Data Source Enter the name of the integration data source when 
you create a custom integration.

Note: The same data source must be used in the 
mapping fields and in the topology section in the 
integration monitor. For details, see “2. Retrieve data 
from EMS system using BAC’s System Availability 
Management Administration (SAM Admin)” on 
page 417.

Note: The sample must be part of the same data source.

Description A description of the integration you are creating. The 
description is displayed in the EMS Integrations page.

OK Click to open the General and Integration 
Implementation Steps areas.
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General Area

The dialog box that opens after the previous dialog box has been filled in 
includes the following elements (listed alphabetically):

Type Select the type of integration you want to create. Select:

➤ Custom. To create a custom integration.

➤ Host. To create a host integration that adds hosts or 
reconciles the new hosts with existing hosts and 
sends data into the hosts. For details, see 
“Understanding the Application<-->Host or Host 
Integration Adapters” on page 375.

➤ Application <---> Host. To create an application to 
host integration. For details, see “Reconciliation of 
Hosts” on page 377.

➤ ServiceCenter. To create a business service 
connected to EMS monitor entities. For details, see 
“Understanding the HP Service Center Integration” 
on page 373.

Note: When you select Host or Application <---> Host, 
the integration automatically runs the assignment 
rules on all the existing CIs.

GUI Element Description

HP OVO Host For OVO integration only.

The name of the HP OVO host. 

This field is not mandatory.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.

GUI Element Description
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HP OVO User Name For OVO integration only.

The name of the HP OVO user.

This field is not mandatory.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.

HP OVO User 
Password

For OVO integration only.

This field is not mandatory.

The password of the HP OVO user.

This information is used to access the HP OVO 
application using the OVO Drill Down context menu 
option. For details, see “OVO Drill Down” in 
CI Attribute Customization.

Limitation: See “OVO Drill Down Event” in CI Attribute 
Customization.

GUI Element Description
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Integration Implementation Steps Area

The area includes the following elements (listed alphabetically):

Switch to Advanced 
Mode

For OVO integration only.

Click to add the Network and Security KPIs enrichment 
to the existing Application Monitor CIs and Host 
Monitor CIs data assignment rules.

The enrichment rules cause the Network and Security 
KPIs to be automatically attached to all OVO CIs 
(except to the EMS Monitor CIs directly under the 
Application CIs) in the Dashboard views in addition to 
the Application, and System KPIs. For details, see 
“Network” or “Security” in CI Attribute Customization.

Clicking the button has no impact in Service Level 
Management: Network and Security KPIs are not 
automatically attached to the OVO CIs when the CIs 
are added to an SLA in Service Level Management. For 
information on attaching these KPIs, see “CIs and KPIs 
for HP OVO” on page 371.

Note: If you change mode after the integration 
topology was created, it is recommended to select the 
assignment rules and to re-run them, with the Run on 
existing CIs option selected, in order to re-attach the 
proper KPIs and rules to the existing CI. For details, see 
“Define Assignment Configuration Dialog Box” on 
page 418.

Description Enables you to specify and implement the integration.

GUI Element Description

Click to create a data assignment rule in the Define 
Assignment Configuration dialog box.

Select a data assignment rule and click to edit the rule 
in the Define Assignment Configuration dialog box.

GUI Element Description
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Select a data assignment rule and click to delete.

Not applicable.

Select a data assignment rule and click to synchronize 
the selected rule.

Select a data assignment rule and click to start the 
assignment of the rule to existing and new CIs.

Select a data assignment rule and click to stop the 
assignment of the rule.

Enables you to select, clear, or invert the selections.

1. Define the CIT 
relationships map

Click to open the CIT relationship map dialog box 
where you can sketch the relationship map for the 
integration. This schema is useful to help you draw 
which CI types will be created and where the EMS 
monitors are located so assignment rules can run on 
those EMS monitors. For details, see “CIT Relationships 
Map Dialog Box” on page 418.

GUI Element Description
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2. Retrieve data from 
EMS system using 
BAC’s System 
Availability 
Management 
Administration (SAM 
Admin)

Click to open the System Availability Management 
application. For details, see “System Availability 
Management Administration” in Using System 
Availability Management.

Select from where the data is extracted (for example: 
Database) and which type of data (measurements, 
events or open incidents) is needed. 

To set up the HP OVO Event Monitor, see “HP OVO 
Event Monitor Settings” in Using System Availability 
Management.

To set up the HP OVO Service Center Monitor, see “HP 
ServiceCenter Monitor Settings” in Using System 
Availability Management.

Limitation: If you have previously defined a SiteScope 
using this option and you reopen System Availability 
Management, the application does not display the 
SiteScope you have previously defined.

3. Define the data 
assignements rules

Lists the existing data assignment rules for the current 
EMS integration adapter. 

One rule should be defined per EMS Monitor CI.

Use the available buttons to create, edit, activate or 
deactivate rules that map between fields and create the 
topology.

Note: It is important to validate the data assignment 
rule enrichment and if you create a custom enrichment 
to select the Run on existing CIs option in the Define 
Assignment Configuration dialog box.

4. View the 
integration results

Click to display the view that corresponds to the 
integration you have created with all the CIs that were 
created by the integration. 

Description The description of the assignment.

Name The name of the assignment.

GUI Element Description
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CIT Relationships Map Dialog Box

Define Assignment Configuration Dialog Box

Status The status: 

➤ Running. The assignment is running on the 
appropriate CIs.

➤ Stopped. The assignment is not running.

Description Enables you to add elements and relationships to the 
CIT relationships map.

To access: Click Define the CIT relationships map in 
the Add Integration Dialog Box.

Important 
Information

Sketch the relationships map to help you when you 
define the data assignment rules in step 3 of the Add 
Integration procedure in “Add Integration Dialog Box” 
on page 411. 

Description Enables you to configure an assignment.

To Access: Click the  button in the KPI Enrichment 
Configuration page.

Important 
Information

After you have created an assignment you cannot 
modify the condition. A workaround is to delete the 
assignment and to recreate it with a new condition.

Included in Tasks ➤ “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 380

➤ “Use the EMS Integration Tool for HP ServiceCenter 
Data” on page 390

➤ “Use the EMS Integration Tool for HP OVO Server 
Data” on page 395

Useful Links “Naming Conventions” in Reference Information

GUI Element Description
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The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Status Assignment Configuration will be stopped after 
creation. Means that after you configure the 
assignment it is automatically set in Stopped status in 
the KPI Enrichment Configuration page.

Name The name of the assignment.

Description The description of the assignment.

Condition The condition is written in XML. It uses parameters to 
specify the criteria used to trigger the Task. For details 
about the parameters, see “KPI Assignment Rule - 
Condition” on page 420.

For details about creating a condition, see “Define the 
Condition” on page 389.

Task The task is written in XML. It uses parameters to 
define the tasks used to assign the KPIs, rules, and 
context menus to the selected CI are listed in the 
following table. The task that is performed after the 
assignment is triggered. For details, see “KPI 
Assignment Rule - Task” on page 421.

For details about creating a task, see “Define the Task” 
on page 389.

Run on existing CIs Set to retroactively run the assignment on existing CIs. 

Validate Click to validate the XML code in both the Condition 
and Task areas and to perform the indentation of the 
code.
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KPI Assignment Rule - Condition

The parameters used to define the KPI Assignment rule conditions are as 
follows:

Element Description

condition A collection used to define the condition. Its attribute is:

➤ cmdb-class. The name of the CMDB class (not the display name) 
that corresponds to the CI for which you are creating the 
assignment. For details about the CMDB classes, see the 
Information Page in “Edit Configuration Item Type Dialog Box” 
in CI Attribute Customization.

Note: This element is mandatory. It can contain one or more 
property-condition elements.

property-
condition

An element that creates a restriction on the condition. You can use 
more than one property-condition. Its attributes are:

➤ name. Mandatory. The name of one of the attributes of the 
CMDB class. For details about the CMDB classes, see the 
Information Page in “Edit Configuration Item Type Dialog Box” 
in CI Attribute Customization.

➤ operator. Mandatory. The operator. It can be: EQ or NOT-EQ or 
LIKE. 

➤ value. Mandatory. A string that is compared to the value of the 
attribute of the CMDB class specified in name. If you are using 
the LIKE operator, the value should have the format %xxx and 
should select strings that end with xxx.

Note: You cannot use two property-condition elements with the 
same name, inside a condition element.
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KPI Assignment Rule - Task

The parameters used to define the KPI Assignment rule tasks are as follows:

Element Description

task-config An element used to define the task.

contextmenu (Optional). An element used to specify the context menu you 
want to add to the CI to which the assignment is attached. Its 
attribute is:

➤ id. The internal name of the context menu. To add more 
than one context menu to a CI, separate their internal 
names with commas (,).

For details about the context menu internal names, see 
“Context Menu Repository Page” in CI Attribute Customization.

kpis-config A collection of kpi-config elements.

kpi-config An element used to define the KPI. Its attribute is:

➤ type. The ID number of the KPI. 

For details about the KPI number, see “KPIs Repository Page” 
in CI Attribute Customization.

rule An element that specifies the number of the rule you want to 
attach to the KPI. For details about the rule numbers, see 
“Parameter Details Dialog Box (KPIs)” in CI Attribute 
Customization.

Note: It can also be a collection of parameters when you want 
to override existing rule parameters or when you want to add 
new parameters to the rule.

rule-parameter (Optional) An element that defines the rule parameter. Its 
attributes are:

➤ key. The display name of the rule parameter.

➤ value. The value of the parameter. Corresponds to the 
Default Value in the Business Rule Repository. For details, 
see “Parameter Details Dialog Box (Rules)” in CI Attribute 
Customization.

➤ type. The type of parameter. Corresponds to the Type of the 
parameter. For details, see “Parameter Details Dialog Box 
(Rules)” in CI Attribute Customization.
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trinity-selector A collection of selector definitions.

Composite
Selector

An element that indicates how to group logically the 
selectors. Its attribute is:

➤ logicalOp. The logical operator. It can be: AND, OR, 
NAND, or NOR.

For example, if you want to create the following sample filter: 
a & b || c & d, use the following set of CompositeSelectors:

CompositeSelector logicalOp="OR"
CompositeSelector logicalOp="AND"

Selector “a”
Selector “b”

CompositeSelector logicalOp="AND"
Selector “c”
Selector “d”

Element Description
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Selector An element that filter samples. . When a monitoring (leaf) CI 
has a KPI and associated business rule that are intended to be 
applied to actual data samples, the KPI properties include a 
selector. A selector is a filter definition that defines which 
samples are relevant for the KPI.

The attributes are:

➤ key. The name of the sample field.

➤ op. The operator. It can be:

➤ EQ, NOT_EQ

➤ GT, LT

➤ IN, NOT_IN. Use the |!| separator in the value attribute.

➤ GTEQ, LTEQ

➤ PREFIX, NOT_PREFIX. Filters in the samples where the 
sample field value starts with the string entered in the 
value attribute.

➤ SUFFIX, NOT_SUFFIX. Filters in the samples where the 
sample field value ends with the string entered in the 
value attribute.

➤ MATCH, NOT_MATCH. The expression you enter in the 
value attribute should follow the Java standard for 
regular expression.

➤ type. The type of field. It can be: String, Double, Integer, 
Long, Boolean, Float, or Binary.

➤ value. The value of the field in the sample. The value can 
contain the reference to a CI property with the following 
format: RefProp:<name of CI property>.

Note: Selectors are used only for monitor CIs.

Element Description
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EMS Integrations Admin Page

The page includes the following elements (listed alphabetically):

Description Lists existing EMS integrations, and enables you to 
define new integrations or edit existing ones.

To access: Select Admin > EMS Integrations > EMS 
Integrations Admin

Important 
Information

This dialog box also enables you to access the HP OVO 
and HP Service Center predefined integrations to 
integrate HP OVO or HP Service Center data into 
HP Business Availability Center.

Included in Tasks ➤ “Integrate Data from Third-Party Sources (EMS Data) 
into HP Business Availability Center” on page 380

➤ “Use the EMS Integration Tool for HP ServiceCenter 
Data” on page 390

➤ “Use the EMS Integration Tool for HP OVO Server 
Data” on page 395

GUI Element Description

Click to create a new integration. The Add Integration 
dialog box opens.

Select an integration and click to edit. The Add 
Integration dialog box opens.

Select an integration and click to delete.

Select all, deselect all, or reverse selection.

Name The name of the integration.

Description Description of the integration.
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HP Diagnostics and HP Business 
Availability Center Integration

This chapter includes configuration and customization steps that must be 
performed to configure the integration between HP Diagnostics and 
HP Business Availability Center.

This chapter describes: On page:

Tasks

View HP Diagnostics Data in HP Business Availability Center 428

Troubleshooting and Limitations 429
427



Chapter 14 • HP Diagnostics and HP Business Availability Center Integration
View HP Diagnostics Data in HP Business Availability Center

To view HP Diagnostics data in HP Business Availability Center, you must 
register the HP Diagnostics server machine in HP Business Availability 
Center.

To register HP Diagnostics:

 1 Access Admin > Diagnostics, to open the HP Diagnostics Server Details page.

If the user name with which you logged in does not have permissions for 
making changes on the HP Diagnostics server, a message is displayed instead 
of the HP Diagnostics page.

 2 Enter the details of the server as follows:

➤ Diagnostics server host name. Enter the name of the machine on which 
the HP Diagnostics server is running

➤ Diagnostics server port number. Accept the port number or enter the 
port number through which HP Diagnostics listens to server traffic

➤ Diagnostics server protocol. Select the communication protocol (HTTP 
or HTTPS) through which HP Business Availability Center connects to 
HP Diagnostics

If the server name is incorrect or the server is unavailable, an error message 
is displayed.

 3 Click Submit to register the server with HP Business Availability Center.

 4 For help with the remainder of this procedure for registering the server, see 
the HP Diagnostics Installation and Configuration Guide (Help > Diagnostics 
Help).

For information on viewing HP Diagnostics data in HP Business Availability 
Center, see the HP Diagnostics User’s Guide. 
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Troubleshooting and Limitations

Problem: After connecting HP Business Availability Center to the 
HP Diagnostics server, a message is displayed: “Session does not exist.”

Solution: Check that Internet Explorer is set up to allow the browser to 
submit cookies to the HP Diagnostics server.

To set up Internet Explorer to allow the browser to submit cookies:

 1 In Internet Explorer (version 6.0), select Tools > Internet Options > Privacy.

 2 In the Web Sites section, click the Edit button.

 3 In the Per Site Privacy Actions dialog box, enter the HP Diagnostics server 
DNS domain name.

 4 Click Allow, OK, and OK.
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Application Performance Lifecycle

Application Performance Lifecycle is designed to integrate between 
HP Business Availability Center and HP Performance Center, enabling you 
to construct load tests based on real-user transaction data collected by the 
Real User Monitor.

This chapter describes: On page:

Concepts

Overview of Application Performance Lifecycle 434

Application Performance Lifecycle Reports 434

Tasks

Application Performance Lifecycle Workflow 438

Analyze the Business Process Distribution Report 439

Replay a Session 442

Generate a Script Template 443

Analyze a Typical Transaction Load Report 443

Analyze the Location Load Analysis Report 445

Use Application Performance Lifecycle Reports – A Case Scenario 447

Refine Your Script Template in VuGen 450

Configure and Run a Load Test 454

Work with the Central Repository Service (CRS) 459
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Overview of Application Performance Lifecycle

Application Performance Lifecycle enables quality assurance engineers to 
design load tests based on data leveraged from a production environment, 
rather than a testing environment. Using Application Performance 
Lifecycle, the QA engineer can construct load tests that are based on real-
user transaction data and are therefore a more accurate simulation of load 
than standard Performance Center load tests. Application Performance 
Lifecycle thus increases the effectiveness of load tests and provides the QA 
team with more accurate test results.

To achieve this goal, Application Performance Lifecycle provides the 
following:

➤ Production Analysis reports from which the QA engineer can extract real-
user transaction data to be used in Performance Center load tests

➤ The ability to create Virtual User Generator (VuGen) script templates, based 
on real-user activity

Application Performance Lifecycle Reports

Use Application Performance Lifecycle Production Analysis reports to 
pinpoint data that you want to use in building your Performance Center 
load test.

This section includes the following topics:

➤ “Business Process Distribution Report” on page 435

➤ “Typical Transaction Load Report” on page 436

➤ “Location Load Analysis Report” on page 437
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Business Process Distribution Report
The report enables you to view transaction run and transaction response 
time data over time for the configured transactions monitored by the Real 
User Monitor, create VuGen script templates that can be used in a 
Performance Center load test. You can create a VuGen script template either 
by instructing Application Performance Lifecycle to automatically generate 
a script template based on a session it selects, or by manually selecting the 
specific session you want to include in your script template. 
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For details, see “Business Process Distribution Page” on page 474.

Typical Transaction Load Report
This report enables you to view the average transaction load (the number of 
Real User Monitor transaction runs) during a typical hour, day, or week 
within a larger time frame that you select. Use the data in this report to:

➤ View the typical load on your system during specific time frames, which can 
assist you in determining the time frame you want to use for your 
Performance Center load test.

➤ Assist you, together with the data in the Business Process Distribution 
report, in selecting the transactions to include in your VuGen script 
templates.

For details, see “Typical Transaction Load Report” on page 485.
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Location Load Analysis Report
This report enables you to view the transaction load (the number of Real 
User Monitor transaction runs) and bit rate (bits per second) per end-user 
location. 

Use the data in this report in configuring Vusers and load generators for 
your Performance Center load test, as well as the run-time settings for your 
Application Performance Lifecycle-generated VuGen script.

For details, see “Location Load Analysis Report” on page 480.
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Application Performance Lifecycle Workflow

Working with Application Performance Lifecycle involves performing the 
following procedures:

Configure Real User Monitor Transactions and Schedule 
the Snapshot Collection
Ensure that Real User Monitor transactions are defined and that a 
transaction snapshot collection schedule is configured.

For details on configuring Real User Monitor transactions, see “New/Edit 
Transaction” in Using End User Management. For details on configuring a 
transaction snapshot collection schedule, see “New/Edit Application” in 
Using End User Management.

Analyze Production Analysis Reports
In the Production Analysis reports, analyze production performance data, 
export the data you want to use when building a Performance Center load 
test, select the real-user transactions and sessions you want to use in your 
VuGen scripts, and generate script templates.

For details, see “Application Performance Lifecycle User Interface” on 
page 473.

Refine Script Templates
In VuGen, adjust the scripts generated by Application Performance Lifecycle 
for use in a Performance Center load test.

For details, see “Refine Your Script Template in VuGen” on page 450.

Setup and Run a Load Test or Scenario That Includes the 
Scripts
In Performance Center or LoadRunner, set up and run a load test or scenario 
that incorporates the scripts you created and refined and emulates the real-
user behavior displayed in the Production Analysis reports.

For details, see “Configure and Run a Load Test” on page 454.
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Analyze the Business Process Distribution Report

You use the Business Process Distribution report to pinpoint the Real User 
Monitor transactions with the greatest number of runs and the highest 
session popularity. You then drill down in this report to view the individual 
sessions in which these transactions were run. You can also use the Business 
Process Distribution report to pinpoint the transactions that were 
problematic in terms of response time and availability and drill down so 
that you can isolate the sessions, and pages within the sessions, that were 
problematic.

You select a session—either one that was popular and contained a large 
number of transaction runs, or one that was problematic in terms of 
response time or availability—as the basis for your VuGen script template. 
Alternatively, you can select transactions from the Business Process 
Distribution report and instruct Application Performance Lifecycle to 
automatically select a session for each transaction and generate a VuGen 
script template based on this session. For each transaction, Application 
Performance Lifecycle selects the session with a combination of the greatest 
number of runs, the shortest duration, and the least number of errors.

Note: You can use this report in conjunction with the Typical Transaction 
Load report to ensure that the transactions you select reflect typical 
transaction behavior during the selected time period. For details of a case 
scenario describing the use of the Business Process Distribution report in 
conjunction with the Typical Transaction Load report, see “Use Application 
Performance Lifecycle Reports – A Case Scenario” on page 447.

To analyze the Business Process Distribution report, access the Business 
Process Distribution report. For details, see “Business Process Distribution 
Page” on page 474. 
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Example

 1 Access the Business Process Distribution report, select a transaction, based 
on the total number of runs for the transaction as well as the transaction’s 
session popularity (or response time/availability data), and click the View 
Sessions button to open the Sessions page. It displays data for each session 
in which the selected transaction was run and a transaction snapshot was 
collected, as well as certain key statistic averages of all the displayed 
sessions. For additional information on the Sessions page, see “Session 
Analyzer Report” in Using End User Management.
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 2 Select the session you want to use for your VuGen script, based on page hit 
and error data, and click the View Session Details button. The Session 
Details page opens, displaying general session and event information, as 
well a list of all the pages accessed as part of the session and the events and 
response time for each page. The pages that were included in the selected 
transaction’s definition are highlighted.

Note: Event data is displayed only if you configured events for the 
application with which the transaction you are viewing is associated. For 
information on events and their configuration, see “Real User Monitor 
Administration User Interface” in Using End User Management.

For additional information on the Session Details page, see “Session Details 
Page” in Using End User Management.
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Replay a Session

To replay a session page by page in your Web browser, in the Session Details 
page (which you access by clicking the View Sessions button for a selected 
transaction in the Business Process Distribution report), click Session 
Replay. The Session Viewer window opens, displaying three panes.

The upper-left pane displays a hierarchal tree of the pages included in the 
session, and their components. There is also an entry for the session details. 
Click on the item in the tree you want to view. Page and component names 
that are preceded by a camera icon, are pages and components for which 
snapshots exist.

The lower-left pane displays general details of the selected page or 
component, or details of the session if Session Details is selected in the 
upper-left pane.

The right-hand pane includes the following tabs:

➤ Snapshot View. Displays a picture of the page accessed by the user.

➤ Page Source. Displays the HTML source code of the snapshot.

➤ Events. Displays the configured events that occurred on the page.

Note: If Session Details is selected for viewing, only the Events tab is 
enabled.

To download all the snapshots included in a session to a zip file, click the 
Download button above the left pane. The Save dialog box opens. Select the 
path and file name you want and click Save. The saved zip file includes a 
Java applet for viewing the saved information.
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Note: If the snapshot requested is one of an HTTP Not Found error (HTTP 
error code 404), in some instances the link to the referring machine will be 
to an HP Business Availability Center server machine instead of to the 
original Web server machine that reported the error. This is due to an html 
script that generates a link being stored in the snapshot, rather than the 
actual link itself.

Generate a Script Template

From the Session Details page, you click Generate Script Template to 
generate a template for your VuGen script that includes the pages in the 
current session. If you have enabled the CRS on the Infrastructure Settings 
Manager page, you are prompted to save the script template in the 
repository. For details on enabling the CRS and saving scripts in the 
repository, see “Save a Script Template or Scenario Package in the CRS” on 
page 460. If the CRS is not enabled, you are prompted to save the script 
template in your regular directory structure.

You should generate a script template for each transaction you would like to 
include in your Performance Center load test.

Tip: Save all your script templates in the same directory so that they are all 
easily accessible when constructing a Performance Center load test.

Analyze a Typical Transaction Load Report

You use the Typical Transaction Load report to view the average transaction 
load during a typical week, day, or hour. In general, you use the Typical 
Transaction Load report, and the ability to drill down within this report, to 
pinpoint the time frame you want to use for your Performance Center load 
test. 
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Example

If you selected to view a typical week during the past month, the Typical 
Transaction Load report may display data such as the following.

Since Wednesday is typically the day with the greatest number of 
transaction runs, you would choose to run your load test on a Wednesday. 
To view the specific hours on Wednesday at which transaction load was 
typically at its peak, click one of the bars in the Wednesday column. The 
Typical Transaction Load graph displays the typical load for each hour on 
Wednesday.
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Since load is typically greatest at 9:00 AM or 11:00 AM, you would choose to 
run your load test during this time range. You can also drill down to view 
the minutes during which transaction load was typically at its peak, 
however this data is less relevant for the construction of a load test than the 
typical daily and hourly data.

Note: You can also use this report in conjunction with the Business Process 
Distribution report to determine whether a large number of runs displayed 
for a transaction in the Business Process Distribution report is typical of the 
transaction’s behavior during the selected time period. If the Typical 
Transaction Load report indicates that the transaction load displayed in the 
Business Process Distribution report is typical of the transaction’s load 
during the selected time period, it is recommended that you use the 
transaction for your VuGen script.

Analyze the Location Load Analysis Report

You use the Location Load Analysis report to view the distribution of Real 
User Monitor transaction runs among end-user locations, as well as the bit 
rate of each transaction at each location. You then use the location data in 
selecting load generators, the transaction run data in distributing Vusers 
among load generators, and the bit rate data in configuring each script’s 
network speed simulation settings.

Example

For example, if you selected to view location data for four transactions—
APL_BuyTx, APL_MyAccountTx, APL_SearchTx, and APL_MyOrdersTx—
during the past month, the Location Load Analysis report may display data 
such as the following.
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Based on this report, you may choose to select load generators from one or 
more of the above locations when configuring your load test. Your 
distribution of Vusers among the load generators would most likely be based 
on the distribution of transaction load (that is, the number of transaction 
runs being run) among the above locations. For an explanation of 
configuring load tests based on Production Analysis report data, see 
“Configure and Run a Load Test” on page 454.

In addition, you would use the bit rate data in this report in configuring the 
Network: Speed Simulation VuGen run-time settings of the Application 
Performance Lifecycle-generated scripts that you are using for your load test. 
For example, if you generated a script based on the APL_SearchTx 
transaction and planned to run this script from two load generators—one 
located in Los Angeles and the other in San Francisco—you would do the 
following:

➤ create two copies of the script;

➤ set the custom bandwidth for the script being run from Los Angeles at 
182,127,139 bits per second;

➤ set the custom bandwidth for the script being run from San Francisco at 
231,718,670 bits per second.

For details on configuring Application Performance Lifecycle-generated 
scripts based on data from the Location Load Analysis report, see the Set the 
Speed Simulation step in “Refine Your Script Template in VuGen” on 
page 450.
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Use Application Performance Lifecycle Reports – A Case 
Scenario

This section describes a typical case scenario in which a user worked with all 
three Application Performance Lifecycle reports to obtain the information 
he required to construct a Performance Center load test. 

Initially, the user accessed the Business Process Distribution report to view 
data for the five transactions with the greatest number of run instances 
during the period of a week, from January 26, 2006 to February 2, 2006. The 
Business Process Distribution report showed that APL_SearchTx was the 
transaction with the greatest number of runs—a total of 4,114 transaction 
runs—as well the most popular transaction (run in 18% of the sessions).

To verify that this data reflected the typical transaction load for the 
APL_SearchTx transaction during this time period, the user accessed the 
Typical Transaction Load report and viewed data for a typical week during 
the monthly period of January 2, 2006 to February 2, 2006. The Typical 
Transaction Load report showed that the average transaction load for the 
APL_SearchTx transaction was indeed significant during this period of time.

The user then drilled down further in the Typical Transaction Load report to 
discover the specific hours on Wednesday (the day with the greatest number 
of transaction runs) during which transaction load was typically at its peak. 

The drilldown showed that load was typically greatest at 9:00 AM, so the 
user decided that he would later run his load test at this hour. To be able to 
use this data as well as the average transaction run data later on, when 
configuring a load test, the user saved the report in .PDF format.
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Having received confirmation of the significance of the APL_SearchTx 
transaction, the user returned to the Business Process Distribution report to 
generate a VuGen script of a session in which the APL_SearchTx transaction 
was run. To view the sessions in which APL_SearchTx was run and a 
transaction snapshot was collected, the user clicked the View Sessions 
button. After viewing error and page hit data for each displayed session, the 
user selected to view details of a session with 1 application error, 1 HTTP 
error, and 13 page hits.

The user then clicked the View Session Details button to view details of the 
end user that ran the selected session, as well as the pages that were accessed 
as part of the session (with those included in the transaction highlighted).

After viewing all of this data, the Application Performance Lifecycle user 
decided to use this session as the basis for a VuGen script and clicked 
Generate Script Template on the Session Details page to Application 
Performance Lifecycle to create a script template from the session. The user 
saved the generated script to the CRS.
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To prepare additional data for the configuration of his load test, the user 
accessed the Location Load Analysis report and selected to view location 
data for the APL_SearchTx transaction. The Location Load Analysis report 
showed that end users at three locations—Los Angeles, San Diego, and San 
Francisco—ran the APL_SearchTx transaction.

To be able to use this data for his Performance Center load test, the user 
saved the Location Load Analysis report in .PDF format.

Based on this report, the user decided to run the script he generated from 
three different load generators, each located at one of the above locations. 
To do so, the user created three different copies of the script and set the 
Network: Speed Simulation VuGen run-time settings for each script 
according to the bit rate for the location from which the script was going to 
be run (for details, see “Set the Speed Simulation” on page 453). The user 
also based his distribution of Vusers among the load generators on the 
distribution of total runs among the above locations. (For details on 
configuring load tests, see “Configure and Run a Load Test” on page 454.)

Note: The above case scenario describes the generation of one script, based 
on one transaction, however a true use case will typically include several 
scripts, based on several different transactions. 
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Refine Your Script Template in VuGen

To use Application Performance Lifecycle-generated scripts in a Performance 
Center load test, you must first customize them using VuGen.

Note: If you exported the script templates you created in Application 
Performance Lifecycle to the CRS, see “Open a Script Saved in the CRS” on 
page 462 for details on how to open the script templates in VuGen.

This section includes the following topics:

➤ “Parameterize Recorded Values” on page 451

➤ “Correlate Recorded Values” on page 452

➤ “Set the Speed Simulation” on page 453
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Parameterize Recorded Values
When you generate a script using Application Performance Lifecycle, the 
script contains the actual end-user values that the Real User Monitor 
recorded. If you want to perform the script’s actions (query, submit, and so 
on) using different values from those recorded by the Real User Monitor, 
you must replace the values with parameters.

Example

Suppose you generated a script containing the following statement that 
searches a library’s database for the title UNIX: 

When you run this script in a Performance Center load test, you do not 
want to repeatedly use the same value, UNIX. You therefore replace the 
constant value with a parameter:

 web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value=UNIX",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);

;

web_submit_form("db2net.exe",
ITEMDATA,
"name=library.TITLE",
"value={Book_Title}",
ENDITEM,
"name=library.AUTHOR",
"value=",
ENDITEM,
"name=library.SUBJECT",
"value=",
ENDITEM,
LAST);
451



Chapter 15 • Application Performance Lifecycle
When you run a load test using a parameterized script, Vusers substitute the 
parameter with different values from a data source that you specify. The data 
source can be either a file or internally generated variables.

For detailed instructions on replacing the constant values in your generated 
script with parameters, as well as setting the properties and data source for 
these parameters, see Using HP Virtual User Generator.

Notes:

➤ You can parameterize complete strings or parts of strings.

➤ You can define more than one parameter for functions with multiple 
arguments (such as URLs, server names, and IP addresses).

Correlate Recorded Values
In addition to parameterizing the script you generated using Application 
Performance Lifecycle, you must correlate certain statements within the 
script. Correlation allows you to link statements by using the results of one 
statement as input for another.

You correlate statements for one or both of the following reasons:

➤ to generate dynamic data – For example, if the Real User Monitor session 
from which you generated your script was identified by the date and time, 
when you try to replay a script of this session, it will fail because the current 
time is different than the original recorded time. Only if you correlate the 
date and time will you be able to save it as dynamic data and use it 
throughout the load test or session step run.

➤ to accommodate unique data records – For example, if the Real User 
Monitor recorded a session requiring the use of unique values, such as the 
process of opening a new bank account, replaying a script of the session will 
fail because the recorded value already exists and cannot be recreated. 
Correlating the value enables you to create additional unique values—based 
on the recorded value—to be used throughout the load test or session step 
run.
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For detailed instructions on correlating a script, see Using HP Virtual User 
Generator.

Set the Speed Simulation
You set the speed simulation for your Application Performance Lifecycle-
generated script based on data contained in the Location Load Analysis 
report.

To set the speed simulation for a script:

 1 In VuGen, select Vuser > Run-Time Settings or click the Run-Time Settings 
button on the toolbar to open the Run-Time Settings dialog box.

 2 In the Run-Time Settings tree, select the Network: Speed Simulation node.

 3 Select Use custom bandwidth and specify the bit rate of the location from 
which you want to run the script, according to the bit rate displayed for this 
location (for the transaction upon which the script is based) in the Location 
Load Analysis report. For example, if the transaction upon which your script 
is based was run by a significant number of users in Los Angeles, California, 
you would specify the bit rate displayed for Los Angeles in the Location 
Load Analysis report’s Transaction Bit Rate Per Location graph.
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Note: If you want to run the same script from several different locations, 
you can save several copies of the script and assign each copy a custom 
bandwidth reflecting the bit rate of a specific location. For details on 
assigning load generators to each copy of the script, see “Configure and Run 
a Load Test” on page 454.

 4 Click OK to apply the updated run-time settings.

Configure and Run a Load Test

This section describes how to configure and run Performance Center and 
LoadRunner load tests that incorporate the scripts you created using 
Application Performance Lifecycle and emulate the real-user behavior 
displayed in the Production Analysis reports.

This section includes the following topics:

➤ “Configure and Run a Load Test in Performance Center” on page 454

➤ “Configure and Run a Scenario in LoadRunner” on page 456

Configure and Run a Load Test in Performance Center
After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a load test in Performance Center that 
incorporates these scripts and emulates the real-user behavior displayed in 
the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a load test. For detailed instructions on creating a load test, see the 
HP Performance Center User’s Guide. 
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Incorporate Application Performance Lifecycle-Generated 
Scripts in a Load Test

Connect VuGen to the Performance Center Web server and either upload 
your script files directly to the Performance Center Web server or save them 
in the file system. For detailed instructions, see Using HP Virtual User 
Generator.

If you saved the Application Performance Lifecycle-generated scripts in the 
CRS, see “Upload Scripts from the CRS to Performance Center” on page 463 
for details on uploading the scripts to the Performance Center Web server.

Incorporate the Production Analysis Report Data in a Load Test

 1 Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, e-mailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieve a Report Saved in the CRS” on page 462.

 2 In Performance Center, select Load Tests > Create/Edit from the left menu 
to open the Load Tests page.

 3 Click New Load Test to create a new load test. 

 4 In the Design Groups tab, select the scripts you generated using Application 
Performance Lifecycle and customized in VuGen. Select one or more load 
generators to run each script, based on the location data in the Location 
Load Analysis report. For example, if the transaction upon which one of 
your scripts is based was run from Los Angeles, California, you would select 
one or more load generators located in Los Angeles to run this particular 
script.

Note: Ensure that the Network: Speed Simulation run-time settings of each 
script are set to match the bit rate specified in the Location Load Analysis 
report for the location from which the script is being run. For details on 
configuring Network: Speed Simulation run-time settings, see “Set the Speed 
Simulation” on page 453.
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 5 Distribute the Vusers among the Vuser groups based on the distribution of 
transaction load among the locations displayed in the Location Load 
Analysis report, represented by the load generators you selected for each 
group. For example, if the transactions upon which your scripts are based 
were run from three locations and each location ran approximately one 
third of the transactions, you would distribute the Vusers evenly among the 
Vuser groups.

The overall number of Vusers for your load test should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers to run, however, ensure that you take into 
account the difference in scaling between load test and production 
environments.

 6 In the Scheduler tab, configure the Ramp Up and Ramp Down of Vusers 
based on data in the Typical Transaction Load report. For example, if the 
Typical Transaction Load report showed that an average of 100 transactions 
were run at the beginning of the time period you selected to use for your 
load test and 80 transactions were run at the end of this time period, you 
might configure your load test to start 100 Vusers every hour and stop 80 
Vusers every hour. Note, however, that you must take into account the 
difference in scaling between load test and production environments.

 7 Complete your load test configuration and run the load test from the Load 
Tests Configuration page by clicking Start, or from the Load Tests page by 
clicking the Run Test icon in the row of the load test that you want to run. 
For details on configuring and running a load test, see the HP Performance 
Center User’s Guide.

Configure and Run a Scenario in LoadRunner
After you have refined your Application Performance Lifecycle-generated 
scripts using VuGen, you can create a manual scenario in the LoadRunner 
Controller that incorporates these scripts and emulates the real-user 
behavior displayed in the Production Analysis reports.

This section describes how to incorporate the Application Performance 
Lifecycle-generated scripts and Production Analysis report data in designing 
a manual scenario. For detailed instructions on creating a manual scenario, 
see the HP LoadRunner Controller User’s Guide. 
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Incorporate Application Performance Lifecycle-generated 
scripts in a scenario

 1 In the New Scenario dialog box, choose Manual Scenario. Do not select the 
Use the Percentage Mode check box.

 2 Click the Browse button, navigate to the directory in which you saved the 
Application Performance Lifecycle-generated scripts that you modified using 
VuGen, and select the scripts.

If these scripts are saved in the CRS, see “Open a Script Saved in the CRS” on 
page 462 for details on selecting them.

 3 Click the Add button to add the scripts to your scenario.

Incorporate the Production Analysis report data in a scenario

 4 Access the Business Process Distribution, Typical Transaction Load, and 
Location Load Analysis reports that you printed, e-mailed, or saved while 
working with the Production Analysis reports. For details on retrieving a 
report from the CRS, see “Retrieve a Report Saved in the CRS” on page 462.

 5 In LoadRunner, to the right of the Scenario Groups pane, click the Add 
Group button. Select a script you generated using Application Performance 
Lifecycle and customized in VuGen. Select one or more load generators to 
run the script, based on the Location Load Analysis report’s location data for 
the transaction upon which the script is based. For example, if the 
transaction upon which one a script is based was run from Los Angeles, 
California, you would select one or more load generators located in Los 
Angeles to run this script.

Note: Ensure that the Network: Speed Simulation run-time settings of the 
script are set to match the bit rate specified in the Location Load Analysis 
report for the location from which the script is being run. For details on 
configuring Network: Speed Simulation run-time settings, see “Set the Speed 
Simulation” on page 453.
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Select a quantity of Vusers for the group. Vusers should be distributed 
among Vuser groups based on the distribution of transaction load among 
the locations displayed in the Location Load Analysis report, represented by 
the load generators you selected for each group. For example, if the 
transactions upon which your scripts are based were run from three 
locations and each location ran approximately one third of the transactions, 
you would distribute the Vusers evenly among the Vuser groups.

The overall number of Vusers for your scenario should be based on the 
average transaction run data in the Typical Transaction Load report. In 
specifying the number of Vusers, however, ensure that you take into 
account the difference in scaling between load test and production 
environments.

Note: You use the Add Group dialog box to add each Application 
Performance Lifecycle-generated script you want to include in your 
scenario. Since each location requires specific script network run-time 
settings, each location requires its own unique script. For details on 
preparing a script to be run from each location, see “Set the Speed 
Simulation” on page 453.

 6 In the Schedule Builder, configure the Ramp Up and Ramp Down of Vusers 
based on data in the Typical Transaction Load report. For example, if the 
Typical Transaction Load report showed that an average of 100 transactions 
were run at the beginning of the time period you selected to use for your 
load test and 80 transactions were run at the end of this time period, you 
might configure your load test to start 100 Vusers every hour and stop 80 
Vusers every hour. Note, however, that you must take into account the 
difference in scaling between load test and production environments.

 7 Complete your scenario configuration and run the scenario from the Run 
tab of the Controller. For details on configuring and running a scenario, see 
the HP LoadRunner Controller User’s Guide.
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Work with the Central Repository Service (CRS)

This section describes how to export Production Analysis reports to the CRS, 
generate a script template or scenario package and save it in the CRS, open 
scripts saved in the CRS, retrieve reports saved in the CRS, and upload 
scripts saved in the CRS to Performance Center.

When working with the Central Repository Service, you are only able to see 
the folders in the Central Repository Service for which you, the logged-in 
user, have permissions to view. For details on setting permissions for the 
Central Repository Service, see “CRS Permissions” in Platform Administration.

This section includes the following topics:

➤ “Export a Report to the CRS” on page 459

➤ “Save a Script Template or Scenario Package in the CRS” on page 460

➤ “Open a Script Saved in the CRS” on page 462

➤ “Retrieve a Report Saved in the CRS” on page 462

➤ “Upload Scripts from the CRS to Performance Center” on page 463

Export a Report to the CRS
By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can export the Production Analysis reports to the CRS.

Note: If the CRS is disabled, re-enable it by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Foundations, 
select Production Analysis, and locate the CRS Enabled entry in the 
Production Analysis - Central Repository Service table. Modify the value to 
true.

To export a report to the CRS:

 1 From the toolbar at the top right-hand corner of the report, select Export > 
Central Repository Service. A new browser window opens, displaying Report 
under Type. 
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 2 In the Name text box, enter the name under which you want to save the 
report in the repository. 

 3 In the Description text box, enter a description of the report. This field is 
optional. 

 4 Browse the Root directory tree to select the folder in which you want to save 
the report. The files that are currently stored in the selected folder are 
displayed in the Folder Content table on the right. 

 5 To save the report in a new folder, click the Create New Folder button, enter 
the folder name and description, click OK, and then click the Refresh button 
to view the new folder in the directory tree. 

 6 To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. 

 7 To delete a folder, click the Delete Folder button and click Yes. 

 8 Click Save. If the save process has been completed successfully, Report saved 
to repository is displayed at the top of the browser window. 

 9 Click Close to close the browser window and return to the report you were 
viewing.

Save a Script Template or Scenario Package in the CRS
By default, the CRS is enabled on the Infrastructure Settings Manager page 
and you can save your generated script templates or a scenario package in 
the CRS.

Note: If the CRS is disabled, re-enable it by selecting Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Foundations, 
select Production Analysis, and locate the CRS Enabled entry in the 
Production Analysis - Central Repository Service table. Modify the value to 
true.
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To save a scenario package or script template in the CRS:

 1 Click the Generate Scenario Package button in the Business Process 
Distribution report, or the Generate Script Template button at the top of 
the Session details page. A new browser window opens, displaying Scenario 
Package or VuGen Script under Type. 

 2 In the Name text box, enter the name under which you want to save the 
scenario package or script template in the repository. 

 3 In the Description text box, enter a description of the scenario package or 
script template. This field is optional. 

 4 Browse the Root directory tree to select the folder in which you want to save 
the scenario package or script template. The files that are currently stored in 
the selected folder are displayed in the Folder Content table on the right. 

 5 To save the scenario package or script template in a new folder, click the 
Create New Folder button, enter the folder name and description, click OK, 
and then click the Refresh button to view the new folder in the directory 
tree. 

 6 To rename a folder, click the Rename Folder button, enter the new folder 
name, click OK, and then click the Refresh button to view the new folder 
name in the directory tree. 

 7 To delete a folder, click the Delete Folder button and click Yes. 

 8 Click Generate. If the generation process has been completed successfully, 
Scenario package saved to repository or VuGen script template saved to 
repository is displayed at the top of the browser window. 

 9 Click Close to close the browser window and return to main page or Session 
Details page of the Business Process Distribution report.
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Open a Script Saved in the CRS
You can open scripts saved in the CRS from both VuGen and the 
LoadRunner Controller.

To open a script saved in the CRS:

 1 In the main VuGen window, select Tools > Quality Center Connection. 

 2 In the LoadRunner Controller’s New Scenario dialog box, click the Quality 
Center button. 

 3 In the Quality Center Connection dialog box, enter the CRS URL, 
http://<HP Business Availability Center server machine>:8080/qcbin, and 
click Connect. 

 4 Click Browse in the Controller, or select File > Open in VuGen, to select the 
scripts you saved in the CRS. If the scripts were automatically generated by 
Application Performance Lifecycle, they are located in a zip file within the 
scenario package file you created.

Note: When you save your scripts after editing them in VuGen, they are 
automatically saved in the CRS.

Retrieve a Report Saved in the CRS
You can retrieve a report saved in the CRS in order to incorporate its data in 
your Performance Center load test or LoadRunner scenario.

To retrieve a report saved in the CRS:

 1 Access the CRS URL (http://<HP Business Availability Center server 
machine>:8080/qcbin). 

 2 Download the report PDF saved in the CRS by clicking the Download 
button. If the report is a Summary report that is part of a scenario package, it 
can be downloaded from the scenario package zip file.
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Upload Scripts from the CRS to Performance Center
To incorporate scripts saved in the CRS in your Performance Center load 
test, you must upload the scripts to the Performance Center Web server.

To upload scripts from the CRS to Performance Center:

 1 In the main VuGen window, select Tools > Quality Center Connection and 
open the scripts you saved in the CRS as described in “Open a Script Saved 
in the CRS” on page 462. 

 2 Connect VuGen to the Performance Center Web server as described in Using 
HP Virtual User Generator. 

 3 Upload the script files to the Performance Center Web server as described in 
Using HP Virtual User Generator.
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Business Process Recognition

This chapter describes the Business Process Recognition (BPR) application.

This chapter describes: On page:

Concepts

Business Process Recognition Application Overview 466

Business Process Recognition Architecture 468

Tasks

Convert Real User Monitor Data into Business Process Recognition 
Data

468

Deploy Business Process Recognition and Analyze the Results 469

Customization

Modify the Threshold Defaults for Brownouts 470

Modify the Maximum Number of Processing Days per Application 471

Modify the Number of Business Processes That Can be Displayed in 
the Main View

471
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Business Process Recognition Application Overview

Use the Business Process Recognition (BPR) application to discover business 
processes that can help you monitor what really matters.

The application uses a Web mining algorithm to discover frequently 
occurring process/transaction patterns in the use of Web applications. Such 
patterns could indicate business processes.

The Business Process Recognition application is part of the APL (Application 
Performance Lifecycle) package. As part of Application Performance 
Lifecycle it extends the abilities of the Real User Monitor solution. Business 
Process Recognition works on Real User Monitor raw data (session click 
streams kept in the Real User Monitor MySQL database). This data is first 
processed into Business Process Recognition format and then can be used as 
an input to the Business Process Recognition reports applet that discovers 
business processes and other useful information.

Both the administration applet and the reports applet work in the context of 
specific Real User Monitor defined applications.

The user selects to run the discovery on specific pages that are Business 
Critical Pages, on all pages (by giving them a new unique Id), or on both 
types of pages. Business Critical Pages are the pages you configure for an 
application in End User Management Administration. 

You can discover business processes day by day up to a maximum of 40 
days. When you want to run the discovery on additional days above the 
maximum, you must remove the equivalent number of days from the 
planned discovery. Data is accumulated using a scheduled process, around 
midnight on the scheduled day. To configure the maximum number of 
processing days, see “Modify the Maximum Number of Processing Days per 
Application” on page 471.

You can also perform emergency import of data. After the data is gathered 
from the Real User Monitor engine files, the discovery is run on all files that 
include data. One applet is used for configuration and one applet for 
reports. Note that the process may take a while, and can also lower Real User 
Monitor performance during business hours.
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On the days you analyze the data, you can tune the discovery as follows:

➤ Specify the minimum session length (minimum number of pages in the 
session)

➤ Remove duplicate pages (automatically refreshed pages for example)

➤ Ignore meaningless pages. For example, if your application pings the server 
regularly, the ping page has no business meaning and can be ignored.

➤ Include sessions that contain specific pages. For example, if you would like 
to find out why users leave the site after a certain page, filter only sessions 
that include this page, so BPR can find the most common business processes 
which lead to leaving the application though this page.

Before generating the report, you must schedule the import and conversion 
of data from the Real User Monitor. After you generate the report, the 
discovery is run on the imported data. Note that, the HPWebAlgorithm.exe 
process (the data mining/analysis process) takes place on the client machine 
and might have an impact on the CPU.

While running, the report is saved in the temporary memory/file, which is 
erased at the end of the session. You can save the report or export it to a 
recipient who can then open the file in the Business Process Recognition 
application.
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Business Process Recognition Architecture

The Business Process Recognition process retrieves data from the Real User 
Monitor database at night. The data is then converted to reduce the data 
size.

Once Real User Monitor sessions are exported into small size format you can 
start to filter/manipulate the data. From this point, you can run the 
algorithm over and over again with no effect on the Real User Monitor 
engine and database. 

You can filter the data by the number of pages in the session. You can 
remove duplicate consecutive pages, ignore pages, include sessions that 
include specific pages, and so on.

Convert Real User Monitor Data into Business Process 
Recognition Data

This section describes the processes used to convert the Real User Monitor 
data into Business Process Recognition data.
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To convert Real User Monitor data into Business Process Recognition data, 
click Application > Application Performance Lifecycle > Business Process 
Recognition > Business Process Recognition Settings and specify how to 
process Real User Monitor sessions data into Business Process Recognition 
format, and schedule the dates when the data will be processed. 

Note: Business Process Recognition tasks automatically stop after two hours 
of processing, whether or not they have completed, to avoid placing a heavy 
load on Real User Monitor resources. Tasks stopped before completion are 
marked as successful and are available for analysis, but only contain the Real 
User Monitor traffic up to the time they stopped and not for the entire date 
as configured.

For details, see “Business Process Recognition Settings Page” on page 491.

Deploy Business Process Recognition and Analyze the 
Results

This section describes how to run the Business Process Recognition tool and 
analyze the resulting data.

Set Up Business Process Recognition 
Once Business Process Recognition data is available, create a report by 
clicking Application > Application Performance Lifecycle > Business Process 
Recognition > Business Process Recognition Settings, select the date range, and 
filter the pages on which you want to run the Business Process Recognition 
tool. 

For details, see “Business Process Recognition Tool Page” on page 494.
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Customize Business Process Recognition
You can modify:

➤ the default threshold settings for brownouts. For details, see “Modify the 
Threshold Defaults for Brownouts” on page 470.

➤ the maximum number of exported days for each application. For details, see 
“Modify the Maximum Number of Processing Days per Application” on 
page 471.

➤ the maximum size of the results. For details, see “Modify the Number of 
Business Processes That Can be Displayed in the Main View” on page 471.

Generate and Analyze the Report
Click Business Process Recognition tools, select the application, select the 
report data, and click the Generate button. The applet downloads the 
Business Process Recognition data in the requested time range, filters the 
data to find business processes, and runs the data mining algorithm to find 
the business processes. Use the different filters to tune the data you want to 
display and use the buttons in the report to configure the graph. You can 
then analyze the displayed data.

For details, see “Business Process Recognition Tool Page” on page 494.

Modify the Threshold Defaults for Brownouts

To modify the default threshold settings for brownouts, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Business Process Recognition, and locate the Critical 
threshold, Major threshold, Minor threshold, and Warning threshold 
entries in the Business Process Recognition - Brownout Settings table. 
Modify the value of those thresholds.
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Modify the Maximum Number of Processing Days per 
Application

To modify the maximum number of processing days per application, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Business Process Recognition, and locate the 
Maximum export days entry in the Business Process Recognition - 
Parameter Settings table. Modify the value of this entry.

Modify the Number of Business Processes That Can be 
Displayed in the Main View

To modify the number of Business Processes that can be displayed in the 
main view of the Business Process Recognition Tool, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Business Process Recognition, and locate the Maximum results size 
entry in the Business Process Recognition - Parameter Settings table. 
Modify the value of this entry. Default is 100.
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Application Performance Lifecycle User 
Interface

This chapter includes the pages and dialog boxes that are part of the 
Application Performance Lifecycle user interface.

This chapter describes: On page:

Business Process Distribution Page 474

Location Load Analysis Report 480

Select Locations Dialog Box 483

Select Transactions Dialog Box 484

Typical Transaction Load Report 485
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Business Process Distribution Page

Description Enables you to:

➤ View transaction run and transaction response time 
data over time for the configured transactions 
monitored by the Real User Monitor. 

➤ Create VuGen script templates that can be used in a 
Performance Center load test. You can create a 
VuGen script template in one of two ways:

➤ by instructing Application Performance Lifecycle 
to automatically generate a script template based 
on a session it selects

➤ by manually selecting the specific session you 
want to include in your script template

To Access: Select Applications > Application 
Performance Lifecycle > Production Analysis > Business 
Process Distribution

Important 
Information

You can drill down in this report to view data for each 
session in which the displayed transactions were run.

Note: If the Central Repository Service (CRS) is 
enabled, you can export a PDF of the report to the CRS 
by selecting Export > Central Repository Service . 
For details on exporting the report to the CRS, see 
“Export a Report to the CRS” on page 459.

Included in Tasks ➤ “Analyze the Business Process Distribution Report” 
on page 439

➤ “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 447
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Report Settings

The area includes the following elements (listed alphabetically):

GUI Element Description

<Common report 
settings>

For details, see “Understanding Common Report 
Elements” in Reference Information.Note: If you already 
selected a time range in one of the other Production 
Analysis reports, the time range you previously selected 
will automatically be displayed in the Business Process 
Distribution report.
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Show <nn> 
transactions 
<condition> from 
<application>

Select and specify:

➤ <nn>. The number of real-user transactions you 
want the report to display.

➤ <condition>. Select one of the following:

➤ with the greatest number of runs. To display the 
real-user transactions that experienced the 
highest total number of run instances.

➤ with the worst response times. To display the 
real-user transactions that experienced the 
greatest overall transaction time.

➤ with the highest session popularity. To display 
the real-user transactions that were most popular 
among the sessions. Popularity is determined by 
dividing the number of unique sessions running a 
transaction by the total number of sessions.

➤ with the lowest availability. To display the real-
user transactions that experienced the lowest 
transaction availability. 

➤ <application>. Select to display the transactions 
from all monitored applications (All applications) 
that meet the selected criteria, or only transactions 
that were defined for a specific application.

Transaction Selection Select this option and click Transaction Selection to 
open the Select Transaction dialog box.

Note:

➤ If you already selected transactions in one of the 
other Production Analysis reports, these transactions 
are automatically be selected in the Business Process 
Distribution report.

➤ You can select a maximum of 20 transactions.

GUI Element Description
476



Chapter 17 • Application Performance Lifecycle User Interface
Summary Table

The Summary table area in the page includes the following elements (listed 
alphabetically):

GUI Element Description

Select a transaction, based on the total number of runs 
for the transaction as well as the transaction’s session 
popularity (or response time/availability data), and 
click the button.

The Sessions page opens, displaying data for each 
session in which the selected transaction was run and a 
transaction snapshot was collected, as well as certain 
key statistic averages of all the displayed sessions. 

For additional information on the Sessions page, see 
“Session Analyzer Report” in Using End User 
Management.

Application The application with which the transaction is 
associated.

Application Response 
Time (seconds)

Displays the net time, in seconds, of the transaction 
(that is, server time + network time + client time of all 
the pages included in the transaction).

Availability The transaction’s availability. 

Note: The color-coding of the column is based on the 
transaction’s availability in relation to the transaction 
availability threshold you defined in End User 
Management Administration.
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Generate Scenario 
Package

Select one or more transactions and click the button to 
instruct Application Performance Lifecycle to 
automatically select a session for each transaction and 
generate a VuGen script template based on this session. 

For each transaction, Application Performance 
Lifecycle selects the session with a combination of the 
greatest number of runs, the shortest duration, and the 
least number of errors. Application Performance 
Lifecycle then generates a VuGen script template based 
on each session, as well as a Summary report 
containing the Business Process Distribution report, 
the Typical Transaction Load report, and the Location 
Load Analysis report for the selected transactions.

If you have enabled the CRS on the Infrastructure 
Settings Manager page, you are prompted to save the 
scenario package in the repository. For details on 
enabling the CRS and saving the package in the 
repository, see “Save a Script Template or Scenario 
Package in the CRS” on page 460. 

If the CRS is not enabled, you are prompted to save the 
scenario package in your regular directory structure.

➤ When you click the button the CRS page is 
displayed, enabling you to generate VuGen script 
templates. You specify a file name and a description 
for the script and select a location in the repository 
in which to save the file. 

Popularity The percentage of unique sessions in which the 
transaction was run over the last day.

Total Runs The total number of run instances for the transaction.

Transaction The transaction name.

GUI Element Description
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Transaction Runs Over Time Graph

The Transaction Runs Over Time graph includes the following elements 
(listed alphabetically):

Transaction Response Time Over Time Graph

The Transaction Response Time Over Time graph includes the following 
elements (listed alphabetically):

GUI Element Description

<Data points> Displays for each period of time on the Time axis, the 
number of transaction runs for the configured 
transactions monitored by the Real User Monitor.

Tooltip: The transaction name and the number of 
transaction runs.

<Legend> Describes the color coding used in the graph.

Runs <y-axis> Displays the number of transaction runs.

Time <x-axis> Displays the time division units for the time range that 
you defined when generating the report. 

GUI Element Description

<Data points> Displays for each period of time on the Time axis, the 
transaction response time data for the configured 
transactions monitored by the Real User Monitor.

Tooltip: The transaction name and response time.

<Legend> Describes the color coding used in the graph.

Response Time (ms) 
<y-axis>

Displays the transaction response time in milliseconds.

Time <x-axis> Displays the time division units for the time range that 
you defined when generating the report. 
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Location Load Analysis Report

Report Settings

The area includes the following elements (listed alphabetically):

Description Enables you to view the transaction load (the number 
of Real User Monitor transaction runs) and bit rate (bits 
per second) per end-user location. 

Use the data in this report in configuring Vusers and 
load generators for your Performance Center load test, 
as well as the run-time settings for your Application 
Performance Lifecycle-generated VuGen script.

To Access: Select Application > Application 
Performance Lifecycle > Production Analysis > Location 
Load Analysis

Important 
Information

For details about analyzing the report, see “Analyze a 
Typical Transaction Load Report” on page 443.

Included in Tasks ➤ “Analyze a Typical Transaction Load Report” on 
page 443

➤ “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 447

GUI Element Description

<Common report 
settings>

For details, see “Understanding Common Report 
Elements” in Reference Information.Note: If you already 
selected a time range in one of the other Production 
Analysis reports, the time range you previously selected 
will automatically be displayed in the Location Load 
Analysis report.
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Report Content Viewed as a Graph

The View as Graph tab includes the following graphs:

Runs per Location 

The Runs per Location graph includes the following elements (listed 
alphabetically):

Location Selection To select locations to be displayed in the Location Load 
Analysis report, click the link to open the Select 
Locations dialog box. 

Transaction Selection If you already selected transactions in one of the other 
Production Analysis reports, by default the Location 
Load Analysis report displays data for the previously 
selected transactions. 

If the Location Load Analysis report is the first 
Production Analysis report you are accessing, or if you 
want to display data for a different group of 
transactions, click the link to open the Select 
Transaction dialog box.

GUI Element Description

<Bars> Display the total number of transaction runs for each 
location at which the selected transactions were run.

Tooltip: The number of transaction runs.

<Legend> Describes the color coding used in the graph.

Location <x-axis> Displays the locations.

Total Runs <y-axis> Displays the number of transaction runs.

GUI Element Description
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Bitrate

The Bitrate graph includes the following elements (listed alphabetically):

Report Content Viewed as a Table

GUI Element Description

<Bars> Display the transaction bit rate (bits per second) for 
each location at which the selected transactions were 
run.

Tooltip: The transaction bit rate (bits per second).

<Legend> Describes the color coding used in the graph.

Location <x-axis> Displays the locations.

Bitrate (Bits/sec) 
<y-axis>

Displays the transaction bit rate (bits per second).

Description Displays a table listing the bit rate (bits/second) and 
total number of runs for each transaction at each 
location, as well as an average of the bit rates and total 
runs of all the transactions at a location, an average of 
the bit rates and total runs for each transaction across 
all locations, and an overall average bit rate and total 
run calculation for all transactions across all locations.
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Select Locations Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to select the locations on which you want 
to run the Location Load Analysis report.

To access: Click Location Selection in the Location 
Load Analysis report.

GUI Element Description

Locations in the 
report

Use the first left-pointing arrow to move the 
appropriate locations from this area to the Locations 
not in the report area to exclude them from the report. 
Use the second left-pointing arrow to move all the 
locations from this area.

Locations not in the 
report

By default, the Select Locations dialog box displays the 
locations associated with the transactions you selected.

Select the locations for which you want to view data, 
and click the first right-pointing arrow to move them 
to the Locations in the report area to include them in 
the report. To view data for all the locations listed, click 
the second right-pointing arrow.

Use unknown 
locations

Select this checkbox to view data for locations that 
have not been assigned names.
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Select Transactions Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to select the transactions on which you 
want to run the Business Process Distribution report.

To access: Click Transaction Selection in the Business 
Process Distribution report or Transaction Selection in 
the Location Load Analysis report.

GUI Element Description

Application Select All applications to display the transactions from 
all monitored applications, or choose a specific 
application to display only transactions that were 
defined for that application. Select the transactions for 
which you want to view data, and click the first arrow. 
To view data for all the transactions listed, click the 
second arrow. Click OK to close the dialog box and save 
your settings.

Transactions in the 
report

Use the first left-pointing arrow to move selected 
transactions from this area to the Transactions not in 
the report area to exclude them from the report. Use 
the second left-pointing arrow to move all the 
transactions.

Transactions not in 
the report

Use the first right-pointing arrow to move selected 
transactions from this area to the Transactions in the 
report area to include them in the report. Use the 
second right-pointing arrow to move all the 
transactions.
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Typical Transaction Load Report

Description Enables you to view the average transaction load (the 
number of Real User Monitor transaction runs) during 
a typical hour, day, or week within a larger time frame 
that you select. 

Use the data in this report to:

➤ View the typical load on your system during specific 
time frames, which can assist you in determining 
the time frame you want to use for your 
Performance Center load test.

➤ Assist you, together with the data in the Business 
Process Distribution report, in selecting the 
transactions to include in your VuGen script 
templates.

To Access: Select Application > Application 
Performance Lifecycle > Production Analysis > Typical 
Transaction Load

Important 
Information

For details about analyzing the report, see “Analyze the 
Business Process Distribution Report” on page 439.

Included in Tasks “Use Application Performance Lifecycle Reports – A 
Case Scenario” on page 447
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Report Settings

The area includes the following elements (listed alphabetically):

GUI Element Description

<Common report 
settings>

For details, see “Understanding Common Report 
Elements” in Reference Information.Note: If you already 
selected a time range in one of the other Production 
Analysis reports, the time range you previously selected 
will automatically be displayed in the Location Load 
Analysis report.

Transaction Selection By default, the Typical Transaction Load report displays 
data for the transactions you previously selected in the 
Business Process Distribution report. If the Typical 
Transaction Load report is the first Production Analysis 
report you are accessing, or if you want to display data 
for a different group of transactions, click the 
Transaction Selection link to open the Select 
Transactions dialog box.

View a typical... Select Hour, Day, or Week. 

Working Days Click the Working Days link to open the Working Days 
dialog box, where you select the days of the week for 
which data will be included in the report.

Note: This link is only available when viewing a typical 
day or hour.

Working Hours Click the Working Hours link to open the Working 
Hours dialog box, where you select the hours of the 
day for which data will be included in the report. 

Note: This link is only available when viewing a typical 
hour.
486



Chapter 17 • Application Performance Lifecycle User Interface
Report Content Viewed as a Graph

The View as Graph tab includes the following elements (listed 
alphabetically):

GUI Element Description

<Bars> Display the average number of transaction runs for the 
selected transactions during a typical hour, day, or 
week within the time frame you specified.

Note:

➤ Click a bar to drill down to a component of the time 
period you selected in the View a typical field in 
report settings. For example, if you have selected a 
typical week, click on a day in the week to display 
the data for a typical day.

➤ The transaction runs for each sub-unit of time are an 
average of the transaction runs for all the 
occurrences of that sub-unit of time during the 
specified time frame. For example, if you choose to 
view a typical week during the period of a month, 
the average number of each of the selected 
transactions for each day in the week are displayed. 
The transaction runs listed for a specific transaction 
on Tuesday are an average of all that transaction’s 
runs on Tuesdays over the course of the specified 
month.

Tooltip: The average number of transaction runs.

<Legend> Describes the color coding used in the graph.

<Time period> 
<x-axis>

Displays the sub-units of time for the unit selected in 
the View a typical field in report settings. For example, 
if you choose to view a typical week, the individual 
days of the week are displayed on the Time period axis.

Runs <y-axis> Displays the number of transaction runs.
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Report Content Viewed as a Table

The View as Table tab includes the following elements (listed 
alphabetically):

GUI Element Description

<Subunit of time> The average number of transaction runs for each 
subunit of time (day, hour or minute), for each selected 
transaction.

Average <column> The average number of transaction runs for all subunits 
of time for each transaction.

Average <row> The average number of transaction runs for all the 
transactions for each subunit of time.

Transaction Transaction name.
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Business Process Recognition User 
Interface

This chapter describes the pages and dialog boxes that are part of the 
Business Process Recognition (BPR) application, listed alphabetically.

This chapter describes: On page:

Advanced Algorithm Setting Dialog Box 490

Business Process Recognition Settings Page 491

Business Process Recognition Tool Page 494

Data Selection Dialog Box 502

Raw Data Information Page 505

Select Pages Dialog Box 505

Unique ID Settings Dialog Box 506
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Advanced Algorithm Setting Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to specify if you want to find Business 
Processes, by their popularity level, automatically using 
an algorithm or manually.

To Access: Click Advanced Algorithm Settings in the 
Data Selection dialog box.

Important 
Information

The quality of a Business Process is characterized by its 
length (number of pages) and its popularity. The 
popularity is defined by percentage of sessions where 
the sequence of pages that represents the Business 
Process is included. 

GUI Element Description

Business Process 
length

Specify the minimum and maximum number of pages 
in the Business Process.

Business Process 
minimal length

Specify the minimum number of pages in the Business 
Process.

Business Process 
popularity initial 
level

Select the popularity level that interests you the most.

Manual mode Select to manually set the algorithm parameters.
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Business Process Recognition Settings Page

Popularity level Select the minimum and maximum popularity levels.

Smart mode Select to make the Web mining algorithm run in smart 
mode.

Smart mode automatically runs the algorithm with a 
high popularity level. It then checks the results and 
decides one of the following:

➤ lower the popularity level and run the algorithm 
again

➤ stop the process (when more than 20 results have 
been discovered) and return the results to the user. 
This enables you to display the most popular 
Business Processes. 

You can define the initial popularity level to shorten 
the running time needed for getting the result. For 
example, if you know (from prior runs) that the 
maximum popularity level is 25%, set the default at 
25% and avoid waiting till the smart mode processes 
down to this range.

Description Enables you to manage the processing task and to 
configure how exactly to process Real User Monitor 
sessions data.

To access: Click Application > Application Performance 
Lifecycle > Business Process Recognition > Business 
Process Recognition Settings

GUI Element Description
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The dialog box includes the following elements (listed alphabetically):

Important 
Information

Limitation: For each application you can process only 
40 days. The current status appears in the upper right 
corner of the month view (for example: 20 out of 40 
export days in use). When reaching the quota of 40 
days, clean some of existing dates to enable defining 
more dates. This value is customizable. For details, see 
“Modify the Maximum Number of Processing Days per 
Application” on page 471.

Included in Tasks “Convert Real User Monitor Data into Business Process 
Recognition Data” on page 468

GUI Element Description

Cancels the processing tasks that were assigned to the 
selected dates.

Clears the processed data that exists for the selected 
dates. This date becomes available for reprocessing.

Activates the processing tasks immediately.

Note: 

➤ The task processes each date one day at a time. The 
processing task takes time and depends on the 
amount of session click streams for the selected data 
and on the availability of the Real User Monitor 
engine. 

➤ This operation is not recommended for day to day 
use, except for testing or troubleshooting purposes. 
It is recommended, instead, to use the Process 
Selected Date option.

Note: The process may take a while, and can also lower 
Real User Monitor performance during business hours.
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Click to schedule a processing task for the dates you 
selected. You can select a range of dates and apply the 
selected schedule for the range.

Note: This operation only schedules a future task for 
the Real User Monitor engine. 

<Legend> The legend describes the meaning of the possible colors 
of the cells in the calendar.

Application Select the Real User Monitor application.

Clear downloaded 
data from local Client 
machine

Select to remove the data downloaded from the Real 
User Monitor server from the local Client machine. 

Clear the option to save the data downloaded from the 
Real User Monitor server on the local Client machine 
after you close the session.

Next Month with 
Data

Click to display the next month, if it includes data. If 
the next month does not include data, the month after 
that is displayed, if it includes data, and so forth.

Previous Month with 
Data

Click to display the previous month, if it includes data. 
If the previous month does not include data, the 
month before that is displayed, if it includes data, and 
so forth.

Refresh Updates the calendar view to see when the operation 
started when you clicked the  button.

UID Setting Click to open the Unique ID Settings dialog box.

GUI Element Description
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Business Process Recognition Tool Page

The page includes the following elements (listed alphabetically):

Description Helps you discover frequently used 
processes/transactions patterns that might represent 
Business Processes.Also generates and displays multiple 
reports that provide data about the discovered Business 
Processes, simultaneously. Each tab on the application 
displays a different business process report.

To access: Click Application > Application Performance 
Lifecycle > Business Process Recognition > Business 
Process Recognition Tool

Important 
Information

➤ You can close a tab (report), print it, save it, rename 
it, and create a new tab.

➤ Only the first 100 Business Processes are displayed.

➤ For more information about the Business Process 
Recognition, see “Business Process Recognition 
Application Overview” on page 466.

➤ Customization: You can customize the number of 
Business Processes that can be displayed. For details, 
see “Modify the Number of Business Processes That 
Can be Displayed in the Main View” on page 471.

Included in Tasks “Deploy Business Process Recognition and Analyze the 
Results” on page 469

GUI Element Description

Click to create a new Business Process Recognition 
report.

A new tab is created in the page.

Click to open an existing Business Process Recognition 
report. For example, use this option to open a report 
that was sent to you. 
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Business Process Recognition Filter Area

The area includes the following elements (listed alphabetically):

Click to print the report.

Click to save the changes.

GUI Element Description

<Tabs> Each discovered business process report is displayed on 
a separate tab. A new tab is created with a default name 
when you click New. Right-click the tab to display the 
following options:

➤ Rename. Opens the Rename dialog box where you 
can change the name of the tab.

➤ Close. Closes the current tab.

➤ Close All Other Tabs. Closes all tabs except the 
current one.

➤ Close All. Closes all the tabs.

➤ New. Creates a new tab.

Applications Select the Real User Monitor application. 

Information about the date and the size of the data 
that was imported when you generated the report is 
displayed on the right of the Applications box. For 
example:

Generate Click to generate a report.

Select Report Data Click to open the Data Selection dialog box where you 
can select the data on which the report is based. For 
details, see “Data Selection Dialog Box” on page 502.

GUI Element Description
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Results Area

The area includes the following elements (listed alphabetically):

Description By default, in each tab, the business processes are 
grouped into one presentation layer. Initially, every 
page that appears on several business process appears 
only once on the generated report. 

You can then filter the pages, group or ungroup pages, 
and select buttons to display different aspects of the 
data.

Important 
Information

Using the buttons and options available on this panel, 
you modify how you display the report (without 
changing the actual contents).

You can adjust the business process display so that each 
business process is displayed separately even if it has a 
shared page with other business processes. 

You can also select to display business processes that 
include specific pages. 

You can:

➤ show only business processes with specified pages.

➤ group pages (aggregate business processes to find the 
common paths between them). 

➤ ungroup pages (view each business processes 
separately).

GUI Element Description

Click to return the graph to the original layout. The 
layout displays the percentage of participation of a 
page compared to the total number of sessions of the 
Business Process.

Display the current report raw data information 
(sessions include, average sessions size and more). For 
details, see “Raw Data Information Page” on page 505.
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Select a page and click the button to open the Define 
Page dialog box in the EUM Administration, where you 
can create a Business Critical Page corresponding to the 
selected RUM page. The page is saved in End User 
Management as a Business Critical page. For details, see 
“Define Page Dialog Box” in Using End User 
Management.

Select two or more pages that you defined as Business 
Critical Pages and click the button to open the Define 
Transaction dialog box, where you can create a 
transaction that is saved in End User Management. 

Note: If you select a page that is not defined as a 
Business Critical Page, the transaction creation fails. 

Fit the complete view in the window. If, for example, 
you have enlarged the view in such a way that it does 
not fit in the window, click the button, to shrink the 
graph so that it fits in the window.

To move pages, click the button, select pages and drag 
them to the required location. To curve a link, click the 
button, click the link where you want to give it a curve, 
and drag until you obtain the right curve.

Click the button. A small window opens. Drag the 
rectangle in that window to magnify the 
corresponding area in the main view. 

Click the button and click and drag the graph to shift 
the location of the complete graph in the main view.

GUI Element Description
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Click the button, click the graph in the main view, 
move the cursor up to shrink the graph, and move the 
cursor down to enlarge the graph.

Click to toggle the display of the minimum and 
maximum number of flows that include the page.

GUI Element Description
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Click to display the percentage of brown-out for the 
pages (a page is brownout when the incoming traffic is 
larger than the outgoing traffic, for example, the 
incoming traffic is 75% while the outgoing traffic is 
35%).

The colors of the brown-out levels are as follows:

➤ Green. 0%-25% (Normal)

➤ Yellow. 25% - 35% (Minor)

➤ Light olive. 35% - 55% (Warning)

➤ Orange. 55% - 75% (Major) 

➤ Red. 75% - 100% (Critical)

Customization: You can change the threshold values. 
For details, see “Customize Business Process 
Recognition” on page 470.

GUI Element Description
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Toggle to display the diagram with:

➤ Percentage values: 

➤ Accurate values:

Note: The diagram is initially displayed with 
percentage values.

GUI Element Description
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Group by: Select:

➤ Identical linked pages. Superimposes identical pages 
that have links to identical pages and superimposes 
the links.

➤ Identical pages. Creates a separate path for each link 
to a different page or when the percentage of links 
to the same page is different for different Business 
Processes. Similar pages are displayed one under the 
other so you can see each link separately.

➤ Do not group. Shows each Business Process 
individually.

GUI Element Description
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Displayed Business Process Pages Area

The area includes the following elements (listed alphabetically):

Data Selection Dialog Box

View Business 
Processes Containing 
Page

Select to open the Select Pages dialog box where you 
can select the pages you want to display. The dialog 
box displays all the pages that are displayed in the 
graph in the Results area.

Description Shows details about all the pages that where discovered 
during the Business Process Recognition process and 
that appear in the graph.

GUI Element Description

Max Popularity Displays the highest number of times the page was 
included in any of the discovered Business Processes.

Min Popularity Displays the least number of times the page was 
included in any of the discovered Business Processes.

Nbr. of Business 
Processes Using the 
Page

The number of discovered Business Processes in which 
this page is included.

Page Name The unique page ID or the name of the page.

Description Enables you to select the data on which the Business 
Process is to be discovered.

To Access: Click Select Report Data in the Business 
Process Recognition Reports page.

Included in Tasks “Convert Real User Monitor Data into Business Process 
Recognition Data” on page 468

GUI Element Description
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Pages Filter Area

The Page Filter area includes the following elements (listed alphabetically):

Sessions Filter Area

The Sessions Filter area includes the following elements (listed 
alphabetically):

GUI Element Description

Ignore selected 
pages

Lists the pages that you selected to filter out in the 
Select Pages dialog box.

Remove consecutive 
duplicate pages

Select to ignore multiple consecutive instances of the 
same page (leave only one instance). For example, if 
the session includes the following sequence of hits: 
login, choose package, choose package, choose package, 
submit, it is reduced to: login, choose package, submit.

Select Pages Click to open the Select Pages dialog box. You can filter 
out pages that are common and that have no impact 
on the business (for example, Welcome page).

GUI Element Description

Include only sessions 
that contain the 
following page

Lists the pages that must be included in the session. For 
example, sessions that include the log out page.

Include only sessions 
that have more than 
<min> or less than 
<max> number of 
pages

Specify the minimum and maximum number of pages 
of the session. Helps you ignore sessions that are too 
short or too long.

By default, those values are 5 and 200.

Select Pages Click to open the Select Pages dialog box.
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Date Filter Area

The Sessions Filter area includes the following elements (listed 
alphabetically):

Description Enables you to select which date you want to analyze 
(remember that first you have to process them into BPR 
format using the administration applet).

Important 
Information

The colors of the cells in the date table indicates 
whether the date has been selected, there is data 
available for processing at that date, and the current 
date.

GUI Element Description

<Legend> The legend describes the meaning of the possible colors 
of the cells in the calendar.

Advanced algorithm 
setting

Click to open the Advanced Algorithm Setting dialog 
box.

Clear All Click to clear the dates you selected for the month.

Next Month with 
Data

Click to display the next month, if it includes data. If 
the next month does not include data, the month after 
that is displayed, if it includes data, and so forth.

Previous Month with 
Data

Click to display the previous month, if it includes data. 
If the previous month does not include data, the 
month before that is displayed, if it includes data, and 
so forth.

Selected Date 
Summary

Click to display the selected dates. The legend below 
the monthly calendar indicates the selected dates, the 
days that have data assigned to them, and the non-
selectable data.

View Selected Date Click to display the dates you selected.
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Raw Data Information Page

Select Pages Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Displays raw data information about the report and 
about the algorithm parameters that were used to run 
the report.

To access: Click the  button in the Business Process 
Recognition Tool Page.

Description Enables you to select the pages that are to be ignored 
when running Business Process Recognition.

To Access: Click Edit in the Pages filter area of the 
Select Report Data dialog box.

GUI Element Description

<arrows> Click the single arrows to select/unselect the selected 
elements. Click the double arrows to select/unselect all 
the elements at a time.

Filter Enter a string to help you filter the list below. 

The string behaves as if it had a star (*) wildcard before 
and a star (*) wildcard after - you do not need to enter 
those characters. 

You can also insert a star (*) wild card in the string. 

Selected pages Select the pages and click the arrows to move the 
selection back to the Unselected pages box.

Unselected pages Lists the available pages. Select them using the filter or 
select the pages and click the arrows to move the 
selection to the Selected pages box.
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Unique ID Settings Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to specify the export method and the URL 
ID setting.

To Access: Click the URL Unique ID Setting button in 
the Business Process Recognition Settings dialog box.

Important 
Information

The first step in analyzing a web application depends 
on the ability to identify its pages. Since the same page 
in a web application probably has different URLs due 
to different session ID, end users, and other 
parameters, it is important to configure how to identify 
the same page across all sessions. To do so, you must 
supply to the Business Process Recognition application 
a simple configuration that helps it to identify pages. 

The unique ID can rely on existing naming methods 
(Business Critical Pages and the meaningful names 
feature).

GUI Element Description

Add/Remove Use to add or remove specific parameters.

Export method Select one of the following:

➤ Use only named hits (Business Critical Pages and 
named pages). To use the business critical pages that 
are defined in End User Management 
Administration and pages to which meaningful 
names were given.

➤ Create unique ID for all hits. To use all pages in the 
click stream and assign a unique Business Process 
Recognition ID to each one of them.

➤ Both. To provide a unique ID to all pages in the click 
stream that do not have a name or are not Business 
Critical Pages. The named pages retain their original 
name.
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Include URI in 
Unique ID

Select to specify which components of the URL are 
used in the generated unique ID. You can select 
whether to include the URI and set of parameters 
(GET/POST) that are to be included in the unique ID.

Parameters Enter the URL parameters. The pages whose URL 
includes those parameters, which should be referred to 
for page identification, are included in the export 
operation.

For example, if the source URL is:
http://micrm.hp.com/callcenter_enu/start.swe?SWEC
md=GotoPageTab&SWEBID=-1&SWEView=All Service 
Request List 
view&SWEC=2&SWETS=&SWEScreen=Service Request 
Screen&SWEVST=-
1&SWEStrCCnt=372&SWECacheId=1&SWEJFN=top._s
we._swejssview.s00

and you enter the SWECmd and SWEView parameters 
to identify this page, the result is: 
SWECmd=GotoPageTab&SWEView=All Service 
Request List view

GUI Element Description
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